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Introduction to Torrent Suite™

Software

■ Torrent Suite™ Software product information . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

■ Operating system compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

■ Browser compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

■ Hardware compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

■ Network and password security requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Torrent Suite™ Software product information

Torrent Suite™ Software is used for sequencing data analysis. The software allows you
to plan and monitor sequencing runs, view sequencer activity, and review sequencing
data that use a variety of sequencer instruments.

Torrent Suite™ Software and hardware provide customizable and automated sample
analysis and data storage solutions. You can plan, monitor, and track your sequencing
runs all within a web interface, while reviewing the quality and accuracy of your run.
In addition, you can perform variant calling and detect SNPs and INDELs.

The Torrent Suite™ Software 5.12 User Guide and the Torrent Suite™ Software 5.12 Help
provide information for using Torrent Suite™ Software on a Ion PGM™ Sequencer or
Ion Proton™, Ion S5™, Ion S5™ XL, and Ion GeneStudio™ S5 Series sequencers.

Operating system compatibility

Ion Torrent™ Server in Torrent Suite™ Software 5.12 is compatible with Ubuntu
operating system 14.04 and 18.04.

Browser compatibility

Torrent Suite™ Software can be operated on all modern web browsers such as
Microsoft™ Internet Explorer™,Microsoft™ Edge, Google™ Chrome™, Safari, and
Firefox™.

1
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Hardware compatibility

• Ion S5™ Sequencer
• Ion S5™ XL Sequencer
• Ion PGM™ Sequencer
• Ion Proton™ Sequencer
• Ion GeneStudio™ S5 Sequencers
• Ion Chef™ Instrument

Network and password security requirements

The network configuration and security settings of your laboratory or facility (such as
firewalls, anti-virus software, network passwords) are the sole responsibility of your
facility administrator, IT, and security personnel. This product does not provide any
network or security configuration files, utilities, or instructions.

If external or network drives are connected to the software, it is the responsibility of
your IT personnel to ensure that such drives are configured and secured correctly to
prevent data corruption or loss. It is the responsibility of your facility administrator,
IT, and security personnel to prevent the use of any unsecured ports (such as USB,
Ethernet) and ensure that the system security is maintained.

Thermo Fisher Scientific strongly recommends that you maintain unique passwords
for all accounts in use on this product. All passwords should be reset upon first sign
in to the product. Change passwords according to your organization's password
policy.

It is the sole responsibility of your IT personnel to develop and enforce secure use of
passwords.

Network
configuration and
security

Password security

Chapter 1 Introduction to Torrent Suite™ Software
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Get started with Torrent Suite™

Software

■ Torrent Suite™ Software user interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

■ Dashboard at a glance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

■ User (Staff) versus Administrator (Superuser) roles . . . . . . . . . . . . . . . . . . . . . . . 18

■ Register for a new user account . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

■ Update software with new releases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

■ Plan a run . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Torrent Suite™ Software user interface

Torrent Suite™ Software user interface is organized into several activities, which
appear as tabs.

• Home—The Home tab contains a Dashboard that provides summary
information about your system and operations.

– View summary information about your instruments, services, and data
management.

– View the runs in progress and get run reports on completed sequencing
runs.

– View instrument activities and status for every sequencer that is attached to
your system.

You can also see News about new software releases, product updates, and other
announcements.

• Plan—Use the Plan tab to access both Planned Run templates (reusable
experiment designs) and Planned Runs (executable instructions for individual
sequencing runs). Select the experimental design for a Planned Run template that
can be reused multiple times for sequencing runs.

– Create a run plan and download directly to the sequencer.
– Specify your sequencing run information, including run details, sample IDs,

and automated data analysis preferences.
– Easily organize and track your data.

• Monitor—Use the Monitor tab to view the status of the system and sequencing
runs.

– Monitor run progress in real-time.
– Monitor key sequencing metrics to help evaluate the status of a run.
– View thumbnail quality graphs that provide near real-time information on

runs in progress, so that you know early on about any instrument problems.

2
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• Data—Use the Data tab to view summaries of completed runs, get detailed run
reports, and review plugin results.

– Filter the completed run list to see specific run types.
– Review Planned Run settings and reanalyze reports with different settings.
– Group result sets into projects for data management, such as archiving or

pruning of result files.
– View run statistics and data analysis results.
– View run results in a standard report format with easy-to-read graphics and

key performance metrics.
– Download output files and run reports.
– Monitor disk usage and archive data to make more room.
– Store your data, results files, and run reports to a Torrent Storage™ NAS

(Network Attached Server) device, your own network access storage (NAS)
device, or a USB drive.

– Export data in industry standard formats to storage, or to Ion Reporter™

Software or third-party software using plug-ins.
•  (Settings)—Use the Settings tab to view information about software versions

and updates, user profiles, analysis parameters, plugins, support contacts,
available references, and system services. The Administrator role is required to
perform some of these functions. For more information, see “Settings tab“ on
page 15.

Use the (Settings) tab on any Torrent Suite™ Software screen to view information
about software versions and updates, user profiles, analysis parameters, plugins,
support contacts, available references, and system services. The Administrator role is
required to perform some of these functions.

Setting Description

About Opens the Releases screen that shows version information
about the operating system and all products in use by your
system.

Accounts Opens the User Profile/Account Information screen where
you can view and update your user profile and account
information. An administrator can review new user
registration requests and set up user profiles.

Analysis Parameters Opens the Analysis Parameters screen where you can view
and copy parameter files pertaining to various chips.

Configure Opens a screen where an administrator can configure:

• Customer support contact information

• IT contact information

• Site name

• Time zone settings

• Email notifications

• Database administration functions

• Ion Torrent™ Servers storage strategies

Settings tab

Chapter 2 Get started with Torrent Suite™ Software
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Setting Description

Ion Mesh Opens the Configure Mesh screen where an administrator can
configure a connection between two or more Ion Torrent™

Servers that are running the same software version.

Ion Reporter Configure Opens the Ion Reporter Uploader Account Configuration
screen where an administrator can configure accounts that
allow uploading of run information to Ion Reporter™ Software.

Plugins Opens the Plugins screen where you can view information
about the plugins that are installed on the Ion Torrent™

Server. An administrator installs the plugins, but users can
rescan the plugins to update the versions.

Reference Sequences Opens a screen where users can import files that contain
reference sequences, target regions, hotspots, test
fragments, barcode sets for use in instrument and
sequencing runs. You can also view the status of uploading
panel files.

Services Opens the System Services screen, where users can view the
identity and status of services that are running on the Ion
Torrent™ Server

In the Telemetry Services section of the System Services,
users can enable or disable their connectivity to Connect in
order to transfer support archived files so that Thermo Fisher
Scientific Technical Support staff to perform remote
troubleshooting on request. Enabling telemetry services also
reports anonymous usage statistics to Thermo Fisher
Scientific. Disabling telemetry services stops all Connect
integration and may make remote support more difficult.

Updates Opens a screen that provides information about any products,
plugins, or instruments that may have updates available. An
administrator can review this information, and then manually
upload new releases when they are available.

Chapter 2 Get started with Torrent Suite™ Software
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Dashboard at a glance

Use the Dashboard to see active and recent sequencing runs. The Dashboard provides
an overview of activity on all of your sequencers. To view the Dashboard, click the
Home tab, then click Dashboard.

The Summary section includes:
• Software link—Click the link to open the Releases screen, where you can click

Update to update your software when new versions are released. Scroll down to
links to support information.

• Instruments column—Shows the number of instruments that are connected or
offline, and those that have alerts.

• Services links—Reports statuses, such as services that are running, nodes that are
down, and RAID storage statuses. Click a link to see details.

• Data Management links—Reports disk usage and data management activity.
Click a link to see details.

• Stop Refresh stops the auto refresh function, which occurs every 30 seconds by
default. Stop the auto refresh function to review the screen without interruption
from the refresh cycle.

Chapter 2 Get started with Torrent Suite™ Software
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The Runs section shows information that is available through the Data, Plan, and
Monitor tabs; however, it is a subset of only the most recent information. The Runs
section includes:

• Run Name link—Takes you to the name of the run or the run report.
The link is not functional until the run report is completed.

• Samples  information icon—Shows names of and information about barcodes
for samples.

• The third column shows the stage of the run, with the date that the run
information was either last updated or completed.

• The fourth column shows the progress of sequencing runs and plugin use. Blue
circles denote normal progress and red circles denote sequencing or plugin
errors.

• The fifth column provides links to thumbnail reports and run reports. If an error
appears in red under a run report, see “Troubleshoot Torrent Suite™ Software“ on
page 376 or contact Technical Support.

– The Run Report links to completed run reports for the time interval selected.
The link becomes active when the run report is complete.

– The Thumbnail Report is an early run report that helps you determine the
quality of a run in progress.

• The Activity list allows you to select a time interval for viewing sequencer
activity. Choices include: Last Hour, Today, Last 24 Hours, and Last 7 days.

The Instruments section shows the instruments that are connected to the system and
their operational status, which may include:

• Connected—Instruments that are connected but status is unknown.
• Analyzing—Instruments that are currently in use.
• Cleaning—Instruments that are currently undergoing a cleaning process.
• Idle—Instruments that are connected, but not currently in use.
• Offline—Instruments that are no longer connected. These instruments are shown

when run reports for runs on these instruments exist in Torrent Suite™ Software.

If an instrument has an operational error, hover the mouse over the  Alert to see
details. Then, resolve the issue on the sequencer.

Use the News screen to see Thermo Fisher Scientific announcements about new
products, software releases, and other news. To view the News screen, click the Home
tab, then click News.

User (Staff) versus Administrator (Superuser) roles

In Torrent Suite™ Software, the User (Staff) role allows the creation and execution of
Planned Runs on a sequencing instrument.

The Administrator (Superuser) role also allows the creation and execution of Planned
Runs, and also allows server configuration, user configuration, base caller
configuration, reference management, and data management. For more information
on Administrator functions, see Chapter 14, “Administer Torrent Suite™ Software“.

News screen

Chapter 2 Get started with Torrent Suite™ Software
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Register for a new user account

When you sign in to Torrent Suite™ Software for the first time, you request a new user
account. The request is sent to the administrator for approval. An account is not active
until approval is granted.

1. On the sign in screen for Torrent Suite™ Software, click Register.

2. Enter the new user information, then click Submit.
Upon the approval by an administrator, the new account is created.

Update software with new releases

An administrator is responsible for installing, configuring, and upgrading Torrent
Suite™ Software, the Ion Torrent™ Server, and plugins. Contact your administrator for
more information.

Plan a run

The following steps describe how to use Planned Run templates and Planned Runs
that fit into your sequencing workflows.

1. Decide on your sequencing application and sequencing product (such as an Ion
AmpliSeq™ panel).

2. Select a preinstalled Planned Run template with defaults for your application
and sequencing product, or create a custom Planned Run template from scratch
to customize your Planned Run.

3. Create new Planned Runs from Planned Run templates, adding the names of the
samples to be sequenced.
Use Planned Run templates and Planned Runs to enter run information through
Torrent Suite™ Software instead of directly on the sequencing instrument. The
use of Planned Run templates and Planned Runs reduces the chance of errors
and wasted runs, reduces setup time on the sequencing instrument, and
increases instrument throughput.

4. Start the run on the sequencer.
On the sequencer, information for a Planned Run is applied to the current Run
Info screen automatically, or by selecting the Planned Run from a list of Planned
Runs. You can also overwrite (change) Planned Run information directly on the
sequencer.

Chapter 2 Get started with Torrent Suite™ Software
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Samples and Sample Sets
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Torrent Suite™ Software uses samples and Sample Sets that sequencing instruments
use to process the genetic material during instrument runs.

About samples and Sample Sets

Samples in Torrent Suite™ Software are the information and attributes that
characterize the data.

Samples contain information, or attributes, that sequencing instruments use to process
the genetic material during instrument runs. After sample sequencing is complete,
software programs, such as Ion Reporter™ Software, use sample information for data
analyses.

Sample information can be transferred to Ion Reporter™ Software from the sequencer
through Torrent Suite™ Software using the IonReporterUploader plugin, or imported
as individual BAM or VCF files. When a Ion Reporter™ Software analysis workflow is
used to analyze a sample, the output in Ion Reporter™ Software is a set of analysis
results.

You can preselect the attributes that you want to associate with each sample before
you start to plan your templating and sequencing runs. Then you can organize the
samples into Sample Sets that you can reuse when you create Planned Runs. Using
Sample Sets can save data entry time and reduce the likelihood of errors when you
plan your instrument runs by entering the information for the Sample Set only once,
then reusing the Sample Set for other runs.

Grouping samples into Sample Sets is also helpful for using barcodes that have
attributes that are assigned to each individual barcode. If you create Sample Sets
before planning the run, you can enter barcodes and the barcode attributes only once

3
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in the Sample Sets. Then you can select one or more Sample Sets to reuse these
barcodes when you create a Planned Run.

You can set up samples in Torrent Suite™ Software in two ways. You can manually
enter sample information for each sample, or import sample information from a CSV
file that contains the sample information.

You can search for and find samples in the software, add Sample Sets to your Planned
Runs, and view details about how the sample libraries were prepared if the run uses
an Ion AmpliSeq™ library preparation kit. To change the sample files, you can also
edit information in the samples, update Sample Sets, and delete samples and Sample
Sets.

Create a Sample Set manually

Create a Sample Set manually by entering sample information into the Torrent Suite™

Software without the use of an external CSV file. This method of entering sample
information is useful for creating small Samples Sets.

To create a Sample Set manually, enter individual samples into the software, then
create a new Sample Set and add your samples to it. Alternatively, you can add your
new samples to an existing Sample Set.

For Sample Sets that contain numerous samples, you may want to import samples
using a CSV file. For more information, see “Create a Sample Set by importing
samples from a CSV file“ on page 22.

1. In the Plan tab, click Samples, then click Add or Update Sample Set/Samples.

2. Click Enter New Sample.
a. Complete the Add Sample dialog box. For information about defining the

samples, see “Sample attributes“ on page 26.

b. Click Done.
Your new samples and sample attributes appear in the Enter Samples list.

c. Enter additional samples if needed.

3. Add the samples to a sample set. Do one of the following:

• Click Add to existing Sample Set, then select an existing Sample Set to
contain the samples.

• Click Create Sample Set. For information about defining the Sample Set, see 
“Sample Set definitions“ on page 30.

4. Click Save Sample Set.
The set name appears in the Sample Sets list.

You can use the Sample Set to create a Planned Run. The information from the Sample
Set and individual samples within the Sample Set are prepopulated in the Planned
Run workflow bar steps and Planned Run template. For more information, see “Plan
by Sample Set“ on page 63.

Chapter 3 Samples and Sample Sets
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Create a Sample Set by importing samples from a CSV file

If you have many samples, you can import new samples into Torrent Suite™ Software,
or update existing samples, using a CSV file that contains sample information. If you
do not yet have a samples file, you can create one from an available CSV template that
is available in Torrent Suite™ Software. During this process, you can also create a new
Sample Set for the new samples.

1. In the Plan tab, click Samples, then click Import Samples from File.

If you do not yet have a samples file, create a new samples file from an available
samples CSV file. For more information, see “Create a samples file from a
template“ on page 23.

2. Upload the samples file, and optionally add a new Sample Set to receive the
samples.

a. In the Import Samples section, click Select file, then navigate to sample
import file, then upload the sample import file.

b. Select a Sample Set CSV file, then click Open.

c. Select a Sample Set to receive the samples.
(Optional) To add a new Sample Set to receive the samples, click Add
Sample Set, then complete the Sample Set information.
For information about how to define a Sample Set, see “Sample Set
definitions“ on page 30.

3. Click Save & Finish.
The system loads, parses, and validates the file, then, if no errors are found, saves
the samples and Sample Sets.

Chapter 3 Samples and Sample Sets
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Create a samples file from a template

If you do not already have a samples file on your computer to use to import samples
from a CSV file, then you can download a samples template and use it to create a
samples file.

1. In the Plan tab, click Samples, then click Import Samples from File.

2. In step 1 of the Import Samples section, click Sample File Format to download a
sample CSV template.
The sample file format CSV contains the version of the CSV file in the top row,
and sample attributes in separate columns.

3. To create a new CSV file, copy and paste the contents of your existing sample
CSV file into the new file format.

4. Open the CSV template and enter sample information into the cells .
For information about how to define the samples, see “Sample attributes“ on
page 26.

5. Save the file to your computer so that is available for use to create a Sample Set.

Sample information

When you add a sample to a Sample Set in Torrent Suite™ Software, you enter
information to describe and identify each sample, with characteristics such as gender,
sample type (RNA or DNA, for example), or relationship group. This sample
information is referred to as sample attributes. You can add user-defined attributes to
the sample attributes that are available in the software. Each attribute that you add
appears in:

• Lists of samples and Sample Sets on the Ion Torrent™ Server.
• The Add Sample dialog box in the software.
• The CSV file that is used to import sample information.

A sample attribute can be made mandatory, in which case you are required to enter
the attribute information for each new sample. After the attribute is added to the
Sample Attributes list, you can edit or delete user-defined attributes. You can also
choose whether the attribute is displayed or hidden from the sample listings and the
Add Sample dialog box.

The attributes that you create are applied to individual samples and not to the Sample
Sets.

Chapter 3 Samples and Sample Sets
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You can view details about a Sample Set and review sample attributes for each sample
that is in a Sample Set.

Some sample attributes are passed from Torrent Suite™ Software for use in Ion
Reporter™ Software. Trio is an example of a Sample Set grouping that is used in an Ion
Reporter™ Software analysis workflow. If you select the Trio Sample Set grouping,
Torrent Suite™ Software automatically selects a Trio Ion Reporter™ Software analysis
workflow when you create a Planned Run.

In a Trio Sample Set, you can view attributes that include:
• Gender—the gender of the sample.
• Type—the Torrent Suite™ Software relationship type used for Example Sample

Set.
• Group—the number is the Sample Set mechanism to mark the samples as related.

Related means that in the eventual Ion Reporter™ Software analysis, these
samples are analyzed in one analysis with a defined relationship between the
samples, such as Tumor and Normal.

1. In the Plan tab, click Samples.

2. In the Sample Sets table, find a sample set that you want to view.
For more information on locating your sample set, see “Find a Sample Set“ on
page 32 and “Sort Sample Sets“ on page 32.
In this example, a Trio Sample Set named Example Sample Set is shown

Each column in the Sample Sets table lists a specific attribute for that Sample Set.

3. Click the arrow in the row of the Sample Set to expand the table and view all
samples within the Sample Set.

Each column in the expanded table lists a specific attribute for each sample
within the selected Sample Set.

View Sample Set
attributes
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1. In the Plan tab, click Samples, then click Sample Attributes4Add.

2. In the Add Attribute dialog box, enter the following:
• Attribute Name
• Attribute Type

If the Attribute Type is set to Integer, you can enter only numeric characters
(whole numbers) for this attribute.

• (Optional) Description

3. (Optional) Select the Is Mandatory checkbox if you want the attribute to be
required for every sample.

4. Click Save.

If you add user-defined sample attributes to the Ion Torrent™ Server, you can:
• Edit sample attributes.
• Choose whether the attributes are displayed or hidden from the list of samples,

Sample Sets, and Add Sample dialog box.
• Delete sample attributes.

1. In the Plan tab, click Samples, then click Sample Attributes4Manage.

Add a sample
attribute to a
sample

Manage sample
attributes
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2. In the Sample Attributes list, click  (Actions) in the row of the attribute that
you want to manage, then click one of the following:

Action Description

Edit • In the Edit Attribute dialog box, edit one or all of the following:
a. Attribute Name

b. Attribute Type

c. Attribute Description

• You can also change whether the attribute is required or optional
by selecting or deselecting the Is Mandatory checkbox.
The attribute that is mandatory is designated by the selected
checkbox in the Required column of the Sample Attributes table.
The absence of the selected checkbox designates the attribute as
optional.

Show/Hide You can hide a user-defined attribute from view without deleting it by
using these options.

• If you hide an attribute, that attribute no longer appears in the list
of samples, Sample Sets, and Add Sample dialog box.
The attribute that is shown is designated by the selected checkbox
in the To Show column of the Sample Attributes table. The absence
of the checkbox designates the attribute as hidden.

• If you hide a mandatory attribute, that attribute is no longer
mandatory.

Delete Deleting a sample attribute permanently deletes that attribute from the
Ion Torrent™ Server.

When you create a Sample Set, you enter sample attributes into the Torrent Suite™

Software, whether you enter attributes manually or by importing samples using a
CSV file. Most of the sample information is optional except for Sample Name.
However, some information is required if you transfer data to Ion Reporter™ Software,
and those attributes required by Ion Reporter™ Software are indicated in the following
table.

Attribute Description

Sample Name

(Required)

The unique name of the sample.

Use any combination of alphanumeric characters, plus spaces,
periods (.), hyphens (-), and underscores (_).

This attribute is used by Ion Reporter™ Software.

A 255‑character limit must be followed for Ion Reporter™ Software
name validation. If you are using Ion Reporter™ Software, and the
actual sample name already exists in that software, a string such
as _v1 or _v2, and so on, is added to the sample name.

Sample External ID (Optional) If you manage samples in an external system, for
example, a Laboratory Information Management System (LIMS),
enter the identifier from that system.

Sample attributes
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Attribute Description

Barcode Kit The name of the barcode kit used to make a library from the
sample. The same barcode kit must be used for all samples in a
Sample Set.

Barcode The name of the specific barcode in the selected barcode kit.
Assign a unique barcode to each sample in a Sample Set.

Sample ID A unique identification code (SampleID) for each barcode in a
sample. This helps to track samples or possibly identify
misassignment between samples and barcodes in a sequencing
run. The SampleID is passed to Ion Reporter™ Software.

If you manage samples in an external system (for example, a
LIMS), you can use the identifier from that system.

This attribute cannot be changed.

Note: This attribute is optional in Torrent Suite™ Software.
However, this value can be required for planned runs that include
automatic upload of data to Ion Reporter™ Software.

Control Type The control type used when preparing the sample. If blank, the
sample is not a control type sample.

Basic Annotations

Description Typically one or two sentences that describe the sample.

Nucleotide Type • Unspecified

• DNA

• RNA

• TNA

• Fusions

Sample Source The source from which the sample is extracted.

• Blood

• FFPE

• Other

Panel Pool Type Reserved for future use.

• Dual Pool

• Single Pool

Chapter 3 Samples and Sample Sets
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Attribute Description

Gender The biological gender of the sample.

This attribute is used by Ion Reporter™ Software.

• Female

• Male

• Unknown

IMPORTANT! If you are using Ion Reporter™ Software, do not
leave this blank. Select Unknown if the gender is not known.
Several analysis workflows in Ion Reporter™ Software, for
example, copy number variation detection and genetic disease
research, are limited when the gender is not known. The analysis
workflows can return unexpected results when the gender is
incorrectly specified for a sample.

Type The relationship type for this sample. Type is used in conjunction
with Relationship Group, described below. For example, a
relationship group can contain two samples, one with a type Tumor
and another with a type Normal.

The following sample relationships are supported by Ion Reporter™

Software:

• Control

• Father

• Mother

• Normal

• Sample

• Self—Use Self for both a single sample and for the proband
sample in a trio. A single sample is not related to other
samples and is analyzed by itself.

• Tumor

Relationship Group Use Relationship Group to designate a group of multiple related
samples within the same Sample Set. For example, DNA and RNA
samples from the same sample would have the same Relationship
Group number.

Use a whole number to define a sample as part of a relationship
group. It is used in conjunction with Type. For example, a Sample
Set can contain 6 samples, consisting of 3 groups of 2 related
samples each (of types Tumor and Normal). In this case, you would
designate the two samples in each group as part of group 1, 2, or 3.
This is identical to the Set ID in the IonReporterUploader plugin.

Extra Annotations (used for specialized applications, such as preimplantation genetic
screening (PGS) research or oncology research)

Sample Collection
Date

The date that the blood sample was drawn.

Sample Receipt
Date

The date that the laboratory received the blood sample.

Chapter 3 Samples and Sample Sets
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Attribute Description

Cancer Type The type of cancer that is present in the sample.

Population The super population code assignment for a sample, as defined by
the human 1000 genomes project ( www.internationalgenome.org/
faq/which-populations-are-part-your-study/). The population is
relevant to the analysis of samples by the TCRB-LR assay workflow
in Ion Reporter™ Software. The TCRB-LR analysis workflow
produces a haplotype group assignment for samples having a
population attribute of "European".

Mouse Strains The name of a mouse strain. Choose from a select number of the
most common strains. In Ion Reporter™ Software 5.12, the selected
mouse strain will not affect Ion Reporter™ Software analysis
workflows.

Cellularity % The percentage of tumor cells in the sample. This is a whole
number between 1 and 100.

Biopsy Days The timepoint post-fertilization at which the biopsy was taken from
an embryo. This is a whole number.

Cell Number The cell count of the biopsied material.

Couple ID An identifier for the couple. For use with the Reproductive research
application.

Embryo ID An identifier for the embryo. For use with the Reproductive
research application.

User-defined Attributes

<user defined>​ If you create additional sample attributes, each attribute is listed
here and in the CSV file. Attributes that are marked as mandatory
must be entered for each sample. If you create an attribute of type
integer, only numeric characters (whole numbers) can be entered
for that attribute.

Chapter 3 Samples and Sample Sets
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Item Description

Sample Set Name

(Required)

Enter a name for this Sample Set.

Use any combination of alphanumeric characters, plus
spaces, periods (.), hyphens (-), and underscores (_).

Group Type Select the Group Type that describes this Sample Set.

Valid options are:

• DNA Fusions

• Other

• Sample_Control

• Self

• Single Fusions

• Trio

• Tumor_Normal

PCR Plate Serial Number Enter the serial number for the PCR plate used for this
Sample Set.

Description Provide a unique description for this Sample Set.

The description is limited to 1,024 characters. Use any
combination of alphanumeric characters, plus spaces,
periods (.), hyphens (-), and underscores (_).

Library Prep Type Specify how your library is prepared for use with this
Sample Set.

Valid options are:

• Manual

• AmpliSeq on Chef

Library Prep Kit Select the library preparation kit that is used to prepare
your library for this Sample Set.

Valid options are:

• Ion AmpliSeq Kit for Chef DL8

• Precision ID Chef DL8

Cycling Protocols Select the cycling protocol to use for sequencing this
Sample Set. This item is for future use.

Valid options are:

• Unspecified

• SOP

• Modified

Sample Set
definitions
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Item Description

Additional Cycle Specify the number, if any, of additional cycles to use for
sequencing this Sample Set. This item is for future use.

Valid options are:

• Unspecified

• 1

• 2

• 3

• 4

View Ion AmpliSeq™ library preparation on an Ion Chef™ System run

You can view a summary of details about how the libraries were prepared for a
completed run on an Ion Chef™ Instrument that used an Ion AmpliSeq™ library
preparation kit. Knowing this information can be useful for troubleshooting an
Ion Chef™ Instrument run.

This information is not available if a library preparation kit is not selected when the
sample is created, of if the run did not use an Ion AmpliSeq™ library preparation kit.

1. In the Plan tab, click Samples.

2. In the row that contains the Sample Set of interest, click  (Actions)4Library
Prep Summary.

3. In the Library Prep Summary screen, view the information that is listed for the
Sample Set. This information is provided by the Ion Chef™ Instrument; some
items may be blank.

• Library Prep Type
• PCR Plate Type
• PCR Plate Serial Number
• Combined Library Tube Label
• Chef Last Updated
• Chef Instrument Name

• Tip Rack Barcode
• Library Kit Type
• Reagent Lot Number
• Solution Part Number
• Solution Expiration
• Chef Script Version
• Chef Package Version

The Chef Script Version lists the version of the software script for the Ion Chef™

Instrument, and the Chef Package Version lists the software package that is used
by the Ion Torrent™ Server. The release version for these scripts can differ if
Torrent Suite™ Software was updated with an off-cycle release.

Chapter 3 Samples and Sample Sets
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Find a Sample Set

1. In the Plan tab, click Samples.

2. In the search box, enter a search term for the Sample Set name, or a Combined
Tube Label (Sample Tube Label).
The search term is not case sensitive. You do not need to know the exact name
because a partial name still returns results.

3. Click  to filter the search, then select Sample set name or Combined library
tube label.

4. Click Go.
The results of the search appear.

5. Click Clear All to return to the complete list of Sample Sets.

Sort Sample Sets

1. In the Plan tab, click Samples.

2. In the Samples Sets table, click any column header to sort the sample rows
alphabetically or numerically.

3. Click the column header again to reverse the order of the column contents.

4. Click Clear to undo the sort.

Chapter 3 Samples and Sample Sets
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Edit a Sample Set

1. In the Plan tab, click Samples.

2. In the row of the Sample Set that you
want to edit, click  
(Actions)4Edit Sample Set.

3. In the Edit Sample Set dialog box,
make any desired changes, then click
Done.

4. To edit an individual sample within
a Sample Set:

a. Click the triangle to the left of
the Sample Set name to expand
the Sample Set, then click  
(Actions)4Edit Sample in Set
in the row of the sample that
you want to edit.

b. Complete the Edit Sample
dialog box, if needed, then click
Done.

c. To delete a sample from a set, click   (Actions)4Remove Sample from
Set in the row of the sample that you want to delete, then click Yes, Delete!.

Delete a Sample Set

1. In the Plan tab, click Samples.

2. Click  (Actions)4Delete Set in the row of the Sample Set that you want to
delete.

3. Click Yes, Delete!.

To delete a sample from a Sample Set, see “Edit a Sample Set“

Chapter 3 Samples and Sample Sets
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Create an Ion AmpliSeq™ on Ion Chef™ Sample Set

Samples that are in the Ion AmpliSeq™ on Ion Chef™ Sample Set samples can be
automatically tracked in Torrent Suite™ Software from library preparation through
sequencing and data analysis. First create a Sample Set in the software, then use it to
set up a library preparation run on the Ion Chef™ Instrument. Sample information is
then automatically transferred to the Planned Run when templating and sequencing
the combined library.

To create a Ion AmpliSeq™ on Ion Chef™ Sample Set, you can either import samples
from a CSV file, or enter them manually. The following is an example of importing
samples from a CSV file.

1. In the Plan tab, click Samples, then click Import Samples from File.

2. In the Import Samples screen, click Sample File Format.
A CSV template file downloads to your computer in the Downloads folder.

3. Open the CSV template file, then enter the sample names, PCR plate positions,
and barcodes used. Save the file to your computer with a new name.
You can also enter sample names in the CSV file, then supply the plate position,
barcode, and other information later by editing the Sample Set in the Sample
Sets screen. For more information, see “Edit a Sample Set“ on page 33.

4. Click Select File, select your new CSV file, then click Open.

5. Click Add Sample Set.

6. Complete the Add Sample Set dialog box.
a. Enter a Sample Set name.

b. Select the appropriate Group Type.

c. Set Library Prep Type to AmpliSeq on Chef.

d. Set Library Prep Kit to Ion AmpliSeq Kit on Chef DL8.

e. Type or scan the PCR plate serial number.

Chapter 3 Samples and Sample Sets
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f. In Description, enter additional information.

g. Click Save & Finish

A new Sample Set is created.

7. In the Plan tab, click Samples.
The Sample Sets table lists the Sample Set run status in the Status column,
indicating whether the Sample Set is ready for a library preparation run, a library
preparation run with the Sample Set is currently running, or the combined
library is ready for a template run.

Status Indication

libPrep_pending The new Sample Set is ready for a library
preparation run.

libPrep_reserved The Sample Set is currently running on an
Ion Chef™ Instrument. You can monitor the run
status at Monitor4Ion Chef.

libPrep_done The Ion Chef™ Instrument has finished the library
preparation run, and the combined library is
ready for a template run.

Chapter 3 Samples and Sample Sets
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8. When the status of your Sample Set
shows libPrep_done, in the row of
the Sample Set, click  (Actions),
then select Plan Run.

9. In the next dialog box, select an
existing Planned Run template, or
create a new template by selecting
Add new template.
The sample information in the Sample Set automatically populates your new
Planned Run.

For further information on how to create or edit a Planned Run template, see 
Chapter 4, “Plan and execute an instrument run“.
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Plan and execute an instrument run

■ Planned Runs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

■ Planned Run templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

■ Steps in the workflow bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

■ Review Planned Run settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

■ Import panel files and parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

■ Create Planned Runs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

■ Create multiple Planned Runs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

■ Planned Runs list . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Planned Runs

Planned Runs are the digital instructions for the sequencing instrument that contain
specifications for sample preparation, sequencing, data export, and post-sequencing
data analysis. A Planned Run contains all of the settings that are used in a sequencing
run. A Planned Run tracks samples, chips, and reagents throughout the sequencing
workflow, from library preparation through subsequent data analysis.

The details that you specify for items depend on the assay and the sequencing
instrument that you use. For example, the Plan Run template specifies a default chip
type, but you can change the chip based on your throughput needs. Changing the
chip triggers changes in the sequencing kit and template kits.

For more information, see the user guides for the specific assays and sequencing
instrument that you plan to use.

Planned Run templates

A Planned Run template is a reusable experimental design that can be saved and used
to create many Planned Runs. Planned Run templates play an important role in
enabling rapid throughput across your sequencing instrument. Planned Run
templates also help reduce the chances of errors, because information is stored and
then applied to Planned Runs, instead of entered manually for each run.

When planning a run, you can use a system Planned Run template that is preloaded
in Torrent Suite™ Software and is suitable for use with specific types of research
applications. If a preinstalled Planned Run template does not meet your needs, you
can create your own unique Planned Run template.

4
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Torrent Suite™ Software is preloaded with many Planned Run templates that contain
predefined settings for common sequencing applications. These system-installed
Planned Run templates are categorized into research applications that describe the
sequencing techniques, or specialized products, for which each system Planned Run
template is used.

If a preinstalled Planned Run template does not meet your needs, you can download a
template from AmpliSeq.com, or you can create your own unique Planned Run
template. Custom templates are for advanced users. For assistance, contact your local
Field Service Engineer.

Planned Run templates are available for use on the Plan tab under Templates. On this
screen, the following categories of research applications filter the list of Planned Run
templates that are available for use. Templates may be available in multiple research
application category.

Research application Description

AmpliSeqDNA Ion AmpliSeq™ research applications (DNA and
exome), including the Ion AmpliSeq™ On‑Demand
Panels, and Ion AmpliSeq™ Made-to-Order and
Community Panels.

AmpliSeqRNA Ion AmpliSeq™ research applications (RNA),
including the Oncomine™ Immune Response
Research Assay.

AmpliSeq HD Ion AmpliSeq™ HD libraries (DNA and RNA).

DNA and Fusions Ion AmpliSeq™ research applications such as
Oncomine® Focus Fusions, Oncomine® Focus DNA &
Fusions, Colon and Lung Research Panel v2.

Generic Sequencing Research applications that do not fit in the other
categories. Use this research application to provide
all of the choices for the experiment. The choices are
not restricted based on a common application
workflow.

Human Identification Applied Biosystems™ Human Identification panels.

Immune Repertoire Ion AmpliSeq™ Immune Repertoire Research Assay.

Inherited Disease Ion AmpliSeq™ Inherited Disease Panel and
Oncomine™ BRCA research panels.

Mutation Load Oncomine™ Tumor Mutation Load Assay.

Oncology – HemeOnc All blood-related oncology research applications. For
example, Oncomine™ Myeloid Research Assay.

Oncology – ImmunoOncology All ImmunoOncology research applications. For
example, Oncomine™ Immune Response Research
Assay.

Oncology – Liquid Biopsy Liquid biopsy oncology research assays.

Oncology – Solid Tumor Solid tumor oncology research assays.

Planned Run
templates for
specific research
applications
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Research application Description

Pharmacogenomics Ion AmpliSeq™ Pharmacogenomics Research Panel
that is imported from AmpliSeq.com.

Reproductive Ion ReproSeq™ PGS kits for Aneuploidy Detection.

RNA Seq RNA sequencing research assays.

TargetSeq TargetSeq™ research applications, with parameters
optimized for hybridization-based target enrichment.

Whole Genome Whole genome sequencing research applications,
such as Ion ReproSeq™ Aneuploidy, which do not
assume enrichment and do not require a target
regions file.

16S rRNA Sequencing Ion 16S™ Metagenomics Kit.

16S Target Sequencing Ion 16S™ Metagenomics Kit.

Create a custom Planned Run template for reuse when the same conditions can be
used for multiple runs. To create a custom Planned Run template, copy an existing
preinstalled Planned Run template, then edit the settings to meet the requirements for
your Planned Run.

IMPORTANT! Before you create a custom Planned Run template, ensure that the
most current reference sequences and the target regions and hotspots BED files are on
the Ion Torrent™ Server. For more information about installing these files, see 
Chapter 11, “References management“. Contact your local Field Service Engineer to
obtain the most current BED files.

1. In the Plan tab, click Templates, then select the desired type of research
application from the left navigation menu.

2. In the list of templates, find the system Planned Run template from which you
want to create your custom Planned Run, then click  (Actions)4Copy.
The Copy Template workflow bar opens to the Save step.

3. Enter or select the required information in the Save step.
As you make your selections, your settings are updated in the Summary pane.

Item Description

Template Name
(Required)

Enter a name for your custom Planned Run template.

Set as Favorite Select the Set as Favorite checkbox to add your custom
template to the Favorites list.

Analysis Parameters Select Default to accept default analysis parameter
settings (recommended). Advanced users can
customize analysis parameters by selecting Custom
and editing appropriate analysis information.
For more information, see “Copy an analysis parameter
set“ on page 62.

Create a custom
Planned Run
template
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Item Description

Reference Library Select the reference library file appropriate for your
sample. Depending on your application, you may have
to select separate DNA, RNA, and fusions reference
library files.

Target Regions Select the target regions BED file appropriate for your
sample. Depending on your application, you may have
to select separate DNA and Fusions Target Regions file.
Check with your local Field Service Engineer for
updates to ensure that the most current files are being
used.
For BED file installation instructions, see “Upload a
target regions file“ on page 271.

Hotspots Select the hotspots (BED or VCF) file appropriate for
your sample.
For BED file installation instructions, see “Upload a
hotspots file“ on page 272.

4. In the Copy Template workflow bar, click the Ion Reporter step, then set up the
transfer of the completed run results to a specified Ion Reporter™ Server, then
click Next.

For more information, see “Ion Reporter step in the workflow bar“ on page 45.

5. In the Research Application step, ensure that the correct Research Application
and Target Technique are selected, then click Next.
For more information, see “Research application step in the workflow bar“ on
page 48.

6. In the Kits step, enter or select the required information, then click Next.
For more information, see “Kits step in the workflow bar“ on page 49.

7. In the Plugins step, select from the available plugins, then configure the selected
plugins as required, then click Next.
For more information on configuring plugins, see “Plugin configuration“ on
page 138.
( For more information on the Plugins step, see “Plugins step in the workflow
bar“ on page 53.

8. In the Projects step, select the project or projects to receive data from the runs
that use this template, then click Next.
For more information, see “Projects step in the workflow bar“ on page 54.

9. In the Save step, click Copy Template to save the new Planned Run template.

The customized template is now available in the Templates screen in the Research
Application group from which you copied the preinstalled Planned Run template. If
you set your customized template to favorites, it also appears in the Favorites list.

Chapter 4 Plan and execute an instrument run
Planned Run templates4

40 Torrent Suite™ Software 5.12 User Guide



You can create Planned Runs from a preinstalled or custom Planned Run template
that contains run settings. The preinstalled Planned Run templates are included in the
software for standard research applications and kits, such as Ion AmpliSeq™ or
Oncomine™ workflows. Custom Planned Run templates can be created as described in 
“Create a custom Planned Run template“ on page 39

When creating a Planned Run from a preinstalled Planned Run template, some
settings are predefined by the template and some remain to be selected or completed.
The predefined settings can vary between Planned Run templates. You can change
any of the settings to create your Planned Run, even those settings that are predefined
in the Planned Run template.

Most Planned Run templates have a corresponding Ion AmpliSeq™ or Oncomine™

panel. When you create a Planned Run from a Planned Run template, the Create Plan
workflow bar opens in the last screen. If you accept all of the Planned Run template
settings, you need only supply a run plan name and sample names to create a Planned
Run.

1. In the Plan tab, click Templates, then select the desired research application from
the left navigation menu. Instead, you may click Favorites if you have added the
template to your favorites list.

2. In the Template Name column of the templates table, click the template name.

The Create Plan workflow bar opens to the Plan step.

3. The Run Plan Name is prepopulated with the template name. Enter new text to
create a unique Planned Run name.

4. Complete additional settings in the Plan step if needed. For more information
about the individual settings, see “Plan step in the workflow bar“ on page 54.
As you make selections, the settings are updated in the Summary pane. You can
also use the information in this pane to review the settings that are predefined by
the template.

5. Click other steps in the workflow bar to enter or change settings if needed.

6. When you have completed your selections, review the settings in the Summary
pane, then click Plan Run at the bottom of the Plan step.
The Planned Run is added to the list on the Planned Runs screen.

If you do not create a Planned Run from a preinstalled or custom Planned Run
template, you can create a Planned Run without a Planned Run template and
predefined settings.

Best practice is to create a Planned Run from preinstalled or custom Planned Run
templates. Planned Run templates contain predefined settings for preparing multiple
runs of the same type (for example, if you are performing the same type of sequencing

Create a Planned
Run from a
Planned Run
template

Create a Planned
Run without a
Planned Run
template
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analysis using the same instruments and reagents on multiple samples). For more
information, see “Create a custom Planned Run template“ on page 39 and “Create a
Planned Run from a Planned Run template“ on page 41.

1. In the Plan tab, in the Templates screen, click Plan New Run.

The Create Plan wizard opens to the Ion Reporter step.

2. In the Ion Reporter step, set up the transfer of the completed run results to a
specified Ion Reporter™ Server. As you make your selections, your settings are
updated in the Summary pane.
For more information, see “Ion Reporter step in the workflow bar“ on page 45.

3. Click Next.

4. In the Research Application step, ensure that the correct Research Application
and Target Technique are selected, then click Next.
For more information, see “Research application step in the workflow bar“ on
page 48.

5. In the Kits step, enter or select the required information, then click Next.
For more information, see “Kits step in the workflow bar“ on page 49.

6. In the Plugins step, select from the available plugins, then configure the selected
plugins as required, then click Next.
For more information on configuring plugins, see “Plugin configuration“ on
page 138.
For more information on the Plugins step, see “Plugins step in the workflow
bar“ on page 53

7. In the Projects step, select the project or projects that receive data from the runs
that use this template, then click Next.
For more information, see “Projects step in the workflow bar“ on page 54.

8. In the Plan step, enter a name for the plan in Run Plan Name, specify the
reference and BED files, then enter or upload your sample information.
For more information about the individual settings, see “Plan step in the
workflow bar“ on page 54.

9. When you have completed your selections, review the settings in the Summary
pane, then click Plan Run at the bottom of the Plan step.
The Planned Run is added to the list on the Planned Runs screen.
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You can search, sort, or filter the Templates list to find a Planned Run template of
interest.

1. In the Plan tab, click Templates.

To… Actions…

Search the
list

1. Click All in the research applications menu on the left to search
all templates. Alternatively, select a research application from
the menu to search for templates within a specific research
application.

2. In Search by Template Name, enter a search term, then click Go.
The templates that contain your search term in the template
name are listed.

Sort the list Click any bolded column header in the list of templates to sort the
order in which the templates appear. Click the column header a
second time to reverse the sort order.

Limit the list
to recent
runs

In Date, select a preset range, or click Date Range, then select the
start and end dates.

Filter the
list

Select from one or more filters to limit the list of templates. Click
More Filters to see all available filters. Within a filter, enter text into
Find to limit the filter choices. To remove a filter, remove the filter
choice or click Clear in the filter list.
In some cases, you can select more than one choice within a single
filter category.

2. Click Clear All to remove filters and restore all results.

You can export the settings from a Planned Run template to a CSV file. You can then
transfer the file to a different Ion Torrent™ Server and import the template into Torrent
Suite™ Software on that server. For more information, see “Import a Planned Run
template“ on page 44.

You can also open the file in a spreadsheet application such as Microsoft™ Excel™ and
edit the settings before import, but be careful to preserve the column headings and
layout.

1. On the Templates screen, on the Plan tab, locate the template that you want to
export.

2. Click  (Actions) in the row of the template, then select Export.

Depending on your browser settings, the CSV file may be created and
downloaded automatically, or you may be prompted to save the file.

Search for a
Planned Run
template

Export a Planned
Run template
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Exported Planned Run templates have "exported" appended to the front of the
original template name, unless you edit the name in the CSV file.

You can import Planned Run template settings that have been exported to a CSV file.
Use this procedure for transferring settings between different Ion Torrent™ Servers.
You can change the settings in an exported CSV file and then import, but be careful to
preserve the column headings and layout.

To export Planned Run template settings to a CSV file, see “Export a Planned Run
template“ on page 43.

1. In the Plan tab, in the Templates screen, select the research application group
that you want to import the template into.

2. Click Upload4Upload Template.

3. In the Import Plan Template dialog box, click Choose File, select the CSV file to
import, then click Load.
The template is listed in the application group. Exported Planned Run templates
have "exported" appended to the front of the original template name, unless the
name has been edited in the CSV file.

4. (Optional) Edit the template name, by clicking  (Actions)4Edit.

You can save Planned Run templates to Favorites to make it easier to find your
frequently used templates within Torrent Suite™ Software.

1. In the Plan tab, click Templates, then search for a template that you want to add
to Favorites.
For more information, see “Search for a Planned Run template“ on page 43.

2. In the row of the template, click  (Actions)4Set as Favorite to add your
Planned Run template to the Favorites list.

3. To see the list of saved favorites, in the Plan tab, click Templates, then click
Favorites at the top of the research applications list.

Import a Planned
Run template

Save a Planned
Run template to
Favorites
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Steps in the workflow bar

Torrent Suite™ Software guides you through steps to provide the information that is
required to create Planned Runs and Planned Run templates, and then execute a
Planned Run. You can work through the steps in workflow order, or you can use only
the steps that you need.

You can use the steps to:
• Create a Planned Run that is based on a predefined Planned Run template that is

prepopulated with information specific for your instrument run. For more
information, see “Create a Planned Run from a Planned Run template“ on
page 41.

• Create custom Planned Run templates that fit your sequencing needs, and save
the custom Planned Run templates to reuse for future Planned Run creation. For
more information, see “Create a custom Planned Run template“ on page 39.

• Create a unique Planned Run that is not based on a Planned Run template. For
more information, see “Create a Planned Run without a Planned Run
template“ on page 41.

• Create Plan workflow bar

• Create Template workflow bar

After a Planned Run is created in Torrent Suite™ Software, the Planned Run is sent to
the Ion Torrent™ sequencer to be executed.

You can also download a CSV file and customize it to create multiple Planned Runs
without using the workflow bar. For more information, see “Create multiple Planned
Runs“ on page 70.

If you are an Ion Reporter™ Software user, when you create a Planned Run or a
Planned Run template, use this step to add settings to transfer automatically run
results to Ion Reporter™ Software for further analysis and visualization.

You can directly transfer results in one of the following ways:
• On the Ion Reporter step in the workflow bar, if you select an Ion Reporter™

Software account and an analysis workflow, then also select the option to upload
files automatically after run completion, an Ion Reporter™ Software analysis is
launched immediately after the run. Successful analyses are then available in Ion
Reporter™ Software when you sign in to the selected account.

• You can also transfer the output files (BAM files and VCF files) from the run to
Ion Reporter™ Software without selecting an Ion Reporter™ Software analysis
workflow. In this case, you can launch the analysis manually in Ion Reporter™

Software. This approach is commonly used to annotate the VCF files by using the
Annotation-only analysis workflow in Ion Reporter™ Software. For details, see Ion
Reporter™ Software Help (Pub. No. MAN0017204).

Ion Reporter step
in the workflow
bar
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In the Ion Reporter step in the workflow bar, you select the Ion Reporter™ Software
account to receive data from the completed run. If you are creating a Planned Run
template, select the account to receive data from every run that is created from this
Planned Run template.

Selections in the Ion Reporter step apply only to Ion Reporter™ Software users. The
Ion Reporter™ Software is not included with Torrent Suite™ Software and is available
under separate license. For details, see Chapter 10, “Integration with Ion Reporter™

Software“.

Use the plan by Sample Set feature when you configure Ion Reporter™ Software in
your Planned Run or template. For details, see “Plan by Sample Set“ on page 63.

1. In the Ion Reporter step in the workflow bar, select the Ion Reporter™ Software
account that you want to transfer output files to for analysis.
The selected account is the one to use to view and further analyze the files in Ion
Reporter™ Software.
If the Ion Reporter™ Software account is not configured, click Configure to add
another account. For more information, see “Set up an account for
IonReporterUploader plugin“ on page 242.

2. Select a Sample Grouping that corresponds to the sample relationship in Ion
Reporter™ Software.
When you select a Sample Grouping, the workflow bar in Ion Reporter™

Software shows only the analysis workflows that are appropriate for the sample.

3. Select an Existing Workflow option.

Option Description

Upload Only Use this option to transfer only the output files from the
sequencing run to Ion Reporter™ Software. If you use this option,
you can access the samples in Ion Reporter™ Software. VCF files
are also available if you run the variantCaller plugin.

Ion Reporter
workflow for
your sample
type

The analysis workflow is automatically launched in Ion Reporter™

Software with the sample data from the run. Successful analyses
are available in Ion Reporter™ Software with the account and
organization that you selected.

4. (Optional) To create a new analysis workflow, click Create New Workflow to
open Ion Reporter™ Software in a new browser window. In Ion Reporter™

Software, create a new analysis workflow, then save it. When you return to
Torrent Suite™ Software, refresh your browser. You can then select the newly
created analysis workflow in the Existing Workflow list.
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5. Select an Ion Reporter Upload Option.

Option Description

Review results after
run completion, then
upload to Ion Reporter

Use this option to review the completed run results and
then manually upload the data to Ion Reporter™ Software.

IMPORTANT! Review the results in Completed Runs &
Reports, then click Upload to IR4Upload as Planned to
upload the data to Ion Reporter™ Software.

Automatically upload
to Ion Reporter after
run completion

Run results are automatically uploaded to Ion Reporter™

Software when a run is complete. If you select an analysis
workflow, an analysis is launched immediately after the
run. Successful analyses are then available to you when you
sign in to Ion Reporter™ Software with the account used in
the setup.

6. Click Next in the workflow bar to continue with the Planned Run or with
Planned Run template creation.
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Use the Research Application step in the workflow bar to select research applications
and target techniques that apply to your template or plan . Available options in
subsequent steps are restricted to those options that are compatible with the selected
research application and target technique.

1. Select the research application used in your plan.

Research application Description

DNA Detects and annotates low frequency (to 0.5% limit of
detection) somatic variants (SNPs, INDELs, and CNVs)
from targeted DNA libraries using Ion AmpliSeq™ HD
technology. This method is compatible with DNA purified
from tumor or liquid biopsy research samples.

DNA and Fusions
(Separate Libraries)

Detects and annotates low frequency (to 0.5% limit of
detection) somatic (SNPs, INDELs, and CNVs) variants
from targeted DNA libraries, and gene fusions from
matching targeted RNA libraries using Ion AmpliSeq™ HD
technology. This method is compatible with DNA and RNA
purified separately from tumor or liquid biopsy research
samples.

DNA and Fusions (Single
Library)

Detects and annotates low frequency (to 0.5% limit of
detection) somatic variants (SNPs, INDELs, CNVs, and
fusions) from targeted nucleic acid libraries using Ion
AmpliSeq™ HD technology. This method is compatible
with DNA and RNA purified together from tumor or liquid
biopsy research samples.

Fusions Detects and annotates gene fusions from targeted RNA
libraries using Ion AmpliSeq™ HD technology. This
method is compatible with RNA purified from tumor or
liquid biopsy research samples

Human Identification For templates to run Applied Biosystems™ Precision ID
set of panels.

Immune Repertoire For use with the Ion AmpliSeq™ Immune Repertoire
panel.

Metagenomics Reserved for future use with Ion Reporter™ Software.

Mutation Load For use with the Oncomine™ Tumor Mutation Load Assay
panel.

Oncology - Liquid
Biology

For use with liquid biopsy oncology research panels.

Pharmacogenomics For use with Ion AmpliSeq™ Pharmacogenomics
Research Panel that is imported from AmpliSeq.com.

RNA For use with RNA (fusions) libraries.

Typing For use when performing molecular fingerprinting to
detect viral or bacterial strains for research purposes.

Research
application step in
the workflow bar
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2. Select the Target Technique that pertains to the selected research application.

Research Application selected Available Target Technique

DNA AmpliSeq DNA
AmpliSeq Exome
AmpliSeq HD - DNA
Other
TargetSeq
Whole Genome

DNA and Fusions (Separate
Libraries)

AmpliSeq DNA and Fusions
AmpliSeq HD - DNA and Fusions (Separate
Libraries)
AmpliSeq RNA

DNA and Fusions (Single Library) AmpliSeq HD - DNA and Fusions (Single
Library)

Fusions AmpliSeq HD - Fusions

Human Identification AmpliSeq DNA

Immune Repertoire AmpliSeq RNA
Mixed Samples (DNA/RNA)

Metagenomics 16S Targeted Sequencing
Other

Mutation Load AmpliSeq DNA

Oncology - Liquid Biology Tag Sequencing

Pharmacogenomics AmpliSeq DNA

RNA AmpliSeq RNA
RNA Sequencing

Typing Other
Whole Genome

3. Click Next in the workflow bar to continue with the Planned Run or with
Planned Run template creation.

Use the Kits step in the workflow bar to set up information that is needed for sample
preparation and sequencing, including the chip and kits used. Options that are
available in the Kits step depend on the instrument used. Selections in this step
influence how the data are analyzed after sequencing.

1. In the Kits step in the workflow bar, enter or select the following information.

Item Selection

Instrument Select the sequencing instrument system being used,
for example, Ion PGM™ System.

Sample Preparation Kit (Optional) Select the sample preparation kit used.

Library Kit Type Select the kit used to prepare the library (for example,
Ion AmpliSeq™ Library Kit Plus).

Kits step in the
workflow bar
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Item Selection

Template Kit 1. Select the instrument system used: OneTouch,
IonChef, or IA.

2. Select the templating kit used.

Sequencing Kit Select the sequencing kit used (for example, Ion S5™

Sequencing Kit).

Chip Type Select the sequencing chip type to be used (for
example, Ion 540™ Chip).

Control Sequence (Optional) Select the control sequence added to the
library preparation. Leave blank if not used.

Barcode Set Select the barcode set used (for example, IonXpress).

Flows Enter the number of nucleotide reagent flows required
to complete the sequencing run (for example, 400).

Mark as Duplicate Reads Select this option to mark duplicate reads in the BAM
file after a run is completed. Do not use with Ion
AmpliSeq™ data.
For more information, see “About the Mark as
Duplicates Reads option“ on page 52.
To remove marked duplicates from the BAM file, select
the FilterDuplicates plugin in the Plugins step in the
workflow bar.
For more information, see “Plugins step in the
workflow bar“ on page 53.

Enable Realignment Select this option to perform realignment, an optional
step that is executed immediately after TMAP. This step
adjusts the alignment, primarily in the CIGAR string.
For more information, see “TMAP modules“ on
page 320.

2. (Optional) In Advanced Settings, click Customize to customize the Advanced
Settings parameters.
For more information, see “Advanced Settings—Kits step in workflow bar“ on
page 51.

IMPORTANT! We recommend using the default settings. Consult your local
Field Service Engineer before modifying advanced settings.

Setting Description

Templating
Protocol

Script that the Ion Chef™ Instrument follows to perform the
templating reaction. We recommend that you do NOT change
this setting.

Forward Library
Key

Select your forward library key, if you have one.

Test Fragment Key Enter your test fragment key.
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Setting Description

Base Calibration
Mode

Select one of the following base calibration options:

• Default Calibration—allows a random subset of wells to
be used for base calibration. This option uses TMAP to
align the training subset of wells and is recommended if a
good reference for the template is available.

• Enable Calibration Standard—allows wells belonging to
the Calibration Standard to be selected as the training
subset.

• Blind Calibration—uses the same random subset of wells
as Default Calibration but does not require an alignment
step to generate the calibration model. This option is
recommended if the template does not align well to a
reference genome or if no reference is specified.

• No Calibration

See your template kit user guide for more details.

Forward 3' Adapter Select your forward 3' adapter.

Flow Order Select the flow order. For more information, see “flow
order“ on page 398.

3. Click Next in the workflow bar to continue with the Planned Run or with
Planned Run template creation.

Advanced Settings—Kits step in workflow bar

You can customize the kit advanced settings in the Kits step in the workflow bar.

IMPORTANT! We recommend using the default settings. Consult your local Field
Service Engineer before modifying advanced settings.

1. In the Kits step in the workflow bar, expand the Advanced Settings box, then
select Customize.

2. Edit one of the following settings.

Setting Description

Templating
Protocol

Script that the Ion Chef™ Instrument follows to perform the
templating reaction. We recommend that you do NOT change
this setting.

Forward Library
Key

Select your forward library key, if you have one.

Test Fragment Key Enter your test fragment key.
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Setting Description

Base Calibration
Mode

Select one of the following base calibration options:

• Default Calibration—allows a random subset of wells to
be used for base calibration. This option uses TMAP to
align the training subset of wells and is recommended if a
good reference for the template is available.

• Enable Calibration Standard—allows wells belonging to
the Calibration Standard to be selected as the training
subset.

• Blind Calibration—uses the same random subset of wells
as Default Calibration but does not require an alignment
step to generate the calibration model. This option is
recommended if the template does not align well to a
reference genome or if no reference is specified.

• No Calibration

See your template kit user guide for more details.

Forward 3' Adapter Select your forward 3' adapter.

Flow Order Select the flow order. For more information, see “flow
order“ on page 398.

About the Mark as Duplicates Reads option

For some applications, duplicate reads coming from PCR cause problems in
downstream analysis. The presence of duplicate reads can create the appearance of
multiple independent reads supporting a particular interpretation, when some of the
reads are in fact duplicates of each other with no additional evidence for the
interpretation.

Torrent Suite™ Software uses an Ion-optimized approach, which considers the read
start and end positions by using both the 5′ alignment start site and the flow in which
the 3′ adapter is detected. Duplicate reads are flagged in the BAM file in a dedicated
field. Use of this method is recommended over other approaches, which consider only
the 5′ alignment start site.

Marking duplicate reads is not appropriate for Ion AmpliSeq™ data, because many
independent reads are expected to share the same 5′ alignment position and 3′ adapter
flow as each other. Marking duplicates on an Ion AmpliSeq™ run risks inappropriately
flagging many reads that are in fact independent of one another.
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Use the Plugins step in the workflow bar to select plugins to include in a Planned Run
or a Planned Run template. Plugins expand the analysis capabilities of Torrent Suite™

Software. Plugins added in this step run automatically during the sequencing run,
and plugin results appear in the run report. The plugin results are added to the run
report and can be used for various purposes. You can set a plugin to run
automatically after every run if you add the plugin to the Planned Run or Planned
Run template. You can also configure the plugin, if necessary.

• The list of available plugins depends on which plugins are active on the Ion
Torrent™ Server that is connected to the instrument you use. Plugins that are
installed, configured, and enabled on your Ion Torrent™ Server are active, and are
available in this list.

• The IonReporterUploader plugin does not appear in this list because it is
configured in the IonReporterUploader step.

• When you enable some plugins, such as the variantCaller and coverageAnalysis
plugins, a Configure link appears for that plugin. For information on configuring
each plugin, see “Preinstalled plugins“ on page 145.

• If you select the variantCaller plugin and the Planned Run does not use a
predefined configuration, you must click the Configure link to configure the
plugin before you can proceed to the next step or save the Planned Run or
Planned Run template. For details about how to configure the variantCaller
plugin, see Chapter 9, “Variant calls in Torrent Suite™ Software“.

1. In the Plugins step in the workflow bar, select the plugins to execute in the
Planned Run.

2. Click Next in the workflow bar to continue with the Planned Run or with
Planned Run template creation.

Plugins step in the
workflow bar
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Use the Projects step in the workflow bar to select one or more projects to receive data
from the completed run. When you create a Planned Run template, select the projects
to receive data from every run that is created from this template.

For more information about projects, see “View result sets in a project“ on page 93.

1. In the Projects step in the workflow bar, in the scrolling list, select the checkbox
next to each project name that you wan to receive data from the completed run.
The list includes all projects that are created and available on the Ion Torrent™

Server.

2. You can also search for or add projects.

Option Description

Search for
projects

(Optional) To search for projects, enter a case-sensitive search
term or partial search term in the search box below the list, then
click Search.

Add projects (Optional) To create a new project or projects, click Add Project,
then enter a name, or enter multiple names that are separated by
commas.

Remove added
projects

(Optional) To remove an added project or projects, click Remove
New Projects.

3. Click Next in the workflow bar to continue with the Planned Run or with
Planned Run template creation.

Use the Plan step in the workflow bar to review the plan and enter or select additional
information to complete the Planned Run.

1. In the Plan step in the workflow bar, enter or select the required information. The
available options are different depending on your sequencing application.

Option Description

Run Plan Name
(Required)

Enter a name for the Planned Run.

Analysis
Parameters

Select Default to accept default analysis parameter settings
(recommended).
Advanced users can customize analysis parameters by
selecting Custom and editing appropriate analysis
parameters. For more information, see “Copy an analysis
parameter set“ on page 62.

Default Reference & Bed Files

Reference Library Select the reference library file appropriate for your sample.
Depending on your application, you may have to select
separate DNA, RNA, and Fusions reference library files.

Projects step in
the workflow bar

Plan step in the
workflow bar
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Option Description

Target Regions Select the target regions BED file appropriate for your sample.
Depending on your application, you may have to select
separate DNA and fusions target regions files.
Check with your local Field Service Engineer for updates to
ensure that the most current files are being used. For BED file
installation instructions, see “Upload a target regions file“ on
page 271.

Hotspot Regions Select the hotspots (BED or VCF) file that is appropriate for
your sample.
For BED file installation instructions, see “Upload a hotspots
file“ on page 272.

2. Depending on your application, select the Use same reference & BED files for
all chips/barcodes checkbox if you are using the same reference sequences and
target regions and hotspots BED files across all of your chips/barcoded samples
in the Planned Run. If you are using different reference sequences or BED files
for one or more of your chips/barcoded samples, clear the Use same reference &
BED files for all chips/barcodes checkbox.

3. (Optional) For DNA and Fusions application, select the Same sample for DNA
and Fusions checkbox when using the same sample for both DNA and Fusions
libraries.

4. Depending on your application, complete the following:

Option Description

Number of
barcodes

For barcoded samples, enter the number of barcodes to be used
in this run, then click  to the right of this option.
Alternatively, click the first barcode, then click , and all
subsequent barcodes are numbered from the first barcode value.

Number of
chips

For non-barcoded samples, enter the number of chips to be used
in this run, then click .

The Samples Table is populated with barcode information or chip number for
each sample.

5. (Optional) Select an option next to the sequencing application (such as Oncology
or Pre-implantation Genetic Screening) to populate required sample
information into the Samples Table.
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6. Complete the Samples Table.

• Save the samples table to a CSV file, fill out required sample information, then
upload the samples table to populate the Samples Table automatically.

a. Click Save Samples Table to save the CSV file to your computer.
b. Edit the CSV file by entering required sample information into the

appropriate sample information columns, then save the CSV file to your
computer.

c. Click Load Samples Table, then select an appropriate CSV file
containing sample information specific for this Planned Run.

d. Click Load to populate the Samples Table in Torrent Suite™ Software
with sample information that is supplied by the CSV file.

• Alternatively, manually enter sample information into the Samples Table
using the software. The available options are different depending on your
sequencing application.

Option Description

Barcode For barcoded samples, select a barcode.

Control Type (Optional) Click the Control Type column
heading to expand the column, then
select the control type.

Sample ID (Optional) Enter a sample ID for each
sample.

Sample Description (Optional) Enter a sample description for
each sample.

DNA/Fusions For DNA and Fusions application, select
DNA or Fusions for each sample.

Reference If using different reference and BED files
for one or more samples, click the
Reference heading to expand the
sections. Then select the reference,
target regions, and hotspots files for
each sample.

Annotations Click the Annotations column heading to
expand the annotation information that is
specific for your application (for example,
cancer type or Embryo ID), then
complete the required information.

Sample Tube Label Scan or enter the barcode of the Ion
Chef™ sample tubes to be used in the
run.

Chip Barcode Scan or enter the barcode of the Ion
Chef™ sample tubes to be used in the
run.

Sample Collection Date Enter the date that the blood sample was
drawn.
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Option Description

Sample Receipt Date Enter the date that the laboratory
received blood sample.

Ion Reporter workflow Select the Ion Reporter™ Software
analysis workflow specific for your run. If
you do not see your analysis workflow,
select the Show All Worklows checkbox
in the column heading.
This option is available if Ion Reporter™

Software is connected.

Relation Select sample relationship group.
This option is available if Ion Reporter™

Software is connected.

Gender Select Male, Female, or Unknown.
This option is available if Ion Reporter™

Software is connected.

IR Set ID Set this option to the same value for
related samples. After file transfer, in Ion
Reporter™ Software, samples with the
same IR Set ID are considered related
samples and are launched in the same
analysis (for example, normal sample
and its corresponding tumor sample).
Do not give unrelated samples the same
IR Set ID value even if the value is zero or
blank.
This option is available if Ion Reporter™

Software is connected.

7. (Optional) In Add a note, add a note about your Planned Run.

8. (Optional) If using LIMS metadata, in Add LIMS Meta Data, enter the text that is
associated with the Planned Run.

9. (Optional) In the Monitoring Thresholds pane, adjust Bead Loading (%), Key
Signal (1-100), and Usable Sequence (%) minimum thresholds for your Planned
Run.
If monitoring thresholds are not met, the run is still processed and an alert
message is shown on the run report after analysis is complete.

10. When you are finished with your selections, scroll to the bottom of the screen,
then click Plan Run.
The Planned Run is added to the Planned Runs list on the Planned Runs screen.
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Review Planned Run settings

You can review the Planned Run settings of a completed run.

1. In the Data tab, click Completed Runs & Reports, then select a run of interest.
The report for that run opens.

2. In the Summary section, click Report Actions4Review Plan.
A Review Plan summary lists the details of the Planned Run. The subcategory
details are different based on different runs.

Category Subcategory

Review Plan The name of the completed run.

Report The name of the report that was
generated for the completed run.

Application Research Application

Research Category

Sample Grouping

Target Technique

Sample Set

Kits Sample Preparation Kit

Library Kit

Library Key

3' Adaptor

Flow Order

Template Kit

Templating Protocol

Sequencing Kit

Control Sequence

Library Read Length

Flows

Chip Type

Barcode Set

Mark as Duplicates Reads

Base Calibration Mode

Enable Realignment

Monitoring Bead Loading (%)

Key Signal (1-100)

Usable Sequence (%)

Reference Reference Library
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Category Subcategory

Reference Target Regions

Hotspot Regions

Plugins & Output Plugins

Projects

Uploaders

Notes

LIMS Meta Data

Plan Meta Data TS version when created

Plan created via

Barcodes & Samples Sample Tube Label

Chip Barcode

A table of information about the barcode
used in the run. Table columns include:
Barcode
Sample Name
Sample ID
DNA/RNA
Reference
Target Regions
Hotspot Regions

Analysis Parameters Used (Default) Thumbnail BeadFind Args

Thumbnail Analysis Args

Thumbnail Pre-BaseCaller Args for
calibration

Thumbnail Calibration Args

Thumbnail BaseCaller Args

Thumbnail Alignment Args

Thumbnail IonStats Args

History A log of system actions taken during the
run. Table columns include:
Date
User
Log

3. After reviewing the information, click Close.
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Import panel files and parameters

You can import panel files and parameters from AmpliSeq.com for an Ion AmpliSeq™

Ready-to-Use Panel, an Ion AmpliSeq™ On-Demand Panel, or an Ion AmpliSeq™

Made-to-Order Panel design. Each package includes a primer pool results panel file,
hotspot BED files, target region files, and JSON parameters files that are required to
produce your sequencing results. You can import the file package directly to the Ion
Torrent™ Server, in which the files are available immediately for use in Torrent Suite™

Software. Before you can import, you must link your Ion Torrent™ Server account with
your AmpliSeq.com account. Alternatively, you can manually upload panel files that
you have saved to a storage location.

For an Ion AmpliSeq™ Ready-to-Use Panel and an Ion AmpliSeq™ Community Panel
(but not Ion AmpliSeq™ Made-to-Order Panel), parameter settings that are optimized
for the variantCaller plugin are included in your new template. You can configure the
variantCaller plugin with these settings when you create the Planned Run, if desired.
For details, see “variantCaller plugin configuration“ on page 207.

Human, animal, and plant reference sequence BED files are also available for import
from AmpliSeq.com.

For more information about Ion AmpliSeq™ Designer, see the Ion AmpliSeq™ Designer:
Getting Started User Guide (Pub. No. MAN0010907).

To import a Planned Run template from AmpliSeq.com into Torrent Suite™ Software,
you must first link your Ion Torrent™ Server account to AmpliSeq.com. Linking your
Ion Torrent™ Server account is a one-time requirement.

1. Click  (Settings)4Accounts.

2. If needed, update or enter any account information in the User Profile/Account
Information section, then click Reset.

3. Click Link to AmpliSeq.
Scroll down to view the link button if
needed.

4. Enter your AmpliSeq.com sign-in information, then click Save.

Your Ion Torrent™ Server account is now linked, and import of panel information
from AmpliSeq.com is enabled.

To unlink your Ion Torrent™ Server account, click Unlink username@domain.com.

Link your Ion
Torrent™ Server
account to
AmpliSeq.com
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You can import Planned Run template parameters directly from AmpliSeq.com.

Before you can import files directly from AmpliSeq.com, you must link your Ion
Torrent™ Server account to your AmpliSeq.com account. For more information, see 
“Link your Ion Torrent™ Server account to AmpliSeq.com“ on page 60. If you want to
import files that are saved to a hard drive or other storage location, see instead 
“Manually upload panel files“ on page 61.

1. In the Plan tab, in the Templates screen, click AmpliSeq.com .

2. In the next screen, select the panel type that you need, then select a panel or
panels from the list of available panels.

• The DNA tab includes exome panels and the RNA tab includes fusion
panels.

• Some panels do not have optimized variantCaller plugin parameters
available for all chips and sequencers. A warning identifies the panels for
which optimized variantCaller plugin parameters have not been developed
for the selected chip type.

• If you have ordered Ion AmpliSeq™ Made-to-Order Panel designs, a list of
the panel files for import appears on this screen.

• If you have downloaded a ZIP archive for a panel from AmpliSeq.com to
your computer, you can also create a Planned Run template by manually
uploading the archive on the right pane of this screen.

3. (Optional) Click the columns to sort the rows alphabetically.

4. Click Import.

5. Refresh your browser to track the progress of the import. When the Status
column shows Complete, return to the Templates screen.

The new template is listed on the Templates screen.

If you import individual panel files from AmpliSeq.com and save the files to a
storage location, you must manually upload them before you can access them in
Torrent Suite™ Software.

Use this procedure only to import files from AmpliSeq.com that were previously
saved to a hard drive or other storage location. This procedure is not necessary if you
import panel files directly from AmpliSeq.com as described in “Import Planned Run
template parameters“ on page 61.

1. In the Plan tab, click Templates.

2. Click Upload4Upload Design/Panel Zip Archive.

3. In the Import Panel from Zip Archive dialog box:
a. Click Select File, then browse to your compressed panel file.

b. Select the instrument type and chip type.

IMPORTANT! If you do not select the correct chip type, a validation error
occurs during the upload.

Import Planned
Run template
parameters

Manually upload
panel files
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c. Click Upload Panel from Zip Archive.

d. Close the upload dialog box.

4. To check the status of the upload, click (Settings)4Reference Sequences, then
click Upload History.

You can copy an existing analysis parameter set, and then customize the settings and
save it as a new parameter set. We recommend this procedure if you need a unique
analysis parameter set for a custom analysis that other users do not need to use in
their runs. Copying an analysis parameter set ensures that the uploaded parameter set
remains intact for other users.

1. Click  (Settings)4Analysis Parameters.
In the Analysis Parameters screen, factory parameters are denoted by "Ion
Torrent" in the Source column.

2. To filter the parameter sets by chip type, select your chip type from All Chips.

3. Identify the parameter set that you want to copy, then click  (Actions)4Copy
in the row for that set.

4. In the Copy Analysis Parameters dialog box, enter a parameter name and
description, make any changes, then click Save.

Your new analysis parameter set is available in the Analysis Parameters table.
The Source column lists the name of the user who created it.

Copy an analysis
parameter set
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5. Click  (Actions)4View in the row of the analysis parameter set to view the
details for that parameter set in the list.

6. You can select the custom analysis parameter set for use in a Planned Run or
reanalysis of a completed run.

Option Description

Create a Planned Run
or a custom Planned
Run template

In the Plan tab of the workflow bar, under the Analysis
Parameters section, click Details+4Custom, then select
the parameter from the list.
You must first specify a chip type for the Planned Run
(under Kits in the workflow bar) before you can select the
custom parameter set.

Reanalyze a
completed run

For details, see “Reanalyze a run“ on page 88.

Create Planned Runs

You can create a Planned Run in two different ways:
• Create a Planned Run with Sample Sets.
• Create a Planned Run with a template.

You can define samples and preselect the attributes that you want to associate with
each sample before you start to plan templating and sequencing runs. You can then
organize samples into Sample Sets that are available to select and reuse when you
create a Planned Run. This approach, which is known as plan by Sample Set, can save
time when you plan your instrument runs if:

• Your samples include many attributes.
• You want to use the same Sample Sets for many instrument runs.
• Your laboratory assigns tasks such as planning and defining sample attributes to

individuals who have specific areas of expertise.
• Your samples include attributes for use with Ion Reporter™ Software.

For example, if you select the Sample Set group type Trio, only Trio analysis
workflows are available to choose when you configure a Planned Run for use
with Ion Reporter™ Software.

• You want to set up multisample analyses in Ion Reporter™ Software.
• Your Ion Torrent™ Server is connected to a LIMS.

Plan by Sample
Set
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If you set up your samples in Sample Sets before you plan an instrument run, you can
add one or more Sample Sets to your Planned Run.

Note that a Sample Set that uses an Ion AmpliSeq™ library preparation kit must also
use the corresponding barcode kit that comes with the library preparation kit.

1. In the Plan tab, click Samples.

2. In the Sample Sets screen, select one or more Sample Sets to add to the Planned
Run.

• To plan a run using a single Sample Set, click  (Actions) 4Plan Run in the
row of the Sample Set.

• To plan a run using multiple Sample Sets, select the checkboxes next to the
Sample Sets that you want to add to the Planned Run, then click Plan Run.

IMPORTANT! Ensure that all of the selected Sample Sets used in the Planned
Run use the same barcode kit. To verify the barcode kit that is used, expand
the Sample Set entry to view its details.

The Select a Run Template to apply to this experiment dialog box lists Planned
Run templates that support your Sample Set.

3. In the Plan Run from Sample Set dialog box, select a run template to use for the
experiment, then click Plan Run.
If you do not see the template that you are looking for, select Show All
Templates, then look again for the template.
The Create Plan workflow opens to the Barcoding step with the Sample Sets that
you selected:

Create a Planned
Run with Sample
Sets
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4. In the Barcoding step in the workflow bar, enter or select the required
information. Depending on your sequencing application, options can vary.

Option Description

Analysis
Parameters

Select Default to accept default analysis parameter settings
(recommended).
Advanced users can customize analysis parameters by
selecting Custom, then editing appropriate analysis options.
For more information, see “Command Line Args (Advanced)
screen“ on page 67.

Reference Library Select the reference library file that is appropriate for your
sample. Depending on your application, you may have to
select separate DNA, RNA, and fusions reference library files.

Target Regions Select the target regions BED file appropriate for your
sample. Depending on your application, you may have to
select separate DNA and fusions target regions files.
Ensure that you are using the current BED or VCF files.

Hotspots Select the hotspots (BED or VCF) file appropriate for your
sample.
Ensure that you are using the current BED or VCF files.

5. Select the Use same reference & BED files for all barcodes checkbox if you are
using the same reference, target regions, and hotspots files across all of your
barcoded samples in the Planned Run.
If you are using different reference and/or BED files for one or more of your
barcoded samples, deselect the Use same reference & BED files for all barcodes
checkbox.

6. In Sample Tube Label, scan or enter the barcode of the Ion Chef™ sample tubes
to be used in the run.

7. In Chip Barcode, scan or enter the barcode that is printed on the chip that is used
for this run.
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8. Complete the samples table.

• You can save the samples table to a CSV file, fill out all required sample
information, and then upload the samples table to populate the Samples
Table automatically.

a. Click Save Samples Table to save the CSV file to your computer.
b. Edit the CSV file by entering all required sample information into the

appropriate sample information columns, then save the CSV file to your
computer.

c. Click Load Samples Table, then select an appropriate CSV file
containing sample information specific for this Planned Run.

d. Click Load to populate the samples table with sample information
supplied by the CSV file.

• Alternatively, you can manually enter sample information into the samples
table. Depending on your sequencing application, options can vary.

Options Description

Barcode For barcoded samples, select a barcode.

Sample Name
(Required)

Select a sample that is a part of the selected sample set or
sets.

Control Type Click the Control Type column heading to expand the column,
then select the control type from the dropdown list.

Sample ID (Optional) Review sample ID information for each sample. To
edit Sample ID, you must edit the Sample Set as described in 
“Edit a Sample Set“ on page 33.

Sample Description (Optional) Review sample description for each sample. To
modify Sample Description, you must edit the Sample Set as
described in “Edit a Sample Set“ on page 33.

DNA/Fusions For DNA and fusions application, select DNA or Fusions for
each sample.

Reference If using different reference and BED files for one or more
samples, click the Reference column heading to expand the
sections, then select reference, target regions, and hotspots
files for each sample.

Annotations Click the Annotations column heading to expand the
annotations specific for your application (for example, cancer
type or embryo ID), then complete the required information.

Ion Reporter
workflow

Select the Ion Reporter™ Software analysis workflow specific
for your run. If you do not see your analysis workflow, select
the Show All Worklows checkbox in the column heading.

Relation Select sample relationship group.

Chapter 4 Plan and execute an instrument run
Create Planned Runs4

66 Torrent Suite™ Software 5.12 User Guide



Options Description

Gender Select Male, Female, or Unknown.

IR Set ID Set the IR Set ID to the same value for related samples. After
file transfer, in Ion Reporter™ Software, samples with the
same IR Set ID are considered related samples and are
launched in the same analysis (for example, normal sample
and its corresponding tumor sample). Do not give unrelated
samples the same IR Set ID value even if the value is zero or
blank.

9. Click Next to continue the steps to create the Planned Run.
The software takes you to the next step in the workflow bar. For more
information, see “Steps in the workflow bar“ on page 45.

10. Click Save & Finish.

The Planned Run is added to the Planned Runs table and can be used in an
instrument run.

Command Line Args (Advanced) screen

When planning a Sample Set in the Barcoding step in the workflow bar, you can click
Custom, then use the Advanced Options screen to customize advanced arguments
for analysis parameters.
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Argument Description

Beadfind args Beadfind module command line arguments.

These arguments should not be modified unless instructed
by Ion Torrent™ Technical Support.

Analysis args Analysis command line arguments.

These arguments should not be modified unless instructed
by Ion Torrent™ Technical Support.

Pre Basecaller args for
calibration

BaseCaller command line arguments. For information on
--barcode-mode, --barcode-cutoff, and --
barcode-filter parameters, see “BaseCaller module
arguments“ on page 309.

This field is used only if a Base Calibration Mode other
than 'No Calibration' is used.

Other BaseCaller arguments should not be modified
unless instructed by Ion Torrent™ Technical Support.

Recalibration Args Recalibration command line arguments.

Basecaller Args BaseCaller command line arguments. For information on
--barcode-mode, --barcode-cutoff, and --
barcode-filter, see “BaseCaller module
arguments“ on page 309.

Other BaseCaller arguments should not be modified
unless instructed by Ion Torrent™ Technical Support.

Alignment Args Arguments for the TMAP aligner.

This replaces the TMAP Args setting that appears in
previous software releases.

To plan a run for DNA and Fusion sample pairs and several individual Fusion or
DNA samples, start with a DNA and Fusions Planned Run template. Then alter the
template to accommodate single samples on the same chip. The following example is
the procedure for creating a mixed Sample Set consisting of two sample pairs, one
DNA-only sample, and two Fusion-only samples.

1. In the Plan tab, click Templates, then click the DNA and Fusions research
application.

2. Identify a DNA and Fusions template for the instrument system that you use,
then in that row click  (Actions) 4Copy.

3. Enter a Template Name and select a DNA Target Regions file, then click Copy
Template.

4. Return to the Templates screen, click the DNA and Fusions research application,
then select the copied template.

5. In the Ion Reporter step of the workflow bar, select an Ion Reporter™ Software
account and analysis workflow, ensure that the DNA and Fusions Sample
Grouping is selected, then click Next.

Create a Planned
Run for mixed
samples with a
Planned Run
template
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6. Ensure that the DNA and Fusions (Single Library) research application and the
AmpliSeq HD DNA and Fusions (Single Library) target technique is selected,
then click Next.

7. Click Plan in the workflow bar.

8. (Optional) The optimal number of barcodes to use with the selected
panel/template is set as the default, but you can change it. If necessary, enter the
number of barcodes, then click .

9. (Optional) Clear the Same sample for DNA and Fusions option. This option is
available for DNA and fusion applications.

10. Rename the samples if desired. To rename the samples, in the Samples table, in
the Sample Name column, click the sample name, then enter a new name.

11. (Optional) Change the DNA/Fusions selections to match samples. To change the
DNA/Fusions selection for a sample, navigate to the DNA/Fusions column in the
Samples Table, then select DNA or Fusions in the row of the sample.

12. (Optional) Select a Cancer Type for each sample.

13. Select the appropriate Ion Reporter™ Software analysis workflows. To select an
analysis workflow, click the existing selection in the Samples Table, then select
an analysis workflow from the list.

14. In the Samples Table, select a Relation and Gender , then click Plan Run at the
bottom of the screen.
For more information, see “Create a Planned Run with Sample Sets“ on page 64.
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Create multiple Planned Runs

To facilitate running the same sequencing run multiple times, you can use a template
CSV file to create multiple Planned Runs at one time. The template CSV file for batch
planning is available for download in the Torrent Suite™ Software.

Each column in the CSV file represents an individual Planned Run. Each row contains
the run parameters for each individual Planned Run. You can add sample information
to Planned Runs that is required for Ion Reporter™ Software analyses, including
account, workflow, and workflow-related attributes such as gender, relation, and IR
Set ID.

The latest CSV batch planning template file indicates the version of the template in the
top row. This version number is required. When you download the template CSV file,
the version is automatically included.

You can create multiple Planned Runs with a template CSV file. To create multiple
Planned Runs for individual non-barcoded libraries, a single batch planning template
CSV file is required.

1. In the Plan tab, click Templates.

2. In the row for the template that you
want to use to create multiple
Planned Runs, click  (Actions)4
Plan Multiple.

3. In the Plan Runs from Template
dialog box, enter the number of
Planned Runs that you want to
create, then click Download CSV for
batch planning.

Create multiple
Planned Runs for
non‑barcoded
libraries
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4. Save the batch planning template CSV file to your drive, then open the file.

In this example, the template creates four Planned Runs with non-barcoded
libraries.

5. Enter the plan parameters for each Planned Run. The following parameters are
required:

• Template name (auto-populated)
• Plan name
• Sample
• Templating Kit name (auto-populated)
• Chip type

6. Name, then save the CSV file.

7. In the Plan tab, in the Templates
screen, click Upload4Upload Plans.

8. In the Upload Plan Runs dialog box,
click Choose File, select the edited
CSV template, then click Open.

9. Click Upload CSV for batch
planning.

The system parses the files, then creates the Planned Runs.
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To create multiple Planned Runs for multiplex sequencing of barcoded libraries, two
batch planning template CSV files are required:

• A master CSV file that is used to specify the plan name, kits, chips, projects, and
plugin selections.

• A sample CSV file for each Planned Run.

1. In the Plan tab, click Templates.

2. In the row for a barcoded template
that you want to use to create
multiple Planned Runs, click 
(Actions)4 Plan Multiple.

3. In the Plan Runs from Template
dialog box, enter the number of
Planned Runs that you want to
create, then click Download CSV for
batch planning.

4. Unzip the downloaded archive file, then save the files to your drive.

Create multiple
Planned Runs for
barcoded libraries
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5. Open the tsPlan file appended with master.csv, enter the Template name, Plan
name, Sample, and Chip type.

In this example, the template creates four barcoded Planned Runs.

6. Save the CSV file.

7. Open each tsPlan file appended with samples.csv, enter the sample parameter
information for each barcoded sample, including Sample Name, Sample ID,
Sample Description, and so on, then save each file.

8. Add the Master CSV template and all Sample CSV template files to a compressed
(zipped) folder.

9. In the Plan tab, in the Templates
screen, click Upload4Upload Plans.

10. In the Upload Plan Runs dialog box,
click Choose File, select the edited
CSV template, then click Open.

11. Click Upload CSV for batch
planning.
The system parses the files, then
creates the Planned Runs, that are then available for use in the Plan tab, in
Planned Runs screen.
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Planned Runs list

The Planned Runs screen under the Plan tab lists Planned Runs that are ready to
execute on an Ion Chef™ Instrument or a sequencer. Planned Runs are listed by date,
and the list includes basic information about each run, including its status in the
sequencing workflow. For more information, see “Planned Run status“ on page 76.

The Planned Runs screen includes tools for searching, sorting, editing, copying, and
deleting Planned Runs, and transferring them to another Ion Torrent™ Server.

You can manage Planned Runs in various ways.

On the Plan tab, click Planned Runs to access various functions to manage Planned
Runs.

To... Do the following...

View all Planned
Runs

Click All above the list.

View Planned Runs
that were created
from a Planned Run
template

Click by Template above the list.

View Planned Runs
that were created
from a Sample Set

Click by Sample above the list.

Search the list 1. In the search box above the Planned Runs list, click 
(Search By), then select the search type from the options.

2. Enter your search terms in the box, then click Go.

Filter the list Select your filter criteria from the lists above the list of Planned
Runs.

Clear all search and
filter settings and
display the complete
list

Click Clear All above the list.

Sort the list Click a column header to sort the list by the information in that
column. Only columns with bold headers are sortable.

View multiple pages
in the list

Click the page number and scroll buttons below the list.

Manage Planned
Runs
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To... Do the following...

Display a list of the
samples in the
Planned Run

In the Sample column, hover over the  (Info) icon.

Display a list of
projects that the run
results will be
transferred to

In the Project column, hover over the  (Info) icon.

Delete Planned Runs Select the checkbox next to each Planned Run, then click Delete
Selected below the list.
Alternatively, click  (Actions) in the Planned Run row, then
select Delete.
You cannot delete Planned Runs with a status of Reserved.

Edit a Planned Run 1. Click  (Actions) in the Planned Run row, then select Edit.
The Edit Plan workflow opens.

2. Edit the settings in any of the steps, then click Update Plan in
the Save step.

Review all the
settings in a Planned
Run

Click  (Actions) in the Planned Run row, then select Review.

Copy a Planned Run 1. Click  (Actions) in the Planned Run row, then select Copy.
The Copy Plan workflow opens.

2. Edit the settings in any of the steps, enter the name of the
new plan in Run Plan Name, then click Copy Plan in the Save
step.

Transfer a Planned
Run to another Ion
Torrent™ Server

To transfer a Planned Run, see “Transfer a Planned Run to
another Ion Torrent™ Server“ on page 79.
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The Planned Run status appears in the Status column of the Planned Runs list.

When you select a Planned Run on a sequencer and start sequencing, the Planned Run
is removed from the Planned Runs list.

You can change the status of an Ion Chef™ Instrument run under specific
circumstances. For more information, see “Manually change Ion Chef™ Instrument
run status“ on page 76.

Status Description

Pending The Planned Run is available and ready for use by an
Ion Chef™ Instrument. It is unavailable for sequencing until
the Ion Chef™ Instrument run is complete.

The software determines whether a run is Pending on an
Ion Chef™ Instrument based on the template kit selection
when you create the run.

Reserved The Planned Run is in use by an Ion Chef™ Instrument, and
is unavailable for use until the current Ion Chef™

Instrument run completes.

Planned The Planned Run is available and ready for use by a
sequencing instrument.

Voided The Ion Chef™ Instrument run is canceled through the
Ion Chef™ Instrument.

Manually change Ion Chef™ Instrument run status

An Ion Chef™ Instrument run must have a status of Planned before a sequencer can
start a sequencing run. If the connection between an Ion Chef™ Instrument and
Torrent Suite™ Software is temporarily lost or interrupted, the status of the Ion Chef™

run may be marked as Reserved, even if the run has completed. To resolve this
problem, you can manually change the status to Planned and enable the run for
sequencing.

1. In the Plan tab, click Planned Runs.

2. Find the Planned Run of interest (with a status of Reserved), then click 
(Actions)4Completed on Chef.
The status for the Ion Chef™ Instrument run on the Planned Runs screen changes
from Reserved to Planned. The sequencer can now use the Planned Run to start
a sequencing run.

Planned Run
status
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A Planned Run is listed in the Planned Runs screen until it is executed on a
sequencer. To execute the run, select it on the sequencer touchscreen, after which the
run is removed from the Planned Runs list.

Depending on your sequencing system, use one of these methods to execute a
Planned Run.

• On the Ion PGM™ System: Press Run in the home screen, then follow the on-screen
instructions. Pending run information appears in the Run info screen. If needed,
press Browse to select a different Planned Run from the Planned Runs list. Press
Next --> when you are ready to start your sequencing run.

You can also type the Planned Run short code (for example, ITHWQ) into the
Planned Run: text box on the run information dialog box.

• On the Ion Proton™ System: Press Run in the home screen, then follow the on-
screen instructions. In step 9 of the workflow, select a Planned Run from the list,
scan or enter the chip barcode, then press Next ►. Pending run information
appears in the next screen. Follow the on-screen instructions to confirm the run
information, load and calibrate the chip, and start the sequencing run.

Execute a Planned
Run on a
sequencer
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• On the Ion GeneStudio™ S5 System and Ion S5™ System: Select your run from the
Run Selection screen, then press Review. On the Select Run screen, ensure that
the run selections are correct, then press Start run.
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If you have multiple Ion Torrent™ Servers and sequencers on a network, you can
create a Planned Run on one Ion Torrent™ Server, then transfer it to a different Ion
Torrent™ Server to perform the run. This is useful if a Ion Chef™ Instrument or
sequencer associated with a particular sever is offline or busy.

A network administrator or your local Field Service Engineer must first set up this
networking capability.

IC 3

TS 1
(origin)

IC 2IC 1 PGM 1 PGM 2 PGM 3

TS 2
(destination)

TS 3
(destination)

Network

For example, as shown in the diagram, a Planned Run can be set up on the first Ion
Torrent™ Server (TS 1) and run on its associated Ion Chef™ Instrument (IC 1). But if the
associated Ion PGM™ Sequencer (PGM 1) is busy or offline, you can transfer the
Planned Run to TS 3 or TS 2 to perform the run on those associated sequencers (PGM
2 or PGM 3).

1. In the Planned Runs screen, find the Planned Run that you want to transfer.
The status of the Planned Run listed in the Status column must be either
Pending (for runs to be sent to an Ion Chef™ Instrument) or Planned (for runs to
be sent to a sequencer). You cannot transfer runs that are in progress on an
Ion Chef™ Instrument (status is Reserved).

2. Click  (Actions) for the selected Planned Run, select Transfer, then select the
name of the destination Ion Torrent™ Server on the network.

Transfer a
Planned Run to
another Ion
Torrent™ Server
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3. Click Transfer to confirm.

• If the transfer is successful, a green confirmation message appears.
• If any files or other settings required for the run are missing on the

destination server, a red message reports what is missing. Edit the transferred
Planned Run on the destination server to add the files or missing settings to
perform the sequencing run.

• You can no longer access the Planned Run on the origin server after it has
transferred.

• To move the results of a sequencing run to a different Ion Torrent™ Server, use the
RunTransfer plugin. For more information, see “RunTransfer plugin“ on
page 186.
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Monitor runs in progress

■ Monitor a sequencing run . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

■ Monitor an Ion Chef™ run . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

■ View data for runs in progress . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

■ Auto Refresh the Monitor tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

■ Review the Planned Run settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

■ Stop an analysis job . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

■ View system memory usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

In Torrent Suite™ Software, use the Monitor tab to monitor information about runs
that are in progress on various instruments. You can also review the Planned Run
settings for a sequencing run that is currently in progress.

For each run, you can view reported metrics, thumbnail graphs, and other indicators.

Active runs and all runs completed within the previous 7 days are available to view.
More data about completed runs is available in the Data tab.

Monitor a sequencing run

Use the Monitor tab to view the thumbnail graphs and metrics of a sequencing run in
progress to determine quickly whether to abort or continue the sequencing run.

In the Monitor tab, click Runs in Progress, then view run metrics in List View.

During a sequencing run, a temporary thumbnail entry shows run metrics and a
heatmap image of chip loading as the information becomes available. You can see at a
glance in the heatmap image, and in the thumbnail graphs, whether any run quality

5

Torrent Suite™ Software 5.12 User Guide 81



metrics are flagged ( ) as falling below the thresholds that are defined in your
Planned Run.

Metric Description

Loading Addressable wells on the chip that have detectable loading.

Live ISPs Loaded wells that have a live signal.

Library ISPs Live wells with a library template.

Key Signal Average 1-mer signal in the library key.

Usable Seq Percentage of the sequence available for analysis after filtering.

Flow Transfer Progress of the sequencing run expressed as number of the total
number of flows completed.

If you decide to abort a sequencing run based on the chip loading metrics observed,
see “Stop an analysis job“ on page 85.

Monitor an Ion Chef™ run

Use the Monitor tab to view details about Ion Chef™ runs from the previous 7 days.
The Planned Runs screen also contains information about the status of Ion Chef™

runs. For more information, see “Planned Run status“ on page 76.

1. In the Monitor tab, click Ion Chef.

2. View the run information.

Item Definition

Last Updated The date and time of the currently displayed run status.

Sample Set For more information, see Chapter 3, “Samples and
Sample Sets“.

Plan The Ion Chef™ run plan in progress.

Chef Instrument The identity of the Ion Chef™ Instrument in use.

Library Prep Progress The progress of an Ion AmpliSeq™ library preparation
run. For an Ion AmpliSeq™ on Ion Chef™ run only.

Library Prep Status The current stage of the library preparation run.

• Not started

• In progress

• Complete

Template Prep Progress The progress of a template preparation run.

Template Prep Status The current stage of the template preparation run.

• Not started

• In progress

• Complete

Chapter 5 Monitor runs in progress
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Item Definition

Estimated Time
Remaining

The estimated time remaining until the run is
completed.

Estimated Time Until User
Intervention

The estimated time and date when the run pauses for
QC, or is completed.

For an Ion Chef™ run in progress, check the Estimated Time Remaining or the
Estimated Time Until User Intervention to see the time remaining before you
can remove Ion Sphere™ Particles (ISPs) samples at the QC pause or remove
loaded chips for sequencing.

View data for runs in progress

You can view data for runs that are in progress.

The Runs in Progress screen on the Monitor tab has two views:
• List View shows 20 runs per screen, with details for each run.
• Table View shows one run per row in columns that you can sort by clicking a

column head. This view shows only the information that is associated with each
report.

Both views show 20 runs at a time. If you have more than 20 runs, multiple screens
are shown.

1. In the Monitor tab, click Runs in Progress.

2. To monitor details about Ion Chef™ Instrument runs, click Ion Chef.

3. To view more data about a run, click the run report name link.
The run report is opened in the Data tab. You can use the navigation links to
view different types of data.
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Auto Refresh the Monitor tab

Use the Auto Refresh feature to update the information on the Monitor tab screens
every 20 seconds. Without Auto Refresh, the screens are a static display of
information at the time you open the screen.

• To set the Runs in Progress screen to automatically refresh:
a. In the Monitor tab, select Runs in Progress, then click Auto Refresh.

b. Click Stop Refresh to turn the Auto Refresh feature off.

• To set the Ion Chef screen to automatically refresh.
a. In the Monitor tab, select Ion Chef, then click Auto Refresh.

b. Click Stop Refresh to turn the Auto Refresh feature off.

Review the Planned Run settings

In the Monitor tab you can review the Planned Run settings for a run in progress.

1. In the Runs in Progress List View, click Review Run Plan for the run of interest.

The Review Planned Run dialog box displays the Planned Run information and
settings.
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2. Click Close to return to the Monitor tab, Runs in Progress screen.

Stop an analysis job

You can stop an analysis job for a run that has started but is not completed.

1. Click  (Settings)4Services.

2. Scroll down to the Active Jobs section, find the Name for the sequencing run that
you want to stop. The Status Message column indicates job is running.

3. Click Terminate for the analysis job that you want to stop.

4. In the confirmation dialog box, click Yes to end the job.

Chapter 5 Monitor runs in progress
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5. Refresh your browser to update the
information in the Active Jobs
section. The job is removed from the
Active Jobs list. The list displays No
active jobs if no other jobs are active.

6. In the Data tab, click Completed Runs & Reports.

The status is TERMINATED next to the
name of the analysis job that you
stopped.

View system memory usage

You can view information about how much system memory is being used in the
System Services screen. This information is useful to monitor sequencing runs, and to
troubleshoot issues that are related to memory usage.

1. Click  (Settings)4Services.

2. Scroll to the System Memory Usage section.

The current system memory usage is shown in GB and as a percentage of the total
memory that is available.

You can always start a new analysis job.
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Manage completed runs and reports

■ Search for a run report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

■ Reanalyze a run . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

■ Edit a run report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

■ Set the Completed Runs & Reports screen to automatically refresh . . . . . . . . . . 91

■ Organize run results with projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Search for a run report

You can search, sort, or filter the Completed Runs & Reports list to find a run report
of interest.

1. In the Data tab, click Completed Runs & Reports.

To… Steps…

Search the
list

In Search, enter a search term, then click Go.

Sort the list Select a sort order from the Sort list (List View or Table View), or click
any bolded column header (List View only) to sort the list. Click the
column header a second time to reverse the sort order.

Limit the list
to recent
runs

In Date, select a preset range, or click Date Range, then select a Start
and End date.

Filter the
list

Select one or more filters to limit the Completed Runs & Reports list.
Click More Filters to see all available filters. Within a filter, enter text
in Find to limit the filter choices.
To remove a filter, deselect the filter choice or click Clear in the filter
list.

View
favorites

Click  next to Search to limit the list to completed runs that are
designated as Favorite.
To set a completed run as a Favorite, click  beside the completed
run name. The Favorite indicator turns blue.

2. Click Clear All to remove filters and restore all results.

6
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Reanalyze a run

You can reanalyze a run to correct a setup error such as a default reference alignment
or an assigned barcode, or to optimize analysis parameters.

Torrent Suite™ Software provides two ways to change the options used to analyze
sequencing data. If you want to change the options for the results of a sequencing run
one time, you can change the options in the run report, then immediately reanalyze
the data. If you want to change the run report for all future reanalyses of the data, you
can edit the run report and save the updated report.

1. In the Data tab, click Completed Runs & Reports.

2. Search, filter, or sort the list to find your run report of interest. For more
information, see “Search for a run report“ on page 87.

3. Do one of the following:

• In Table View mode, in the row of the run of interest, click
 (Actions)4Reanalyze.

• Alternatively, switch to List View mode, find your run of interest, then click
Reanalyze.

4. In the menu on the left, click Reanalyze Run, enter a Report Name for the new
run, then select from the available options.

Option Description

Thumbnail only Select to reanalyze only the thumbnail report. This option is
available only for Ion Proton™ System, Ion S5™ System, and Ion
GeneStudio™ S5 Systems data.

Start reanalysis
from

• Select Signal Processing to reanalyze from DAT files.
The analysis does not use the Use data from the previous
result option, but reprocesses from the DAT files. You can
also use Analysis and Base Calling options.

• Select Base Calling (default) to reanalyze from 1.WELLS files.
The analysis uses the Use data from the previous result or
Base Calling options, but reprocesses from the 1.WELLS file.
The analysis does not use the Analysis Parameters option.

Use data from
previous result

Select the previous result if more than one result is available. This
option applies only when starting reanalysis from the basecalling
step.

Analysis
Parameters

Use the default analysis parameters, or click Custom to select the
analysis parameters.
For more information, see “Copy an analysis parameter set“ on
page 62.
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5. (Optional) In the menu on the left, click Analysis Options, then set the options as
needed.

Option Description

Library Key The sequence that is used to identify library reads.

TF Key The sequence that is used to identify test fragment reads.

3′ Adapter The sequence of the 3′ Adapter that is used.

Mark as Duplicate
Reads

Select to have PCR duplicates flagged in the BAM file.

Base Calibration Mode Base calibration mode allows for empirical alignments to
influence flow signals to achieve better homopolymer
calibration to improve overall accuracy.

Enable Realignment Select to use an optional analysis step to adjust the
alignment, primarily in the CIGAR string.

6. (Optional) Set the reference and barcoding options.
a. In the menu on the left, click Reference & Barcoding, then click Edit Run

Plan.

b. On the Edit Run Plan screen, set the default options as needed.

c. Click Update Run to return to the reanalyze setup screen to select plugins to
use in the analysis.

d. If you do not need to return to the setup screen to change the plugins, click
Update Run and Reanalyze.

7. (Optional) In the menu on the left, click Plugins.
a. Select the plugin to include in the reanalysis.

b. (If needed) Click the Configure link next to the plugin, scroll down to
configure the plugin, then click Save Plugin Settings.
For more information, see “Plugin configuration“ on page 138, or the
configuration topic specific to the selected plugin.

c. Repeat steps a and b to include additional plugins in the reanalysis.

8. Click Start Analysis.

You can change the default alignment reference for a completed run, and then analyze
the run again.

1. In the Data tab, click Completed Runs & Reports.

2. Use either Table View or List View, then find the run of interest.
For help finding an individual run, see “Search for a run report“ on page 87.

3. In the row of the run that you want to reanalyze, click  (Actions)4Reanalyze.

Change the
default alignment
reference
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4. In the next screen, click Reference & Barcoding.

5. Click Edit Run Plan, change any settings as appropriate, then click either Update
Run or Update Run & Reanalyze.
For more information, see “Create a custom configuration for the variantCaller
plugin“ on page 210 and “Run the variantCaller plugin manually“ on page 206.

Edit a run report

You can edit a completed run report to correct a setup error or optimize parameters
for all future reanalyses.

Preinstalled Planned Run templates cannot be edited. Create a copy of the
preinstalled Plan Run template, then make changes in the copy.

1. In the Data tab, click Completed Runs & Reports.

2. Search, filter, or sort the list to find the run report of interest.
For more information, see “Search for a run report“ on page 87.

3. Open the Edit Run wizard.

• Use Table View, then click  (Actions)4Edit in the row of the run report
that you want to edit.

• Use List View, then identify the run report of interest, then click Edit.

The Edit Run wizard opens to the Save screen.

4. Click a step in the workflow bar to access the screens to make changes.

Workflow step Description

Ion Reporter Select the Ion Reporter Account, Sample Grouping, and Ion
Reporter Upload Options.

Research Application Select the Research Application and Target Technique.

Plugins Select the plugins to be included in the run.

Projects Select the Project for the run data.

Save Enter a Run Plan Name, then complete the information as
needed.

5. Click Update Run, or Update Run & Reanalyze to start the reanalysis
immediately.

You can change barcoding when you set up a reanalysis, but you can also change
barcoding for all future reanalyses. Use the Edit option to:

• Add barcoding to a completed sequencing run.
• Change the barcode set for a completed sequencing run.
• Remove barcoding from a completed sequencing run.

In each case, you must reanalyze the run after editing the barcode information. These
steps apply only to completed runs.

Add or change
barcoding for a
completed run
report
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1. In the Data tab, click Completed Runs & Reports.

2. In table or list view, navigate to your run of interest.
For help finding an individual run, see “Search for a run report“ on page 87.

3. Click  (Actions)4Edit in the row of the run.

4. In the Edit Run screen, edit the Run Plan Name if desired, make the appropriate
barcoding changes, then click either Update Run, or Update Run & Reanalyze.

Set the Completed Runs & Reports screen to automatically refresh

Use the automatic refresh feature to update the Completed Runs & Reports screen.
When the automatic refresh function is turned on (the default), the screen refreshes
every 20 seconds. When the automatic refresh function is turned off, the screen is a
static display of information at the time you opened the screen.

1. In the Data tab, on the Completed Runs & Reports screen, click Auto Refresh.

The button changes to Stop Refresh indicating that the automatic refresh
function is turned off.

2. Click Stop Refresh to turn off the automatic refresh function.

Organize run results with projects

Projects are groups of result sets that you can create and to organize results into
unique categories that are useful for your organization. A project can contain run
results for the same laboratory project or results from completed runs that you want
to combine. Projects also allow you to combine run results into a single run report.
When you open a list of projects, you can:

• Quickly find and view details for a group of run results.
• Search the list by project name or partial name, or by date (date range, current

month, current week, current day, or specific date).
• Click Edit to rename a project
• Click Delete to delete a project.
• Click Log to view a log of the project history.
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You can search for projects and result sets lists by name.

1. (Optional) To display a result sets list, in the Projects table, click the name of the
project containing your result set.

2. To find the projects or result sets or of your interest, you can search, sort, and
filter the Projects and Result Sets lists:

To... Steps...

Search the
list

Enter your search term in Search names, then click Go. The
information displayed in the table is limited only to the names that
match or contain the search string.
In Search names, you can enter a complete or partial name. For
example, the following project names match the search string "mpli":
amplicon, amplicon33, AmpliSeq, Samplier. The search is not
case‑sensitive and wildcards are not supported in the search string.

Sort the list Click any bolded column header in the table to sort the order in which
the projects or result sets are displayed. Click the column header a
second time to reverse the sort order.

Filter the
list by date

• In Last Modified select a preset range (for example, last 7 days,
or this month).

• Click Date Range, then select the Start and End dates to limit
your search to projects or result sets that are modified within the
selected date range.

• Click Older than Date or Newer than Date to limit your search to
project or result sets that are modified before or after the
selected date.

3. Click Clear to remove all search criteria and to display the unfiltered list of
projects or result sets.

You can group specific result sets in a project, then add the project to a Planned Run
or Planned Run template. The results sets in a project are viewable in the Data tab.

When you create a Planned Run, search for, then enter project names in the Projects
step in the workflow bar:

For more details, see Chapter 4, “Plan and execute an instrument run“.

Search for
projects by name

Add a project to a
Planned Run
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Add selected results to another project

1. In the Data tab, click Projects to see the list of projects.

2. In the Name column of the Projects table, click the project name to view the list
of result sets in the project.

3. Select the checkboxes in the row of the result sets that you want to add to one or
more other projects, then click Process Selected4Add to Project.

4. Select the checkbox for each project that the result sets are to be copied to, then
click Add projects.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the result sets that are included in the project.

You can compare report metrics side-by-side for all runs that are assigned to a project.

1. In the Data tab, click Projects.

2. Select a project.

3. Click Compare All to view all the runs in the project side-by-side.

4. (Optional) Click Customize.
The Show and Hide dialog box opens.

5. (Optional) In the Run Info column, deselect metadata to remove it from view.

View result sets in
a project

Compare reports
of runs in a project
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6. (Optional) In the Result Name column, deselect runs to remove them from view.

7. Click Apply.

8. Review the reports for all of the runs in the project.

9. (Optional) Export the results.

• Click Download PDF to create a PDF report.
• Click Download CSV to create a CSV file of the results.
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You can export, archive, or delete data from results that are included in a project.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project from the list to view the result sets in the project.

3. Click Process Selected4Data Management.
For details on how to export, archive, or delete data results in the project, see 
“Manually export run data“ on page 349, “Manually archive run data“ on
page 349 , and “Manually delete selected data from a run report“ on page 350.

If you are running an application that requires better coverage than the coverage
provided by a single chip, you can:

• run multiple chips with the same sample and library
• combine aligned reads from multiple sequencing reports

The combined aligned reads can be treated the same way as results from a single
run. For example, it can be exported or used as an input for a plugin.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the result sets in the project.

3. Select the result set or sets that you want to combine into a single run result set.

4. Click Combine Selected4Combine Alignments.

5. In the Combine Selected dialog box, enter a new report name.

6. Make appropriate selections:

Option Description

Mark as
duplicate

Select this to identify duplicate reads and mark them in the BAM file.
For some applications, duplicate reads coming from PCR cause
problems in downstream analysis. The presence of duplicate reads
can create the appearance of multiple independent reads supporting
a particular interpretation, when some reads are in fact duplicates of
each other with no additional evidence for the interpretation.

Note: Marking duplicate reads is not appropriate for Ion AmpliSeq™

data, because many independent reads are expected to share 5'
alignment position and 3' adapter flow as each other. Marking
duplicates on an Ion AmpliSeq™ run risks inappropriately flagging
many reads that are in fact independent of one another.

Overwrite
sample
name

Select this to identify duplicate names in your combined samples so
that you can rename them.

7. Click Launch.

8. (Optional) Click Report to open the summary of the report, or Log to open the log
for the report.

The combined report is added to the project from which the combine action was run.

Manage data for
result sets in
projects

Combine aligned
reads from
multiple run
reports
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You can download a CSV file of analysis metrics for one or more result sets, then
compare results across analyses.

1. In the Data tab, click Projects, then click a project name to open the list of result
sets for the project.

2. Select the checkboxes for the analyses, then click Download Selected CSV.
The analysis metrics file is downloaded through your browser to a directory on
your computer, based on your browser settings.

Analysis metrics file fields

In the analysis metrics file, each line represents a Torrent Suite™ Software analysis run.
Within each line, fields are separated by a comma. Each comma-separated field is
listed in a separate column. You can open the files with spreadsheet software such as
Microsoft™ Excel™ or Apache® OpenOffice ™ Calc.

The file has many fields per entry. Rows 4 through 11 (marked by *) contain test
fragments metrics. The other rows contain library read metrics.

Field Description

Report Name of the analysis run report.

Status Status of the analysis (for example, Started,
Complete).

Flows Number of flow cycles from the actual
sequencing run.

TF Name* Test Fragment Name.

Q10 Mean* Average Q10 read length.

Q17 Mean* Average Q17 read length.

System SNR* System Signal-to-Noise Ratio.

50Q10 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q10.

50Q17 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q17.

Keypass Reads* Number of reads that have test fragment
keys.

TF Key Peak Counts* Signal strength of the first three bases of
the TF key.

Total_Num_Reads Total number of reads.

Library_50Q10_Reads Reads of length at least 50bp with 90% or
greater accuracy.

Library_100Q10_Reads Reads of length at least 100bp with 90% or
greater accuracy.

Download a CSV
file of metrics
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Field Description

Library_200Q10_Reads Reads of length at least 200bp with 90% or
greater accuracy.

Library_Mean_Q10_Length Average length of reads with 90% or greater
accuracy.

Library_Q10_Coverage Average per base coverage considering
reads with 90% or greater accuracy.

Library_Q10_Longest_Alignment Longest read length amongst reads with
90% or greater accuracy.

Library_Q10_Mapped Bases Total bases from reads with 90% or greater
accuracy.

Library_Q10_Alignments Number of alignments from reads with 90%
or greater accuracy.

Library_50Q17_Reads Reads of length at least 50bp with 98% or
greater accuracy.

Library_100Q17_Reads Reads of length at least 100bp with 98% or
greater accuracy.

Library_200Q17_Reads Reads of length at least 200bp with 98% or
greater accuracy.

Library_Mean_Q17_Length Average length of reads with 98% or greater
accuracy.

Library_Q17_Coverage Average per base coverage considering
reads with 98% or greater accuracy.

Library_Q17_Longest_Alignment Longest read length amongst reads with
98% or greater accuracy.

Library_Q17_Mapped Bases Total bases from reads with 98% or greater
accuracy.

Library_Q17_Alignments Number of alignments from reads with 98%
or greater accuracy.

Library_50Q20_Reads Reads of length at least 50 bp with 99% or
greater accuracy.

Library_100Q20_Reads Reads of length at least 100 bp with 99% or
greater accuracy.

Library_200Q20_Reads Reads of length at least 200 bp with 99% or
greater accuracy.

Library_Mean_Q20_Length Average length of reads with 99% or greater
accuracy.

Library_Q20_Coverage Average per base coverage considering
reads with 99% or greater accuracy.
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Field Description

Library_Q20_Longest_Alignment Longest read length amongst reads with
99% or greater accuracy.

Library_Q20_Mapped_Bases Total bases from reads with 99% or greater
accuracy.

Library_Q20_Alignments Number of alignments from reads with 99%
or greater accuracy.

Library_Key_Peak_Counts Signal strength of the first three bases of
the library key.

Library_50Q47_Reads Number of perfect reads of length at least
50 bp.

Library_100Q47_Reads Number of perfect reads of length at least
100 bp.

Library_200Q47_Reads Number of perfect reads of length at least
200 bp.

Library_Mean_Q47_Length Average length of perfect reads.

Library_Q47_Coverage Average per-base coverage considering
only perfect reads.

Library_Q47_Longest_Alignment Longest reads length amongst perfect
reads.

Library_Q47_Mapped_Bases Total bases from perfect reads.

Library_Q47_Alignments Number of alignments from perfect reads.

Library_CF CAFIE metric: Carry forward.

Library_IE CAFIE metric: Incomplete extension.

Library_DR CAFIE metric: Signal/polymerase loss
(droop).

Library_SNR System signal-to-noise ratio.

Sample Name of the sample.

Library Name of the reference genome.

Notes Any additional user-provided notes.

Run Name Long name of the analysis run.

PGM Name Name of the Ion PGM™ or Ion Proton™

instrument where the sample was
sequenced.

Run Date Date that the sample was sequenced.

Run Directory Location of the raw DAT files on the Ion
Torrent™ Server.
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Field Description

Num_Washouts NA

Num_Dud_Washouts NA

Num_Washout_Ambigous NA

Num_Washout_Live NA

Num_Washout_Test_Fragment NA

Num_Washout_Library NA

Library_Pass_Basecalling NA

Library_pass_Cafie NA

Number_Ambiguous NA

Number_Live Number of wells producing a signal.

Number_Dud Number of wells with ISPs but no signal.

Number_TF Number of wells containing test fragment.

Number_Lib Number of wells containing library.

Number_Bead Number of wells containing beads.

Library_Live Number of wells containing library ISP with
signal.

Library_Keypass Number of wells containing library ISP with
signal and match key.

TF_Live Number of wells containing test fragment
ISP with signal.

TF_Keypass Number of wells containing test fragment
ISP with signal and match key.

Keypass_All_Beads Number of wells containing ISP with signal
and match key.

P JSON string of plugin data.

s JSON string of plugin data.
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You can remove a result set from a project. Removing does not delete the selected run
reports and their result sets from the system; it removes them only from the current
project.

1. In the Data tab, click Projects to see the list of projects.

2. To view the list of result sets in the project, in the Name column of the Projects
table, click the project name.

3. Select the checkboxes in the row of the result sets that you want to remove from
the project, then click Process Selected4Remove from Project.

Remove a result
set from a project
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Review and manage run reports

■ About run reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

■ Search for a run report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

■ Open a run report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

■ View details about completed runs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

■ Organize run results with projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

■ Reanalyze a run . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

■ Edit a run report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

■ Set the Completed Runs & Reports screen to automatically refresh . . . . . . . . . 136

A Torrent Suite™ Software run report contains statistics and quality metrics from
completed sequencing runs. You can use this information to evaluate the run. You can
also complete other tasks from the run report.

About run reports

For runs completed on a Ion Proton™, Ion S5™, Ion S5™ XL, or Ion GeneStudio™ S5
Series system, each run report includes one full chip report and one thumbnail report.
If the run has been reanalyzed, additional reports are available when you open the
run report. If the run was completed on an Ion PGM™ System, only a full chip report
is available.

You can complete several tasks from the run report, including:
• Upload output files from the run report to Ion Reporter™ Software. For more

information, see “Run the IonReporterUploader plugin manually“ on page 247.
• Review, edit, or copy the Planned Run settings for the sequencing run. For more

information, see “Review Planned Run settings“ on page 58 and “Create a custom
Planned Run template“ on page 39.

• Rerun the data analysis for the run. For more information, see “Reanalyze a
run“ on page 88.

• Archive, edit, or delete data for the run. For more information, see Chapter 12,
“Data management“.

• Toggle between different run reports for the same sample. For more information,
see “Open a run report“ on page 102.

• Run Torrent Suite™ Software plugins. For more information, see “Run a plugin
manually from the sequencing run report“ on page 141.

• Download the run report or plugin summary in PDF format. For more
information, see “Download a run report summary PDF“ on page 120 and 
“Download a plugin report PDF“ on page 141.

7
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For further details about how to evaluate a run, see How to assess an Ion S5™/Ion
GeneStudio™ S5 sequencing run report User Bulletin, (Pub. No. MAN0017983).

Search for a run report

You can search, sort, or filter the Completed Runs & Reports list to find a run report
of interest.

1. In the Data tab, click Completed Runs & Reports.

To… Steps…

Search the
list

In Search, enter a search term, then click Go.

Sort the list Select a sort order from the Sort list (List View or Table View), or click
any bolded column header (List View only) to sort the list. Click the
column header a second time to reverse the sort order.

Limit the list
to recent
runs

In Date, select a preset range, or click Date Range, then select a Start
and End date.

Filter the
list

Select one or more filters to limit the Completed Runs & Reports list.
Click More Filters to see all available filters. Within a filter, enter text
in Find to limit the filter choices.
To remove a filter, deselect the filter choice or click Clear in the filter
list.

View
favorites

Click  next to Search to limit the list to completed runs that are
designated as Favorite.
To set a completed run as a Favorite, click  beside the completed
run name. The Favorite indicator turns blue.

2. Click Clear All to remove filters and restore all results.

Open a run report

Every sequencing run report includes at least two versions: a full chip report that
contains complete details about the run, and a thumbnail version that includes a
limited data set. If the run has been reanalyzed, additional reports are available.

The thumbnail reports use a limited set of data points to give a summary of the fully
sequenced and analyzed run. Thumbnail reports can be used to determine quickly the
success of the run or whether a run should be terminated. Thumbnail reports are
appended with _tn at the end of the report name and can be opened before the full
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chip reports are generated. The full chip reports contain all the data points and can be
used for your analysis review.

1. In the Data tab, click Completed Runs & Reports.
Completed Runs & Reports are displayed in List View layout.

2. (Optional) Click Table View to review Completed Runs & Reports details in a
table layout.

3. To open an individual run report:

• In the List View, find the pane that contains details about your run of interest,
then click the link in the Report Name column to view details about any of
the available reports for that run.

If more than two reports are listed, click Show all reports to view the list of
reports associated with your run of interest.

• In the Table View, find the run that you want to view the report for, then click
the link in the Report Name column.
To open another report that is associated with your run of interest, click the
Reports list, then select the report that you want to open.

To determine the quality of the sequencing run, you can review the quality metrics for
the unaligned reads. Primary pipeline processing, base calling, and signal processing
generate these metrics. The quality metrics for unaligned reads are divided into three
categories:

• Quality of chip loading, expressed as the density of Ion Sphere™ Particles (ISPs)
loaded onto the chip.

• Quality of the ISPs that are loaded onto the chip.
• The length of sequencing reads.

Review unaligned
reads
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1. In the Data tab, in the Completed Runs & Reports screen, find the report that
you want to review, then click the report name link in the Report Name column.

2. In the left navigation menu, click Unaligned Reads.

3. Review the unaligned read quality metrics in ISP Density, ISP Summary, and
Read Length panes.

4. (Optional) Click  to view more details about the information in each pane.

Run report metrics before alignment

To assess the sequencing run, you can review the quality metrics for the unaligned
reads. Primary pipeline processing, basecalling, and signal processing generate these
metrics. The following prealignment metrics are provided in the run report. Access
the run report in the Torrent Suite™ Software using the Data tab.

1 2

3

4

5

7

8

9

10

11

14

6

12 13

Number Metric Description

1 Total Bases The number of filtered and trimmed base pairs reported in the
output BAM file.

2 Key Signal The average signal for all library ISPs with library key (TCAG).

3 ISP Loading The percentage of chip wells that contain an Ion Sphere
Particle (ISP). The percentage value considers only
addressable wells.

4 ISP Loading
Density

A visual representation of well loading distribution on the chip
surface. Red color indicates areas of high loading and blue
indicates areas of low loading.

5 Total Reads The total number of filtered and trimmed reads independent
of length reported in the output BAM file.

6 Usable
Reads

The percentage of library ISPs that pass the polyclonal, low
quality, and primer-dimer filters. This percentage is calculated
by dividing final library ISPs by library ISPs.
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Number Metric Description

7 ISP
Summary-
Loading

The percentage of chip wells that contain an ISP. The
percentage value considers addressable wells.

8 ISP
Summary-
Enrichment

The predicted number of live ISPs that have a key signal
identical to the library key signal or test fragment (TF) key
signal. The Percent Enrichment value reported is the number
of loaded wells with live ISPs that are Library ISPs or TF ISPs.
This number is calculated by dividing wells with live ISPs by
the number of wells loaded with ISPs.

9 ISP
Summary-
Clonality

The percentage of clonal ISPs (all library and TF ISPs that are
clonal, not polyclonal).

An ISP is clonal if all of its DNA fragments are cloned from a
single original template. All the fragments on such an ISP are
identical and they respond in unison as each nucleotide is
flowed in turn across the chip. This percentage is calculated by
dividing the number of ISPs with a single DNA template by the
number of live wells.

10 ISP
Summary-
Final Library

The percentage of reads, which pass all filters, and which are
recorded in the output BAM file. This value can be different
from the Total Reads due to technicalities associated with read
trimming beyond a minimal requirement that results in Total
Reads being slightly less than Final Library.

11 Mean Read
Length

The average length, in base pairs, of called reads.

12 Median Read
Length

The median length, in base pairs, of called reads.

13 Mode Read
Length

The mode length, in base pairs, of called reads.

14 Read Length
Histogram

The read length histogram is a histogram of the trimmed
lengths of all reads present in the output files.

Additional metrics are shown when you click the magnifying glass icon in the run
report.

Metric Description

Empty Wells Percentage of chip wells that do not contain an ISP. The
percentage value considers only potentially addressable
wells. The percentage is calculated by the number of
potentially addressable wells, minus the number of loaded
ISPs, divided by the number of potentially addressable
wells.

No Template Percentage of chip wells that do not contain a DNA
template. This percentage is calculated by the number of
loaded ISPs minus TF ISPs divided by the number of
loaded ISPs plus TF ISPs.
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Metric Description

Polyclonal Percentage of polyclonal ISPs (ISPs carrying clones from
two or more templates). A high polyclonal percentage
indicates that library input is too high and should be
titrated down. Enrichment does not filter out polyclonal
ISPs, it removes only template-negative ISPs. This
percentage is calculated by dividing polyclonal ISPs by live
ISPs.

Final Library Percentage of reads that pass all filters and are recorded
in the output BAM file. This value can be different from the
Total Reads due to specifications associated with read
trimming beyond a minimal requirement resulting in Total
Reads being slightly less than Final Library. This
percentage is calculated by dividing final library ISPs by
clonal ISPs.

% Test Fragments Percentage of live ISPs with a key signal that is identical to
the test fragment (TF) key signal. This percentage is
calculated by dividing TF ISPs by clonal ISPs.

% Adapter Dimer Percentage of ISPs with an insert length of less than 8 bp.
This percentage is calculated by dividing primer‑dimer
ISPs by clonal ISPs.

% Low Quality Percentage of ISPs with a low or unrecognizable signal.
This percentage is calculated by dividing low quality ISPs
by clonal ISPs.

Addressable Wells Total number of wells on the chip minus excluded wells.

With ISPs Number (and percentage) of addressable wells that were
determined to be positive for the presence of an ISP in the
well. Positive is determined by measuring the diffusion
rate of a flow with a different pH. Wells containing ISPs
have a delayed pH change due to the presence of an ISP
slowing the detection of the pH change from the solution.
This percentage is calculated by dividing the number of
wells with ISPs by total addressable wells.
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View the aligned reads to determine the accuracy of your sequencing run.

1. In the Data tab, click Completed Runs & Reports, then select a report of interest.

2. In the left navigation menu, click Aligned Reads, then review the metrics to
determine the accuracy of your sequencing data.

Click , or on an image to open an enlarged view.

Quality following alignment

You can use read alignment to evaluate the quality of the sequencing reaction and the
quality of the corresponding library when an accurate reference is available. Reads are
aligned to a reference genome sequence. Any discrepancy in alignment to a reference,
whether biological (actual variant) or technical (sequencing error) is listed as a
mismatch. Alignment performance metrics are reported using the alignment quality
(AQ) score, which defines the accuracy of sequencing reads when compared to a
reference genome sequence. Torrent Suite™ Software reports alignment quality using
three parameters:

• AQ17—the greatest length at which the error rate is 2% or less.
• AQ20—the greatest length at which the error rate is 1% or less.
• Perfect—the longest perfectly aligned segment.

Aligned read length calculation

The aligned length of a read at a given accuracy threshold is defined as the greatest
position in the read at which the accuracy in the bases, up to and including the
position, meets the accuracy threshold. Accuracy is specified using the Phred -10log10
transformation, where 20 represents an error rate of 1%, and 17 represents an error
rate of 2%.

In Torrent Suite™ Software, the alignment quality (AQ) score represents alignment
quality for the total number of bases that are sequenced or for consecutive sequencing
reads. The AQ20 length is the greatest length at which the error rate is 1% or less, and
the AQ17 length is the greatest length at which the error rate is 2% or less. The ideal
length is the longest perfectly aligned segment. The AQ score for the total number of
bases represents the number of all aligned bases in the sequencing reaction that meet
a specific AQ score.

Review aligned
reads
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For all of these calculations, the alignment is constrained to start from position 1 in the
read - that is, no 5' clipping is allowed. The underlying assumption is that the
reference to which the read is aligned represents the true sequence that is seen.

Appropriate caution must be taken when values for the AQ score are interpreted for
situations in which the sample that is sequenced has substantial differences relative to
the reference used. For example for alignments to a rough draft genome, or for
samples that are expected to have high mutation rates relative to the reference used.
In these situations, the AQ20 and AQ17 lengths can be short even when sequencing
quality is excellent.

The AQ20 length is calculated using the following steps:
• Every base in the read is classified as being correct or not correct according to the

alignment to the reference.
• At every position in the read, the total error rate is calculated up to and including

that position.
• The greatest position at which the error rate is one percent or less is identified

and that position defines the AQ20 length.

For example, if a 100-bp read consists of 80 perfect bases that are followed by 2 errors
that are then followed by 18 more perfect bases, the total error rate at position 80 is
zero percent. At position 81 the total error rate is 1.2% (1/81), at position 82 the error
rate is 2.4%, continuing up to position 100 where it is 2% (2/100). The greatest length
at which the error rate is 1% or less is 80, and the greatest length at which the error
rate is 2% or less is 100. Therefore, the AQ20 and AQ17 lengths are 80 and 100 bases,
respectively.

Alignment

Torrent Suite™ Software provides a view on alignment that helps determine run and
library quality.

Many alignment algorithms are available in the marketplace. You are encouraged to
consult with a bioinformatician for the most appropriate alignment algorithm for your
downstream analysis requirements.

Alignment in Torrent Suite™ Software is performed using TMAP. TMAP is currently
an unpublished alignment algorithm, created by the authors of the BFAST algorithm.
For more information, see “TMAP modules“ on page 320, or contact your local Field
Service Engineer or Technical Support.

Although TMAP is unpublished and a reference is not currently available, the
precursor to TMAP, BFAST, is based on the ideas in the following publications:

• Homer N, Merriman B, Nelson SF (2009) BFAST: An Alignment Tool for Large
Scale Genome Resequencing. PLoS ONE 4(11): e7767. doi: 10.1371/
journal.pone.0007767

• Homer N, Merriman B, Nelson SF (2009) Local alignment of two-base encoded
DNA sequence. BMC Bioinformatics 10: 175. doi: 10.1186/1471-2105-10-175
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Reads used for alignment

The alignment process involves aligning reads produced by the pipeline to a reference
sequence and extracting metrics from those alignments. By default, Torrent Suite™

Software aligns all reads to the reference; however, there may be situations,
particularly with large reference sequence, when the alignment exceeds the amount of
time that you are willing to wait. If so, the software can define on a per-reference basis
the maximum number of reads that are aligned from a run.

When the number of reads in a run exceeds a reference-specific maximum, a random
sample of reads is taken and results are extrapolated to represent the full run. By
sampling a random pool of reads and extrapolating the alignment quality values to
represent all reads, the software provides sufficient information to assess the quality
of the sample, library, and sequencing run.

The output of the alignment process is a BAM file. The BAM file includes an
alignment of all reads, including the unmapped reads, with exactly one mapping per
read. When a read maps to multiple locations, the mapping with the best mapping
score is used. If more than one such mapping exists, a random mapping is used and a
mapping quality of zero is given.

Predicted quality (Q20)

The number of called bases with a predicted quality of Q20 is reported. The predicted
quality values are reported on the Phred scale, defined as -10 log10 (error probability).
Q20, therefore, corresponds to a predicted error rate of one percent.

Per-base quality score system

The Ion Torrent™ technology per-base quality score system uses a Phred-like method
to predict the probability of correct base calls. The prediction is based on the quality
of the base incorporation signal that was used for generating the base calls. The
quality score system used by the sequencers uses a set of six predictors whose values
are correlated with the probability of a base miscall.

A Phred lookup table is used for converting the values of predictors to error
probabilities. The lookup table is generated by training on a representative data set in
a customer configuration. The lookup table is retrained for each software release and
is shipped as part of the software package. Quality scores are published in the BAM
file.

Quality score predictors

Torrent Suite™ Software uses the following six quality score predictors that are
correlated with empirical base call quality:

Predictor Description

P1 Penalty Residual—A penalty based on the difference between
predicted and actual flow values. Computed by the base caller.

P2 Local Noise—Noise (defined as the maximum absolute difference
between the flow value and the nearest integer) in the immediate
neighborhood (plus/minus 1 base) of the given base.
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Predictor Description

P3 High-Residual Events—Number of high-residual flows in the 20-
flow window around the flow containing the base. A flow has high
residual when the normalized difference between the observed
and model-predicted signal exceeds 0.4 or falls below –0.4. The
more high-residual flows in the window, the lower quality the base
call.

P4 Multiple Incorporations—Number of incorporated bases in this
flow. Length of the homopolymer. For multiple incorporations of
the same nucleotide in one flow, the last base in the incorporation
order is assigned a value equivalent to the total number of
incorporations. All other bases in the sequence of the multiple
incorporations are assigned the value 1.

P5 Environment Noise—The average signal noise (defined as the
absolute difference between the flow value and the nearest
integer) in the neighborhood (plus/minus 5 bases) of the given
base.

P6 State Inphase—Live polymerase in phase.

The six quality predictors are calculated for each base. Other predictors (not described
here) are computed from the corrected flow values generated by the base caller.

The corresponding per-base quality value is found by finding the first line in the
lookup table for which all six calculated predictors are less than or equal to the
predictor values in the table. This process occurs automatically as part of the standard
analysis.

The Phred lookup tables are stored in the /opt/ion/config directory on Ion
Torrent™ Server. The Ion Torrent™ Server supports separate Phred tables for each type
of chip.

The per-base quality along with all other read information is written to the unmapped
BAM file. The per-base quality scores are reported in the QUAL field, which is part of
the SAM/BAM file format specification (see https://samtools.github.io/hts-specs/
SAMv1.pdf, pages 6 and 8.

The quality scores are on a phred-10*log_10 (error rate) scale.

References

1. Brockman, et al. (2008): "Quality scores and SNP detection in sequencing-by-
synthesis systems." Genome Res. 18: 763-770.References.

2. Ewing B, Hillier L, Wendl MC, Green P. (1998): "Base-calling of automated
sequencer traces using phred. I. Accuracy assessment." Genome Res.
8(3):175-185.

3. Ewing B, Green P. (1998): "Base-calling of automated sequencer traces using
phred. II. Error probabilities." Genome Res. 8(3):186-194.
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Run report metrics after alignment

To assess the sequencing run when an accurate reference is available, you can review
the quality metrics for aligned reads. Reads are aligned to a reference genome
sequence. The following post-alignment metrics are provided in the run report.

1 2 7 8

4
5

9
10
11
12

3

6

Number Metric Description

1 Total Aligned
Bases

The number of filtered and trimmed aligned base pairs
reported in the output BAM file that are aligned to the
reference sequence, excluding the library key, barcodes, and
3' adapter sequences.

2 Reference
Coverage

The ratio of the total aligned bases divided by the number of
bases in the reference sequence. Reference coverage does not
account for enrichment done to selectively amplify a subset of
the reference sequence.

3 Alignment
plot

A plot of the number of aligned reads (blue) and unaligned
(purple) by position in an aligned sequence.

4 Total Reads The total number of reads after filtering.

5 Aligned
Reads

The number of reads that align to the reference sequence
expressed as a total count and percentage of the total aligned
reads.

6 Unaligned
Reads

The number of reads that do not align to the reference
sequence expressed as a total count and percentage of the
total reads.

7 Mean Raw
Accuracy 1x

The mean raw accuracy across each individual base position
in a read calculated as 1− (total errors in the sequenced
base) / total bases sequenced.

8 AQ17 Total
Bases

The total number of bases over all positions that align with an
error rate of 2% or less.

9 Total
Number of
Bases (bp)

The total number of bases over all positions that align with a
given error rate. (AQ17 ≤2% error rate, AQ20 ≤1% error rate,
Perfect = no measurable error)
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Number Metric Description

10 Mean Length
(bp)

The average length, in base pairs, for aligned reads at a given
error rate. (AQ17 ≤2% error rate, AQ20 ≤1% error rate, Perfect
= no measurable error)

11 Longest
Alignment
(bp)

The maximum sequence read length for a given error rate.
(AQ17 ≤2% error rate, AQ20 ≤1% error rate, Perfect = no
measurable error)

12 Mean
Coverage
Depth (x)

The ratio of the total aligned bases at a given error rate to the
size of the target region. (AQ17 ≤2% error rate, AQ20 ≤1%
error rate, Perfect = no measurable error)

You can use the six run report metrics to evaluate the quality of a sequencing run:
• Throughput (or Total Bases)—The number of filtered and trimmed base pairs

reported in the output BAM file.
• ISP loading density—The percentage of chip wells that contain Ion Sphere™

Particles (ISPs). The percentage value considers only potentially addressable
wells. Bead loading density is calculated as the number of loaded wells divided
by the number of potentially addressable wells.

• Total reads—The total number of filtered and trimmed reads independent of
length reported in the output BAM file.

• Read length—The length of called reads measured in base pairs.
• Read length histogram—A histogram that reflects the size distribution of the

library minus the Ion adapter sequences.
• Key signal—The average signal (post software processing) for all ISPs that

identically match the library key (TCAG). When the library key signal is lower
than expected, increased 3' quality trimming occurs. Therefore, the higher the
starting key signal, the less the impact of signal droop and the less 3' quality
trimming is expected to occur.

Throughput considerations

To assess a run, examine the throughput or total bases. Consider whether these
numbers make sense for the application and chip type.

Chip type
Number of

addressable
wells

Number of
reads

Throughput

200 Base Read 400 Base Read

Ion 510™ Chip ~6 million 2–3 million 0.3–0.5 Gb 0.6–1 Gb

Ion 520™ Chip ~12 million 4–6 million 0.6–1 Gb 1.2–2 Gb

Ion 530™ Chip ~37 million 15–20 million 3–4 Gb 6–8 Gb

Ion 540™ Chip ~150 million 60–80 million 10–15 Gb N/A

Ion 550™ Chip ~260 million 100–130 million 20–25 Gb N/A

The following table provides information regarding the number of wells per chip type
and sequencing throughput specifications for sequencing runs from an Ion PGM™

System.

Run report
metrics
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Chip type
Number of

addressable
wells

Number of
reads

Throughput[1]

200 Base Read 400 Base Read

Ion 314™ Chip v2 BC ~1.2 Million 400–500
Thousand

30–50 Mb 60–100 Mb

Ion 316™ Chip v2 BC ~6 Million 2–3 Million 300–600 Mb 600 Mb–1 Gb

Ion 318™ Chip v2 BC ~11 Million 4–5.5 Million 600 Mb–1Gb 1.2–2 Gb

[1] Expected output with >99% aligned accuracy. Output is dependent on read length and application.

The throughput, total bases, and read length metrics are found at the top of the run
report. This example is from the 200-base read run (500 flows) on an Ion 540™ Chip
with a CEPH control library.

1 2 3

Total bases or throughput depends on the ISP loading density, total reads (usable sequence), and read length.

1 Throughput (Total Bases)
2 Total Reads
3 Read Length

ISP loading density

ISP loading density is the percentage of chip wells that contain an Ion Sphere™

Particle (ISP; templated and non-templated, or live and dud ISPs). This percentage
value considers only the potentially addressable wells and is a result of the software
well classification step.

For more information, see “Well classification“ on page 114.

The ISP density image is a color image of the Ion Chip™ that shows the percentage of
loading across the physical surface. Red indicates adequate ISP loading density,
yellow indicates less-than adequate loading density, and blue indicates an absence of
loaded beads.
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Note: To open a larger version of the ISP density image, click the chip image in the
run report.

1

2

3

ISP loading density chip image

1 Sequencing reagent flow inlet
2 Notch position
3 Loading port

Total reads

The total reads value is the total number of reads that are written to barcode or no-
match output BAM files. Filtered reads are not included in this count.

Well classification

Empty and loaded wells are separated by the differences in buffering over the chip
during the nucleotide key flows (flows 1-8). Wells that are loaded with ISPs and
associated polymerase have greater buffering capacity than empty wells and the
software uses this difference to identify and classify loaded versus empty wells.

Live versus dud (non-templated ISPs) and TF versus Library ISPs are also identified
based on data from the key flows. Therefore, both sequencing primer and sequencing
polymerase are required for proper well classification.
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Read filtering and trimming

Empty and loaded wells are separated by the differences in buffering and signal over
the chip during the nucleotide key flows (flows 1–8). Wells that are loaded with ISPs
and associated polymerase have greater buffering capacity and higher signal than
empty wells, and Torrent Suite™ Software uses these differences to identify and
classify loaded versus empty wells.

After well classification, the software further processes the identified test fragments
and library reads, including read filtering and trimming. This processing affects the
total number of library reads and bases. You can see both well classification and
library read filtering results that are displayed in the run report. Read trimming
operations trim bases off the read, thereby making reads shorter, while read filtering
operations completely remove them from the output BAM files. By default, reads that
have a trimmed read length of less than 25 bases are being filtered. The different
categories of filtered reads shown in the run report are in the table below.

Filter Description

Polyclonal Filters reads from ISPs with >1 unique library template
population. Occasionally, low or unexpected signal ISPs
can also get caught in this filter.

Low Quality Filters reads with unrecognizable key signal, low signal
quality, and reads trimmed to <25 bases.

Primer Dimer Filters reads where no or only a very short sequencing
insert is present. Reads that, after P1 adapter trimming,
have a trimmed length of <25 bases are considered primer
dimers.
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You can see both well classification and library read filtering results that are displayed
in the run report.

1

2

1 Well classification results
2 Library ISP filtering results

The ISP summary panel also presents the well classification and library ISP summary
table using slightly different calculations.

1

2

1 Usable reads percentage
2 ISP summary percentages

The usable reads percentage is calculated by

library reads passing filters (77,529,592) x 100
number of library ISPs identified (134,802,984)

% usable reads =
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Each ISP summary percentage is calculated by dividing the current value by the
previous values. For example,

library reads passing filters (77,529,592) x 100
number of clonal reads (92, 369,180)% final library =

Read length

Read length value is the length of called reads measured in base pairs. The Read
Length histogram presents all filtered and trimmed library reads reported in the
output BAM file and the mean read length in base pairs. The shape of the histogram
should closely resemble the library size distribution trace, without the adapter
sequences.

2

1

1 The y-axis provides the read count.
2 The x-axis provides the read length in base pairs.

In addition to the loading density and read filtering and trimming, the average library
read length also affects the total sequencing run throughput. Read length is
considered in the total sequencing run throughput. For example, a sequencing run on
an Ion 530™ chip produces about 15 million final library reads:

• If the average read length is 300 bp, then the approximate throughput is
15,000,000 reads * 300 bp = 4.5 Gbp.

• If the average read length is 400 bp, then the approximate throughput is
15,000,000 * 400 bp = 6 Gbp.

For more information, see How to assess an Ion S5™/Ion GeneStudio™ S5 sequencing run
report User Bulletin (Pub. No. MAN0017983).
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Key signal

The library key signal is determined in the first eight flows of the sequencing run. The
library key sequence is TCAG and all four nucleotides (T, C, A, and G) are
incorporated during the first eight nucleotide flows.

Note: The library and test fragment (TF) keys, and the flow order can be found under
the Analysis Details section of the run report.

Analysis detail Example Description

Flow Order TACGTACGTCTGAGGATCGATGTACA
GC

The order in which the chip is
exposed to each particular dNTP.

Library Key TCAG A short known sequence of bases
used to distinguish the library
fragment from the test fragment.

TF Key ATCG The nucleotide sequence that is
used to identify test fragment
reads.

The reported key signal is the average signal (post software processing) for all ISPs
that identically match the library key (TCAG). Each templated library ISP in a well
has many library templates (ideally, clonally amplified during template preparation)
all of which contribute to the dNTP incorporation signals reported for that well. The
more templates per ISP, the higher the reported incorporation signal is for that well. In
simple terms, the key signal essentially measures the number of templates per ISP or
the efficiency of the template preparation reaction.

When the library key signal is lower than expected, increased 3’ quality trimming can
result, especially for long reads (400-base read sequencing). Over the sequencing run,
as with all sequencing by synthesis technologies, the signal that is generated drops
due to the reaction conditions (polymerase dissociation) and eventually becomes
indistinguishable from the background noise. As the signal generated approaches the
background noise, the quality of the read decreases and is subject to 3’ quality
trimming by the software. Therefore, the higher the starting key signal, the less the
impact of the signal droop and the less 3’ quality trimming is expected to occur.

You can view and download the output files from your sequencing runs. The files
include:

• Library sequences of unaligned and aligned reads
• Barcode reports of performance metrics for each barcode included in the run, if

you used barcode adapters during the library preparation for your sample.

Output files
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Download output files

You can download the library files for unaligned and aligned reads in BAM or BAI file
formats.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click Output Files or scroll to the Output Files
section, then click a file type to download the following files:

Option Description

Unaligned
Reads

Nucleotide bases covered by reads that have not been aligned to
the reference. Can be downloaded as a binary aligned/mapped
(BAM) file.

Aligned Reads Number of bases covered by reads that have been aligned to the
reference. Can be downloaded as a BAM or binary
aligned/mapped index (BAI) file.

View and download barcode reports

You can view barcode reports for sequencing runs that use barcode adapters during
library preparation for samples. The reports show key performance metrics for each
barcode included in the run.

The number of barcodes in the barcode report reflects the barcode set that was used in
the run and the barcodes that are present in the sample. Data is included only for
barcodes that are present in the run.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click Output Files, then scroll to the barcode section
of the run report.
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The barcode section of a run report displays the following information and provides
access to downloadable files for each barcode:

Column Description

Barcode Name The individual barcode in the barcode set.

The row labeled No barcode reports on unclassified barcodes,
which are reads that could not be classified as a match for one of
the expected barcodes in the barcode set.

Sample Name of the sample that was sequenced on instrument.

Bases Post-filtering base output for each barcode.

% ≥ Q20 The percentage of reads that have a predicted quality score of Q20
or better.

Reads Total number of filtered and trimmed library reads (independent of
length). This number is reported in the barcode BAM file.

Mean Read Length The average read length, in base pairs (bp), of all filtered and
trimmed library reads reported in the BAM file for the barcoded
run.

Read Length
Histogram

A thumbnail histogram of the read lengths for this barcode. Click
the thumbnail histogram to open a larger image.

UBAM Download a binary file that contains unaligned or unmapped
reads. Viewing the file requires a viewer application, such as the
Integrative Genomics Viewer from the Broad Institute.

BAM Download a compressed, binary form of the SAM file. The BAM file
contains aligned reads sorted by genome reference location.

BAI Download the BAM index (BAI) file. This file speeds up the access
time for a coordinate-sorted BAM file.

You can download a run report summary in PDF format. The PDF report reflects what
is visible in the run report screen.

1. In the Data tab, click Completed Runs & Reports, then click the report name link
for your completed sequencing run.

2. Click Download PDF 4Summary PDF.
A PDF version of the run report is downloaded through the browser to a
directory on your computer that is indicated in the browser settings.

View details about completed runs

You can view various details about a completed sequencing run in Torrent Suite™

Software.

Download a run
report summary
PDF
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You can view the test fragment results and determine the quality of your sequencing
run if you included key signal test fragments in your run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click Test Fragments.

Parameter Description

Test Fragment Test fragment name. For more information, see “Test
fragments“ on page 292.

Reads Number of filtered & trimmed reads identified for this
test fragment.

Percentage 50AQ17 The percentage of reads for this test fragment with a
minimum of 50 base pairs in length and an error rate of
1 in 50, Phred-like 17, or better. Quality is based on
alignment, not predicted quality.

Percent 100AQ17 The percentage of reads for this test fragment with a
minimum of 100 base pairs in length and an error rate
of 1 in 100, Phred-like 17, or better. Quality is based on
alignment, not predicted quality.

Read length histogram A thumbnail histogram of trimmed lengths of all reads
present in the test fragment.

3. In the Read length histogram column, click the thumbnail histogram to open a
larger image and review the histogram details.

The figure shows an example histogram of read lengths, represented in base pairs (bp),
that have a Phred-like score of ≥17, or one error in 50 bp (only the ends are shown
because of width considerations). Distributions skewed to the right are ideal, showing
longer read lengths (test fragments are a discrete length). It is likely that the sequence can
extend all the way through the test fragment, if enough flows are run, so that the
histogram displays only a maximum size based on the length of the test fragment.

View test
fragments for a
completed run
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You can view a summary of reagent usage in an S5 Consumable Summary for
sequencing runs on Ion S5™ Systems and Ion GeneStudio™ S5 Systems.

Note: A summary of consumables that are used during a sequencing run is not
reported for sequencing runs performed on the Ion PGM™ or Ion Proton™ systems.

1. In the Data tab, click Completed Runs & Reports, then click the name of the
report of interest to open the report.

2. In the left navigation menu, click Details or scroll down to the Details section of
the run report, then click the S5 Consumables Summary tab.

3. Note the details, including remaining uses for the cleaning solution.

Detail Description

Chip Type Chip type and version.

Chip Barcode Barcode number of the chip.

Ion S5 Cleaning Solution Row includes Part Number, Lot Number, Expiration
Date, and Remaining Uses.

Ion S5 Sequencing Reagents Row includes Part Number, Lot Number, Expiration
Date, and Remaining Uses.

Ion S5 Wash Solution Row includes Part Number, Lot Number, Expiration
Date, and Remaining Uses.

You can view a summary for a completed run by an Ion Chef™ Instrument by viewing
the run report.

1. In the Data tab, click Completed Runs & Reports, then click the report name link
to open the report of interest.
If necessary, filter the list to show only Ion Chef™ Instrument runs.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Chef Summary tab.

The following parameters are listed.
• Chef Last Updated
• Chef Instrument Name
• Chef Operation Mode
• Sample Position
• Tip Rack Barcode
• Chip Type 1
• Chip Type 2
• Chip Expiration 1
• Chip Expiration 2
• Templating Kit Type
• Chef Flexible Workflow
• Reagent Expiration

• Reagent Lot Number
• Reagent Part Number
• Reagent Cartridge Serial Number
• Solution Lot Number
• Solution Part Number
• Templating Protocol Planned
• Solution Cartridge Serial Number
• Solution Expiration
• Templating Protocol Executed
• Chef Script Version
• Chef Package Version

Start Time
• Completion Time

View consumables
used in a
completed run

View the summary
for an Ion Chef™

Instrument run
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You can review calibration settings that were applied to a run. Results can be
calibrated to TMAP, the reference genome, or the calibration standard. For more
information on setting calibration options, see “Advanced Settings—Kits step in
workflow bar“ on page 51.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Calibration Report tab.
Calibration details are displayed. If Default Calibration was selected for the run,
the tab lists the usual Pre Base and Calibration Arguments. If No Calibration or
the Calibration Standard were selected, the tab lists the control reads, total
bases, and Q20 bases.

Another way to access calibration details is to click Report Actions4Review
Plan, then scroll down to Advanced Parameters. For more information, see 
“Review Planned Run settings“ on page 58.

You can view analysis details for a completed run report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Analysis Details tab.

3. Review the analysis details.

View the
calibration report
for a completed
run

View analysis
details for a
completed run
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You can view information about the versions of the software that was used for a
completed run.

IMPORTANT! The version numbers that are shown can be different from your
current version of the software depending on the date of the run. It is possible that the
report was analyzed with an older version of the software. See  (Settings)4About
in Torrent Suite™ Software for a complete list of modules and their version on your
Ion Torrent™ Server. See the Torrent Suite™ Software Release Notes for details about the
versions in a specific release.

1. In the Data tab, click Completed Runs & Reports, then click the report name link
to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Software Version tab.
The Software Version tab shows only the software products that were used to
analyze the selected run.

Organize run results with projects

Projects are groups of result sets that you can create and to organize results into
unique categories that are useful for your organization. A project can contain run
results for the same laboratory project or results from completed runs that you want
to combine. Projects also allow you to combine run results into a single run report.
When you open a list of projects, you can:

• Quickly find and view details for a group of run results.
• Search the list by project name or partial name, or by date (date range, current

month, current week, current day, or specific date).
• Click Edit to rename a project
• Click Delete to delete a project.
• Click Log to view a log of the project history.

View software
versions used in a
run
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You can search for projects and result sets lists by name.

1. (Optional) To display a result sets list, in the Projects table, click the name of the
project containing your result set.

2. To find the projects or result sets or of your interest, you can search, sort, and
filter the Projects and Result Sets lists:

To... Steps...

Search the
list

Enter your search term in Search names, then click Go. The
information displayed in the table is limited only to the names that
match or contain the search string.
In Search names, you can enter a complete or partial name. For
example, the following project names match the search string "mpli":
amplicon, amplicon33, AmpliSeq, Samplier. The search is not
case‑sensitive and wildcards are not supported in the search string.

Sort the list Click any bolded column header in the table to sort the order in which
the projects or result sets are displayed. Click the column header a
second time to reverse the sort order.

Filter the
list by date

• In Last Modified select a preset range (for example, last 7 days,
or this month).

• Click Date Range, then select the Start and End dates to limit
your search to projects or result sets that are modified within the
selected date range.

• Click Older than Date or Newer than Date to limit your search to
project or result sets that are modified before or after the
selected date.

3. Click Clear to remove all search criteria and to display the unfiltered list of
projects or result sets.

You can group specific result sets in a project, then add the project to a Planned Run
or Planned Run template. The results sets in a project are viewable in the Data tab.

When you create a Planned Run, search for, then enter project names in the Projects
step in the workflow bar:

For more details, see Chapter 4, “Plan and execute an instrument run“.

Search for
projects by name

Add a project to a
Planned Run
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Add selected results to another project

1. In the Data tab, click Projects to see the list of projects.

2. In the Name column of the Projects table, click the project name to view the list
of result sets in the project.

3. Select the checkboxes in the row of the result sets that you want to add to one or
more other projects, then click Process Selected4Add to Project.

4. Select the checkbox for each project that the result sets are to be copied to, then
click Add projects.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the result sets that are included in the project.

You can compare report metrics side-by-side for all runs that are assigned to a project.

1. In the Data tab, click Projects.

2. Select a project.

3. Click Compare All to view all the runs in the project side-by-side.

4. (Optional) Click Customize.
The Show and Hide dialog box opens.

5. (Optional) In the Run Info column, deselect metadata to remove it from view.

View result sets in
a project

Compare reports
of runs in a project
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6. (Optional) In the Result Name column, deselect runs to remove them from view.

7. Click Apply.

8. Review the reports for all of the runs in the project.

9. (Optional) Export the results.

• Click Download PDF to create a PDF report.
• Click Download CSV to create a CSV file of the results.
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You can export, archive, or delete data from results that are included in a project.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project from the list to view the result sets in the project.

3. Click Process Selected4Data Management.
For details on how to export, archive, or delete data results in the project, see 
“Manually export run data“ on page 349, “Manually archive run data“ on
page 349 , and “Manually delete selected data from a run report“ on page 350.

If you are running an application that requires better coverage than the coverage
provided by a single chip, you can:

• run multiple chips with the same sample and library
• combine aligned reads from multiple sequencing reports

The combined aligned reads can be treated the same way as results from a single
run. For example, it can be exported or used as an input for a plugin.

1. In the Data tab, click Projects to see the list of projects.

2. Select a project in the list to view the result sets in the project.

3. Select the result set or sets that you want to combine into a single run result set.

4. Click Combine Selected4Combine Alignments.

5. In the Combine Selected dialog box, enter a new report name.

6. Make appropriate selections:

Option Description

Mark as
duplicate

Select this to identify duplicate reads and mark them in the BAM file.
For some applications, duplicate reads coming from PCR cause
problems in downstream analysis. The presence of duplicate reads
can create the appearance of multiple independent reads supporting
a particular interpretation, when some reads are in fact duplicates of
each other with no additional evidence for the interpretation.

Note: Marking duplicate reads is not appropriate for Ion AmpliSeq™

data, because many independent reads are expected to share 5'
alignment position and 3' adapter flow as each other. Marking
duplicates on an Ion AmpliSeq™ run risks inappropriately flagging
many reads that are in fact independent of one another.

Overwrite
sample
name

Select this to identify duplicate names in your combined samples so
that you can rename them.

7. Click Launch.

8. (Optional) Click Report to open the summary of the report, or Log to open the log
for the report.

The combined report is added to the project from which the combine action was run.

Manage data for
result sets in
projects

Combine aligned
reads from
multiple run
reports
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You can download a CSV file of analysis metrics for one or more result sets, then
compare results across analyses.

1. In the Data tab, click Projects, then click a project name to open the list of result
sets for the project.

2. Select the checkboxes for the analyses, then click Download Selected CSV.
The analysis metrics file is downloaded through your browser to a directory on
your computer, based on your browser settings.

Analysis metrics file fields

In the analysis metrics file, each line represents a Torrent Suite™ Software analysis run.
Within each line, fields are separated by a comma. Each comma-separated field is
listed in a separate column. You can open the files with spreadsheet software such as
Microsoft™ Excel™ or Apache® OpenOffice ™ Calc.

The file has many fields per entry. Rows 4 through 11 (marked by *) contain test
fragments metrics. The other rows contain library read metrics.

Field Description

Report Name of the analysis run report.

Status Status of the analysis (for example, Started,
Complete).

Flows Number of flow cycles from the actual
sequencing run.

TF Name* Test Fragment Name.

Q10 Mean* Average Q10 read length.

Q17 Mean* Average Q17 read length.

System SNR* System Signal-to-Noise Ratio.

50Q10 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q10.

50Q17 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q17.

Keypass Reads* Number of reads that have test fragment
keys.

TF Key Peak Counts* Signal strength of the first three bases of
the TF key.

Total_Num_Reads Total number of reads.

Library_50Q10_Reads Reads of length at least 50bp with 90% or
greater accuracy.

Library_100Q10_Reads Reads of length at least 100bp with 90% or
greater accuracy.

Download a CSV
file of metrics
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Field Description

Library_200Q10_Reads Reads of length at least 200bp with 90% or
greater accuracy.

Library_Mean_Q10_Length Average length of reads with 90% or greater
accuracy.

Library_Q10_Coverage Average per base coverage considering
reads with 90% or greater accuracy.

Library_Q10_Longest_Alignment Longest read length amongst reads with
90% or greater accuracy.

Library_Q10_Mapped Bases Total bases from reads with 90% or greater
accuracy.

Library_Q10_Alignments Number of alignments from reads with 90%
or greater accuracy.

Library_50Q17_Reads Reads of length at least 50bp with 98% or
greater accuracy.

Library_100Q17_Reads Reads of length at least 100bp with 98% or
greater accuracy.

Library_200Q17_Reads Reads of length at least 200bp with 98% or
greater accuracy.

Library_Mean_Q17_Length Average length of reads with 98% or greater
accuracy.

Library_Q17_Coverage Average per base coverage considering
reads with 98% or greater accuracy.

Library_Q17_Longest_Alignment Longest read length amongst reads with
98% or greater accuracy.

Library_Q17_Mapped Bases Total bases from reads with 98% or greater
accuracy.

Library_Q17_Alignments Number of alignments from reads with 98%
or greater accuracy.

Library_50Q20_Reads Reads of length at least 50 bp with 99% or
greater accuracy.

Library_100Q20_Reads Reads of length at least 100 bp with 99% or
greater accuracy.

Library_200Q20_Reads Reads of length at least 200 bp with 99% or
greater accuracy.

Library_Mean_Q20_Length Average length of reads with 99% or greater
accuracy.

Library_Q20_Coverage Average per base coverage considering
reads with 99% or greater accuracy.
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Field Description

Library_Q20_Longest_Alignment Longest read length amongst reads with
99% or greater accuracy.

Library_Q20_Mapped_Bases Total bases from reads with 99% or greater
accuracy.

Library_Q20_Alignments Number of alignments from reads with 99%
or greater accuracy.

Library_Key_Peak_Counts Signal strength of the first three bases of
the library key.

Library_50Q47_Reads Number of perfect reads of length at least
50 bp.

Library_100Q47_Reads Number of perfect reads of length at least
100 bp.

Library_200Q47_Reads Number of perfect reads of length at least
200 bp.

Library_Mean_Q47_Length Average length of perfect reads.

Library_Q47_Coverage Average per-base coverage considering
only perfect reads.

Library_Q47_Longest_Alignment Longest reads length amongst perfect
reads.

Library_Q47_Mapped_Bases Total bases from perfect reads.

Library_Q47_Alignments Number of alignments from perfect reads.

Library_CF CAFIE metric: Carry forward.

Library_IE CAFIE metric: Incomplete extension.

Library_DR CAFIE metric: Signal/polymerase loss
(droop).

Library_SNR System signal-to-noise ratio.

Sample Name of the sample.

Library Name of the reference genome.

Notes Any additional user-provided notes.

Run Name Long name of the analysis run.

PGM Name Name of the Ion PGM™ or Ion Proton™

instrument where the sample was
sequenced.

Run Date Date that the sample was sequenced.

Run Directory Location of the raw DAT files on the Ion
Torrent™ Server.

Chapter 7 Review and manage run reports
Organize run results with projects 7

Torrent Suite™ Software 5.12 User Guide 131



Field Description

Num_Washouts NA

Num_Dud_Washouts NA

Num_Washout_Ambigous NA

Num_Washout_Live NA

Num_Washout_Test_Fragment NA

Num_Washout_Library NA

Library_Pass_Basecalling NA

Library_pass_Cafie NA

Number_Ambiguous NA

Number_Live Number of wells producing a signal.

Number_Dud Number of wells with ISPs but no signal.

Number_TF Number of wells containing test fragment.

Number_Lib Number of wells containing library.

Number_Bead Number of wells containing beads.

Library_Live Number of wells containing library ISP with
signal.

Library_Keypass Number of wells containing library ISP with
signal and match key.

TF_Live Number of wells containing test fragment
ISP with signal.

TF_Keypass Number of wells containing test fragment
ISP with signal and match key.

Keypass_All_Beads Number of wells containing ISP with signal
and match key.

P JSON string of plugin data.

s JSON string of plugin data.
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You can remove a result set from a project. Removing does not delete the selected run
reports and their result sets from the system; it removes them only from the current
project.

1. In the Data tab, click Projects to see the list of projects.

2. To view the list of result sets in the project, in the Name column of the Projects
table, click the project name.

3. Select the checkboxes in the row of the result sets that you want to remove from
the project, then click Process Selected4Remove from Project.

Reanalyze a run

You can reanalyze a run to correct a setup error such as a default reference alignment
or an assigned barcode, or to optimize analysis parameters.

Torrent Suite™ Software provides two ways to change the options used to analyze
sequencing data. If you want to change the options for the results of a sequencing run
one time, you can change the options in the run report, then immediately reanalyze
the data. If you want to change the run report for all future reanalyses of the data, you
can edit the run report and save the updated report.

1. In the Data tab, click Completed Runs & Reports.

2. Search, filter, or sort the list to find your run report of interest. For more
information, see “Search for a run report“ on page 87.

3. Do one of the following:

• In Table View mode, in the row of the run of interest, click
 (Actions)4Reanalyze.

• Alternatively, switch to List View mode, find your run of interest, then click
Reanalyze.

Remove a result
set from a project
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4. In the menu on the left, click Reanalyze Run, enter a Report Name for the new
run, then select from the available options.

Option Description

Thumbnail only Select to reanalyze only the thumbnail report. This option is
available only for Ion Proton™ System, Ion S5™ System, and Ion
GeneStudio™ S5 Systems data.

Start reanalysis
from

• Select Signal Processing to reanalyze from DAT files.
The analysis does not use the Use data from the previous
result option, but reprocesses from the DAT files. You can
also use Analysis and Base Calling options.

• Select Base Calling (default) to reanalyze from 1.WELLS files.
The analysis uses the Use data from the previous result or
Base Calling options, but reprocesses from the 1.WELLS file.
The analysis does not use the Analysis Parameters option.

Use data from
previous result

Select the previous result if more than one result is available. This
option applies only when starting reanalysis from the basecalling
step.

Analysis
Parameters

Use the default analysis parameters, or click Custom to select the
analysis parameters.
For more information, see “Copy an analysis parameter set“ on
page 62.

5. (Optional) In the menu on the left, click Analysis Options, then set the options as
needed.

Option Description

Library Key The sequence that is used to identify library reads.

TF Key The sequence that is used to identify test fragment reads.

3′ Adapter The sequence of the 3′ Adapter that is used.

Mark as Duplicate
Reads

Select to have PCR duplicates flagged in the BAM file.

Base Calibration Mode Base calibration mode allows for empirical alignments to
influence flow signals to achieve better homopolymer
calibration to improve overall accuracy.

Enable Realignment Select to use an optional analysis step to adjust the
alignment, primarily in the CIGAR string.

6. (Optional) Set the reference and barcoding options.
a. In the menu on the left, click Reference & Barcoding, then click Edit Run

Plan.

b. On the Edit Run Plan screen, set the default options as needed.

c. Click Update Run to return to the reanalyze setup screen to select plugins to
use in the analysis.

d. If you do not need to return to the setup screen to change the plugins, click
Update Run and Reanalyze.
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7. (Optional) In the menu on the left, click Plugins.
a. Select the plugin to include in the reanalysis.

b. (If needed) Click the Configure link next to the plugin, scroll down to
configure the plugin, then click Save Plugin Settings.
For more information, see “Plugin configuration“ on page 138, or the
configuration topic specific to the selected plugin.

c. Repeat steps a and b to include additional plugins in the reanalysis.

8. Click Start Analysis.

You can change the default alignment reference for a completed run, and then analyze
the run again.

1. In the Data tab, click Completed Runs & Reports.

2. Use either Table View or List View, then find the run of interest.
For help finding an individual run, see “Search for a run report“ on page 87.

3. In the row of the run that you want to reanalyze, click  (Actions)4Reanalyze.

4. In the next screen, click Reference & Barcoding.

5. Click Edit Run Plan, change any settings as appropriate, then click either Update
Run or Update Run & Reanalyze.
For more information, see “Create a custom configuration for the variantCaller
plugin“ on page 210 and “Run the variantCaller plugin manually“ on page 206.

Edit a run report

You can edit a completed run report to correct a setup error or optimize parameters
for all future reanalyses.

Preinstalled Planned Run templates cannot be edited. Create a copy of the
preinstalled Plan Run template, then make changes in the copy.

1. In the Data tab, click Completed Runs & Reports.

2. Search, filter, or sort the list to find the run report of interest.
For more information, see “Search for a run report“ on page 87.

3. Open the Edit Run wizard.

• Use Table View, then click  (Actions)4Edit in the row of the run report
that you want to edit.

• Use List View, then identify the run report of interest, then click Edit.

The Edit Run wizard opens to the Save screen.

Change the
default alignment
reference

Chapter 7 Review and manage run reports
Edit a run report 7

Torrent Suite™ Software 5.12 User Guide 135



4. Click a step in the workflow bar to access the screens to make changes.

Workflow step Description

Ion Reporter Select the Ion Reporter Account, Sample Grouping, and Ion
Reporter Upload Options.

Research Application Select the Research Application and Target Technique.

Plugins Select the plugins to be included in the run.

Projects Select the Project for the run data.

Save Enter a Run Plan Name, then complete the information as
needed.

5. Click Update Run, or Update Run & Reanalyze to start the reanalysis
immediately.

You can change barcoding when you set up a reanalysis, but you can also change
barcoding for all future reanalyses. Use the Edit option to:

• Add barcoding to a completed sequencing run.
• Change the barcode set for a completed sequencing run.
• Remove barcoding from a completed sequencing run.

In each case, you must reanalyze the run after editing the barcode information. These
steps apply only to completed runs.

1. In the Data tab, click Completed Runs & Reports.

2. In table or list view, navigate to your run of interest.
For help finding an individual run, see “Search for a run report“ on page 87.

3. Click  (Actions)4Edit in the row of the run.

4. In the Edit Run screen, edit the Run Plan Name if desired, make the appropriate
barcoding changes, then click either Update Run, or Update Run & Reanalyze.

Set the Completed Runs & Reports screen to automatically refresh

Use the automatic refresh feature to update the Completed Runs & Reports screen.
When the automatic refresh function is turned on (the default), the screen refreshes
every 20 seconds. When the automatic refresh function is turned off, the screen is a
static display of information at the time you opened the screen.

1. In the Data tab, on the Completed Runs & Reports screen, click Auto Refresh.

Add or change
barcoding for a
completed run
report
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The button changes to Stop Refresh indicating that the automatic refresh
function is turned off.

2. Click Stop Refresh to turn off the automatic refresh function.
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Manage plugins for data analysis

■ Plugin configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

■ Run a plugin manually from the sequencing run report . . . . . . . . . . . . . . . . . . 141

■ Download a plugin report PDF . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

■ View plugin run status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

■ Preinstalled plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

■ Plugins available on Connect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

You can expand the analysis capabilities of Torrent Suite™ Software with plugins that
are preinstalled with the software. Additional plugins can be downloaded and
installed from Connect. The plugin results are added to the report summary and can
be used for a variety of purposes.

Plugin configuration

Some plugins have settings that can be configured by users. These plugins can be
configured three different ways.

• Global configuration: For plugins that can be configured globally, your
administrator can change the settings for all users of the software on a particular
server. These default settings can be overridden when setting up a Planned Run
or Planned Run template, or when running the plugin manually.
Some plugins require configuration, and fail unless certain settings are
configured. For example, some plugins require that a file directory is configured
to receive output files.

• Planned Run configuration: Some plugins can be configured when setting up a
Planned Run or Planned Run template. These options are available under
Plugins in the Planned Run workflow bar. Settings that are selected here override
the global settings.

• Manual configuration: Some plugins can be configured when they are selected to
run on the data from a sequencing run after the run is complete. These plugins
can be configured and run from the Run Summary screen. Settings that are
selected here override the global settings or any Planned Run settings.

8
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An administrator can change the global configuration of a plugin. The following
preinstalled plugins can be configured globally.

• DataExport plugin
• ERCC_Analysis plugin
• FileExporter plugin
• IonReporterUploader plugin
• RunTransfer plugin

Some plugins that cannot be configured globally can be configured when you set up a
Planned Run or a Planned Run template, or if you run the plugin after a sequencing
run.

1. Click  (Settings)4Plugins.

2. In the Manage column for the plugin of interest, click  (Actions)4Configure.

The settings in the configuration dialog box vary depending on the plugin. See
the plugin-specific configuration topic for more information.

3. To save your changes, click Submit or Save Configuration.

You can configure a plugin to run automatically by default. You can configure any
plugin that is installed in Torrent Suite™ Software, whether it is preinstalled or it is
downloaded from the Connect. If a plugin runs automatically, you can still rerun the
plugin manually after a sequencing run is completed. For details, see “Run a plugin
manually from the sequencing run report“ on page 141.

• To set a plugin to run automatically after every run:
a. Click  (Settings)4 Plugins.

b. Ensure that the Enabled checkbox is selected next to the plugin name that
you want to run automatically by default.

c. Select the Selected by Default checkbox next to the plugin name.

The plugin is now set to run after every sequencing run. You can deselect the
Selected by Default checkbox to disable automatic execution of the plugin.

Configure plugins
globally

Configure a plugin
to run
automatically
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• To set a plugin to run automatically as part of a Planned Run or Planned Run
template (not required if you previously set the plugin to run by default after
every run):

a. Under the Plan tab, in the Templates screen, select an application in the left
navigation menu.

b. Select an existing Planned Run template from the list. Alternatively, select
Add New Template, or Plan New Run to create a new Planned Run
template or Planned Run.

c. Click Plugins in the workflow bar.

d. Select the plugins that you want to run automatically after a run.

Note: If Configure appears after selecting the plugin, be sure to click the
link and configure the plugin before starting the run. For detailed plugin
configuration information for available plugins, see “Preinstalled
plugins“ on page 145.

e. Click Next, or another tab in the workflow bar to make further changes to
your Planned Run.

f. When all changes to the Planned Run have been made, click Plan in the
workflow bar, then click Plan Run.

The plugin is now set to run after every sequencing run that uses the Planned
Run or Planned Run template.
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Run a plugin manually from the sequencing run report

After a sequencing run is complete, you may want to manually run a plugin to
perform an analysis, regardless of whether a plugin was run automatically after a run.
You may need do this if you did not configure the plugin in the run plan, to run an
updated version of a plugin, or to run a previously used plugin with a different
configuration.

1. In the Data tab, click Completed Runs & Reports, then click the report name link
for the completed sequencing run.

2. Click Plugins4Select Plugins to
Run, then click the name of the
plugin that you want to run.

3. In the Configure Plugin screen, click
the screen to configure the plugin if
needed. If prompted, select the
desired plugin options, then click
Submit to start the analysis.
For detailed plugin configuration
information for the available plugins,
see the configuration topic for each
plugin in “Preinstalled plugins“ on
page 145.
If the plugin does not require
configuration, analysis starts
immediately without a confirmation
screen.

Download a plugin report PDF

You can download a PDF file of a plugin report for a completed sequencing run.

1. In the Data tab, click Completed Runs & Reports, then click the report name link
for your completed sequencing run.

2. Click Download PDF 4Plugins PDF.
A detailed report of the plugins that are included the run report is downloaded
through the browser to a directory on your computer, based on the browser
settings.
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View plugin run status

After a plugin run is started, it is listed in the Plugin section of the run report. You can
view the status of a plugin run to determine whether the run has completed. You can
also stop a plugin run in progress, view a log for the plugin run, or delete the
completed plugin report.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click the plugin name, or scroll to the Plugins section
of the run report.

The plugin run status (Queued, Started, or Completed) is listed under the name
of each plugin.

You can stop a plugin run that is in progress.

1. In the left navigation menu, click the name of the plugin you want to stop, or
scroll to the appropriate plugin section in the run report.

2. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

3. In the left navigation menu, click Plugins, or the name of the plugin results to be
deleted.

4. Click Stop to cancel a plugin run that has started.

Stop a plugin run
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If a Plugin report indicates that an error occurred during a plugin run, you can view a
log that contains details about the plugin run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin that has the
log you want to view.

3. Click View Log to the right of the plugin name.
The log for the plugin run opens.

Open a plugin log
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You can delete plugin results from the Plugins section of the run report.

1. In the Data tab, click Completed Runs & Reports, then click the report name link
for your completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin results that
you want to delete.

3. Click Delete to the right of the plugin name.
The plugin results are deleted from the run report.

Delete plugin
results from a run
report
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If you uninstalled and reinstalled a plugin, you can rescan the plugin to ensure that all
files from the previous installation were removed. When you rescan a plugin, the files
for the plugin are updated with any changes.

You can also rescan the output files from the list of reports when you view the usage
for a plugin.

1. Click  (Settings)4Plugins. The installed plugins are listed.

2. Click  Actions4Rescan in the row of the plugin.
You cannot complete other operations in Torrent Suite™ Software until the rescan
is complete.

Preinstalled plugins

The following table lists and describes the plugins that are preinstalled with Torrent
Suite™ Software.

Plugin name Description

ampliSeqRNA plugin Generates statistics, downloadable data files, and
interactive visualizations that represent targeted RNA
transcripts for sequencing runs that use the Ion
AmpliSeq™ Transcriptome Human Gene Expression Kit or
Ion AmpliSeq™ RNA panels.

AssemblerSPAdes plugin Performs an initial level analysis on assembly and provides
metrics. The plugin is ideal for genomes less than 50
megabases in size.

coverageAnalysis plugin Generates statistics and graphs to describe the level of
sequence coverage that is produced for targeted genomic
regions.

Rescan a plugin
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Plugin name Description

DataExport plugin Exports data from a sequencing run to an external hard
drive or a removable media, such as a USB drive.

ERCC_Analysis plugin Indicates whether a problem exists with library preparation
or sequencing for runs that use the ERCC RNA Spike‑In
Mix.

FieldSupport plugin Provides assistance with technical support. Enable and run
this plugin only under the guidance of Thermo Fisher
Scientific Technical Support. If you have questions about
this plugin, contact your local Field Service Engineer or
Technical Support.

FileExporter plugin Customizes the output file names of an analysis run. This
plugin allows you to rename output files. Also generates a
FASTQ format file of the analysis output, renames
variantCaller plugin output files (when available), and
compresses output files.

FilterDuplicates plugin Removes duplicate reads and creates BAM files that do not
contain the duplicate reads.

immuneResponseRNA
plugin

Used to quantify gene expression levels for the Oncomine™

Immune Response Research Assay.

IonReporterUploader plugin Transfers run results files to Ion Reporter™ Software.

For details, see Chapter 10, “Integration with Ion
Reporter™ Software“.

molecular Coverage Analysis
plugin

Generates statistics, downloadable data files, and
interactive visualization of molecular coverage over
targeted regions of the reference genome.

PGxAnalysis plugin Use with the Ion AmpliSeq™ Pharmacogenomics Research
Panel, which is a targeted gene panel that allows the
interrogation of pharmacogenomics variants in samples
for genotyping and CYP2D6 copy number detection.

RunTransfer plugin Transfers the signal processing output of a completed
sequencing run from one Ion Torrent™ Server to another
Ion Torrent™ Server, then runs an analysis of the
transferred files on the receiving Ion Torrent™ Server.

sampleID plugin Uses sample fingerprinting to identify any cross-
contamination between samples or between barcodes in a
run.

variantCaller plugin Calls single-nucleotide polymorphisms (SNPs),
multinucleotide polymorphisms (MNPs), insertions,
deletions, and block substitutions in a sample across a
reference or within a targeted subset of that reference.
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The ampliSeqRNA plugin is used with the Ion AmpliSeq™ Transcriptome Human
Gene Expression Kit, Ion AmpliSeq™ Transcriptome Mouse Gene Expression Kit, or
Ion AmpliSeq™ RNA panels. The plugin generates statistics, downloadable data files,
and interactive visualizations that represent targeted RNA transcripts.

Use the ampliSeqRNA plugin on runs that are aligned to the human or mouse
transcriptome references and appropriate target regions files listed below. For more
information on the references, see “Import a preloaded reference sequence file“ on
page 261 and for more information on target regions files, see “View and manage
target regions files“ on page 268.

Reference Target Regions file Description

hg19_AmpliSeq_Transcripto
me_V1.2 [1]

hg19_AmpliSeq_Transcripto
me_v1.2

The most up-to-date
annotations are included in
the panel files available
from AmpliSeq.com.

For more information, see
the Ion AmpliSeq™

Transcriptome Human Gene
Expression Kit User Guide
(Pub. No. MAN0010742).

AmpliSeq_Mouse_Transcrip
tome_V1

AmpliSeq_Mouse_Transcrip
tome_v1

The most up-to-date
annotations are included in
the panel files available
from AmpliSeq.com.

For more information, see
the Ion AmpliSeq™

Transcriptome Mouse Gene
Expression Kit User Guide
(Pub. No. MAN0017343).

[1] Previous versions (hg19_AmpliSeq_Transcriptome_ERCC_V1 and hg19_AmpliSeq_Transcriptome_V1.1) are 
still supported for those users who have already performed experiments with the older reference files.

ampliSeqRNA
plugin
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ampliSeqRNA plugin configuration

The configuration options for the ampliSeqRNA plugin are described in the following
table. This plugin cannot be configured globally.

You can change the Reference Genome used in the plugin run, for example from hg19
to mm10, if you edit the run report, then reanalyze the raw reads. For details, see 
“Edit a run report“ on page 90.

Alternatively, you can reanalyze the run. For details, see “Reanalyze a run“ on
page 88.

Setting Description

The following settings can be configured when you select the ampliSeqRNA plugin as
part of a Planned Run or Planned Run template.

Filter Barcodes Select this checkbox to remove whole barcodes from
subsequent analyses if they have a relatively low number
of reads, such as those that can result from barcode
contamination. A warning appears in the barcode summary
report if any barcodes were discounted from the analysis.
This setting is ignored for runs not employing barcodes.

Typically, this option is not needed if your Planned Run
specifies which samples to associate with specific
barcodes.

ERCC Tracking Select this checkbox if your Ion AmpliSeq™ RNA targets
(amplicons) were spiked with ERCC tracking targets.

Setting Description

The following settings can be configured when you run the ampliSeqRNA plugin
manually.

Library Type ampliSeqRNA is selected automatically and is currently
the only library type that the ampliSeqRNA plugin is
designed to work with.

If the Planned Run specified a different application, a
message warns you that the plugin may not be appropriate
for the run.

Targeted Regions This is set by default to the target regions file used in the
Planned Run.

You can override the default setting that each barcode
uses. This might be useful to specify a subset of genes of
interest, or to correct the original Planned Run.
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Setting Description

Filter Barcodes Select this checkbox to remove whole barcodes from
subsequent analyses.

Typically, this option is not needed if your Planned Run
specifies which samples to associate with specific
barcodes.

ERCC Tracking Select this checkbox if your Ion AmpliSeq™ RNA targets
(amplicons) are spiked with ERCC tracking targets.

Review ampliSeqRNA plugin results

The ampliSeqRNA plugin generates an initial summary report that lists the samples,
the number of mapped reads, the percent of valid reads, and the percent of targets
detected. A series of log2 reads-per-million (RPM) pair correlation plots are included
for rapid correlation analysis. Microsoft™ Excel™-compatible reports are also
generated, including differential expression tables. Additional details about read
coverage are also provided on a per-barcode basis, along with a list of gene
annotations for each sequenced region.

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click ampliSeqRNA to view the plugin results.

• Click the ampliSeqRNA.html link to open the ampliSeqRNA Report –
Barcode Summary for all barcodes.

• In the barcode table, click individual barcode names to see the results for an
individual barcode.
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• Click the Distribution Plots, Correlation Heatmap, Correlation Plot, and
Gene Heatmap tabs to review the data graphically.

Graphical report Description

Distribution Plots

Reads Alignment
Summary

A graphical summary of the number of mapped and
unmapped reads across barcodes, as reported in the
Barcode Summary table.

Distribution of Gene
Reads

Distribution of genes across barcodes showing the
frequency of numbers of genes having similar log10
read counts. All curves are plotted on the same axis
scale. The counts data are fitted to a Gaussian kernel
using the default R 'density' function.

Correlation Heatmap A heatmap of Spearman correlation r-values for
comparing log2 RPM reads pair correlation barcodes,
with dendrogram reflecting ordering of barcodes as
being most similar by these values.

Correlation Plot

Barcode read pair
correlation plot

Lower panels show log2(RPM+1) values plotted for
each pair of barcodes, with linear least squares
regression line overlaid and line slope reported.
Upper panels show Pearson correlation r-values for
the regression line. Diagonal panels show the
frequency density plot for the individual log(RPM+1)
values for each barcode. (If only one barcode has
reads, a density plot is displayed.) Click the plot to
open an expanded view.

Gene Heatmap

Gene Representation
Heatmap

Displays 250 genes showing the most variation in
representation across barcodes as measured by the
coefficient of variation (CV) of normalized read counts
for genes that have at least one barcode with at least
100 RPM reads, plotted using log10 of those counts.
For this plot, barcodes are omitted if they have <105

total reads.

• Click the links at the bottom of the report to download associated report files.
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ampliSeqRNA plugin reports

The following ampliSeqRNA plugin reports are available for download from the
results screen as tab-delimited text files, which are compatible with Microsoft™ Excel™

or similar applications.

Report Description

Barcode Summary Report A table listing each barcode sample name, total reads,
aligned reads, and percent aligned.

Absolute Reads Matrix A table listing absolute reads for the genes found on each
barcode.

Absolute Normalized Reads
Matrix

A table listing absolute normalized reads for the genes
found on each barcode.

CHP files normalized by
RPM

A file format designed for use with Applied Biosystems™

microarray software applications to produce additional
reports.

Differential Expression for
Barcode Pair

A pop-up window that allows you to compare two barcodes.
You can set a threshold for minimum read count and
exclude targets from the differential expression table.
Differential expression for each target that is represented
as the log2 of the ratio of RPM reads of the experiment
barcode to the control barcode.

The AssemblerSPAdes plugin is a de Bruijn graph assembler. The plugin breaks
sequence reads into kmers of defined length, makes a connected graph, and traverses
through that graph to produce contigs. The plugin report includes basic analysis
metrics such as number of contigs, N50, length of the longest contig, and a
downloadable FASTA file of the assembled sequences. The plugin assumes a haploid
genome, and is ideal for genomes under 50 megabases in size. For multiploid
genomes, reads from different copies of a chromosome tend to assemble into different
contigs.

For de novo assembly, use a Generic Sequencing application Planned Run template
for the Torrent Suite™ Software analysis.

AssemblerSPAdes
plugin
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AssemblerSPAdes plugin configuration

The configuration options for the AssemblerSPAdes plugin are described in the
following table. These settings can be configured only when you select this plugin to
run manually from the Run Summary screen. After you select the plugin, click
Advanced Settings + to display these options.

Setting Description

Fraction of reads to use The default setting of 100% is recommended, and handles
most changes in coverage. If you enter a value of less than
100%, the reads are randomly sub-sampled.

Only process barcodes By default, the plugin processes all barcodes in the
analysis and produces a separate set of contigs for each
barcode. To limit plugin analysis to only specific barcodes,
list those barcodes here (separated by commas and no
spaces. For example,
IonXpress_001,IonXpress_002,IonXpress_003).

Skip barcodes with fewer
than __ reads

The software ignores barcodes whose number of reads do
not meet the threshold specified here. The default
threshold is 500 reads. This setting is intended to filter out
barcode classification problems with noisy data.

RAM to allocate The plugin attempts to allocate the specified amount of
RAM when it runs. The default is 32 GB. With larger
amounts of memory, the plugin runs faster. With less
memory, the plugin takes longer to complete.

The plugin crashes if the memory allocation fails.

SPAdes version Select the version that you prefer. Select the default of
3.1.0 if you are not sure.
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Setting Description

Assembly settings Set this menu as follows:

• Uniform coverage (default setting)—This is used for
data with average GC (35–68%) content. This setting
uses the default kmers.

• Non-uniform coverage—choose this setting for data
with low GC (<35%) content. This setting uses the
default kmers.

• Highly non-uniform coverage—choose this setting for
data with high GC (>68%) content. This setting uses a
different set of kmers.

• Custom—choose this setting to enter user-defined K
and Mode settings.

– K—enter values (separated by commas, no
spaces) to determine the size and number of
kmers to be used in the analysis. Enter short
kmer values to improve error-prone or low-
coverage regions, long kmers to resolve
repetitive regions, or a combination of kmer
values to account for both situations.

Note: Each additional kmer adds a fixed amount
to the processing time (for example, using
2 kmers takes twice as long as 1 kmer).

– Mode—Select Multi-cell (default) for data with
average or low GC content. Select Single-cell for
data with high GC (>68%) content.

Run read correction before
doing assembly

This setting is enabled by default, which is recommended.

Skip assembly if previous
results exist

Select this checkbox to detect whether assembly results
already exist and you do not want to overwrite the results.
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Review AssemblerSPAdes plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link in the Report
Name column.

3. In the left navigation menu, click AssemblerSPAdes to view the plugin results.

The plugin results show assembly statistics for the selected barcode.

• To show assembly statistics for an individual barcode, select a barcode in the
View Results menu.

• To download results for all barcodes used in the run, click Downloads.
• To download a FASTA file of the assembled contigs, click Assembled Contigs

(FASTA).
• To download a FASTA file of the assembled scaffolds, click Assembled
Scaffolds (FASTA).

• To download a copy of the assembly summary statistics, click Assembly
Statistics.

You can also click SPAdes Log (TXT) to view the execution file for the
AssemblerSPAdes plugin, or click QUAST report (HTML) to view a QUAST
report.
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Analysis metrics file fields

In the analysis metrics file, each line represents a Torrent Suite™ Software analysis run.
Within each line, fields are separated by a comma. Each comma-separated field is
listed in a separate column. You can open the files with spreadsheet software such as
Microsoft™ Excel™ or Apache® OpenOffice ™ Calc.

The file has many fields per entry. Rows 4 through 11 (marked by *) contain test
fragments metrics. The other rows contain library read metrics.

Field Description

Report Name of the analysis run report.

Status Status of the analysis (for example, Started,
Complete).

Flows Number of flow cycles from the actual
sequencing run.

TF Name* Test Fragment Name.

Q10 Mean* Average Q10 read length.

Q17 Mean* Average Q17 read length.

System SNR* System Signal-to-Noise Ratio.

50Q10 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q10.

50Q17 Reads* Number of TF Ion Sphere™ Particles (ISP) at
50+ bp at Q17.

Keypass Reads* Number of reads that have test fragment
keys.

TF Key Peak Counts* Signal strength of the first three bases of
the TF key.

Total_Num_Reads Total number of reads.

Library_50Q10_Reads Reads of length at least 50bp with 90% or
greater accuracy.

Library_100Q10_Reads Reads of length at least 100bp with 90% or
greater accuracy.

Library_200Q10_Reads Reads of length at least 200bp with 90% or
greater accuracy.

Library_Mean_Q10_Length Average length of reads with 90% or greater
accuracy.

Library_Q10_Coverage Average per base coverage considering
reads with 90% or greater accuracy.

Library_Q10_Longest_Alignment Longest read length amongst reads with
90% or greater accuracy.
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Field Description

Library_Q10_Mapped Bases Total bases from reads with 90% or greater
accuracy.

Library_Q10_Alignments Number of alignments from reads with 90%
or greater accuracy.

Library_50Q17_Reads Reads of length at least 50bp with 98% or
greater accuracy.

Library_100Q17_Reads Reads of length at least 100bp with 98% or
greater accuracy.

Library_200Q17_Reads Reads of length at least 200bp with 98% or
greater accuracy.

Library_Mean_Q17_Length Average length of reads with 98% or greater
accuracy.

Library_Q17_Coverage Average per base coverage considering
reads with 98% or greater accuracy.

Library_Q17_Longest_Alignment Longest read length amongst reads with
98% or greater accuracy.

Library_Q17_Mapped Bases Total bases from reads with 98% or greater
accuracy.

Library_Q17_Alignments Number of alignments from reads with 98%
or greater accuracy.

Library_50Q20_Reads Reads of length at least 50 bp with 99% or
greater accuracy.

Library_100Q20_Reads Reads of length at least 100 bp with 99% or
greater accuracy.

Library_200Q20_Reads Reads of length at least 200 bp with 99% or
greater accuracy.

Library_Mean_Q20_Length Average length of reads with 99% or greater
accuracy.

Library_Q20_Coverage Average per base coverage considering
reads with 99% or greater accuracy.

Library_Q20_Longest_Alignment Longest read length amongst reads with
99% or greater accuracy.

Library_Q20_Mapped_Bases Total bases from reads with 99% or greater
accuracy.

Library_Q20_Alignments Number of alignments from reads with 99%
or greater accuracy.

Library_Key_Peak_Counts Signal strength of the first three bases of
the library key.
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Field Description

Library_50Q47_Reads Number of perfect reads of length at least
50 bp.

Library_100Q47_Reads Number of perfect reads of length at least
100 bp.

Library_200Q47_Reads Number of perfect reads of length at least
200 bp.

Library_Mean_Q47_Length Average length of perfect reads.

Library_Q47_Coverage Average per-base coverage considering
only perfect reads.

Library_Q47_Longest_Alignment Longest reads length amongst perfect
reads.

Library_Q47_Mapped_Bases Total bases from perfect reads.

Library_Q47_Alignments Number of alignments from perfect reads.

Library_CF CAFIE metric: Carry forward.

Library_IE CAFIE metric: Incomplete extension.

Library_DR CAFIE metric: Signal/polymerase loss
(droop).

Library_SNR System signal-to-noise ratio.

Sample Name of the sample.

Library Name of the reference genome.

Notes Any additional user-provided notes.

Run Name Long name of the analysis run.

PGM Name Name of the Ion PGM™ or Ion Proton™

instrument where the sample was
sequenced.

Run Date Date that the sample was sequenced.

Run Directory Location of the raw DAT files on the Ion
Torrent™ Server.

Num_Washouts NA

Num_Dud_Washouts NA

Num_Washout_Ambigous NA

Num_Washout_Live NA

Num_Washout_Test_Fragment NA

Num_Washout_Library NA
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Field Description

Library_Pass_Basecalling NA

Library_pass_Cafie NA

Number_Ambiguous NA

Number_Live Number of wells producing a signal.

Number_Dud Number of wells with ISPs but no signal.

Number_TF Number of wells containing test fragment.

Number_Lib Number of wells containing library.

Number_Bead Number of wells containing beads.

Library_Live Number of wells containing library ISP with
signal.

Library_Keypass Number of wells containing library ISP with
signal and match key.

TF_Live Number of wells containing test fragment
ISP with signal.

TF_Keypass Number of wells containing test fragment
ISP with signal and match key.

Keypass_All_Beads Number of wells containing ISP with signal
and match key.

P JSON string of plugin data.

s JSON string of plugin data.

Use the coverageAnalysis plugin to view statistics and graphs that describe the level
of sequence coverage produced for targeted genomic regions. The results in the
Summary screen for a run analyzed with the plugin vary based on the library type
that you select when you configure the plugin. You can export some charts as
graphics, such as the Amplicon and Reference Coverage charts.

coverageAnalysis plugin configuration

The coverageAnalysis plugin uses the following settings.

Setting Description

The following settings are available for all library types.

Reference Genome The reference genome selected in the Planned Run.

Library Type The default value is the library type selected in the Planned Run, and it can be changed
only if the plugin is run manually. If you change the library type, a different report is
generated.

coverageAnalysis
plugin
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Setting Description

Targeted Regions The targeted regions are selected in the Planned Run, and can be changed only after
the run is complete if the plugin is run manually. Target regions can be overwritten by
the specific barcode targets.

Select the targeted regions file from the list. For whole genome and Ion Total RNA-Seq
sequencing runs, you typically select None.

Barcode-specific Targets This option is available only when the coverageAnalysis plugin is run manually.

Select the checkbox to assign specific target region files to individual barcodes.

1. Select a specific barcode.

2. Select the specific Target Regions file to associate with the selected barcode.

3. Click Add.

4. Repeat steps 1 through 3 to associate additional barcodes with specific Target
Region files.

Alternatively, you can copy and paste the barcode/target file pairs manually.

Barcodes without a Target Region specified above assume the default target specified
by the Target Regions option.

For targeted applications, any barcode targets specifically set to None, or defaulting to
Target Regions set to None, are omitted from subsequent analysis.

When the Barcode-specific Targets option is deselected, all barcodes use the targets
specified by the Target Regions, even if barcode-specific targets are listed.

The following are advanced options.

Minimum Aligned Length Specify the minimum aligned length that is required to ensure that the read is included
in an analysis.

Minimum Mapping Quality Specify a minimum value that reads must exceed to be included in the analysis.

Tier 1 Coverage Depth Specify the first-tier coverage depth at which percentage of target coverage is reported.
This value must be at least 2, because the coverage depth output is always specified at
1x read depth. The default value of 20 means that the percentage of targets, total base
targets, and/or individual target bases with at least 20 reads is reported.

Tier 2 Coverage Depth Specify the second-tier coverage depth at which percentage of target coverage is
reported. This value must be greater than the value used for the first-tier coverage.
The default value of 100 means that the percentage of targets, total target bases,
and/or individual target bases with at least 100 reads is reported.

Tier 3 Coverage Depth Specify the third-tier coverage depth at which percentage of target coverage is
reported. This value must be greater that the value used for the second-tier coverage.
The default value of 500 means that the percentage of targets, total target bases,
and/or individual target bases with at least 500 reads is reported.

The following settings are available only with specific library types.

Uniquely Mapped Reads Select this option to analyze only reads that are mapped to a unique location in the
reference. Reads that are non-uniquely mapped can have equally well-aligned reads
that are mapped to multiple locations, and are typically mapped randomly to one.
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Setting Description

Sample Tracking The Ion AmpliSeq™ Sample ID Panel is a companion panel of 9 primer pairs that can be
added to any Ion AmpliSeq™ human gDNA panel during target amplification to generate
a unique identification tag for research samples. Select this checkbox if you added the
Ion AmpliSeq™ Sample ID Panel to your library.

Target Padding Enter a number to pad the target by the number of bases entered. If you do not enter a
number, the default of 0 is used.

Non-duplicate Reads Select the checkbox to avoid duplicates. The analysis must have included alignments
with Mark Duplicates enabled.

Review coverageAnalysis plugin results

The coverageAnalysis plugin generates a Coverage Analysis Report. This report
includes read statistics and several charts. The statistics and charts that are presented
depend on the library type for the analysis.

The report summary lists the barcodes, the samples, the number of mapped reads, the
percentage of on target reads, mean base coverage depth, and base coverage
uniformity. Microsoft™ Excel™-compatible reports are also generated, including
differential expression tables. Additional details regarding read coverage are also
provided on a per-barcode basis, along with a list of gene annotations for each
sequenced region.

You can download statistics files and the aligned reads BAM file from the file links at
the bottom of the Coverage Analysis Report. After the sequencing run completes,
review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click coverageAnalysis to view the plugin summary.
A summary table of the coverage analysis, by barcode, is included in the
coverageAnalysis summary pane.

4. In the coverageAnalysis barcode summary, in the Barcode Name column, click a
link to open a detailed Coverage Analysis Report for that barcoded sample.
Alternatively, click the coverageAnalysis.html link to open the summary table
for all barcodes in a new window.

5. In the Coverage Analysis Report, review the plugin results. Click the links at the
bottom of the Coverage Analysis Report to download associated statistics and
summary files for each barcoded sample in the run.
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Reads statistics 

General statistics

Statistic Description

Number of mapped reads The total number of reads mapped to the reference genome.

Percent reads on target The percentage of filtered reads mapped to any targeted region relative to all reads
mapped to the reference. If no target regions file is specified, this value will be the
percentage of reads passing uniquely mapped and/or non‑duplicate filters, or 100%
if no filters were specified. A read is considered on target if at least one aligned base
overlaps at least one target region. A read that overlaps a targeted region but where
only flanking sequence is aligned, for example, due to poor matching of 5' bases of
the read, is not counted.

Amplicon read coverage statistics

The following statistics describe the reads that are assigned to specific amplicons. Each sequence read is assigned to
exactly one of the amplicons specified by the targets file. If a read spans multiple amplicon targets, the target region
that the reads covers most is assigned. In the even of a tie, the target that is the closest to the 3' end is assigned.

Statistic Description

Number of amplicons The number of amplicons that is specified in the target regions file.

Percent assigned amplicon
reads

The percentage of reads that were assigned to individual amplicons relative to all
reads mapped to the reference. A read is assigned to a particular (inner) amplicon
region if any aligned bases overlap that region. If a read might be associated with
multiple amplicons, it is assigned to the amplicon region that has the greatest
overlap of aligned sequence.

Average reads per amplicon The average number of reads assigned to amplicons.

Uniformity of amplicon
coverage

The percentage of amplicons that had at least 20% of the average number of reads
per amplicon. Cumulative coverage is linearly interpolated between nearest integer
read depth counts.

Amplicons with at least N
reads

The percentage of all amplicons that had at least N reads.

Amplicons with no strand bias The percentage of all amplicons that did not show a bias towards forward or reverse
strand read alignments. An individual amplicon has read bias if it has ≥10 reads and
the percentage of forward or reverse reads to total reads is greater than 70%.
Amplicons with <10 reads are considered to have no strand bias.
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Statistic Description

Amplicons reading end-to-end The percentage of all amplicons that were considered to have a sufficient proportion
of assigned reads (70%) that covered the whole amplicon target from 'end‑to‑end'. To
allow for error, the effective ends of the amplicon region for read alignment are
within 2 bases of the actual ends of the region.

Amplicon base composition
bias

A number that represents the proportion of amplicons showing low representation (
<0.2x mean reads) in the lower and/or upper quartiles of amplicons ordered by
increasing G/C base pair content of their insert sequences. The value is relative to
that in the center 50th percentile of amplicons and weighted by the standard
deviation of representation over all amplicons. An RMS (root mean square) value is
used so that a bias greater in either upper or lower quartiles produces a larger value
than a mean bias seen more equally in both outer quartiles. The value is 0 if the
uniformity of amplicon coverage metric is 100%, however, the value is not
necessarily high at lower amplicon uniformity.

Target base coverage statistics

The following statistics describe the targeted base reads of the reference. A base covered by multiple target regions is
counted only once per sequencing read.

Statistic Description

Bases in target regions The total number of bases in all specified target regions of the reference.

Percent base reads on target The percent of all bases covered by reads aligned to the reference that covered bases
in target regions. Clipped bases, deletions, and insertions (relative to the reference)
are not included in this percentage.

If no specific target regions was specified, the targeted regions is the whole genome.

Average base coverage depth The average number of reads of all targeted reference bases. This is the total
number of base reads on target divided by the number of targeted bases, and
therefore includes any bases that had no coverage.

Uniformity of base coverage The percentage of bases in all targeted regions (or whole genome) that is covered by
at least 20% of the average base coverage depth reads. Cumulative coverage is
linearly interpolated between nearest integer base read depths.

Target base coverage at Nx The percentage of target bases covered by at least N reads.

Target bases with no strand
bias

The percentage of all target bases that did not show a bias toward forward or reverse
strand read alignments. An individual target base is considered to have read bias if it
has ≥10 reads and the percentage of forward or reverse reads to total reads is
greater than 70%. Target bases with <10 reads are considered to have no strand bias.

Percent end‑to‑end reads The percentage of on‑target reads that fully cover their assigned amplicon (insert)
from 'end‑to‑end'. To allow for error, the effective ends of the amplicon region for
read alignment are within 2 bases of the actual ends of the region.

Example charts generated by the coverageAnalysis plugin

Many of the charts in the detailed Coverage Analysis Report include a Plot menu
that allows you to change characteristics of the chart. For example, you can show both
strands (see callout 3 in Figure 5).
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The  button (in the top right corner of a chart) opens the chart Viewing Options
panel. The  button opens a description of the chart.

Figure 1   Representative Depth of Coverage Chart

The Depth of Coverage Chart shows the distribution of targeted base coverage. The X‑axis
represents the base read depth. The left Y-axis represents the number of reads at a given base
read depth or a range (bin) of base read depths, as a percentage of the total number of base
reads. The right Y-axis represents the cumulative count of the number of reads at a given read
depth or greater, as a percentage of the total number of reads. The individual orange bars
represent the percentage of reads in the specific range of base read depths. The blue curve
measures the cumulative reads at a given base read depth or greater. If your analysis includes a
regions of interest file, this chart reflects only target regions (reads that fall within a region of
interest).

In most charts, you can click a data point to open a detail pane for that data. For
example, in the Depth of Coverage Chart in Figure 1, click an individual orange bar to
open the detail pane for bases within a specific range of base read depths. Click a
point on the blue curve to open the detail pane for cumulative bases at that base read
depth or greater. For example detail panes, see Figure 2. Similarly, you can click any
point or bar within the Amplicon Coverage chart to view details for each amplicon
coverage bin (see Figure 4).

Figure 2   Example detail panes
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Figure 3   Representation Plots

Use the Display list to view different amplicon representation plots. This figure shows an
example Pass/Fail vs. Target G/C Content plot.

1

2

Figure 4   Representative Amplicon Coverage Chart

The Amplicon Coverage charts summarize the amplicon coverage results. Several plots views
are available. The X‑axis in all plots represents individual amplicons. The left Y‑axis in all plots
represents assigned reads (on a base 10 log scale). Use the Plot and Overlay lists to customize
the chart view. The right Y‑axis varies depending on the plot view that is selected from the
Overlay dropdown list. Click on any bar or any point on the chart to view the detail pane for that
data.

1 Example Total Reads plot with a Target GC percentage overlay
2 Click on the bar to open the detail pane for the specific amplicon. Click View in Reference

Coverage Chart to zoom in on the amplicon in the Reference Coverage Chart (see callout 3
in Figure 5).
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1

2

3

Figure 5   Representative Reference Coverage Chart

The Reference Coverage Chart is an overlay of where target regions are defined and overlap on
the reference. The X‑axis represents the target region chromosomal position. The Y‑axis
represents the Base Read Depth.

1 Example Total Base Reads plot with Viewing Options panel expanded. The plot is zoomed
in on a specific chromosomal region. Click a yellow bar (top of the chart) to open the detail
pane for a specific amplicon in the Amplicon Coverage Chart (see callout 2 in Figure 4).

2 Example Total Base Reads plot where a chromosomal region has multiple targets. In the
Resolve Multiple Targets pane, click  to zoom in on the region, or click one of the links
to open the detail pane for the specific amplicon in the Amplicon Coverage Chart.

Chapter 8 Manage plugins for data analysis
Preinstalled plugins 8

Torrent Suite™ Software 5.12 User Guide 165



3 Example Strand Base Reads plot that is zoomed in on one specific amplicon. Click the
yellow box to open the detail pane for the specific amplicon in the Amplicon Coverage
Chart.

Output files generated by the coverageAnalysis plugin

You can download coverageAnalysis plugin results files from links that are contained
in the File Links section.

Sometimes the file name can be too long to open in applications such as Microsoft™

Excel™. To resolve this problem, right-click the file and click Save As to rename the
downloaded file.

Click  (Help) next to the file to open a description of the file.

The following is an example of the content of a results file that is generated by the
coverageAnalysis plugin.

The list of files depends on the application type selected.

File Description

Coverage
statistics
summary

A summary of the statistics presented in the tables at the top of the plugin report. The first line is
the title. Each subsequent line is either blank or a particular statistic title followed by a colon (:)
and its value.

Base depth of
coverage

Coverage summary data used to create the Depth of Coverage Chart. This file contains the
following fields:

• read_depth: the depth at which a (targeted) reference base has been read.

• base_cov: the number of times any base was read (covered) at this depth.

• base_cum_cov: the cumulative number of reads (coverage) at this read depth or greater.

• norm_read_depth: the normalized read depth (depth divided by average base read
depth).

• pc_base_cum_cov: same as base_cum_cov but represented as a percentage of the
total base reads.
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File Description

Amplicon
coverage
summary

Coverage summary data used to create the Amplicon Coverage Chart. This file contains these
fields:

• contig_id: the name of the chromosome or contig of the reference for this amplicon.

• contig_srt: the start location of the amplicon target region.
This coordinate is 1-based, unlike the corresponding 0-based coordinate in the original
targets BED file.

• contig_end: the last base coordinate of this amplicon target region.

Note: The length of the amplicon target is given as tlen = (contig_end - contig_srt + 1).

• region_id: the ID for this amplicon as given as the 4th column of the targets BED file.

• gene_id: the gene symbol as given as the last field of the targets BED file.

• gc_count: the number of G and C bases in the target region. %GC = 100% * gc / tlen.

• overlaps: the number of times this target was overlapped by any read by at least one
base.
Individual reads might overlap multiple amplicons where the amplicon regions themselves
overlap.

• fwd_e2e: the number of assigned forward strand reads that read from one end of the
amplicon region to the other end.

• rev_e2e: the number of assigned reverse strand reads that read from one end of the
amplicon region to the other end.

• total_reads: the total number of reads assigned to this amplicon. This value is the sum
of fwd_reads and rev_reads and is the field that rows of this file are ordered by (then by
contig id, srt and end).

• fwd_reads: the number of forward strand reads assigned to this amplicon.

• rev_reads: the number of reverse strand reads assigned to this amplicon.

• cov20x: the number of bases of the amplicon target that had at least 20 reads.

• cov100x: the number of bases of the amplicon target that had at least 100 reads.

• cov500x: the number of bases of the amplicon target that had at least 500 reads.

Chromosome
base coverage
summary

Base reads per chromosome summary data used to create the default view of the Reference
Coverage Chart. This file contains these fields:

• chrom: the name of the chromosome or contig of the reference.

• start: the coordinate of the first base in this chromosome. This is always 1.

• end: the coordinate of the last base of this chromosome. Also its length in bases.

• fwd_reads: the total number of forward strand base reads for the chromosome.

• rev_reads: the total number reverse strand base reads for the chromosome.

• fwd_ontrg (if present): the total number of forward strand base reads that were in at least
one target region.

• seq_reads: the total sequencing (whole) reads that are mapped to individual contigs.

Aligned reads
BAM file

Contains all aligned reads that are used to generate this report, in BAM format. This is the same
file that can be downloaded from the main report (for the specific barcode). See the current SAM
tools documentation for more file format information.

Aligned reads BAI
file

Binary BAM index file as required by some analysis tools and alignment viewers such as IGV. This
is the same file that can be downloaded from the main report (for the specific barcode).
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Use the DataExport plugin to export data from a sequencing run to a network drive,
an external hard drive, or a removable media device, such as a USB drive. The
exported data can be used to create backups, or to quickly transfer files to another
system. When you configure the plugin, you select which file categories from the run
are included in the export.

Before you use the DataExport plugin, a software administrator must configure the
path to the directory that is used for the export. The Destination Path to the external
drive is then available in the global settings for the plugin.

DataExport plugin configuration

The DataExport plugin can be configured to set the destination path of the exported
files, and to specify the file types to be exported.

The configuration options for the DataExport plugin are described in the following
table:

Setting Description

Destination Path Designates the location of the network drive, external hard drive
or removable media device where the files are exported to.

Signal Processing
Input

Exports DAT files.

Basecalling Input Exports WELLS files.

Output Files Exports all output files, including BAM files, reports, and analysis
files.

Intermediate Files Exports files used for troubleshooting by qualified system
engineers.

Review DataExport plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the Summary, click DataExport to view the plugin summary.

After the export is complete, the report is available in the DataExport pane. The
following parameters are shown.

Parameter Description

FILE CATEGORIES Lists the categories for the file types that are included in the
export.

DESTINATION Location where the files are exported to after the plugin is run.

STATUS Shows the status of the file transfer.

DataExport plugin
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Use the ERCC_Analysis plugin to determine if a problem exists with either the library
preparation or the sequencing instrument run. The ERCC_Analysis plugin determines
the relative abundance of the actual versus expected number of ERCC transcript reads
for sequencing runs that include ERCC RNA Spike-in Controls.

The ERCC_Analysis plugin takes approximately 2–3 minutes to complete for
sequencing runs with ≤1,000,000 total reads, and 1–2 minutes longer for each
additional million total reads. For example, a run with 5 million total reads can take
10–15 minutes. If Torrent Suite™ Software is busy performing additional processing
functions, plugin run times are longer.

You can configure the ERCC_Analysis plugin to run automatically. However,
automatic execution is not recommended, unless most analyses on the Ion Torrent™

Server include ERCC controls.

ERCC_Analysis plugin configuration

The configuration options for the ERCC_Analysis plugin are described in the
following table.

Setting Description

Use only forward strand
reads

Available when manually running the plugin.

Passing R-squared value (Optional) To change the R-squared value to set a default
value for the summary report screen, enter a value
between 0 and 1 as your minimum acceptable R-squared
value (a lower value is indicated by a red light in the
summary report).

The value you enter on the ERCC Plugin Configuration
screen is used when the plugin is auto-run and when the
plugin is manually launched without entering a value. You
can override this value on a per-run basis when the plugin
is manually launched.

Minimum transcript counts The minimum number of reads that an ERCC transcript
must have to be included in the analysis.

ERCC pool used Select the ERCC transcript pool used when preparing the
library.

Barcodes of interest IMPORTANT! If you configure a Planned Run or Planned
Run template to execute the ERCC_Analysis plugin, and
your experiment uses the Ion Total RNA-Seq Kit v2, you
must select a barcode option:

· Select IonXpressRNA if your experiment uses this kit.
· Select RNA_Barcode_None if your experiment does

not use a barcode kit

ERCC_Analysis
plugin
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Review the ERCC_Analysis plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, locate the run of interest, then click the link Completed Runs
& Reports screen, click the report name to open.

3. In the left navigation menu of the EERC_Analysis screen, click ERCC_Analysis
to view a summary of the plugin analysis results.

4. (Optional) Click the ERCC_Analysis.html link to open the ERCC Analysis
Report and view the barcode summary and plugin analysis results.

Setting Description

Use only forward strand
reads

Indicates whether forward strand reads were used in
the analysis.

Passing R-squared value The value entered on the ERCC Plugin Configuration
screen.

Minimum transcript
counts

The minimum number of reads included in the analysis.

ERCC pool used The ERCC transcript pool used when preparing the
library.

5. In Barcode Name, click the barcode name to open the ERCC Report to see the
results for an individual barcode.

Interpret the ERCC Dose Response plot 

The axes of the ERCC Dose Response plot are log (base 2), with the raw read counts
for each ERCC transcript on the y-axis and the known relative concentration of the
ERCC transcripts on the x-axis. In the plot, the points are color-coded based on
mapping quality. There is also a line of best fit, the parameters (slope, y-intercept, and
R-squared value) of which are shown in tabular form to the right of the graph (N = the
number of points (ERCC transcripts) included in the regression analysis). Ideally, the
points all fall on a straight line. However, the raw counts and relative concentration
should at least correlate with a high R-squared (for example, ≥0.9) value. Although 92
transcripts are in the ERCC mix, it is not expected that all 92 are detected. The number
of transcripts detected depends on the sequencing depth.
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View ERCC transcript details

You can look at the details of a particular ERCC transcript in two ways: by using the
plot or by using the transcript. To view all of the details regarding a particular ERCC
transcript, you can use both ways.

• Using the plot—Hover your mouse-cursor over a point in the ERCC Dose
Response plot to display a popup window that shows details regarding that
transcript. Zoom in on the overlapping points on the plot to more easily
distinguish the points.

a. To zoom in on a selected area, click-drag your mouse to highlight the area of
interest.

b. Double-click in the plot, or click Reset Zoom to zoom out to the full view of
the ERCC Dose Response plot.

Parameter Description

log2 relative
ERCC
concentration

The log (base 2) of the relative ERCC transcript concentration.

log2 ERCC
counts

The log (base 2) of the mapped reads to an ERCC transcript.

transcript The ERCC transcript identifier, including length in base pairs (bp).

reads The number of reads that map to the particular transcript.

mean mapping
quality

A Phred score of the probability that this read was aligned
specifically versus any other place in the reference. In practice it is
based on the absolute and relative alignment scores for the first
two alternative mapping locations. The mapping quality that is
reported is based on mean base read quality (after trimming).
The points in the display are color coded based on the mapping
quality.
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• Using the transcript—Scroll to the particular transcript, then click the [+] next to
the transcript name.

Parameter Description

Reads The number of reads that map to the particular transcript.

Coverage
Depth

The minimum and maximum number of reads covering bases in
the transcript. If coverage is 100%, the minimum value is > 0.

Coverage The number of base positions covered by at least one read. Also
expressed as a percentage of the full length.

Start Sites The number of base positions that are the start site for a read.

Unique Start
Sites

The number of base positions that have only one read starting at
the position.

Coverage CV The coefficient of variation for coverage = average coverage /
standard deviation coverage for the entire transcript.

Definitions

This section defines terms used in the plugin output.
• Coverage Depth—The minimum and maximum number of reads covering bases

in the transcript. If coverage is 100%, the minimum value is >0.
• Coverage—The number of base positions covered by at least one read.
• Start Sites—The number of base positions that are the start site for a read.
• Unique Start Sites—The number of start sites that have only one read starting at

the site.
• Coverage CV—The coefficient of variation for coverage = average coverage /

stddev coverage for the entire transcript.

ERCC resources

The External RNA Controls Consortium (ERCC) is hosted by the U.S. National
Institute of Standards and Technology.

For more information on ERCC RNA Spike-In Control Mixes (Cat. Nos. 4456739 and
4453740), see the ERCC RNA Spike‑In Control Mixes User Guide (Pub. No. 4455352).

For more information on ERCC analysis, see the ERCC_Analysis Plugin User Bulletin
(Pub. No. 4479068).

The FieldSupport plugin is used for technical support purposes only. For details,
contact Technical Support or your Field Application Scientist.

IMPORTANT! Enable and run this plugin only when directed by Thermo Fisher
Scientific Technical Support or your local Field Service Engineer.

FieldSupport
plugin
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Use the FileExporter plugin to rename the output files from the Torrent Suite™

Software runs.

The plugin also offers the following options:
• Generates files of the analysis results that use BAM, VCF, XLS, or FASTQ formats.
• Renames variantCaller plugin output files (when available).
• Compresses the analysis results files.
• Provides links that allow you to download the results files.

Configure the FileExporter plugin

1. Select from the following options to choose the file types that you export:

Option Description

Include Select to generate a separate link for the file in the plugin results.

Archive Select Archive for each file type that you want to include in a compressed
file. You can export a standard compressed directory in a ZIP or tar.bz2
format.

For each option, you can choose to include or archive the following file types:

File types Description

BAM Native file format for data generated by Ion
instruments.

Variant Call Format (VCF) File containing only the differences between the BAM
file and a reference file.

Variant Caller File (XLS) Microsoft™ Excel™ format of VCF.

FASTQ Text format of the nucleotides.

FileExporter
plugin
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2. Name the file. Select one of the following:

• Select a unique file name by entering the desired name in the Custom Name
text box.

• Create a name using parameters of the run. Drag and drop components from
the selections pane onto the name pane row. The naming options are in the
blue boxes. The name appears under Example Name.

• Select the delimiter that is used between metadata fields. Support delimiters
are dot, dash, and underscore (a naming pattern uses only one delimiter).

1

1 Name pane row

3. Click Save Configuration.

Review FileExporter plugin results

After the sequencing run completes, you can download the following files after you
run the FileExporter plugin from the report summary:

• Any of the Torrent Suite™ Software analysis output files that use BAM, VCF, XLS,
or FASTQ formats.

• A compressed file that contains the analysis output files.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click FileExporter to view the plugin summary.
BAM files load quickly, and you may see these files first in the list of links. The
other file formats take longer to download, so you may have to wait for the links
to the VCF, XLS, and FASTQ formats to appear.
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4. Ensure that the status of the plugin run is Completed. If the status is not
Completed or the list of files does not include all the files that you selected when
you configured the plugin, click Plugins4Refresh plugins at the top of the
Summary screen.

5. When the list contains all of the files that you want to download, click a file name
link under Output Files to download.

6. To review the parameters that were used for the files, click Show Parameters.

Use the FilterDuplicates plugin to remove duplicate reads from merged data after a
run is completed. The removed BAM files are saved in the FilterDuplicates directory.
The original BAM files in the main analysis directory are not modified.

The Mark as Duplicate Reads feature in the main analysis pipeline marks reads as
duplicates but does not remove them from the BAM files. Enable this feature in the
Kits step of Planned Run creation.

Review FilterDuplicates plugin results

After the sequencing run completes, review the FilterDuplicates plugin results, and
download the BAM files with duplicate reads removed.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click FilterDuplicates to view the plugin summary.

4. In the FilterDuplicates section, click FilterDuplicates.html to open the BAM
Files with Duplicate Reads Removed report in the browser.
BAM files load quickly, and you may see these files first in the list of links. The
other file formats take longer to download, so you may have to wait for the links
to the VCF, XLS, and FASTQ formats to appear.

The plugin output contains links to the BAM files that have duplicate reads that
are removed. This table also shows the percentage of reads that were removed
and the percentage of all reads that reached the adapter.

5. To download the filtered BAM Files, click the link for each file listed that you
want to download.
The BAM files are downloaded to the directory that you use to download files
from the browser. This location depends on your browser settings.

FilterDuplicates
plugin
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Use the immuneResponseRNA plugin to quantify gene expression levels for the
Oncomine™ Immune Response Research Assay. This plugin produces gene transcript
quantification from sequence read data. The plugin summary includes gene
expression counts (number of aligned reads to a given gene target), a data analysis
summary, and QC plots. The normalized, gene-level count data from the run are
available to download for further analyses with Transcriptome Analysis Console
(TAC) v3.1 software.

The immuneResponseRNA plugin requires a target regions BED file and an
associated reference sequence library FASTA file. For more information on installing
these files, see Chapter 11, “References management“.

The plugin also accepts a second (optional) BED file that specifies a subset of target
genes allowing sample clustering.

immuneResponseRNA plugin configuration

The configuration options for the immuneResponseRNA plugin are described in the
following table:

Setting Value

Library Type AmpliSeqRNA

Targeted Regions ImmuneResponse_v3.1_target_designed_20160908.bed

Add new gene list (Optional) Select your target gene subset BED file in the
Add genes of interest list.

Review immuneResponseRNA plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click immuneResponseRNA to view the plugin
summary.

4. In the immuneResponseRNA section, click the immuneResponseRNA.html
link to open the immuneResponseRNA Report for all barcodes.
BAM files load quickly, and you may see these files first in the list of links. The
other file formats take longer to download, so you may have to wait for the links
to the VCF, XLS, and FASTQ formats to appear.

immuneResponse
RNA plugin

Chapter 8 Manage plugins for data analysis
Preinstalled plugins8

176 Torrent Suite™ Software 5.12 User Guide



5. In the Analysis Summary window, review your Mapped Reads, Valid Reads,
and the Targets that are detected by barcode.

Column Description

Barcode Name The barcode used for the sample.

Sample The sample name as it was entered in the sequencing
Run Plan.

Mapped Reads The number of reads that map to the reference
sequences.

Valid Reads The percentage of mapped reads ≥50% amplicon
length.

Targets ≥1 reads The number of targets/genes with at least 1 read.

Targets ≥2 reads The number of targets/genes with at least 2 reads.

Targets ≥10 reads The number of targets/genes with at least 10 reads.

6. Click an individual barcode name to view the results for that barcode.

7. Scroll down, then click the Sample Characteristics, Sample Correlation,
Analysis of Selected Targets (available only if a Genes of interest subset BED file
was selected), or Analysis of All Targets tabs to review the data in graphic
format.

Downloadable reports

The following reports are available for download as tab-delimited text files,
compatible with Microsoft™ Excel™, or similar applications.

At the bottom of the screen are links for downloading raw analysis output files:

Report hyperlink Description

Download Barcode
Summary Report

A table listing the sample name for each barcode, total reads,
aligned reads on targets, and number of targets detected.

Download absolute
read counts data

A table listing read counts for each barcoded sample along with
gene annotations.
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Report hyperlink Description

Download RPM data
(normalized by total
read counts)

A table listing RPM (Read count per million mapped reads) for
each barcoded sample along with gene annotations. RPM is
calculated as:

(read count)  × 106 / total number of mapped reads

Download mean
housekeeping scaled
log2 RPM data

A table listing housekeeping-gene normalized, log2-transformed
read counts for each barcoded samples along with gene
annotations. Conceptually, these values are read count normalized
by the average expression of housekeeping (hk) genes rather than
by the total number of mapped reads as described above. The
values are calculated as:

These values are useful for differential analysis when a large
proportion of the target genes (non-housekeeping genes) are
expected to be differentially expressed or when the expression
levels of the housekeeping genes in the 2 groups differ
significantly.

Download CHP files
normalized by RPM

The RPM data is converted to CHP file format for use with
Transcriptome Analysis Console (TAC) software. The downloaded
ZIP file contains all the CHP files from the sequencing run. Each
barcoded sample has one CHP file.

Download CHP files
normalized by mean
housekeeping genes

Similar to the above CHP file, but data in these CHP files are
normalized by housekeeping genes.

Download
background
expression from
genomic DNA and
H2O neg_control

A table containing background expression (in absolute read count)
from four experiments using genomic DNA and H2O as negative
control samples.

Analysis files that are generated in Torrent Suite™ Software can be directly transferred
to an Ion Reporter™ Software account in Ion Reporter™ Software with the
IonReporterUploader plugin.

Ion Reporter™ Software uses Torrent Suite™ Software output BAM file for analysis.
The Ion Reporter™ Software annotation-only analysis workflow also accepts the VCF
output file of the variantCaller plugin. Use the IonReporterUploader plugin to
transfer these BAM and VCF output files to Ion Reporter™ Software.

For details about the IonReporterUploader plugin, see Chapter 10, “Integration with
Ion Reporter™ Software“

IonReporterUploa
der plugin
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Use the molecular Coverage Analysis plugin to view statistics and graphs that describe
the level of sequence molecular coverage produced for targeted genomic regions. The
plugin generates statistics, downloadable data files, and interactive visualization of
molecular coverage over targeted regions of the reference genome.

The plugin is only compatible with libraries prepared using Ion AmpliSeq™ HD or
Taq Sequencing chemistries.

molecular Coverage Analysis plugin configuration

The molecular Coverage Analysis plugin uses the following settings.

Setting Description

Reference Genome The reference genome selected in the Planned Run.

Library Type The library type selected in the Planned Run.

Targeted Regions Select the appropriate target region for this run.

The targeted regions are selected in the Planned Run, and can be changed only after
the run is complete if the plugin is run manually. Target regions can be overwritten by
the specific barcode targets.

Barcode-specific Targets Select this checkbox to assign specific target region files to individual barcodes. This
option is available only when the plugin is run manually.

1. Select a specific barcode.

2. Select the specific Target Regions file to associate with the selected barcode.

3. Click Add.

4. Repeat above steps to associate additional barcodes with specific Target Region
files.

Alternatively, you can copy and paste the barcode/target file pairs manually.

When the Barcode-specific Targets option is deselected, all barcodes use the targets
specified by the target regions, even if barcode-specific targets are listed.

Parameter file Click to load the external parameter file that pertains to this plugin.

Review molecular Coverage Analysis plugin results

The molecular Coverage Analysis plugin generates a Molecular Coverage Analysis
Report. This report includes molecule statistics and several charts. The report
summary lists the barcodes, the samples, the median molecular coverage, the
molecular uniformity, and the median reads per functional molecule, and the median
percentage of functional reads.. Additional details regarding molecular coverage are
also provided on a per-barcode basis, along with a list of gene annotations for each
sequenced region.

You can download statistics files at the bottom of Molecular Coverage Analysis
Report. After the sequencing run completes, review the plugin results in the report
summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

molecular
Coverage Analysis
plugin
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3. In the left navigation pane, click molecular Coverage Analysis to view the plugin
summary.
A summary table of the molecular coverage analysis, by barcode, is included in
the Summary screen.

4. In the molecularCoverageAnalysis barcode summary, in the Barcode Name
column, click a link to open a detailed Molecular Coverage Analysis Report for
that barcoded sample.
Alternatively, click the molecularCoverageAnalysis.html link to open the
summary table for all barcodes in a new window.

5. In the Molecular Coverage Analysis Report, review the plugin results.

6. Click the links at the bottom of the Molecular Coverage Analysis Report to
download associated statistics and summary files for each barcoded sample in
the run.

Molecule statistics

Statistic Description

Median Functional Molecular
Coverage per Amplicon

A functional molecule is a collection of reads that covers the amplicon and
satisfies all criteria associated with the parameters (for example,
min_tag_fam_size and min_fam_per_strand_cov) in the parameter
file. Molecular coverage is the number of functional molecules. The median
is calculated across all amplicons.

Uniformity of Molecular Coverage for
all Amplicons

Percentage of amplicons having molecular coverage between 0.5x and 2x of
the median molecular coverage.

Percentage of Amplicons larger than
0.8x Median Functional Molecular
Coverage

Percentage of amplicons having molecular coverage more than 0.8x of the
median functional molecular coverage

Median Total Molecular Coverage per
Amplicon

The number of molecules that satisfies size criteria in the parameters file.
The median is calculated across all amplicons.

Percentage of Reads with Perfect
Molecular Tags

Percentage of reads whose molecular tags are exactly the same with design.

Median Functional Molecular Loss
due to Strand Bias per Amplicon

The metric is calculated by 1- (Functional Molecular Coverage) /
(Molecular Coverage without Strand Constraint), which
measures the loss of functional molecules due to strand constraint for
molecular functionality. The median is calculated across all amplicons.

Median Percentage of Functional
Molecules out of Total Molecules per
Amplicon

The percentage of functional molecules out of the number of molecules that
satisfies size criteria. The median is calculated across all amplicons.

Median Reads per Functional
Molecule

For each amplicon, the number of reads supporting each functional molecule
is averaged across all functional molecules for that amplicon to determine
the number of reads per functional molecule at the amplicon level. The
median is calculated across all amplicons.
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Statistic Description

Median Reads Contributed to
Functional Molecules per Amplicon

For each amplicon, the percentage of reads supporting functional molecules
is (Number of Reads Supporting Functional Molecules) /
(Number of Reads). The median is calculated across all amplicons.

Percentage of Amplicons below
(around) n% LOD

LOD is calculated based on the number of functional molecules for each
amplicon and variant calling parameters in the parameter file. Around x n%
means in the range from 0.5x n% to 2x n%.

Example charts generated by the molecular Coverage Analysis plugin

The charts in the detailed Molecular Coverage Analysis Report include Plot and
Overlay menus that allow you to customize the data that is displayed in each chart.

Click  (Search) (in the top right corner of a chart) to open the chart Viewing
Options panel. Click  (Help) to open a description of the chart.

Figure 6   Representative Depth of Coverage Chart

The Depth of Coverage Chart summarizes the amplicon depth of coverage results. The X‑axis
represents the amplicon molecular depth. The left Y-axis represents the number of amplicons
at a given molecular depth or a range (bin) of molecular depths, as a percentage of the total
number of amplicons. The right Y-axis represents the cumulative count of the number of
amplicons, at a given molecular depth or greater, as a percentage of the total number of
amplicons. The individual orange bars represent the percentage of amplicons in the specific
range of molecular depths. The blue curve measures the cumulative amplicons at a given
molecular depth or greater. Use the Plot dropdown list to switch between Maximum Read
Depth, 99.9% of All Reads, and Normalized Coverage plots.
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Figure 7   Representative Amplicon Coverage charts

The Amplicon Coverage charts summarize the amplicon molecular coverage results. The X‑axis
in all plots represents amplicons that are grouped into bins, where each bin contains amplicons
that have the same molecular coverage. Depending on the plot selection, the left Y‑axis
represents either the average number of molecules (on a base 10 log scale) or the percentage
of functional molecules in a given bin. The right Y‑axis represents the percentage of functional
reads in a given bin. Use the Plot and Overlay dropdown lists to customize the chart view.

1 Representative Total Molecules plot with an Perc Functional Reads overlay
2 Representative Strand Molecules plot with an Perc Functional Reads overlay
3 Representative Reads per Molecule plot with an Perc Functional Reads overlay
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Figure 8   Example detail panes

In most plots, you can click a data point to open a detail pane for that data. For example, in the
Depth of Coverage Chart in Figure 6, click an individual orange bar to open the detail pane for
amplicons in a specific range of molecular depths or click a point on the blue curve to open the
detail pane for cumulative amplicons at that molecular depth or greater. Similarly, you can click
any point or bar within each Amplicon Coverage chart to view details for each amplicon
coverage bin. For example detail panes, see Figure 8.
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Output files generated by the molecular Coverage Analysis plugin

You can download plugin results files from links that are contained in the File Links
section of the Molecular Coverage Analysis Report. The output is a tab-separated
text file with an XLS file extension.

Click  (Help) next to the file to open a description of the file.

The following is an example of the content of a results file that is generated by the
molecular Coverage Analysis plugin.

Setting Description

Coverage statistics
summary

This section of the file is a summary of the statistics presented in the tables at the top of the
Molecular Coverage Analysis Report plugin report. The first line is the title. Each subsequent
line is either blank or a particular statistic title followed by a colon (:) and its value.

Amplicon
molecular coverage
summary

This section of the Amplicon molecular coverage summary file contains the following fields.

• contig_id: the name of the chromosome or contig (from contiguous) of the reference
for this amplicon.

• contig_srt: the start location of the amplicon target region. This coordinate is 1-based,
unlike the corresponding 0-based coordinate in the original targets BED file.

• contig_end: the last base coordinate of this amplicon target region. The length of the
amplicon target is given as (contig_end - contig_srt + 1).

• region_id: the ID for this amplicon as given as the 4th column of the targets BED file.

• gene_id or attributes: the gene symbol or attributes field as provided in the
targets BED file.

• func_mol_cov: the number of molecules (functional molecules) which are available for
the variantCaller plugin.

• lod: LOD (limitation of detection) calculated from the number of functional molecules.

• strict_func_umt_rate: the percentage of functional molecules used with strict
molecular tags.

• func_mol_cov_loss_due_to_strand: the percentage of functional molecules loss
due to strand bias.

• fwd_only_mol_cov: the number of molecules containing forward strand only.

• rev_only_mol_cov: the number of molecules containing reverse strand only.

• both_strands_mol_cov: the number of molecules containing both forward strand and
reverse strand.

• r2m_conv_rate_all: the percentage of reads contributed to functional molecules.

• reads_per_func_mol: the average reads per functional molecules.

• perc_to_mol_(<3_reads): the percentage of reads contributed to small size
molecules(size<3).

• perc_to_mol_(>=3&<30_reads): the percentage of reads contributed to median size
molecules (size ≥3 && size <30).

• perc_to_mol_(>=30_reads): the percentage of reads contributed to large size
molecules (size ≥30).

Chapter 8 Manage plugins for data analysis
Preinstalled plugins8

184 Torrent Suite™ Software 5.12 User Guide



The PGxAnalysis plugin analyzes sequencing output from the Ion AmpliSeq™

Pharmacogenomics panel, a hotspot panel that interrogates pharmacogenomically
relevant variants in samples for genotyping and CYP2D6 copy number detection for
research use. It requires two other Torrent Suite™ Software plugins: the variantCaller
plugin for genotyping and coverageAnalysis plugin for CYP2D6 copy number
detection.

The figure describes the pipeline of analyses.

For details about how to set up Torrent Suite™ Software Planned Runs that
incorporate the Ion AmpliSeq™ Pharmacogenomics template and the PGxAnalysis
plugin, see the following documents at the Thermo Fisher Scientific website
(thermofisher.com):

• Customization Guidelines for Ion AmpliSeq™ Pharmocogenomics Research Panels
(Pub. No. MAN0014300)

• Create a Planned Run using the Ion AmpliSeq™ Pharmocogenomics Research Panel
Plugin (Pub. No. MAN0013730)

Review PGxAnalysis plugin results

After the sequencing run completes, review the plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click PGxAnalysis to view the plugin summary.

4. Click the PGxAnalysis.html link to open the Pharmacogenomics Analysis
Report.

PGxAnalysis
plugin
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5. View the plugin analysis reports.

• Click the variantCaller_out link to view the Variant Caller Report. See 
Chapter 9, “Variant calls in Torrent Suite™ Software“ for details on
variantCaller plugin results interpretation.

• Click the coverageAnalysis_out link to view the Coverage Analysis Report.
See “Review coverageAnalysis plugin results“ on page 160 for details on
coverageAnalysis plugin results interpretation.

Use the RunTransfer plugin to do the following:
• Transfer the signal processing output files from a completed run to a different Ion

Torrent™ Server.
• Rerun an analysis of the transferred signal processing files on the new server. The

Run Summary that includes the transferred files is listed in the Completed Runs
& Reports for the server that receives the transfer, as if it is generated on that
server. The results of the analysis are contained in the ISP images of the Run
Summary.

The files that are transferred are the BaseCaller input category of files, including the
1.WELLS file. This file contains observations from the instrument that are captured
electronically.

For Ion Proton™ analyses, you can configure the option to transfer only thumbnail
files or transfer the 96 block files in a full chip run.

RunTransfer plugin configuration

The RunTransfer plugin requires global configuration to connect to the Ion Torrent™

Server that receives transferred files.

The following configuration settings are used by the plugin:

Setting Description

IP address or fully qualified
hostname

The IP address or fully qualified host name of the receiving
Ion Torrent™ Server.

Remote TS Username
(default ionadmin)

The user name of the administrator-level user on the
receiving Ion Torrent™ Server. The default administrator
user name on a new Ion Torrent™ Server is ionadmin, but
this can be changed.

Password The password of the administrator-level user on the
receiving Ion Torrent™ Server.

Upload Path
(default /results/uploads/)

The path of the directory used to store transferred files and
analyses on the receiving Ion Torrent™ Server.

RunTransfer
plugin
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Setting Description

Data set type Select an option based on the following considerations:

• Thumbnails/PGM—This option transfers all files,
including thumbnails. However, the plugin does not
run if full chip sequencing runs are performed on the
Ion Proton™ System, Ion S5™ System, and Ion
GeneStudio™ S5 System. With this setting, a warning
is issued and the plugin does not run if the instrument
used a Full Chip run.

• Thumbnails/PGM and Full Chip—This option
transfers only thumbnails of Ion PGM™ System, Ion
Proton™ System, Ion S5™ System, and Ion
GeneStudio™ S5 System data sets. Use this option if
disk space is limited on the destination or network
bandwidth is limited.

Review RunTransfer plugin results

After the sequencing run completes, you can review information about the run
reports that were transferred to another Ion Torrent™ Server.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click RunTransfer to view the plugin summary.

4. Click the Report Name link to open the summary for your report.

5. To view the plugin summary, click the RunTransfer link.
In the RunTransfer section, review a list of the files that were transferred. If the
plugin is configured to use the data type set as Thumbnails/PGM, these files are
shown:
1.wells
analysis.bfmask.bin
processParameters.txt
avgNukeTrace_ATCG.txt
avgNukeTrace_TCAG.txt
bfmask.stats', 'bfmask.bin'
analysis.bfmask.stats
analysis_return_code.txt
sigproc.log
avgNukeTrace_ATCG.txt
avgNukeTrace_TCAG.txt
analysis.bfmask.stats
explog.txt
Bead_density_20.png
Bead_density_70.png
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Bead_density_200.png
Bead_density_1000.png
Bead_density_raw.png
Bead_density_contour.png

Use the sampleID plugin to track samples or possibly identify misassignment or mix
up between samples and barcodes in a sequencing run. The sampleID plugin
produces a unique identification code (SampleID) for each barcode in a sample.

The plugin can be used with the Ion AmpliSeq™ Sample ID Panel, which is a human
SNP genotyping panel, to ensure that the accuracy of samples increase confidence in
sample data management. The Ion AmpliSeq™ Sample ID Panel is composed of the
identified human sample gender and IUPAC base letters for eight high-frequency
noncoding SNPs. Ion AmpliSeq™ Sample ID Panel contains nine primer pairs that can
be combined with any Ion AmpliSeq™ Ready-to-Use Panel or Custom Panel.

For the samples to work with this plugin, the Ion AmpliSeq™ library must have been
prepared with Ion AmpliSeq™ sample tracking amplicons.

The sampleID plugin is preconfigured and does not require input.

Review sampleID plugin results

After the sequencing run completes, review the plugin results in the report summary.

Note: If the sampleID is undetermined, a ? can appear in the report summary. The
sampleID can be undetermined due to low coverage. For example, F-? is reported if
only the female gender can be called due to low coverage and F-GCTYR??A is
reported if specific alleles (2 out of the 8 called) could not be called due to low
coverage or ambiguous allele frequency.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click sampleID to view the plugin summary.

4. Click sampleID.html to open the sampleID report in the browser tab. Then, you
can open a detailed report and other data files.

5. (Optional) Scroll to the File Links table, then click a link to:

• Download a PDF image of the report.
• Download all variant calls as a table file.
• Download the tracking target regions file.
• Download the tracking loci regions (SNPs) file.
• Download the aligned tracking reads (BAM) file.
• Download the aligned tracking reads index (BAI) file.

6. (Optional) Click Download Barcode Summary Report to open the data in a
downloadable tab-separated spreadsheet, or PDF report.

7. To return to Torrent Suite™ Software, click back in the browser.

sampleID plugin
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The variantCaller plugin calls single-nucleotide polymorphisms (SNPs), multiple
nucleotide polymorphisms (MNPs), insertions, deletions, and block substitutions in a
sample across a reference or within a targeted subset of that reference.

This plugin provides optimized preset parameters for many experiment types. It can
also be customized. After you find a parameter combination that works well on your
data and that has the balance of specificity and sensitivity that you want, you can save
that parameter set and reuse it in your research. Customization is supported when
you run the plugin after a sequencing run and when the plugin is run through a
Planned Run.

For details about the variantCaller plugin, see Chapter 9, “Variant calls in Torrent
Suite™ Software“.

Plugins available on Connect

Two plugins are supported by Thermo Fisher Scientific and are available on Connect
at https://apps.thermofisher.com/apps/publiclib/#/plugins. These plugins are not
preinstalled in the Torrent Suite™ Software. For details about plugins that are included
with the software, see “Preinstalled plugins“ on page 145.

Plugin name Description

“RNASeqAnalysis
plugin“ on page 189

Analyzes cDNA reads. This plugin is an RNA transcript alignment
and analysis tool for use with the reference genomes hg19 and
mm10.

“smallRNA
plugin“ on page 202

Analyzes small RNA reads with an emphasize on microRNA
molecules. Use with reference genome hg19 only.

The RNASeqAnalysis plugin is an RNA Transcript Alignment and Analysis tool for
use with reference genomes hg19 and mm10.

To use the hg19 or mm10 genomes with this plugin, the reference genomes must first
be imported from the preloaded references screen. Also, annotation files for the
human and mouse references are available for import. For more information on
downloading references and annotation files, see “Import a preloaded reference
sequence file“ on page 261.

Annotation file name Description

Human

hg19_annotation_v1.gtf Human genome annotation (hg19)

XrRNA.fasta Human auxiliary small RNA sequences
(cDNA)

Mouse

mm10_annotation_v1.gtf Mouse genome annotation (mm10)

XrRNA.fasta Mouse auxiliary small RNA sequences
(cDNA)

variantCaller
plugin

RNASeqAnalysis
plugin
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Use this plugin to analyze cDNA reads, as produced by RNA-Seq. Reads are aligned
to the reference genome using STAR and bowtie2 aligners to find full and partial
mappings. The alignments are analyzed by HTSeq and Picard tools to collect assigned
read counts and cufflinks to extract gene isoform representation. For barcoded data,
comparative representation plots across barcodes are created in addition to individual
reports for each barcode. All alignment, detail, and summary report files are available
for download.

RNASeqAnalysis plugin configuration

The RNASeqAnalysis plugin can be configured with either the hg19 or mm10
reference genome when you plan a run. You can also add hg19 and mm10 annotation
files.

This plugin requires the use of the RNA Seq Planned Run templates for sequencing
runs: Ion RNA–Small or Ion RNA–Whole Transcriptome. If the RNA Seq Planned Run
templates are not used when you run the plugin manually, you receive an error.

Setting Description

Reference Genome In the Configure Plugin dialog box, select:

• hg19, or
• mm10

Regenerate indices Check to ensure that any pregenerated indexing and
annotation files for the specified reference are deleted
before the analysis starts. New files are generated as
needed, which may add several hours to the plugin run
time (approximately 3 hours for human-sized genomes).

Using this option is necessary if the plugin previously failed
during (STAR) reference index generation of the reference
sequence was updated.
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To use the mouse mm10 Reference Genome with this plugin, first import the
preloaded Ion reference genome using Torrent Suite™ Software. For more information,
see “Import a preloaded reference sequence file“ on page 261.

Review RNASeqAnalysis plugin run results

After a sequencing run completes, you can review plugin results in the report
summary.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.
Reports for any plugins that have completed analysis are included in the
Summary.

3. In the left navigation menu, click RNASeqAnalysis to view the plugin results.

4. In the RNASeqAnalysis section, view the Barcode Summary for the
RNASeqAnalysis plugin. The summary includes columns for Barcode Name,
Sample, Total Reads, Aligned Reads, Percent Aligned, Mean Read Length, Genes
Detected, and Isoforms Detected.

• Click the RNASeqAnalysis.html link to open the report in the browser tab.
• Click the RNASeqAnalysis.html link to view the RNASeqAnalysis Report

for all barcodes.
• Click the links at the bottom of the report to download associated report files:

Link name Download description

Barcode Summary
Report

A table that lists the sample name for each barcode,
total reads, aligned reads and percent aligned.

absolute reads table A table that lists absolute reads for the genes found
for each barcode.

absolute normalized
reads table

A table that lists absolute normalized reads for the
genes found for each barcode.

aligned reads
distribution table

A table that lists the distribution of genes across
barcodes to show the frequency of numbers of genes
having similar log10 read counts.

isoform FPKM values
table

The isoform gene heatmap in a table format.
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• Click the links at the bottom of the RNASeqAnalysis Report to download
raw analysis output files for the selected barcode. For examples, see 
“Individual barcode view“ on page 195.

Link name Raw analysis output file description

Download the Statistics
Summary

An overview of the individual barcodes from the
RNASeqAnalysis plugin results.

Gene Read Counts A table that lists the number of times a gene was
counted for the individual barcodes.

Output Files A directory for various output files for the selected
barcode.

Cufflinks Output Files A list of links to Cuflinks output files.

• Click individual barcode names to see graphs for the selected barcode. For
examples, see “Downloadable reports for individual RNASeqAnalysis plugin
barcodes“ on page 193.

Link name Download description

Reference table A plot that shows the number of genes that have
reads in log10 counting bins.

Gene Mapping Summary A summary of reads mapped to genes of the
annotated reference.

Base Mapping Summary A summary of base reads aligned to genetic features
of an annotated reference.

Normalized Transcript
Coverage

A plot of normalized transcript coverage that shows
the frequence of base reads with respect to the
length of individual transcripts as they are aligned to
in the 3" to 5" orientation.

Gene Isoform Expression Box plots showing variation of isoforms expressed at
FPKM ≥ 0.3 for each set of genes grouped by the
number of anticipated (annotated) isoforms.
Whiskers are defined by points within Q1-1.5xIQR to
Q3+1.5xIQR. Only genes with 25 or less isoforms are
represented in this plot. The data and a plot for all
genes are available for download using the download
reports links at the bottom of the screen.

• Click the Distribution Plots, Correlation Heatmap, Correlation Plot, and
Gene Heatmap tabs to review the following data graphically.

Graphical report Description

Distribution Plots For details, see “Distribution plots“ on page 197.

Correlation Heatmap For details, see “Correlation heatmap“ on page 199.

Correlation Plot For details, see “Correlation plot“ on page 200.

Gene Heatmap For details, see “Gene heatmap“ on page 201.

Isoform Heatmap For details, see “Isoform heatmap“ on page 201.
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Downloadable reports for individual RNASeqAnalysis plugin barcodes

You can download raw analysis output files for individual barcodes if you click the
links at the bottom of the RNASeq Analysis Report.

• Download the Statistics Summary—Provides an overview of the individual
barcodes RNA Seq Analysis results.
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• Download the Gene Read Counts—Lists the number of times a gene was
counted for the individual barcode.

• Download Output Files (page)—Provides a directory for various output files for
this barcode.

• Download Cufflinks Output Files (page)—Provides a list of links to Cufflinks
output files.
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Individual barcode view

Click any barcode of interest in the RNASeqAnalysis Report to see graphs for the
selected barcode.

Reference table—A plot showing the number of genes with reads in log10 counting
bins.

Gene Mapping Summary—A summary of reads mapped to genes of annotated
reference.

Base Mapping Summary—A summary of base reads aligned to genetic features of an
annotated reference.

Transcript Coverage—A plot of normalized transcript coverage the frequency of base
reads the length of individual transcripts they are aligned to in the 3' to 5' .
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Isoform Expression— plots showing the variation of isoforms that are expressed at
FPKM ≥ 0.3 for each set of genes that are grouped by the number of anticipated
(annotated) . Whiskers points Q1-1.5xIQR to Q3+1.5xIQR. Only genes with 25 or less
isoforms are represented in this plot. The data and a plot for all genes are available for
download using the download reports links at the bottom of the screen.
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Distribution plots

Reads Alignment Summary—A graphical summary of the number of mapped and
unmapped reads across barcodes, as reported in the barcode summary table.

Alignment Distribution—A graphical summary of the distribution of reads to
genomic features.

Normalized Transcript Coverage—An overlay of individual normalized transcript
coverage plots for each barcode.
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Distribution of Gene Reads—Distribution of genes across barcodes showing the
frequency of numbers of genes having similar log10 read counts. All curves are
plotted on the same axis scale. The counts data are fitted to a Gaussian kernel using
the default R 'density' function.

Distribution of Isoform Reads—Distribution of transcript isoforms across barcodes
showing the counts of isoforms having similar FPKM values. All curves are plotted on
the same y-axis, normalized to the highest count, and scaled for FPKM values ≥0.3.
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Correlation heatmap

The correlation heatmap is a heatmap of Spearman correlation r-values for comparing
log2 RPM reads pair correlation barcodes. The dendrogram (lines on the top and the
left side of the heatmap) reflects the ordering of barcodes as being most similar by
these values.
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Correlation plot

The correlation plot is a barcode read pair correlation plot. Lower panels show
log2(RPM+1) values plotted for each pair of barcodes, with linear least squares
regression line overlaid and line slope reported. Upper panels show Pearson
correlation r-values for the regression line. Diagonal panels show the frequency
density plot for the individual log(RPM+1) values for each barcode. (If only one
barcode has reads, a density plot is displayed.)

Click the plot to open an expanded view in a new window.
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Gene heatmap

The following is a gene representation heatmap of 250 genes showing the most
variation in representation across barcodes as measured by the coefficient of variant
(CV) of normalized read counts for genes that have at least one barcode with at least
100 RPM reads. The heatmap is plotted using log10 of those counts. For this plot,
barcodes are omitted if they have less than 100,000 total reads.

Isoform heatmap

A transcript isoform representation heatmap of up to 250 gene transcript isoforms
showing the most variation in representation across barcodes as measured by the
coefficient of variation (CV) of FPKM values for isoforms that have an FKPM value ≥
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100 for at least one barcode, plotted using log10 of FKPM+1. Barcodes are excluded if
they have less than 1,000 isoforms detected at FPKM values ≥ 0.3.

Use the smallRNA plugin to analyze microRNA (miRNA) reads. Reads are aligned to
mature miRNAs using the TMAP or bowtie2 alignment software that is bundled with
the plugin. Unmapped reads are further aligned to the whole-genome to rescue
miRbase unaligned reads and count other RNA molecules (tRNAs, rRNAs, mRNAs,
and so on). miRNA raw counts are generated using featureCounts software.

smallRNA plugin

The RNASeqAnalysis plugin can be configured with the either the hg19 reference
genome or the microRNA reference when you plan a run.

Setting Description

microRNA reference mirbase (build 20)–Use to align against a mirBase reference,
constructed from the mirBase GFF file with 10 bp padding.

genome–Use to align against the whole genome.

Rescue reference hg19

smallRNA plugin
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Review smallRNA plugin results

After your sequencing run completes, review plugin results in the report summary.

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click smallRNA to view the plugin results.

4. In the smallRNA section, click smallRNA.html link to open the smallRNA
Analysis Report for all barcodes.

• In the barcode table, click individual barcode names to see the results for an
individual barcode.

Report Description

Download the Statistics
Summary

An overview of read mapping statistics and smallRNA
molecules.

mirBase mapping quality
(page_)

Mapping quality output from Qualimap.

Download the mirRNA
Mature Counts

A table with per mature RNA read counts.

Download the miRNA Per
Precursor 5p-3p Counts

A table with 5p-arm and 3p-arm read counts on the
same line.

Download the miRNA
High Confidence Mature
Counts

A table with per mature read counts for miRNAs
identified as high confidence miRNAs in mirBase
build 21

Download the miRNA Per
Precursor 5p-3p Counts

A table with 5p-arm and 3p-arm read counts on the
same line. Restricted to miRNAs identified as high
confidence miRNAs in mirBase Build 21.

Download the mirBase
alignments (BAM) file
(genomic coordinates)

mirBase alignments converted to genomic
coordinates when mirBase was used as reference.

Download the mirBase
alignments index (BAI)
file

Index file for the mirBase alignment.

Download Output files
(page_)

A page that provides the ability to download all
output files individually.

• Click Download Barcode Summary Report to download the data into
downloadable tab-separated spreadsheet, or PDF report.

• Click Download absolute reads matrix to download a table that lists absolute
reads for the genes that are found on each barcode.
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Variant calls in Torrent Suite™

Software

■ About the variantCaller plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204

■ Run the variantCaller plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205

■ Create a custom configuration for the variantCaller plugin . . . . . . . . . . . . . . . . 210

■ Apply configuration settings to specific barcodes . . . . . . . . . . . . . . . . . . . . . . . . 211

■ Create and use a custom parameters setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213

■ Review variantCaller plugin run results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213

■ Save adjusted parameters to a variantCaller plugin configuration . . . . . . . . . . 228

■ variantCaller plugin advanced parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229

About the variantCaller plugin

The variantCaller plugin calls single-nucleotide polymorphisms (SNPs),
multinucleotide polymorphisms (MNPs), insertions, deletions (INDELs), and complex
variants in a sample across a reference genome or within a targeted subset of that
reference in Torrent Suite™ Software.

You can set the plugin to run automatically after a sequencing run is completed, or
you can run the plugin manually for completed runs.

When you configure the variantCaller plugin, you can adjust parameter settings to
affect the stringency of the variant calls that are made on your data. Adjustments to
the parameters balance the specificity (that is, false positive calls) and sensitivity (that
is, true positive calls). For more information, see “variantCaller plugin
configuration“ on page 207.

These parameter settings, when combined with the reference genome that you select,
a target regions file, and a hotspots file, comprise a configuration that you can save,
then use for subsequent runs of the variantCaller plugin. You can also select a
predefined configuration that is included with Torrent Suite™ Software.

Preconfigured plugin settings are available as predefined or custom configurations
that are available when you configure the variantCaller plugin. Use these
configurations to save significant setup time. Predefined configurations for use with
the Ion AmpliSeq™ and Ion AmpliSeq™ HD research applications can also be
downloaded from AmpliSeq.com. For more information, see “Import panel files and
parameters“ on page 60.
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Run the variantCaller plugin

The variantCaller plugin identifies variants and adds a VCF file to the output that is
available for completed sequencing runs. You can run the variantCaller plugin for
sequencing results in Torrent Suite™ Software.

• To see variant calls immediately after a sequencing run, configure the
variantCaller plugin as part of the Planned Run.

• You can also manually configure and run the variantCaller plugin after the
sequencing run from a completed run report. You must run the plugin manually
after the run to use a reference genome, target regions file, or hotspots file for one
or more barcodes that are is specified in the Planned Run.

To get variantCaller plugin results as quickly as possible, set up the plugin to run
automatically.

To run the variantCaller plugin automatically after the Torrent Suite™ Software
analysis completes, configure the variantCaller plugin to run by default.

If the variantCaller plugin runs automatically, you can run the plugin again manually
after a sequencing run is completed. For more information, see “Run the variantCaller
plugin manually“ on page 206.

IMPORTANT! Parameter changes that you make in a Planned Run affect only that
specific run. If you change variantCaller plugin parameter settings in a Planned Run
template, the changes affect all users who create Planned Runs from that template.

1. Click  (Settings)4 Plugins.

2. Ensure that the Enabled checkbox in the row of the variantCaller plugin is
selected.

3. Select the Selected by Default checkbox in the row of the variantCaller plugin
name.
The plugin is now set to perform its function after every sequencing run.

4. (Optional) To disable automatic execution of the plugin, deselect the Selected by
Default checkbox in the row of the plugin.

5. To use a reference genome, target regions file, or hotspots file for one or more
barcodes that are specified in the Planned Run, run the variantCaller plugin
manually after the run.

Variants are called for each barcode that is configured to use the specific reference
genome, target regions file, and hotspot file that is included in the Planned Run. For
more information, see “Plan step in the workflow bar“ on page 54. When you
configure the variantCaller plugin in a Planned Run, you cannot change the reference
genome, target regions file, or hotspots file for any barcoded sample. The Planned
Run uses the same parameter file for all barcodes.

You can configure the barcodes and set the variantCaller plugin to run automatically
as part of a Planned Run in Torrent Suite™ Software.

Configure the
variantCaller
plugin to run by
default after every
run

Configure the
variantCaller
plugin to run as
part of a Planned
Run
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If the variantCaller plugin runs automatically, you can run the plugin again manually
after a sequencing run is completed.

IMPORTANT! The variantCaller plugin parameter settings are saved in Planned Run
templates but are not saved in Planned Runs. Parameter changes that you make in a
Planned Run affect only that specific run. When you change variantCaller plugin
parameter settings in a Planned Run template, your changes affect all users who
create Planned Runs from that template.

1. In the Plan tab, click Templates, then select a research application in the left
navigation menu.

2. Select an existing Planned Run template from the list. Alternatively, select Add
New Template, or Plan New Run to create a new Planned Run template or
Planned Run.

3. Click Plugins in the workflow bar.

4. Select variantCaller plugin, then click Configure.
The variantCaller plugin parameter settings change according to the selections
you make. Default settings can be different depending on the sequencer in use.

5. Select settings that are appropriate for the sequencing instrument that is used,
the experiment, and the frequency of the variants of interest. For more
information, see “variantCaller plugin configuration“ on page 207.

6. Click Next, or another tab in the workflow bar to make further changes to your
Planned Run.

7. When all changes to the Planned Run have been made, click Plan in the
workflow bar, then click Plan Run.

The plugin is now set to run after every sequencing run that uses the Planned Run
template or new Planned Run.

You can run the variantCaller plugin on a completed run report in Torrent Suite™

Software. If the sequencing run includes barcodes, you can apply one configuration
that you saved previously to all barcodes. You can also apply a different configuration
for individual barcodes. For more information, see “Create a custom configuration for
the variantCaller plugin“ on page 210.

1. In the Data tab, click Completed Runs & Reports screen, then click the Report
Name link for the completed sequencing run of interest.

2. Click Plugins 4Select Plugins to Run, then click the name of the plugin that
you want to run.

3. In the Select a Plugin to Run dialog box, select the variantCaller plugin, then
click Configure.
The Configure Plugin window opens. The variantCaller plugin parameter
settings change according to the selections you make. Default settings can be
different depending on the sequencer in use.

Run the
variantCaller
plugin manually
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4. Select settings that are appropriate for the sequencing instrument that is used,
the experiment, and the frequency of the variants of interest. For more
information, see “variantCaller plugin configuration“ on page 207.

5. When your changes are complete, click Submit.
The variantCaller plugin reruns, then applies the changes that you made.

Use the Torrent Variant Caller screen to configure the variantCaller plugin. For
information about how to get to this screen, see “Configure the variantCaller plugin to
run as part of a Planned Run“ on page 205
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Setting Details

Configuration [1] A reusable predefined or a custom configuration for the
variantCaller plugin that includes settings for a reference genome,
targeted regions, hotspots, and parameter settings.

For more information, see “Create a custom configuration for the
variantCaller plugin“ on page 210.

Manage
Configurations/Barc
odes [1]

Manage and apply configurations for barcodes when you run the
variantCaller plugin manually. For more information, see “Apply
configuration settings to specific barcodes“ on page 211.

(Optional) To run the variantCaller plugin manually for a limited
number of barcodes, select Skip this barcode for the barcodes
that you do not want to include in the plugin run.

For more information, see “Apply configuration settings to specific
barcodes“ on page 211.

Chip Type [1] The chip type that is used in the sequencing run.

If you change this option, it affects only the fields that are selected
by default in the variantCaller Configuration screen. It does not
affect the sequencing run.

Library Type [1] Library type options include:

• Whole Genome

• AmpliSeq

• AmpliSeq HD

• TargetSeq

When Library Type is set to AmpliSeq, read trimming is
automatically applied to remove the primers from reads.

Variant Frequency [1] Variant frequency options include:

• Somatic—Detects somatic variants at low allele frequencies.

• Germline—Detects germline variants that are expected to be
present at low allele frequencies.

• Rare Somatic—Detects rare somatic variants in FFPE or
cfDNA samples. The option is available only if AmpliSeq HD is
selected as the Target Technique in the Planned Run.

AmpliSeq Panel [1] Panels ordered from AmpliSeq.com have predefined variantCaller
plugin parameter settings. For details, see “Import panel files and
parameters“ on page 60.

When an Ion AmpliSeq™ panel is selected, the plugin configuration
screen automatically selects target regions, hotspots, and
parameter settings files that are for use with the panel.

Add panel [1] Upload a panel.
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Setting Details

Reference Genome [1] The reference genome that is for use with variant calling.

To configure barcodes in the run to use the same genome
reference that was used for the current run report, select the As
Specified in the Plan for Each Barcode option. If the selected
reference genome differs from the reference genome that is
included in the Planned Run, the software must realign the data,
which requires more time for the plugin run.

Targeted Regions Target Regions are the regions of interest for which you want to
call variants. If a target regions file is not provided, the
variantCaller plugin analyzes every position of the reference
genome, which typically takes longer.

To configure barcodes to use the same target regions file that is
included in the current Planned Run, select the As Specified in the
Plan for Each Barcode option.

Before a targeted regions file can be selected, it must be uploaded
from in Torrent Suite™ Software and associated with a specific
reference genome. For more information, see “Upload a target
regions file“ on page 271.

Add targets Upload a target regions file.

Hotspots Hotspots files are BED or VCF files that define variant alleles of
interest. Hotspots files instruct the variantCaller plugin to include
these variant alleles in its output files, including evidence for a
variant and the filtering thresholds that disqualified a variant
candidate. A hotspots file affects only the variantCaller plugin, not
other parts of the analysis pipeline. If you do not specify a hotspots
file, the software reports only the de novo variants that show as
present. In contrast, if a hotspots file is used, the variant calls and
the filtering metrics for each hotspot allele are reported in the
output VCF file, including data for absent or NOCALL variants.

To configure hotspots files to use the same hotspots file that is
included in the current Planned Run, select the As Specified in the
Plan for Each Barcode option.

Before a hotspots file can be selected, it must be uploaded from in
Torrent Suite™ Software and associated with a specific reference
genome. For more information, see “Upload a hotspots file“ on
page 272.

IMPORTANT! A carefully designed hotspot file is recommended
to optimize the overall performance of variant calling. For help
with designing a hotspots file, contact your local Field Service
Engineer.

Add Hotspots Upload a hotspots file.
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Setting Details

Parameter Settings Option to use parameter settings that are predefined in the
variantCaller plugin, or to use Custom parameter settings. For Ion
AmpliSeq™ experiments, panel templates from AmpliSeq.com can
contain parameter settings that are optimized for the variantCaller
plugin and are available for use during variantCaller plugin
configuration.

• The variantCaller plugin provides generic parameter settings
that are optimized for the selected Chip Type, Library Type,
and Variant Frequency, and for the parameters settings that
are downloaded from AmpliSeq.com.

• Select Custom to change the advanced parameter settings.
For more information, see “variantCaller plugin advanced
parameters“ on page 229.

Load external
parameter file

Imports a file that contains parameter settings.

Copy selected
settings to Custom

Creates a custom parameter setting that is based on a generic
parameter setting. For more information, see “Create and use a
custom parameters setting“ on page 213.

Configuration Name [1]Names and saves a custom configuration when changes are made
to the predefined settings.

Show Advanced
Settings

Configure advanced parameter settings. For more information,
see “variantCaller plugin advanced parameters“ on page 229.

Hover your mouse over the field to see tooltips with descriptions of
the advanced settings.

[1] Hidden in sequencing runs that use Tag Sequencing as the target technique.

Create a custom configuration for the variantCaller plugin

You can create a custom configuration for the variantCaller plugin in Torrent Suite™

Software. Later, when you run the plugin manually, you can apply the custom
configuration to the variantCaller plugin run, or to individual barcodes that are
included in the run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for the completed sequencing run.

2. Click Plugins4Select Plugins to Run.

3. In the Select a Plugin to Run dialog box, select the variantCaller plugin, then
click Configure.
The variantCaller plugin configuration screen opens.
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4. Set plugin configuration parameters.
For more information, see “variantCaller plugin configuration“ on page 207 and 
“Create and use a custom parameters setting“ on page 213.

5. In Configuration Name, enter a name for the configuration, then click Save.

The new configuration is included in the Configuration drop-down list in the
variantCaller plugin configuration screen. You can apply the configuration when you
run the variantCaller plugin manually.

Apply configuration settings to specific barcodes

You can save and retrieve custom configurations, for the variantCaller plugin and
apply these custom configurations to specific barcodes when you run the
variantCaller plugin manually from a completed Torrent Suite™ Software run Report.
By applying specific custom configurations to individual barcodes, you can refine
your analysis results.

You can use configurations for barcoded runs to:
• Save a variantCaller plugin configuration that applies to all barcodes.
• Apply one or more saved configurations to individual barcodes.

When you apply saved configurations to specific individual barcodes, you must
run the plugin immediately after you apply the configurations. You can apply a
saved configuration to an individual sample on a chip for each barcode.
Configurations applied to individual barcodes cannot be saved.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
for the completed sequencing run of interest.

2. Click Plugins 4Select Plugins to Run, then in the Select a Plugin to Run dialog
box, click variantCaller.

3. In the Configure Plugin dialog box, click Manage Configurations/Barcodes, then
click OK.

4. In the Torrent Variant Caller dialog box, in the Setup tab, apply configurations
to all barcodes or specific configurations to individual barcodes.

To Action

Apply the same configuration to
all barcodes in a sequencing run.

In Set All, select the configuration to apply to all
barcodes., then click Submit.

Apply a specific configuration to
an individual barcode.

In the Configuration column, select the
configuration from the list of available
configurations for each individual barcode.
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5. (Optional) In the Torrent Variant Caller dialog box, in the Configuration tab,
create a new configuration or edit an existing one.

Action Description

Edit a
configuration.

1. Click Edit. The Configure Plugin dialog box becomes
specific to the configuration selected.

2. Change the existing selections as desired.
To add a new panel, target regions, or hotspots file, you
are redirected to the appropriate Settings ( ) screen.
Close the Configure Plugin dialog box, then reopen the
dialog box to access the new file.

3. Click Show Advanced Settings, then edit the parameters if
needed.

4. Click Save.

Delete a
configuration.

1. Click Delete.

2. Click OK to confirm.

Create a new
configuration.

1. Click Add.

2. Enter a configuration name.

3. Make selections from the available lists.

4. Click Save.
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Create and use a custom parameters setting

You can create a custom parameters setting that you can save and reuse. The custom
parameters setting that you create can be used with a manual run of the variantCaller
plugin. To use a customized parameter file that is designed for your customized panel
or other special requirements, you must create a custom parameters setting, then run
the variantCaller plugin manually with the custom parameters setting.

The parameters file in the variantCaller plugin is a JSON text file that contains the
variant calling parameters that are listed in “variantCaller plugin advanced
parameters“ on page 229.

1. In the Data tab, in the Completed Runs & Reports screen, click the report name
of the run that you want to apply configuration settings to.

2. Click Plugins4Select Plugins to Run, then in the Select a Plugin to Run dialog
box, click variantCaller.

3. In the Parameter Settings section, click Custom.

To . . . Do this . . .

Use a JSON parameters
file that you have saved
on your computer.

1. Click Load external parameter file.

2. Browse to the JSON file, then click Open.

Edit a predefined
parameters setting.

1. In Configuration, select the predefined parameter
setting that you want to edit.

2. Click Copy selected to Custom.

3. If you agree to save the new custom parameter
setting, click OK.

4. Click Show Advanced Settings to enter changes for
the custom parameter settings.

You can edit the values of the advanced parameter settings. Predefined
parameter settings are in read-only mode and cannot be edited.

The custom parameters setting is now ready to be applied to run results when you
run the variantCaller plugin manually.

Review variantCaller plugin run results

After a variantCaller plugin run completes, you can access variantCaller run results
from the run report screen in Torrent Suite™ Software. On the run report screen, in the
variantCaller section you can:

• Review the summary of the variantCaller plugin run for each barcode used.
• Review the library type, reference genome, targeted regions, hotspots file, and

parameter settings that were used in the run.
• Download data files for all barcodes and each individual barcode or sample.
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You can also access the detailed variantCaller plugin summary report for each
barcode or sample from the variantCaller section on the run report screen. In the
detailed variantCaller plugin summary report browser, you can:

• View variant call information by allele for the specific barcode, such as allele
location on the chromosome, allele annotations, coverage metrics, and quality
metrics.

• Review the library type, reference genome, target regions, hotspots, and
parameter settings that were used in the run.

• Download BED files and the parameters file that are used for the specific barcode.
• Download BAM and BAI files for the mapped and TVC-processed reads.
• Download data files for variant calls and coverage for the specific barcode.
• View variant calls in IGV.

The variantCaller plugin supports SNPs, MNPs, INDELs, and complex alleles as input
candidates at genomic positions with the target regions file. If the variant is outside of
the target regions, then the variant is not generated as a candidate and is not further
evaluated, even if the variant is specified in the hotspots file.

1. In the Data tab, click Completed Runs & Reports.

2. In the Completed Runs & Reports list, find the run of interest, then click the
report link in the Report Name column in the row of the run.

3. In the left navigation menu, click variantCaller to navigate to the variantCaller
results section.

• If the sequencing run contains barcodes, the plugin report includes a list of
the barcodes that were used and file download options for all barcodes and
each individual barcode.
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Downloads options for all barcodes that were used in the plugin run.

Download option Description

VCF.ZIP A compressed directory that contains separate VCF files for
each barcode.

XLS.ZIP A compressed directory that contains separate XLS files for
each barcode.

XLS A file that contains a list of alleles for all barcodes in a tab-
separated file that can be opened by Microsoft™ Excel™.

COV A file that contains the coverage of the variant call results
for all barcodes in tab-separated file format, which can be
opened in Microsoft™ Excel™.

• If the sequencing run does not contain barcodes, the plugin report contains
information for the sample that is used in the run and the file download
options for the sample.

4. To open the detailed variantCaller plugin report for a specific barcode or sample,
do one of the following in the variantCaller run summary table:

• In the Barcode name column in a barcoded sequencing run report, click the
barcode name link.

• In the Sample column in a report from a sequencing run that does not contain
barcodes, click the sample name link.
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The detailed variantCaller plugin report contains variantCaller run information,
results, and the associated files for download that are specific for an individual
barcode or sample.

To access the report, click the sample name link in the Sample column in a report
from a sequencing run.

1

2

3

4

1 Review run information for a specific barcode or sample and download the associated
files.

2 View variants called and their associated allele annotation information, coverage metrics,
and quality metrics. For more information, see “Variant Calls by Allele table“ on page 217.

3 Export the variant data files for troubleshooting. For more information, see “Export files
for troubleshooting“ on page 227.

4 Adjust variantCaller plugin filter settings that were used for the specific barcode or
sample, then save the adjusted parameters to a new configuration. For more information,
see “Save adjusted parameters to a variantCaller plugin configuration“ on page 228.

The following table lists and describes the download options for an individual
barcode or the sample used in the run. The available options in the table depend on
the run type.

Download option Description

Target Regions BED—The BED file that specifies the genomic positions of interest.

Hotspot Regions BED—The BED file that specifies the variant alleles of interest.

Effective Regions BED—The BED file that specifies the regions actually processed in
the variantCaller run for the sample or barcode (available if read
trimming is enabled).

Detailed
variantCaller
plugin report

Chapter 9 Variant calls in Torrent Suite™ Software
Review variantCaller plugin run results9

216 Torrent Suite™ Software 5.12 User Guide



Download option Description

Parameter Settings JSON—The JSON file that contains the parameter settings used in
the variantCaller run for the sample or barcode.

Mapped Reads • BAM—The BAM file that is input to the Torrent Variant Caller
Pipeline for discovering and evaluating variants. Note that
realignment may be applied.

• BAI—The BAI file that contains the index information for the
corresponding BAM file.

Torrent Variant
Caller-Processed
Reads

• BAM—The BAM file that is processed by Torrent Variant
Caller. Note that read trimming and read filtering may be
applied. In Tag Sequencing and Ion AmpliSeq™ HD runs, the
BAM file may contain consensus reads that are obtained by
compressing the reads in the mapped BAM that originate
from the same DNA molecule.

• BAI—The BAI file that contains the index information for the
corresponding BAM file.

Variants Calls • VCF.GZ—The compressed VCF file that contains the variant
calls.

• VCF.GZ.TBI—The index file for VCF.GZ.

• XLS—The file that contains a list of variant alleles in the tab-
separated file format, which can be opened in Microsoft™

Excel™.

• COV—The file that contains coverage analysis for each variant
call, which can be opened in Microsoft™ Excel™.

Variants + Non-
Variant Coverage

• gVCF.GZ—The bgzip-compressed genome-VCF file that
contains the variant calls.

• gVCF.GZ.TBI—The tabix index file for gVCF.GZ.

View Variant Calls in
IGV

IGV—The JNLP file that can be opened using (IGV) to visualize the
variant calls.

The detailed variantCaller plugin report contains the Variant Calls by Allele table.
The table lists the details about each variant that is called, including the allele locus,
allele annotation, coverage metrics, and quality metrics for the specific barcode or
sample. You can use the table to find the variant alleles of interest and information
about those alleles. You can also export the information to be saved to your local
storage.

To access the report, click the sample name link in the Sample column in a report
from a sequencing run.

Variant Calls by
Allele table

Chapter 9 Variant calls in Torrent Suite™ Software
Review variantCaller plugin run results 9

Torrent Suite™ Software 5.12 User Guide 217



1

2

4

3

1 Find the variants of interest by applying filters to the table to narrow down the list of
variants called.

2 Change the display of the table to view allele annotation, coverage metrics, or quality
metrics for each variant. To switch between different displays, you can select one of the
following tabs.

• View Allele Annotation. For more information, see “View allele annotations “ on
page 219.

• View Coverage Metrics. For more information, see “View coverage metrics “ on
page 220.

• View Quality Metrics. For more information, see “View quality metrics“ on page 221.
3 Click the column heading to sort variant alleles by the values in the column.
4 Export the information that is associated with the selected variant alleles to an XLS file.

The exported XLS file contains all the information about the selected variants, including
the information listed in the View Allele Annotation, View Coverage Metrics, and View
Quality Metrics tabs. The tabs that are available depend on the run type. For information
about how to export the information, see “Export variant calls to a file“ on page 222.

Column Description

Position The chromosome (or contig) name in the reference genome, and
the position of the chromosome (or contig) in the one-based
coordinate.

Ref The reference base or bases.

Variant The variant allele base or bases.

Allele Call The zygosity (homozygouse or heterozygous) or type (absent or No
Call) of the allele that is called by the zygosity (homozygouse or
heterozygous) or type (Absent or No Call) of the allele all by the
variantCaller plugin.

Frequency The frequency, in %, of the variant allele.

LOD The limit of detection (LOD) at the genome location, estimated
based on the number of detected molecules.

This column is available only for sequencing runs that use the tag
sequencing or Ion AmpliSeq™ HD as the target technique in the
Planned Run. For more information, see “Research
application step in the workflow bar“ on page 48.

Chapter 9 Variant calls in Torrent Suite™ Software
Review variantCaller plugin run results9

218 Torrent Suite™ Software 5.12 User Guide



Column Description

Quality The Phred-scored quality.

For variants found by the Long INDEL Assembler, this value is
always set to 50. Larger values mean higher confidence in the call.

Quality is calculated by posterior probability that the variant allele
frequency is greater than the cutoff (min_allele_freq in the
parameter file), if a variant call is made, or posterior probability
that the variant allele frequency is below this cutoff (if a reference
call). The posterior probability that is computed as conditional on
the reads observed includes sampling variability.

Quality score is typically very large for reads strongly
distinguishing variants with good depth, that is, under the model
assumed, evidence is overwhelming for the variant or for the
reference. Marginal values can mean that either the reads do not
distinguish the variant well, there is insufficient depth to resolve,
or the observed allele frequency is near the cutoff.

PPA (Optional) An indication (0 or 1) of whether the variant allele is a possible
polypoidy allele (PPA). Only absent alleles can be labeled as PPA;
heterozygous and homozygous alleles are not treated as PPA.

This column is available if the report_ppa parameter is set to 1.
For more information on how to set the report_ppa parameter,
see “Torrent Variant Caller module advanced settings“ on
page 229.

You can view the following information in the View Allele Annotations tab of the
Variant Calls by Allele table.

Column Description

Allele Call Decision whether the allele is detected (Heterozygous or
Homozygous), not detected (Absent), or filtered (No Call). No Call
and Absent are for only hotspot calls.

Subset Of The name of the called allele that is a strict superset of the two
SNPs. For example, if a called (homozygous or heterozygous) MNP
is composed of two SNPs, then the MNP is considered to be a
strict superset of the two SNPs.

Variant Type The type of the variant called.

• SNP—single nucleotide polymorphism.

• IND—insertion.

• DEL—deletion.

• MNP—multiple nucleotide polymorphism or the substitution
of a block sequence by the block of another length.

• COMPLEX—Block substitution of sequence by a block of
unequal length.

View allele
annotations 
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Column Description

Allele Source Allele source is called as:

• Hotspot—for alleles included in the hotspots file.

• Novel—for all other alleles.

Allele Name The allele name as defined in the hotspots file.

For novel alleles, the name is defined as tvc.novel.#.

Gene ID The Gene ID as defined in the target regions file.

Region Name The region name as defined in the target regions file.

You can view the following information in the View Coverage Metrics tab of the
Variant Calls by Allele table. The columns that are available on this tab vary
according to the run type.

Column Description

Total Read Cov Total read coverage at this position, after downsampling.

Variants calls are made on a sample of reads when coverage is
higher than specified in the parameter settings file. This is
referred to as "downsampling". For more information, see
downsample_to_coverage in “variantCaller plugin advanced
parameters“ on page 229.

Read Cov + Total read coverage on the forward strand, after downsampling.

Read Cov - Total read coverage on the reverse strand, after downsampling.

Allele Read Cov The number of reads that contain this allele, after downsampling.

Allele Read Freq [1] The frequency of this allele across all reads.

Total Mol Cov[1] The number of molecules covering this location.

Allele Mol Cov[1] The number of detected molecules containing this allele.

Allele Mol Freq[1] The frequency of molecules containing this allele.

Allele Cov + [1] Allele coverage on the forward strand, after downsampling.

Allele Cov - [2] Allele coverage on the reverse strand, after downsampling.

Strand bias The discrepancy between allele frequencies on the forward and
reverse strands.

[1] This column is unavailable for sequencing runs that use Tag Sequencing or Ion AmpliSeq™ HD as the target 
technique.

[2] This column is unavailable for sequencing runs that use Tag Sequencing as the target technique.

View coverage
metrics 
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You can view the following information in the View Quality Metrics tab of the
Variant Calls by Allele table.

This tab does not appear in Tag Sequencing runs.

Column Description

Common Signal
Shift

The distance between predicted and observed signal at the allele
locus. [RBI]

Reference Signal
Shift

The distance between predicted and observed signal in the
reference allele. [REFB]

Variant Signal Shift The distance between predicted and observed signal in the variant
allele. [VARB]

Relative Read
Quality

The Phred-scaled mean log-likelihood difference between the
prediction under reference and variant hypothesis. [MLLD]

HP Length Homopolymer length.

Context Error + The probability of sequence-specific error on the forward strand
(reported only for deletion variants).

Context Error - The probability of sequence-specific error on the reverse strand
(reported only for deletion variants).

Context Strand Bias Basespace strand bias (reported only for deletion variants).

For candidates that are filtered out, the filtering reason is highlighted in the table.

View quality
metrics
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You can export variant calls to a tab-separated file that can be opened using
spreadsheet software such as Microsoft™ Excel™. The exported file is named
subtable.xls and has the same columns that are included in the Variant Calls by
Allele table. The file includes columns for all three display options: View Allele
Annotations, View Coverage Metrics, and View Quality Metrics.

1. In the Data tab, in the Completed Runs & Reports screen, click the report name
of the run from which you want to export variant calls to a file.

2. In the left navigation menu, click variantCaller, then open the detailed
variantCaller plugin report for a specific barcode or sample.

• In the Barcode name column in a barcoded sequencing run report, click the
barcode name link.

• In the Sample column in a report from a sequencing run that does not contain
barcodes, click the sample name link.

3. In the Variant Calls by Allele table, select the checkbox in the row of each
variant that you want to export, then click Export Selected.

4. Select Download table file of selected rows, then click OK.
The subtable.xls file is created and downloaded to your computer.

5. (Optional) View the file, then save it to your local storage using a descriptive file
name.

Export variant
calls to a file
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You can troubleshoot results in the variantCaller plugin detailed report to analyze
why expected variants were missed (false negatives) or to examine false positives.
Plugin parameters can be adjusted and the plugin can be rerun. You can also export
troubleshooting results to share them with a field bioinformatics specialist (FBS).

Find false negatives with an alignment viewer

When an expected variant is not called by the variantCaller plugin, an alignment
viewer, such as Integrative Genomics Viewer (IGV) or Ion Reporter™ Genomic Viewer
(IRGV) can help you confirm the absence of the variant in the sample, or help you
understand how to adjust the plugin parameters to enable the plugin to call the
variant. Using the IGV or IRGV can reveal problems such as mismapping or low
coverage. In particular, an alignment viewer lets you visually inspect the coverage of
the region where the variant is expected, and focus attention on the depth of coverage
and the quality of the bases covering the position of the variant. Low coverage or low
base quality can explain a no-call. A genomic viewer can also reveal that variant is
slightly misplaced (especially for INDELs) and therefore not called.

1. On the detailed variantCaller plugin summary report screen, click IGV to open
the viewer.

Troubleshoot
variantCaller
plugin results
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2. In the viewer, select the chromosome where the variant of interest is located,
scroll to the chromosomal position of the variant, then zoom in until you can
read the nucleotide sequence surrounding the variant allele.
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3. Hover over a variant read to view read analytics.

4. Adjust plugin parameters.

5. Rerun the variantCaller plugin.

Find false negatives by using the variantCaller plugin report

You can use built-in variantCaller plugin tools to display and examine call details.

• If a hotspots file was used:
a. Check that the position of the variant is included in the hotspots file.
b. Check the Variant Calls output table. Values that cause a candidate to be
filtered out are shown in colored cells:
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c. Adjust plugin parameters.
d. Rerun the variantCaller plugin.

• If a hotspots file was not used:
a. Navigate to the variantCaller plugin results directory on the Ion Torrent™

Server and open the small_variants_filtered.vcf file.
– Open the detailed report in Torrent Suite™ Software, then click the

Barcode Name link in a report from a barcoded sequencing run. Or, click
the Sample Name link in a report from a non-barcoded sequencing run.
Scroll to, or search for the small_variants_filtered.vcf link. You can click
the link to view the file in the browser or download the file to your
computer.

– On Linux backend, the variantCaller plugin results directory can be
found
at /results/analysis/output/Home/{analysis_report_name
}/plugins/variantCaller/ for non-barcoded runs
or /results/analysis/output/Home/{analysis_report_name
}/plugins/variantCaller/{bar code}/ for barcoded runs.

b. Find the location of the variant, then examine the FR (filtered reason) field.
c. Relate the reason to plugin run parameters using the parameter definitions in 

“variantCaller plugin advanced parameters“ on page 229.
d. Adjust plugin parameters.
e. Rerun the variantCaller plugin.

Fix false positives

False positives are usually related to artifacts that create unexpected amplification,
such as a primer-dimer or contamination problems. Some false positives are reported
because of the difficulties inherent with the handling of homopolymer regions.

Use one of the following methods to resolve these issues:
• Adjust parameters that control the homopolymer calls. This can increase the

report of false negatives.
• If you are repeatedly running a panel, manually curate specific sites (positions),

since the false positive tends to occur in the same positions.

The variantCaller plugin does not support manual curation. Manual curation is
available in the command-line version.

Chapter 9 Variant calls in Torrent Suite™ Software
Review variantCaller plugin run results9

226 Torrent Suite™ Software 5.12 User Guide



Export files for troubleshooting

Torrent Suite™ Software includes a tool that helps you determine why variant calls are
unclear in analyses. You can use the Slicer tool to select one or more variant calls, then
export the related data as miniature BAM, BED, and VCF files. You can then share
these files with a field bioinformatics specialist for further review.

Navigate to the variantCaller plugin output table, then follow the steps listed below.

1

2

3

4

5

6

1 Click Show Troubleshooting.
2 Select the variant or variants of interest.
3 Click Export for Troubleshooting.
4 Enter the Expectant Variant.
5 Click Export.
6 Wait for the export process to complete, then click Download the zip.

The compressed directory of miniature BAM, BED, and VCF files is downloaded to
the directory, according to your browser settings.
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Save adjusted parameters to a variantCaller plugin configuration

You can adjust the variantCaller plugin parameters that are used for the barcode, then
save the adjusted parameters to a configuration.

The reference genome, target regions, and hotspots files in the saved configuration
inherit the files that are used to obtain the variantCaller plugin results for this
barcode.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
for the completed sequencing run of interest.

2. In the left navigation menu click variantCaller, or scroll to the variantCaller
results section.

3. Click the barcode name link to open the detailed variantCaller plugin summary.

4. Click Show Filter Settings, then adjust the Parameter threshold values.

5. Enter the Configuration Name that stored the adjusted parameters, then click
Save to Configuration.

6. To apply the updated configuration to additional barcodes, run the plugin
manually, then assign the saved configuration with the adjusted parameters to
the desired barcodes.
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variantCaller plugin advanced parameters

Advanced parameter settings for the variantCaller plugin allow additional
customization of the variant calling algorithm and are for use only by advanced users.

In general, you can safely customize parameters for SNP calling. For INDEL calling,
changes to the parameters tend to have a significant impact on the number of INDELs
called. As a result, consider the tradeoff between sensitivity and specificity for INDEL
calls when you optimize customized parameters.

The variant calling pipeline in the variantCaller plugin contains three modules:
• Torrent Variant Caller module—The Torrent Variant Caller module evaluates the

list of candidates and examines evidence for the variants in flow space.
• FreeBayes module—The FreeBayes module, as a candidate generator, generates

lists of variant candidates.
• Long INDEL Assembler module—Some long INDELs, if improperly aligned to

the reference genome, may not be discovered and evaluated by the FreeBayes and
the Torrent Variant Caller modules. The purpose of the Long INDEL Assembler
module is to call these long INDELs. A unification step in the pipeline combines
the variants that are called by the Torrent Variant Caller and the Long INDEL
Assembler module into one VCF file. The VCF file is available to the software.

The following table lists and describes the Torrent Variant Caller module advanced
settings.

IMPORTANT! The advanced parameters and settings are recommended for advanced
users only. If you need help setting advanced parameters, contact your local Field
Service Engineer.

Torrent Variant Caller advanced parameters and settings

Parameter Description

X_min_allele_fr
eq

X is one of the allele types in {indel, snp, mnp, hotspot}.

A variant evaluation parameter: The presence of the allele of the
type is defined by which allele frequency is greater than this value.

Allowed values: Decimal between 0 and 1

Suggested trial value: between 0.01 (somatic) and 0.2 (germline)

X_min_variant_s
core

X is one of the allele types in {indel, snp, mnp, hotspot}.

A filter parameter: A called allele of the type needs to have a QUAL
score greater than this Phred-scaled value.

Filter reason: quality score.

Related VCF fields: QUAL

Allowed values: Decimal values ≥ 0

Suggested trial value: > 10

Torrent Variant
Caller module
advanced settings
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Parameter Description

X_min_coverage X is one of the allele types in {indel, snp, mnp, hotspot}.

A filter parameter: The location of a called allele of the type needs
to have a coverage greater than this value.

Filter reason: MINCOV

Related VCF fields: FRO, FAO

Allowed values: Integers ≥ 0

Suggested trial value: between 5 and 20

X_min_cov_each_
strand

X is one of the allele types in {indel, snp, mnp, hotspot}.

A filter parameter: Minimum coverage required on each strand for
a the type of allele to be called.

Filter reason: PosCov or NegCov

Related VCF fields: FSRF, FSRR, FSAF, FSAR

Allowed values: Integers ≥ 0

Suggested trial value: ≥ 3

X_strand_bias X is one of the allele types in {indel, snp, mnp, hotspot}.

A filter parameter: A candidate allele of the type will be filtered out
if its strand bias p-value is less than X_strand_bias_pval, and
its strand bias is greater than X_strand_bias. The parameter is
critical for filtering out the false positive calls due to the strand-
specific sequencing error.

Filter reason: STDBIAS and STDBIASPVAL

Related VCF field: STB

Allowed values: Decimal numbers between 0.5 (requires perfect
balance on both strands) and 1.0 (tolerates extremely strong
strand bias)

Suggested trial value: 0.95

X_strand_bias_p
val

X is one of the allele types in {indel, snp, mnp, hotspot}.

A filter parameter: A candidate allele of the type will be filtered out
if its strand bias p-value is less than X_strand_bias_pvall and
its strand bias is greater than X_strand_bias.

Filter reason: STDBIAS and STDBIASPVAL

Related VCF field: STBP

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.01 for strand bias filter, 1 for no strand
bias filter
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Parameter Description

X_min_var_cover
age

X is one of the allele types in {indel, snp, mnp, and hotspot}.

A filter parameter: Minimum number of variant coverage after
flow-evaluation required to make the call.

Filter reason: VarCov

Related VCF field: FAO

Allowed values: Integer ≥ 0

Suggested trial value: 3 (TagSequencing or AmpliSeq HD), 0
(other)

downsample_to_c
overage

Reduce coverage in over-sampled locations to this value to save
computational time.

Allowed values: Integers ≥1

Suggested trial value: 400 (germline), 2000 (somatic)

use_fd_param (experimental in Torrent Suite™ Software 5.4)

A filtering parameter: Use Flow Disruptiveness (FD) instead of
allele types (INDEL, SNP, MNP) as the criterion to select the
parameter set.

If turned on, the (non-FD, weak FD, strong FD) allele applies the
(INDEL, SNP, MNP) parameters, respectively.

If powered on, the (non-FD, weak FD, strong FD) allele applies the
(INDEL, SNP, MNP) parameters, respectively.

Allowed values: 0: do not use FD parameters, 1: use FD
parameters.

data_quality_st
ringency

A filter parameter: A called variant needs to have a mean log-
likelihood difference per read greater than this Phred-scaled
value.

Filter reason: STRINGENCY

Related VCF field: MLLD

Allowed values: Decimal numbers ≥ 0

Suggested trial value: ≥ 6.5

filter_unusual_
predictions

A filter parameter: A called variant needs to have RBI less than
this value. The parameter is critical for filtering out the false
positive calls due to the strand-specific sequencing error.

Filter reason: PREDICTIONSHIFTx

Related VCF fields: RBI = sqrt(FWDB ^ 2 + REVB ^ 2)

Allowed values: Decimal numbers ≥ 0

Suggested trial value: 0.3
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Parameter Description

filter_deletion
_predictions

A filter parameter: Filter out a deletion if the observed clusters
deviate from predictions more than this amount.

Filter reason: PREDICTIONVarSHIFTx or PREDICTIONRefSHIFTx

Related VCF fields: VARB, REFB

Allowed values: Decimal numbers ≥ 0

Suggested trial value: 0.2

filter_insertio
n_predictions

A filter parameter: Filter out an insertion if the observed clusters
deviate from predictions more than this amount.

Filter reason: PREDICTIONVarSHIFTx or PREDICTIONRefSHIFTx

Related VCF fields: VARB, REFB

Allowed values: Decimal numbers ≥ 0

Suggested trial value: 0.2

min_callable_pr
ob

A reporting parameter (TagSeq/AmpliSeq HD only): The minimum
callable probability for the calculation of Limit Of Detection (LOD).

• LOD is defined to be the lowest possible allele frequency in
the sample such that the variant is callable with probability
greater than this value, when the molecular depth is given.

• Allowed values:Decimal numbers between 0 and 1

• Suggested trial value:0.98

min_fam_per_str
and_cov

An evaluation parameter for Tag Sequencing and Ion AmpliSeq™

HD runs only: Minimum required coverage of reads on each strand
in a bi-directional functional molecular tag family.

Allowed values: Integers ≥ 0

Suggested trial value: 1

min_tag_fam_siz
e

An evaluation parameter for Tag Sequencing and Ion AmpliSeq™

HD runs only: Minimum number of reads with same molecular tag
required to form a functional molecular family.

Allowed values: Integer ≥ 1

Suggested trial value: 3

tag_trim_method An evaluation parameter for Tag Sequencing and Ion AmpliSeq™

HD only: Requirement of the molecular tag of the read must match
the format specified in the Planned Run.

Allowed values: strict-trim (requires match), sloppy-trim (does
not require match)

Suggested trial value: sloppy-trim
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Parameter Description

indel_func_size
_offset

An evaluation parameter for Tag Sequencing and Ion AmpliSeq™

HD runs only: requires a family size ≥ (min_tag_fam_size + this
value) to be functional for calling HP-INDEL.

Allowed values: Integers ≥ 0

Suggested trial value: 0

heavy_tailed A variant evaluation parameter: (2*heavy_tailed-1) is the degree of
freedom of the t-distribution for modeling the heavy tail in signal
residual distribution.

Allowed values: Integers ≥ 1

Suggested trial value: 3

outlier_probabi
lity

A variant evaluation parameter: probability that a read comes from
none of the models under consideration.

The variantCaller plugin will make NOCALL with filter reason
REJECTION if FXX is too high.

Related VCF field: FXX

Allowed values: Decimal numbers between 0 and 1.0

Suggested trial value: between 0.005 and 0.01

prediction_prec
ision

A variant evaluation parameter: The number of pseudo data points
suggesting our predictions match the measurements without bias.

Allowed values: Decimal numbers ≥ 0.1

Suggested trial value: 1.0

max_flows_to_te
st

A variant candidate evaluating parameter: The maximum number
of scoring flows being used.

Allowed values: Integers > 0

Suggested trial value: 10

suppress_recali
bration

A variant evaluation parameter: Homopolymer recalibration values
should not be used when set.

Allowed values: 0 = enable recalibration, 1 = disable recalibration

Suggested trial value: 0

do_snp_realignm
ent

A variant candidate evaluating parameter: Realign reads in the
vicinity of SNP candidates when set.

Related VCF content: REALIGNEDx

Allowed values: 0 = do not realign, 1 = realign

Suggested trial value: 0
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Parameter Description

do_mnp_realignm
ent

A variant candidate evaluating parameter: Realign reads in the
vicinity of MNP candidates when set.

Related VCF content: REALIGNEDx

Allowed values: 0 = do not realign, 1 = realign

Suggested trial value: 0

realignment_thr
eshold

A variant candidate evaluating parameter: Maximum allowed
fraction of reads where realignment causes an alignment change.

Related VCF content: SKIPREALIGNx

Allowed values: Decimals between 0 and 1

Suggested trial value: 1

min_ratio_for_f
d

A filter parameter: Claim flow-disruption if the portion of reads
that are flow-disrupted greater than or equal to this value.

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.1

indel_as_hpinde
l

A filter parameter: A flag indicating whether INDEL filters or SNP
filters should be applied to non-HP INDELs.

Allowed values: 0 (false), 1 (true)

hp_max_length A filter parameter: HP indels of more than this length will be
filtered out.

Filter reason: HPLEN

Related VCF field: HRUN

Allowed values: Integers ≥ 1

Suggested trial value: 8

hp_indel_hrun A filter parameter: Define the HRUN for filtering HP-INDEL
variants with lengths specified by hp_del_len and hp_ins_len.

Filter reason: HPINSLEN, HPDELLEN

Related VCF field: HRUN

Allowed values: Vector of positive integers (for example, [1,2,3])
with size matches hp_del_len and hp_ins_len
Suggested trial value: []

hp_ins_len A filter parameter: Filter out HP-INS variants whose INS length is
less than or equal to the corresponding entry of this vector if the
HRUN is defined in hp_indel_hrun.

Filter reason: HPINSLEN

Related VCF field: HRUN

Allowed values: Vector of non-negative integers (for example,
[1,2,3]) with size matches hp_del_len and hp_indel_hrun.

Suggested trial value: []
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Parameter Description

hp_del_len A filter parameter: Filter out HP-DEL variants whose DEL length is
less than or equal to the corresponding entry of this vector if the
HRUN is defined in 'hp_indel_hrun'.

Filter reason: HPDELLEN

Related VCF field: HRUN

Allowed values: Vector of nonnegative integers (for example,
[1,2,3]) with size matches hp_ins_len and hp_indel_hrun.

Suggested trial value: []

use_position_bi
as

A filter parameter: Enable the position bias filter when set.

Filter reason: POSBIAS, POSBIASPVAL

Allowed values: 0 = disable, 1= enable

Suggested trial value: (AmpliSeq) 1, (other) 0

position_bias A filter parameter: Filter out a variant if the position bias is greater
than position_bias and the position bias p-value is less than
position_bias_pval.

Filter reason: POSBIAS, POSBIASPVAL Related VCF field:
POSBIAS

Allowed values: Ddecimal numbers between 0 and 1

Suggested trial value: 0.75

position_bias_p
val

A filter parameter: Filter out a variant if the position bias is greater
than position_bias and the position bias p-value is less than
position_bias_pval.

Filter reason: POSBIAS, POSBIASPVAL Related VCF field:
POSBIASPVAL

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.05

position_bias_r
ef_fraction

A filter parameter: Skip the position bias filter if (reference read
count) / (reference and alt read count) ≤ this value.

Filter reason: POSBIAS, POSBIAS-PVAL

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.05

error_motifs The file name of the error motif file
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Parameter Description

sse_prob_thresh
old

A filter parameter: Filter threshold for motif-predicted error
probability.

Filter reason: NOCALLxPredictedSSE, NOCALLxPositiveSSE,
NOCALLxNegativeSSE

Related VCF fields: SSEP, SSEN

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.02

report_ppa A reporting parameter: Report Possible Polyploidy Alleles (PPA) in
the VCF file and the variant calls in the XLS files.

Related VCF field: PPA

Allowed values: 1 = report PPA, 0 = do not report

Note: This feature is experimental and by default is set to
report_ppa = 0 (do not report).

The FreeBays module advanced parameter settings control the behavior of the
FreeBayes module, a module within the variantCaller plugin, which performs read
filtering and generates lists of variant candidates.

IMPORTANT! The advanced parameters settings are recommended for advanced
users only. If you need help setting advanced parameters, contact your local Field
Service Engineer.

Parameter Description

allow_indels Candidate generation parameter: Allow INDEL candidates to be
generated when set.

Allowed values: 0 = does not generate indel candidates, 1 =
generates INDEL candidates

Suggested trial value: 1

allow_snps Candidate generation parameter: Allow SNP candidates to be
generated when set.

Allowed values: 0 = does not generate SNP candidates, 1 =
generates SNP candidates

Suggested trial value: 1

allow_mnps Candidate generation parameter: Allow MNP candidates to be
generated when set.

Allowed values: 0 = does not generate MNP candidates , 1 =
generates MNP candidates

Suggested trial value: 1

FreeBayes module
advanced settings
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Parameter Description

allow_complex Candidate generation parameter: Allow complex variant
candidates to be generated when set.

Allowed values: 0 = does not generate complex candidates, 1 =
generates complex candidates

Suggested trial value: 1

gen_min_alt_all
ele_freq

A candidate generation parameter: A non-HP-INDEL candidate
needs to have an allele frequency greater than this value in the
pileup.

Allowed values:Decimal numbers between 0 and 1

Suggested trial value: 0.02 to 0.15

gen_min_indel_a
lt_allele_freq

A candidate generation parameter: An HP-INDEL candidate needs
to have an allele frequency greater than this value in the pileup.

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.02 to 0.15

gen_min_coverag
e

A candidate generation parameter: A variant candidate location
needs to have coverage depth greater than this value.

Allowed values: Integers ≥ 0

Suggested trial value: 6

min_mapping_qv A read filtering parameter: Minimum mapping quality value
required for a read to be counted (for both candidate generation
and variant evaluation).

Allowed values: ≥ 0

Suggested trial value: 4

read_snp_limit A read filtering parameter: Do not use reads with number of SNPs
above this.

Allowed values: Integers ≥ 0

Suggested trial value: 10

read_max_mismat
ch_fraction

A read filtering parameter: Ignore reads with fraction of mismatch
greater than this value.

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 1.0
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Parameter Description

min_cov_fractio
n

A read filtering parameter: Do not use reads with fraction of
covering the best assigned unmerged target region below this.

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.9 (TagSequending and Ion AmpliSeq™

HD), 0 (otherwise)

read_mismatch_l
imit

A read filtering parameter: Do not use reads with number of
mismatches (where 1 gap open counts 1) above this value.

Allowed values: Integers ≥ 0 (0 disables the filter)

Suggested trial value: 5 (Tag Sequencing and Ion AmpliSeq™ HD),
0 (other)

The Long INDEL Assembler module advanced parameter settings control the
behavior of the Long Indel Assembler module, a module within the variantCaller
plugin.

IMPORTANT! The advanced parameters settings are recommended for advanced
users only. If you need help setting advanced parameters, contact your local Field
Service Engineer.

Parameter Description

kmer_len Size of the smallest k-mer used in assembly.

Impact: Increasing values make INDEL calls less sensitive but
more specific.

Allowed values: Integers ≥ 5

Suggested trial value: 11 and 30

min_var_freq Minimum frequency of the variant to be reported.

Impact: Increasing values make INDEL calls less sensitive but
more specific.

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.1 and 0.4

min_var_count Minimum support for a variant to be evaluated.

Impact: Increasing values make INDEL calls less sensitive but
more specific.

Allowed values: Integers > 1

Suggested trial value: 3 and 30

Long INDEL
Assembler
module advanced
settings
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Parameter Description

short_suffix_ma
tch

Minimum assembled sequence match on both sides of the variant.

Impact: Increasing values make INDEL calls less sensitive but
more specific.

Allowed values: Integers > 2

Suggested trial value: 4 and kmer_len

min_indel_size Minimum size indel reported by assembly.

Impact: Increasing values make INDEL calls less sensitive but
more specific.

Allowed values: Integers > 0

Suggested trial value: 2 and 30

max_hp_length Variants containing HP larger than this are not reported.

Impact: Increasing values make INDEL calls more sensitive but
less specific.

Allowed values: Integers > 1

Suggested trial value: 2 and 11

relative_strand
_bias

Variants with strand bias above this are not reported.

Impact: Increasing values make INDEL calls more sensitive but
less specific.

Allowed values: Decimal numbers between 0 and 1

Suggested trial value: 0.6 and 1.0

output_mnv Enables reporting of complex variants.

Allowed values: 1 = report complex variants, 0 = don't report

Suggested trial value: 0

Parameter Description

Torrent Variant Caller
arguments

Advanced arguments for Torrent Variant Caller.

Alignment arguments Desirable alignment arguments for variant calling
purpose. Realignment of the BAM file may be triggered in
the plugin if the entry is different from the alignment
arguments specified in the run plan.

Unify vcf arguments Advanced manipulation of the variant calling VCF file.

SVB BED file Full path to a previously uploaded sequence variant
baseline (SVB) BED file. For
example, /results/uploads/BED/65536/foo/unm
erged.

Advanced
argument settings
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Integration with Ion Reporter™

Software

■ About Ion Reporter™ Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240

■ Install the IonReporterUploader plugin on a Ion Torrent™ Server . . . . . . . . . . 241

■ Set up an account for IonReporterUploader plugin . . . . . . . . . . . . . . . . . . . . . . 242

■ Automatically transfer Torrent Suite™ Software output to Ion
Reporter™ Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
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■ IonReporterUploader plugin file transfer progress . . . . . . . . . . . . . . . . . . . . . . . 250

■ Tune IonReporterUploader plugin speed parameters . . . . . . . . . . . . . . . . . . . . . 252

■ Review IonReporterUploader plugin results . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252

■ IonReporterUploader command-line utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255

About Ion Reporter™ Software

Ion Reporter™ Software performs analysis on BAM files that are output from Torrent
Suite™ Software. VCF output files, that result from using the variantCaller plugin, can
also be transferred and used for Ion Reporter™ Software analyses, if an annotation-
only analysis workflow is used to process the files in Ion Reporter™ Software.

To transfer these BAM and VCF output files to Ion Reporter™ Software, you must add
one or more Ion Reporter™ Software accounts. You can add accounts at any time, or
when you configure the IonReporterUploader plugin. After an account is configured,
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there are several ways that you can transfer files to an organization in Ion Reporter™

Software.
• Torrent Suite™ Software can automatically transfer files from a completed run

report to Ion Reporter™ Software and either make them available:
– As analyses in Ion Reporter™ Software. In this case, the output files are

transferred to Ion Reporter™ Software and the analysis workflow of your
choice for use in Ion Reporter™ Software is automatically launched on your
newly transferred samples.

– In Ion Reporter™ Software as BAM and VCF files that can be later defined as
samples in Ion Reporter™ Software.

• You can optionally choose to upload data manually to Ion Reporter™ Software
Use this option if, for example, you want to upload data to Ion Reporter™

Software multiple servers. To upload data manually from Torrent Suite™ Software
to Ion Reporter™ Software, do one of the following:

– Run the IonReporterUploader plugin manually from a completed run report.
– Select the option to review results from a completed run in Torrent Suite™

Software when you create a Planned Run.

When the IonReporterUploader plugin defines samples from the newly transferred
samples for Ion Reporter™ Software, sample relationships for paired and trio samples
and sample attributes are also defined. For details, see “Sample gender“ on page 247.

Ion Reporter™ Software is available under separate license and is not included with
Torrent Suite™ Software.

Install the IonReporterUploader plugin on a Ion Torrent™ Server

The IonReporterUploader plugin is installed automatically on a Ion Torrent™ Server
when you update to a new release of Ion Reporter™ Software.

To update the IonReporterUploader plugin on Ion Reporter™ Software that is
connected to the Internet, you can use the off-cycle plugin upgrade process. For
details, see “Enable off-cycle product updates“ on page 341 and “Update off-cycle
release plugins“ on page 344.

If you do not have an internet connection, then download and install the latest version
that is named IonReporterUploader_<version>.deb from http://
iru.ionreporter.thermofisher.com/.

1. Click  (Settings)4Plugins.

2. In the list of plugins, click Install or Upgrade Plugin.

3. Click Upload a Plugin file, then browse to and select the
IonReporterUploader.zip file that you downloaded.

4. Click Open, then click Upload and Install.

The new IonReporterUploader plugin is added to the list of plugins in Torrent Suite™

Software.
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Set up an account for IonReporterUploader plugin

Before you can transfer files to Ion Reporter™ Software with the IonReporterUploader
plugin, you must configure a valid Ion Reporter™ Software account. Torrent Suite™

Software uses the account information to transfer output files to an Ion Reporter™

Software organization.

You can add more than one account for the IonReporterUploader plugin. When you
add multiple accounts, any available account can be selected when you run the
plugin, or when you manually upload output files to Ion Reporter™ Software. You can
upload the Torrent Suite™ Software output files to any of the Ion Reporter™ Software
accounts that are available in Torrent Suite™ Software.

IMPORTANT! When you upgrade to a new version of Ion Reporter™ Software, you
must reconfigure the IonReporterUploader plugin with a Ion Reporter™ Software
account that is set up for the new version of Ion Reporter™ Software. This account
must be set up before you can access the IonReporterUploader plugin from the
updated software.

When an account is set up, two email notifications are sent each time that a
IonReporterUploader plugin finishes a run. The first email is sent when the plugin
run starts. Another email is sent when the upload to Ion Reporter™ Software is
finished. The notifications are sent to the email address of the Ion Reporter™ Software
user who is signed in when the IonReporterUploader plugin is launched.

1. Click  (Settings)4 Ion Reporter Configure:

2. In the Ion Reporter Uploader Account Configuration screen, click Add Account,
then select an account type:

Option Description

Ion Reporter™ Software on Connect Select Ion Reporter Cloud

Ion Reporter™ Software on Ion Reporter™ Server Select Ion Reporter

Ion Reporter™ Software on Connect—China
version

Select Ion Reporter Cloud -
China

3. In the Add Ion Reporter account screen, enter the appropriate account
information.
Ask your system administrator for values for a local Ion Reporter™ Server.

Item Description

Server Type Enable HTTPS.

Display Name Enter a name of your choice for the account. This name can be
selected when you configure a Planned Run template or run
the IonReporterUploader plugin manually. Use only the
alphanumeric, dash, underscore, and space characters.

Server Enter: 40.dataloader.ionreporter.iontorrent.com, or the
address for your local Ion Reporter™ Server.

Port 443 is the port number that is automatically populated.
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Item Description

Username Enter your Ion Reporter™ Software username (your email
address).

Password Enter the password you use to Sign in to Ion Reporter™

Software.

4. Select one of the following account options:

• Default—The account that is configured by default in the Planned Run
templates and Planned Runs. If the main account is for file transfers, select the
Default checkbox. You can change the default account after you set up a
Planned Run template, or through the Upload to IR menu on the completed
run report.

• Get Versions—Select an available version of the software.
This option is available if multiple versions of Ion Reporter™ Software are
available and multiple accounts are configured.

5. Click Add.

6. (Optional) The IonReporterUploader plugin can manage multiple configurations.
To add another configuration, repeat the procedure.

When at least one account is successfully configured, the IonReporterUploader plugin
is ready to transfer output files to Ion Reporter™ Software. If you set up multiple
accounts, the accounts are listed in the Upload to IR menu in the completed run
report that you can use to upload output files manually to Ion Reporter™ Software.
The accounts are also listed when you configure a Ion Reporter™ Software Planned
Run or Planned Run template.

Automatically transfer Torrent Suite™ Software output to Ion
Reporter™ Software

To transfer output files from a Torrent Suite™ Software analysis to Ion Reporter™

Software automatically, configure the IonReporterUploader plugin when you create a
Planned Run.

The results files that are transferred to Ion Reporter™ Software can be:
• Automatically defined as samples Ion Reporter™ Software that are launched in an

analysis workflow immediately after the instrument run is complete. Successful
analyses are then available in Ion Reporter™ Software when you sign in with the
account that is included in the setup.

IMPORTANT! To set up automatic transfer, you must select the
IonReporterUploader plugin and select the Ion Reporter™ Software analysis
workflow in the Planned Run.
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• Made available in Ion Reporter™ Software as output files (BAM and VCF files)
that can later be defined as samples in Ion Reporter™ Software. In this case, you
can define your samples and then launch the analysis manually in Ion Reporter™

Software. This approach is commonly used to annotate the VCF files, using the
annotation-only analysis workflow in Ion Reporter™ Software.
VCF files are available as output files when you configure the
IonReporterUploader plugin. For details, see Chapter 9, “Variant calls in Torrent
Suite™ Software“.

For sequencing runs that use barcoded data, select the correct barcode kit under Kits
in the workflow bar. When you select a barcode kit, a sample name field for each
barcode is generated.

Use the plan by Sample Set feature when you configure Ion Reporter™ Software in
your Planned Run or template. For details, see “Plan by Sample Set“ on page 63.

1. In the Plan tab, click Templates, then select a Research Application, for example,
AmpliSeq DNA.

2. Select a template that matches your panel.
For example, if you are using an Ion AmpliSeq™ Exome Panel, select the Ion
AmpliSeq™ DNA template with the same name.

3. Add samples, confirm the default settings, enter a plan name, then select Ion
Reporter in the workflow bar.

4. Select the Ion Reporter™ Software account that you want to use by default for the
transfer of output files to Ion Reporter™ Software.
Data files are transferred to the default Ion Reporter™ Software account, unless
you change it during run planning.

IMPORTANT! If you select None, you must transfer files from Torrent Suite™

Software manually to Ion Reporter™ Software.

5. If the Ion Reporter™ Software account is not configured, click Configure to add
an account.
For more information, see “Set up an account for IonReporterUploader
plugin“ on page 242.

6. Select a Sample Grouping that corresponds to the sample relationship in Ion
Reporter™ Software.
When you select a Sample Grouping, the workflow bar in Ion Reporter™

Software displays only analysis workflows that match the type of analysis
workflows selected.
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7. Select an option in the Existing Workflow menu.

Option Description

Ion Reporter
workflow for
your sample
type

Use this option to launch automatically the analysis workflow in
Ion Reporter™ Software with the sample data from the run.
Successful analyses are available in Ion Reporter™ Software with
the account and organization that you selected.

Upload Only Use this option to transfer only the output files from the
sequencing run to Ion Reporter™ Software. If you use this option,
you can access the samples in Ion Reporter™ Software. VCF files
are also available if you ran the variantCaller plugin.

8. (Optional) Click Create New Workflow to open Ion Reporter™ Software in a new
browser window. In Ion Reporter™ Software, create your new analysis workflow,
then save it.
When you return to Torrent Suite™ Software, refresh your browser. You can select
the newly created analysis workflow in the Existing Workflow menu.

9. Select an Ion Reporter Upload Option.

Option Description

Review results after
run completion, then
upload to Ion Reporter

Use this option to review the completed run report and then
manually transfer the data files to Ion Reporter™ Software.

IMPORTANT! After you review the results in Completed
Runs & Results, you must click Upload to IR4Upload as
Planned to upload the data to Ion Reporter™ Software.

Automatically upload
to Ion Reporter after
run completion

Use this option to upload automatically results to Ion
Reporter™ Software. If you select an analysis workflow, an
Ion Reporter™ Software analysis is launched immediately
after the run. Successful analyses are then available in Ion
Reporter™ Software when you sign in with the account that
is included in the setup.

10. Continue with the steps to create the Planned Run.
For more information, see “Steps in the workflow bar“ on page 45.

11. If appropriate, enter the gender of a sample.
For more information, see “Sample gender“ on page 247.

12. To save the Planned Run or Planned Run template, do one of the following
actions in the workflow bar:

• Click Save for a new Planned Run template, enter the new template name,
and optionally mark it as a favorite.

• Click Save & Finish if you used Plan by Sample Set, then enter the new
Planned Run name.

• Click Plan Run for a new Planned Run, then enter the new run plan name
and sample information.

13. The Planned Run is ready to run on your sequencing system.
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You can reduce the number of Ion Reporter™ Software analysis workflows that are
listed when you create a Planned Run or Planned Run template in Torrent Suite™

Software. To do so, use the Tag for IRU label in Ion Reporter™ Software. Only
workflows that use this tag are listed when you plan instrument runs in Torrent
Suite™ Software.

1. Sign in to Ion Reporter™ Software.

2. In the Workflows tab, click Overview.

3. Select an analysis workflow, then click Actions4Tag for IRU.

The Tag for IRU in the Details section for the analysis workflow is changed to
Yes. Only analysis workflows that include the Tag for IRU label are listed when
you plan instrument runs in Torrent Suite™ Software.

4. To undo, select Untag for IRU.

Manage the Ion
Reporter™

Software analysis
workflow list
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Several analysis workflows in Ion Reporter™ Software, especially copy number
variation detection and Ion AmpliSeq™ IDP trio, are limited when the sample gender
is unknown, and they return unexpected results when the gender is incorrectly
specified.

For example, in the Ion AmpliSeq™ IDP trio analysis workflow, when the gender of
the proband is not known, variants cannot be assigned in the categories
HasMaleMaternalX and HasUnknownX.

If a sample with no gender is transferred from Torrent Suite™ Software to Ion
Reporter™ Software, you can go to the Define Samples step in Ion Reporter™ Software
and edit the sample to specify the gender attribute.

Note:
· You cannot edit samples that have been launched in an Ion Reporter™ Software

analysis. Instead, define new samples from the BAM or VCF data files, and add the
correct gender metadata to the new samples.

· If the gender of the sample is not specified or is specified as "Unknown", the
Integrative Genomics Viewer uses female as the gender.

Run the IonReporterUploader plugin manually

You can run the IonReporterUploader plugin manually from a completed run report
in Torrent Suite™ Software. This process transfers data from a completed sequencing
run to Ion Reporter™ Software. You might want to run IonReporterUploader plugin
manually if after a sequencing run is completed, for example, you want to annotate
only variants, and therefore upload only VCF files. This option is not available when
the plugin is run from the Planned Run or run template. Instead both BAM and VCF
files are uploaded to Ion Reporter™ Software.

For barcoded runs, you can select the barcodes that you want to include in your
plugin results. You can also select the barcode kit on the instrument before the run,
then run the plugin manually when the run is complete. In this case, the barcode kit
that you enter on the sequencer is used in the run. The barcode kit that you select on
the instrument overwrites the barcode kit that is selected in the Planned Run.

When you run the plugin manually, you can select whether to upload only VCF files,
only BAM files, or both VCF and BAM files.

You can also see the barcoded samples that were used in the sequencing run. You can
upload any barcoded sample that includes a sample name.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link for your completed sequencing run.

2. Click Plugins4Select Plugins to Run link, then click IonReporterUploader.
The Configure Plugin dialog box opens.

Sample gender

Chapter 10 Integration with Ion Reporter™ Software
Run the IonReporterUploader plugin manually 10

Torrent Suite™ Software 5.12 User Guide 247



3. For runs that include barcoded samples, click Barcode Sample Settings.
You can select one or more samples to upload to Torrent Suite™ Software.

IMPORTANT! To upload a sample with a barcode, the barcode must include a
sample name. If you select a barcode for a sample that is not named, the
IonReporterUploader plugin does not upload the sample.

a. Select the checkbox for barcodes for the sample or samples that you want to
upload. By default, all samples that include sample names are selected for
upload.

4. (Optional) To adjust speed parameters in IonReporterUploader plugin that
change the rate at which files are uploaded, click Advanced Settings.

a. Set the Number of Parallel Streams to Default (the recommended optimal
speed) or select 1-5 to slow down upload.

b. Set File Segment Size to Default (recommended), or 16MB, 32MB, 64MB, or
128MB.

5. In the Upload Options section of the Configure Plugin dialog box, select the file
types that you want to upload: BAM, VCF, or BAM and VCF. Then click Launch
IRU in the row next to the Ion Reporter™ Software account that you want to use
for the upload.

6. Click Yes to confirm that you want to upload the data.
Your upload starts. Upload times vary depending on the speed of your internet
connection and the size of the dataset being transferred. An email notification is
sent when the upload is complete. When the upload completes, you can sign in
to Ion Reporter™ Software, then launch an analysis on the new datasets.

IonReporterUploader plugin configuration

The following settings are configured when you set up accounts for the
IonReporterUploader plugin.

Setting Description

Server Type Enable HTTPS.

Display Name Enter a name of your choice. This name can be selected
when a run plan template is created or edited and is visible
to other Torrent Suite™ Software users. Use only the
alphanumeric, dash, underscore, and space characters.

Server Enter 40.dataloader.ionreporter.iontorrent.com.

Port Enter 443.

Username Enter your Ion Reporter™ Software user name (your email
address).

Password Enter the password that you use to sign in to Ion Reporter™

Software.

Chapter 10 Integration with Ion Reporter™ Software
IonReporterUploader plugin configuration10

248 Torrent Suite™ Software 5.12 User Guide



Setting Description

Default Enable if this account is for automatic analyses in Ion
Reporter™ Software.

Version Select the version for use with each account.

The following settings can be configured when you run the IonReporterUploader
plugin manually.

You can select barcodes for the samples or samples that were used in the sequencing
run. By selecting these barcodes, you can select the samples that you want to upload
to Ion Reporter™ Software. For details, see “Run the IonReporterUploader plugin
manually“ on page 247.

Setting Description

Barcode Sample Settings Select the barcodes for the sample or samples used in the
sequencing run that you want to upload to Ion Reporter™

Software.

Select Ion Reporter™

Software account
Select the Ion Reporter™ Software account to use to upload
files to Ion Reporter™ Software

Upload Options

BAM Select this option to upload only BAM files.

VCF Select this option to upload only VCF files.

BAM and VCF Select this option to upload both BAM and VCF files.

Advanced Settings For details on these settings, see “Tune IonReporterUploader plugin
speed parameters“ on page 252.

Number of Parallel
Streams

Set the Number of Parallel Streams to Default (the
recommended optimal speed) or select 1-5 to slow down
upload.

File Segment Size Set File Segment Size to Default (recommended), or to
16MB, 32MB, 64MB, or 128MB.
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IonReporterUploader plugin file transfer progress

You can monitor the progress of the transfer of analysis results files from Torrent
Suite™ Software to Ion Reporter™ Software.

To monitor
IonReporterUploader

plugin progress through…
See details in…

Email Email notifications sent for each plugin run:

• When the plugin starts to transfer your files.

• When the upload to Ion Reporter™ Software is
complete.

Email notifications are sent to the email address of the Ion
Reporter™ Software user whose authentication token was
used to configure the plugin.

Torrent Suite™ Software “View plugin run status“ on page 142.

Log files “Open a plugin log“ on page 143.

You can view a list of the run reports on which the IonReporterUploader plugin has
been run, the plugin completion status, and the sizes of the plugin output.

1. Click  (Settings)4Plugins.
The installed plugins are listed.

2. Click  (Actions)4Usage in the row of the IonReporterUploader plugin.

3. View the following information from the list of run reports:
• Time that a plugin run started and ended.
• Status of the plugin run.
• Size of the plugin run result output files.

View
IonReporterUploa
der plugin status
details
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IMPORTANT! This action permanently deletes the IonReporterUploader plugin
report for a run and cannot be undone.

1. Sign in to Torrent Suite™ Software.

2. Click Settings ( )4Plugins. The installed plugins are listed.

3. Click Settings ( )Usage for IonReporterUploader plugin:

4. Click Delete on the row for the plugin report that contains the files that you want
to delete.

The output files for the plugin report are deleted.

Delete
IonReporterUploa
der plugin report
files
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Tune IonReporterUploader plugin speed parameters

You can adjust speed parameters for the IonReporterUploader plugin to change the
rate at which files are uploaded.

Update these settings only if file transfers from IonReporterUploader plugin are
difficult or slow with the default settings.

1. In the Data tab, click Completed Runs & Reports.

2. Click Plugins4Select Plugins to
Run, then select
IonReporterUploader.

3. Click Advanced Settings.
a. Set the Number of Parallel

Streams to Default (the
recommended optimal speed)
or select 1-5 to slow down
upload.

b. Set File Segment Size to Default (recommended), or 16MB, 32MB, 64MB, or
128MB.

Review IonReporterUploader plugin results

1. In the Data tab, click Completed Runs & Reports.

2. In the list of runs, find the run of interest, then click the link in the Report Name
column.

3. In the left navigation menu, click IonReporterUploader to view the plugin
results.
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4. From the IonReporterUploader plugin, you can view information that is related
to the data transfer, including the name of the Ion Reporter™ Server used, the
version of Ion Reporter™ Software that is on the server, the server directory that
contains the uploaded files, and the Ion Reporter™ Software organization and
user account that was used. You can also review details about barcoded samples
that were uploaded with the IonReporterUploader plugin, or failed to upload.

To do this Click

View error messages associated with the plugin run. Errors

View warnings that contain details about the barcoded
samples that are used in the plugin run.

Warnings

Show or hide a detailed status of the pre- and post-
processing of the data transfer.

Show detailed
status/Hide detailed
status

Open a report the data transfer in a separate browser tab. Stdout

Open the plugin log files in a separate browser tab. Log

Open a startplugin.json file that contains metadata
used by the plugin.

Input

Download a CSV file that contains a list of the uploaded and
defined samples.

Download CSV list of
samples that are
uploaded and defined

Download a compressed directory of the
IonReporterUploader plugin log files and other plugin files

Download IRU logs
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Typically the BAM file output of your Torrent Suite™ Software analysis is uploaded to
Ion Reporter™ Software and then the software runs through major analysis phases:

1. Mapping
2. Variant calling
3. Annotation

The following table describes how Torrent Suite™ Software output files are used in Ion
Reporter™ Software analyses.

Torrent Suite™ Software
output file

Output from this Torrent
Suite™ Software analysis

phase

Input to this Torrent Suite™

Software workflow

BAM file TS analysis pipeline Any except annotation-only

VCF file TS Variant Caller
(variantCaller) plugin

Annotation-only

The IonReporterUploader plugin by default uploads both the BAM file and the VCF
file from the Ion Torrent™ Server to Torrent Suite™ Software.

Torrent Suite™

Software output
and Ion Reporter™

Software analysis
phases
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The following table describes the input and output file types for the analysis phases.

Analysis phase Input file type Output file type

Mapping BAM file (mapped or
unmapped)

Mapped BAM file

Variant calling Mapped BAM file VCF file

Annotation VCF file (with or without
annotations)

Annotated VCF file

Each output file type is required as input to the next analysis phase. In almost all
cases, the Ion Reporter™ Software analysis phases are performed in order.

The exception is the annotation phase. The annotation-only analysis workflow runs
this phase by itself. (All other analysis workflows include the annotation phase as
their last analysis phase.) The annotation-only analysis workflow requires as input a
VCF file, which can be generated from either an Ion Reporter™ Software analysis, a
variantCaller plugin analysis, or a different source.

IonReporterUploader command-line utility

The IonReporterUploader command-line utility is an alternative to the
IonReporterUploader plugin that is included with Torrent Suite™ Software. You can
use the IonReporterUploader command-line utility to transfer results files to Ion
Reporter™ Software and to define samples, based on the transferred files. The
IonReporterUploader command-line utility uses your sign in ID to transfer run data
from Torrent Suite™ Software to Ion Reporter™ Software. The utility supports these
transfer scenarios:

• Transfer a single BAM or VCF file
• Transfer all results files for a Torrent Suite™ Software analysis
• Transfer results files that are in a single flat folder
• Transfer multiple files that are not restricted to a single folder

You can later analyze the samples with Ion Reporter™ Software. You can enter
IonReporterUploader command-line utility options through command line
arguments, or through a properties file.

CAUTION! IonReporterUploader command-line utility should not be used for
uploading samples from references other than hg19 and GRCh38. Although E-
coli and animal reference genomes can be used in Torrent Suite™ Software, they
are not supported in Ion Reporter™ Software.

The IonReporterUploader command-line utility can be run on any of the following:
• A Ion Torrent™ Server.
• A standard Linux™ computer.
• A standard Windows™ computer that uses the Windows™ XP operating system or

later.
• A standard Macintosh™ computer.
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IonReporterUploader command-line utility supports the upload of combined Ion
Reporter™ Software analysis results that are output by the Combine Alignments
option in the Torrent Suite™ Software Projects tab. The IonReporterUploader plugin
does not support uploading these files.

You can download the IonReporterUploader command-line utility at: http://
iru.ionreporter.thermofisher.com/. For information on IonReporterUploader plugin,
see the Torrent Suite™ Software Help, or the Torrent Suite™ Software User Guide.

The IonReporterUploader command-line utility is an alternative to the
IonReporterUploader plugin that is included with Torrent Suite™ Software. You can
download the IonReporterUploader command-line utility at: http://
iru.ionreporter.thermofisher.com/. For information on IonReporterUploader plugin,
see the Torrent Suite™ Software Help, or the Torrent Suite™ Software User Guide.

This procedure explains how to download and install the IonReporterUploader
command-line utility from Ion Reporter™ Software. The procedure can vary, based on
the operating system of the target computer. In general, decompress the downloaded
directory on your target machine, then copy the directory IonReporterUploader-
cli to a convenient location.

Ideally, download the IonReporterUploader command-line utility onto the computer
where it is to be run. At a minimum, you must use a computer with the same
operating system.

IMPORTANT! Use only the decompression utility available on your local computer.
Do not decompress files on a different operating system and copy those files to a
computer that uses a different operating system.

1. Click Settings ( )4Download Ion Reporter Uploader.

2. Click the filename IonReporterUploader-cli.zip, then download the file
to the target computer.

3. Extract the downloaded IonReporterUploader-cli.zip file, then copy the
IonReporterUploader-cli directory to a convenient location on the target
computer.

The IonReporterUploader command-line utility irucli is ready to run after you
extract it. Run the IonReporterUploader command-line utility from the
IonReporterUploader-cli bin directory (with the irucli.bat or irucli.sh
script).

Instructions to use the IonReporterUploader command-line utility are downloaded
with the utility. For more information, see the Torrent Suite™ Software User Guide.

Download
IonReporterUploa
der command-line
utility

Run
IonReporterUploa
der command-line
utility
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About references

Torrent Suite™ Software provides access to references for use in your sequencing runs.
References are available for reference genome sequences, barcode sets, test fragments,
and other files that filter or restrict genomic sequencing and analysis to the regions of
interest. Before you can use some of these files in sequencing runs, you must upload
or import the files to the Ion Torrent™ Server that is connected to the sequencing
instrument.

References are accessed in Torrent Suite™ Software by clicking 
(Settings)4References, and using options in the left navigation menu.

Reference type Description

Reference sequences Import preloaded Torrent Suite™ Software validated
reference genome sequences, or a custom reference
genome to add them to Planned Runs and Planned Run
templates.

Obsolete reference
sequences

Reference sequences become obsolete and are listed in the
Obsolete References Sequences screen after Torrent
Suite™ Software is updated with a release that includes a
new TMAP index.

Target regions Upload these files to add them to your Planned Runs.

Hotspots Upload hotspots files to add them to your Planned Runs.
The variantCaller plugin generates output files that include
these positions whether or not a variant is called, and
include evidence for a variant and the filtering thresholds
that disqualified a variant candidate.

Test fragments Use these known sequences to monitor system
characteristics.
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Reference type Description

Barcodes Upload Ion barcode sets or your own custom barcodes sets
for use in sequencing runs.

Upload history Review records of recent uploads of target regions,
hotspots, and ZIP files from AmpliSeq.com.

Reference sequences

To identify genetic variations within a nucleic acid sample, sequencing reads are
aligned to a reference genome sequence. Torrent Suite™ Software comes preloaded
with reference genome files containing genomic sequences that represent several
species, including two commonly used human genome references—hg19 and
GRCh38. You can also import a custom reference file to use for your sequence
analysis.

As part of the standard analysis process in Torrent Suite™ Software, reads are aligned
to a genomic reference using the TMAP aligner that comes preinstalled on the Ion
Torrent™ Server. For more information, see “TMAP modules“ on page 320.

The Human Genome version 19 (hg19) reference is a human genome reference that is
based on the Genome Reference Consortium's human genome assembly version 37
with patch 5 (GRCh37.p5), and its equivalent UCSC hg19 reference. For more
information, see the Genome Reference Consortium's website: ncbi.nlm.nih.gov/grc/
human/data. Several notable differences exist between the hg19 reference in Torrent
Suite™ Software and the GRCh37.p5/UCSC hg19 reference sequences:

• The Y chromosome PAR regions in the hg19 reference are hard masked with 'N',
while the GRCh37.p5 reference Y chromosome PAR regions are unmasked.

• Three nucleotide positions that are masked with 'N' in the GRCh37/UCSC hg19
reference have IUPAC ambiguity codes in hg19 reference sequence.

• The hg19 reference in Torrent Suite™ Software uses the Revised Cambridge
Reference Sequence (rCRS) for chromosome M, while UCSC hg19 uses the
original chromosome M sequence.

For more information, see genome.ucsc.edu/cgi-bin/
hgGateway?org=human&db=hg19. To download sequence and annotation data, go to
the Genome Browser FTP server at hgdownload.soe.ucsc.edu/goldenPath/hg19 or the
Downloads screen at hgdownload.soe.ucsc.edu/downloads.html#human.

Hard masked PAR regions in chromosome Y

The mammalian Y chromosome contains regions that are identical to the X
chromosome called pseudoautosomal regions (PARs). These regions allow for
recombination between the sex chromosomes. When the human Y chromosome was
sequenced and assembled, the PAR regions were not sequenced, and therefore were
not included in the assembly. Instead, the corresponding sections from the X
chromosome sequence were copied onto the Y chromosome. This sequence
duplication must be considered when sequence analysis is performed by the software
so that allelic duplication can be distinguished from other types of duplications such
as repeats and segmental duplication.

hg19 reference
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When the female DNA sample is sequenced, reads from the PAR regions align to both
the X and the Y PAR sequences. This alignment affects the mapping quality of the
reads in these regions and creates problems with variant calling on the gender
chromosomes. For this reason, the PAR sequence on the Y chromosome is replaced
with 'N', or "hard masked", in the hg19 reference. In the GRCh37 reference, the PAR
sequence is unmasked. Hard masking the PAR sequence on the Y chromosome
preserves the PAR coordinates on the Y chromosome and eliminates the duplication
at this locus. The Y chromosome in the hg19 assembly contains two PAR regions that
are taken from the corresponding regions in the X chromosome and have identical
DNA sequences.

Chromosome Y PAR coordinates Corresponding chromosome X PAR
coordinates

10,001–2,649,520 60,001–2,699,520

59,034,050–59,363,566 154,931,044–155,260,560

Three positions with ambiguity codes

Three positions on chromosome 3 are masked with 'N' in the UCSC version of the
hg19/GRCh37 reference genome. These positions have IUPAC ambiguity codes in our
hg19 version:

• M—IUPAC code for A or C nucleotides
• P—IUPAC code for A or G nucleotides

Position IUPAC ambiguity code in
hg19 reference

Hard masked character in
UCSC hg19

60830534 M N

60830763 R N

60830764 R N

Chromosome M reference sequence

The hg19 reference in Torrent Suite™ Software uses the Revised Cambridge Reference
Sequence (rCRS) for the Homo sapiens mitochondrial sequence (chromosome M or
chrM) – GenBank accession number NC_012920. UCSC hg19 reference uses the
original chromosome M sequence – GenBank accession number NC_001807. UCSC
begins using the rCRS for chromosome M in the GRCh38 (hg38) assembly.

The following background information is from the UCSC site http://genome.ucsc.edu/
cgi-bin/hgGateway?org=human&db=hg19.

"Since the release of the UCSC hg19 assembly, the Homo sapiens mitochondrion sequence
(represented as 'chrM' in the Genome Browser) has been replaced in GenBank with the record 
NC_012920. We have not replaced the original sequence, NC_001807 in the hg19 Genome
Browser. We plan to use the Revised Cambridge Reference Sequence (rCRS) in the next
human assembly release."
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The Genome Reference Consortium's human genome assembly version 38 (GRCh38)
is the latest version of the GRC human genome reference. The GRCh38 assembly is
referred to as "hg38" in the UCSC Genome Browser and includes the following
updates to the GRCh37/UCSC hg19 version:

• Alternate sequences for highly variable genes
• Centromere representation
• Sequence updates such as fixed errors, filled gaps, and changes to chromosome

coordinates
• Updated mitochondrial genome sequence (GenBank accession number

NC_012920.1)
• Hard masked PAR regions in chromosome Y

Chromosome Y PAR coordinates Corresponding chromosome X PAR
coordinates

10,000–2,781,479 10,000–2,781,479

56,887,902–57,217,415 155,701,382–156,030,895

For more information, see genome.ucsc.edu/cgi-bin/hgGateway?db=hg38.

To download sequence and annotation data, go to Genome Browser FTP server at 
hgdownload.soe.ucsc.edu/goldenPath/hg38/ or the Downloads screen at 
hgdownload.soe.ucsc.edu/downloads.html#human.

Torrent Suite™ Software includes validated reference sequence files that you can
download onto your Ion Torrent™ Server. You can also import custom reference
sequence files from your local storage or a remote server. After you import the
reference sequence files onto your Ion Torrent™ Server, the reference sequences are
available for use when you set up Planned Runs and when the software performs data
analysis.

Guidelines for importing custom reference sequence files

The following guidelines are for preparing a new custom reference genome sequence
file to be imported into Torrent Suite™ Software:

• Download a FASTA format reference genome file and save it to your local
storage. FASTA files can found at ncbi.nlm.nih.gov/genome.

• The file selected for import must have a .fasta extension.
• When working with larger genomes, performance improves if you compress the

FASTA file. Torrent Suite™ Software supports ZIP and GZIP archive file formats,
provided each archive file contains one FASTA file.

• The variantCaller plugin does not support IUPAC base codes other than A, C, T,
G, and N. When the software uploads a genome containing other IUPAC
characters, each such character is replaced with N.

• Prepare any related target regions, hotspots, and reference annotation files to
upload with the reference genome file and save them to your local storage. For
more information, see “Target regions and hotspots files“ on page 267 and 
“Import reference sequence files“ on page 260.

GRCh38 reference

Import reference
sequence files
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Import a preloaded reference sequence file

Validated reference sequence genome files suitable for use with Torrent Suite™

Software are preloaded on the Ion Torrent™ Server. These reference files can be easily
imported into the software using this procedure. After you import the reference
genome file, the references can enabled for use in Planned Runs and data analysis.

You can also edit the reference genome information, or permanently delete the
reference file from the software. For more information, see “View a reference
sequence file“ on page 263.

IMPORTANT! If you edit or delete a reference sequence file, the change affects all
users.

1. Click  (Settings)4References.

2. Click Import Preloaded Ion References.

The Ion References and Downloads lists are displayed.

3. In the Ion References list, find the file of interest.

Option Description

Reference To import a reference file, click Import in the row of the reference
file to import.

Annotation
Files

To download annotation files that pertain to the reference file that
you are importing:

1. Click Import Annotation Files.

2. In the Import Annotation Files dialog box, select the
annotations that you want to import, then click Import
Selected.

The file import status appears in the row of the selected file in the Ion References
list. When the status is complete, a compressed folder in ZIP file format is added
to the Downloads list and the reference genome is added to the Reference
Sequences table. You can now use the reference genome in a Planned Run.
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Import a custom reference sequence file

If you want to use a custom reference genome sequence in a Planned Run and data
analysis, you can import a custom reference file into the Torrent Suite™ Software from
your local storage or a remote server location.

IMPORTANT! First-time users should review custom reference file rules and
restrictions to avoid uploading errors. For more information, see “Guidelines for
importing custom reference sequence files“ on page 260.

1. Click  (Settings)4References.

2. Click Import Custom Reference.

3. In the Add New Reference Genome dialog box, do one of the following.

• Upload a FASTA file from your local storage.
a. Select the Upload File tab.
b. Click Select File.
c. Navigate to and select the file from your local storage, then click Open.

• Upload a FASTA file from a remote server.
a. Select the Install via URL tab.
b. In Reference URL, enter the file path to the reference file.

4. Complete the required information. This information is used in various report
outputs and in the Reference Sequences table.

Item Description

Short name
(Required)

Enter a recognizable short form of the genome name. Make
sure that the short name does not repeat with other reference
genome files. You can delete any reference genome that you do
not use to allow the short name to be used again for a new
reference genome file. Use any alphanumeric character and
underscore (_).

Description
(Required)

Enter a longer, more descriptive reference genome name. The
description usually includes the genus, species, version, and
other identifying reference genome information.
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Item Description

Version
(Required)

Enter the genome version number and the accession number,
if there is one (for example, "hg19", "gi|39933080|
NC_005296.1").

Notes
(Optional)

Use to record any notes about the reference genome.

5. Click Import Reference.
The reference genome and associated information is added to the Reference
Sequences table.

After the reference genome file is imported, you can view and edit the reference
genome information, or delete the reference genome file. For more information, see 
“View a reference sequence file“ on page 263. If you encounter any errors during file
upload, see “Troubleshooting file import/upload errors“ on page 385.

After you import a reference sequence file into Torrent Suite™ Software, you can view
the file properties and review the reference sequence in the FASTA format.

For instructions on how to import the file into Torrent Suite™ Software , see “Import
reference sequence files“ on page 260.

1. Click  (Settings)4References.

2. In the Reference Sequences screen, do one of the following to access the
reference sequence file properties screen.

• In the Reference Sequences table, in the Short Name column, click the
reference sequence file name.

• Click Import Preloaded Ion References, then click complete in the row of the
imported Ion reference file.

The file properties screen opens.

View a reference
sequence file
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3. Click the FASTA file link to view the FASTA format reference sequence in the
browser window.

After you import a reference sequence file into Torrent Suite™ Software, you can edit
the file properties.

To edit the reference sequence file properties, you must first import the file into
Torrent Suite™ Software. For more information, see “Import reference sequence
files“ on page 260.

1. Click  (Settings)4References.

2. In the Reference Sequences table, in the Short Name column, click the reference
sequence file name.
The file properties screen opens.

Edit reference
sequence file
properties
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3. In the file properties screen, edit the file properties. Only these file properties can
be edited.

Property Description

Description Description of the reference.

Version Version number or letter of the reference.

Notes Any meaningful details about the reference.

Enabled References are enabled by default. To disable a reference that is not
being used anymore, deselect Enabled.

You cannot edit Short Name. To change or reuse the reference sequence file short
name, click Delete Genome to delete the existing reference sequence file from
the Ion Torrent™ Server, then upload a new file.

4. Click Save.
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After you import a reference sequence file using Torrent Suite™ Software, you can
permanently delete the file from the Ion Torrent™ Server. Deleting a reference
sequence file is useful if you want to upload a new file using the same Short Name as
an existing file, or if you no longer require the reference for your Planned Runs.

IMPORTANT! Recovery of a deleted reference sequence is not possible.

1. Click  (Settings)4References.

2. In the Reference Sequences table, in the Short Name column, click the reference
sequence file name.

3. In the file properties screen, click Delete Genome4Yes, Delete It.

The reference is removed from the Reference Sequences table and is
permanently deleted from the Ion Torrent™ Server.

A reference sequence becomes obsolete and is listed in the Obsolete References
Sequences table after Torrent Suite™ Software is updated with a release that includes
a new TMAP index.

Torrent Suite™ Software automatically records the libraries that were installed before
the upgrade, then automatically creates the list of obsolete reference sequences.

Each list is different, depending on the reference sequences that you use.

Permanently
delete a reference
sequence file

Obsolete
reference
sequences
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Target regions and hotspots files

Target regions and hotspots Browser Extensible Data (BED) files supply chromosome
positions or regions as reference information during the analysis of a sequencing run.
These BED files, when applied to a reference sequence in a Planned Run, or in a
variantCaller plugin configuration, perform two functions:

• Target regions files narrow the analysis to your regions of interest, for example,
regions that are amplified with primer panels in targeted sequencing. When a
target regions file is selected in a Planned Run, the complete Torrent Suite™

Software analysis pipeline, including plugins, is restricted to the regions of the
reference sequence specified in that file. Target regions files use only BED file
format.

• Hotspots files instruct the variantCaller plugin to include loci known to be
frequently altered in its output files, including evidence for a variant and the
filtering thresholds that disqualify a variant candidate. A hotspots file affects only
the variantCaller plugin, not other parts of the analysis pipeline. A hotspots file is
usually a BED file, or it can be a Variant Call Format (VCF) file that is generated
from a BED file by Torrent Suite™ Software during a sequencing run.

Target regions and hotspot files are listed on screens that are accessed from the
Reference Sequences link. When a target regions or hotspots file is uploaded to
Torrent Suite™ Software, it is assigned a specific reference sequence, and is then
available for use when that reference sequence is selected during run planning.

• Target regions BED files provide an option to restrict analysis to regions of
interest. Do not specify a target regions BED file in the Plan step of the Planned
Run workflow if you want variant analysis to span an entire genome. Use the
whole-genome application with a reference sequence to support whole-genome
analysis.

• All regions that are included in the target regions BED file that you select are
analyzed. Before you upload your target regions BED file, follow the instructions
in “Modify a BED file“ on page 270 to delete lines representing regions
containing variants that you do not want to call.

• The BED file coordinates (for example: chr2 29443689 29443741) use zero-based
indexing and a half-open interval. The start position is included, and the range
extends up to, but not including, the end position.

• BED files that are used with Ion AmpliSeq™ panels define only the internal
segment, and do not include the primer sequence.

• A BED or VCF file is tied to a specific reference sequence. The coordinates in a
BED or VCF file must match coordinates and the coordinate sorting in the
reference sequence. Torrent Suite™ Software reference sequences are sorted alpha-
numerically (not by a chromosome sort). The BED files and VCF files that you use
with references must also use an alpha-numeric sort. If you upload your own
reference genome sequence, the BED and VCF files that you use with that
reference must be sorted by the same method as your reference file.

• The variantCaller plugin calls variant candidates at hotspot positions with higher
sensitivity than candidates at other positions. You can customize specific
variantCaller parameters separately for hotspot candidates.

• Torrent Suite™ Software accepts VCF files as hotspots files, but the VCF file must
be generated by the variantCaller plugin from a hotspots BED file.

Guidelines for
using target
regions and
hotspots files
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• Target regions and hotspots files for use with Ion AmpliSeq™ panels can be
downloaded with panel files from AmpliSeq.com.

• If you need Oncomine™ panel target regions and hotspots files, contact your local
Field Service Engineer.

You can upload target regions files for use with a specific reference sequence. After
target regions files are uploaded, the files are available when the related reference
sequence is selected for use in a Planned Run. When you select a target regions file in
run planning, the sequencing run results are restricted to the regions of the reference
sequence that is specified in the target regions file.

1. To view the target regions files that are available on the Ion Torrent™ Server, click
 (Settings)4References.

2. In the left navigation pane, click Target Regions.
Available target regions files are listed in the Target Regions table.

3. In Search, enter a search term, or select a target region from Reference to filter
the list.

4. Click a target regions file name to open a Target Regions Details screen that
displays information such as the number of targets, genes, covered bases,
description, and notes. Scroll to view original upload information.

File information Target Regions detail

Processed File The name of the file. Click to download the BED file to
view on your computer.

Reference The reference genome species.

Number of Targets The number of target regions included in the file.

Number of Genes The number of genes included in the target regions file.

Covered Bases The number of bases covered by the target regions file.

View and manage
target regions
files
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File information Target Regions detail

Description A short description of the file.

Notes (Optional) Additional information about the target
regions file.

Enabled Select the checkbox to enable use of the file in a
Planned Run.
Deselect the checkbox to prevent use of the file in a
Planned Run.

5. Enter any additional information if needed, then click Save Changes.

6. To delete a file from the Ion Torrent™ Server, click Delete.

You can upload hotspots files for use with a specific reference sequence. After hotspot
files are uploaded, the files are available when that reference sequence is selected for
use in a Planned Run or variantCaller plugin configuration. When you select a
hotspots file in run planning, the file instructs the variantCaller plugin to report on
loci, which is known to be frequently altered, in its output files.

1. To view the hotspots files that are available on the Ion Torrent™ Server, click
 (Settings)4References.

2. In the left navigation menu, click Hotspots. Available hotspots files are listed in
the Hotspots table.

3. In Search, enter a search term, or select a hotspot from Reference to filter the list.

View and manage
hotspots files
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4. Click the name of a hotspots file to open a Hotspots Details screen that displays
file information such as the number of loci, description, and notes. Scroll to view
the original upload information.

File information Hotspots detail

Processed File The file name. Click to download the BED file to view on
your computer.

Reference The reference genome species.

Number of Loci The number of hotspot alleles included in the hotspot
file.

Description A short description of the file.

Notes (Optional) Additional information about the hotspot file.

Enabled Select the checkbox to enable use of the file in a
Planned Run.
Deselect the checkbox to prevent use of the file in a
Planned Run.

5. Enter any additional information if needed, then click Save Changes.

6. To delete a file from Torrent Suite™ Software, click Delete.

You can modify an existing target regions or hotspots BED file, if necessary, to remove
regions from the file for which you do not want variants called.

If you modify a BED file, you must modify it before it is uploaded to Torrent Suite™

Software. A target regions or hotspots BED file cannot be modified after the file is
uploaded.

To modify a BED file:

1. Copy the BED file, then rename the new file in a way that reflects changes you
make to the regions being analyzed.

2. Open the BED file with a text editor.

3. Delete the lines for regions you do not want.

4. Save the file.

5. Upload the modified file as described in “Upload a target regions file“ or 
“Upload a hotspots file“.

Note:
· If the region (or regions) appears in both your target regions BED file and in

your hotspots BED file, you must delete the line for those regions from both
types of BED file.

· Do not modify a VCF hotspots file. We recommend that you upload it first to
convert it to a BED file before modifying it.

Modify a BED file
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You can upload a target regions BED file from your computer to Torrent Suite™

Software to use with a reference sequence.

Target regions files are only BED files. Supported file extensions are .bed, .zip,
and .bed.gz. During file upload, the software validates the BED file, then ensures that
the coordinate regions of the BED file are valid for the selected reference genome. The
new BED file is then available as an option when you create a Planned Run. The new
file appears in the Target Regions list in the Plan step of the Planned Run workflow
bar, and also appears in the Target Regions table in the References tab.

IMPORTANT! You must upload target regions files that match both the reference
sequence and the reference sequence version. The uploader cannot always detect
mismatch errors. It is your responsibility to avoid the following uploading errors:

· Uploading a BED file for a reference sequence of a different version (for example,
an hg18 BED with an hg19 reference).

· Uploading a BED file for a different species.
· Uploading a hotspots BED file as a target regions BED file.

1. Click  (Settings)4References, then click Target Regions in the left navigation
menu.

2. In the Target Regions screen, click Add Target Regions.

3. In the New Target Regions screen, click Select File, then navigate to the file to be
uploaded.

4. Select the reference sequence from the Reference list.

IMPORTANT!
· Be careful to select the correct reference sequence because the new target

regions file can be used only with this reference.
· The reference sequence must be uploaded and available for selection before a

target regions file can be uploaded.

5. (Optional) Add a description and notes.

6. Click Upload Target Regions File.
Wait while the file is validated. The status updates to Successfully Completed
after the upload finishes. Errors are reported in the Processing Log pane.

Upload a target
regions file
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For large files, validation can take several minutes. Refresh your browser to
check that validation is complete.

You can upload a hotspots file from your computer to Torrent Suite™ Software to use
with a reference sequence.

Hotspots files can be BED or VCF files. Supported file extensions
are .bed, .vcf.gz, .zip, .bed.gz, and .vcf.gz. During file upload, the software validates
the BED or VCF file, then ensures that the coordinate regions of the file are valid for
the selected reference sequence. The new BED file is then available as an option when
you create a Planned Run or configure the variantCaller plugin.

IMPORTANT! Upload BED or VCF files that match both the reference sequence and
the reference sequence version. The uploader cannot always detect mismatch errors. It
is your responsibility to avoid the following uploading errors:

· Uploading a BED or VCF file to a reference sequence of a different version (for
example, an hg18 BED file with an hg19 reference).

· Uploading a BED or VCF file for a different species.
· Uploading a target regions BED file as a hotspots BED file.
· Uploading a hotspots file listing loci not included in a target regions file.

Upload a hotspots
file
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1. Click  (Settings)4References, then click Hotspots in the left navigation menu.

2. In the Hotspots screen, click Add Hotspots.

3. In the New Hotspots screen, click Select File, then navigate to the file to be
uploaded.

4. Select the reference sequence from the Reference list.

IMPORTANT!
· Ensure that you select the correct reference sequence because the new hotspots
file can be used only with this reference.

· The reference sequence must be uploaded and available for selection before a
hotspots file can be uploaded.

5. (Optional) Add a description and notes.

6. Click Upload Hotspots File.
Wait while the file is validated. The status updates to Successfully Completed
after the upload finishes. Errors are reported in the Processing Log pane.
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Note:
· For large files, validation can take a few minutes. Refresh your browser to

check that validation is complete.
· If you selected a VCF file for upload, the software validates it and converts it

to a BED file.

The new file appears in the Hotspots list in the Plan step of the Planned Run
workflow bar, and also appears in the Hotspots table in the References tab.

The Browser Extensible Display (BED) format is used for both target regions files and
hotspot files. Torrent Suite™ Software also accepts the Variant Call Format (VCF) for
hotspot files.

BED files are text files with tab-separated fields.

Target regions BED file formats

Target regions files use a BED file format in 3-column, 4-column, 6-column, and
8-column formats.

BED file formats
and examples
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3-column target regions BED file format

The 3-column target regions BED file format is used when amplicon IDs and gene
names are not known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description

name String A unique design identifier.
Optional.

description String A description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245"

In a 3-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Field Type Description

chrom String (chars ≥ 0x20, other
than \tab)

The name of the
chromosome. This name
must be an exact match with
a chromosome in the
reference.

chromStart Unsigned int64 The starting position of the
feature (zero-based).

chromEnd Unsigned int64 The ending position of the
feature (not inclusive). Must
be greater than
chromStart.

Partial example of a 3-column target regions BED file:

chr9 133738312 133738379 
chr9 133747484 133747542 
chr9 133748242 133748296 
chr9 133748388 133748452 
chr9 133750331 133750405 
chr9 133738312 133738379 
chr9 133747484 133747542 
chr9 133748242 133748296 
chr9 133748388 133748452 
chr9 133750331 133750405 
chr14 105246407 105246502 
chr14 105246407 105246502 
chr14 105246407 105246502 
chr2 29432658 29432711
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4-column target regions BED file format

The 4-column target regions BED file format is used when gene names are not known
and some or all amplicon IDs are known.

The track line is optional. If present, it includes these tab-separated fields:

Field Type Description

name String A unique design identifier.
Optional.

description String A description of the design.
Optional.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245"

In a 4-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Field Type Description

chrom String (chars >= 0x20, other
than \tab)

The name of the
chromosome. This name
must be an exact match with
a chromosome in the
reference.

chromStart Unsigned int64 The starting position of the
feature (zero-based).

chromEnd Unsigned int64 The ending position of the
feature (not inclusive). Must
be greater than
chromStart.

AmpliconID String The amplicon ID. If missing,
the following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

Partial example of a 4-column target regions BED file:

chr9 133738312 133738379 amplID73150 
chr9 133747484 133747542 amplID73075 
chr9 133748242 133748296 amplID73104 
chr9 133748388 133748452 491413 
chr9 133750331 133750405 74743 
chr9 133738312 133738379 73150 
chr9 133747484 133747542 73075 
chr9 133748242 133748296 73104 
chr9 133748388 133748452 491413 
chr9 133750331 133750405 74743 
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chr14 105246407 105246502 329410 
chr2 29432658 29432711 34014

6-column target regions BED file format

The 6-column target regions BED file format is used when some or all of the gene
names are known. BED files that are generated by AmpliSeq.com use this 6-column
format.

The track line is required in a 6-column target regions BED file. The track line includes
these tab-separated fields:

Field Type Description

name
(Optional)

String A unique design identifier.

description
(Optional)

String A description of the design.

type
(Required)

String Must be bedDetail
(without quotes).

ionVersion String Introduced in the Torrent
Suite™ Software 4.0 release.

The following is an example track line:

track name="ASD270245" description="AmpliSeq Pool ASD270245" 
type=bedDetail

In a 6-column target regions BED file, the coordinates lines require the following tab-
separated fields:

Field Type Description

chrom String (chars ≥ 0x20, other
than \tab)

The name of the
chromosome. This name
must be an exact match with
a chromosome in the
reference.

chromStart Unsigned int64 The starting position of the
feature (zero-based).

chromEnd Unsigned int64 The ending position of the
feature (not inclusive). Must
be greater than chromStart.

AmpliconID String Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"
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Field Type Description

ID String A customer-specified ID. If
missing, set to '.'. This field
is not used.

GeneSymbol String The gene name. If missing,
set to '.'.

Partial example of a 6-column target regions BED file:

track name="ASD270249_v1" description="AmpliSeq Pool 
ASD270249" type=bedDetail 
chr9 133738312 133738379 AM73150 NM_005157 ABL1 
chr9 133747484 133747542 AM73075 NM_005157 ABL1 
chr9 133748242 133748296 AM73104 NM_005157 ABL1 
chr9 133748388 133748452 AM491413 NM_005157 ABL1 
chr9 133750331 133750405 74743 NM_005157 ABL1 
chr9 133738312 133738379 73150 NM_007313 ABL1 
chr9 133747484 133747542 73075 NM_007313 ABL1 
chr9 133748242 133748296 73104 NM_007313 ABL1 
chr9 133748388 133748452 491413 NM_007313 ABL1 
chr9 133750331 133750405 74743 NM_007313 ABL1 
chr14 105246407 105246502 329410 NM_001014431 AKT1 
chr14 105246407 105246502 329410 NM_001014432 AKT1 
chr14 105246407 105246502 329410 NM_005163 AKT1 
chr2 29432658 29432711 34014 NM_004304 ALK

8-column target regions BED file format

An 8-column target regions BED file format is for fusion panels.
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In an 8-column target regions BED file, the coordinates lines require the following tab-
separated fields. The format is similar to the 6-column target regions BED file, with
two additional columns. The additional columns are score and strand.

Field Type Description

chrom String (chars ≥ 0x20, other
than \tab)

The name of the
chromosome. This name
must be an exact match with
a chromosome in the
reference.

chromStart Unsigned int64 The starting position of the
feature (zero-based).

chromEnd Unsigned int64 The ending position of the
feature (not inclusive). Must
be greater than
chromStart.

AmpliconID String Amplicon ID. If missing, the
following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

ID String A customer-specified ID. If
missing, set to '.'. This field
is not used.

GeneSymbol String The gene name. If missing,
set to '.'.

score Unsigned int64 Score. If missing, set to "."

strand String (+ or -) Strand. If unknown, set to
"+".

BED files generated by Ion AmpliSeq™ Designer custom designs

The track line for BED files generated by Ion AmpliSeq™ Designer custom designs
follow the 6-column BED format, but with two additional fields. These additional
fields are not used by Torrent Suite™ Software.

Field Type Description

name String A unique design identifier.

description String A description of the design.

type String Must be bedDetail (without
quotes). Required.

ionVersion String Introduced in Torrent Suite™

Software 4.0. When set to
"4.0" or later, indicates that
the BED file supports the
Extended BED Detail format.
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Field Type Description

db String The UCSC Assembly ID.

reference String The Ion Torrent™ Server
reference ID. Present for Ion
AmpliSeq™ Designer 5.2 and
higher.

color String Code for color track in UCSC
Genome Browser (when
uploaded from 
AmpliSeq.com).

priority String Sets the order for color
track in UCSC Genome
Browser (when uploaded
from AmpliSeq.com).

Hotspots file format

The track line is required in a hotspots BED file.

The following is an example track line:

track name="ASD270245" description="HotSpots locations for 
AmpliSeq ASD270245" type=bedDetail db=hg38 reference=GRCh38.p2

The track line includes these tab-separated fields:

Field Type Description

track name
(Optional)

String A unique design identifier.

description
(Optional)

String A description of the design.

type
(Required)

String Must be bedDetail
(without quotes).

db
(Optional)

String The UCSC Assembly
identifier.

reference
(This field is optional for
hg19, and is required for
GRCh38.)

String The Ion Torrent™ Server
reference identifier.

In hotspots BED files, the coordinates lines require these tab-separated fields:
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Field Type Description

chrom String (chars >= 0x20, other
than \tab)

The name of the
chromosome. This name
must be an exact match with
a chromosome in the
reference.

chromStart Unsigned int64 The starting position of the
feature (zero-based).

chromEnd Unsigned int64 The ending position of the
feature (not inclusive). Must
be greater than
chromStart.

HotSpotName String The name is either the
COSMIC identifier, dbSNP
identifier, or is user-defined.
If missing, the following
string is used "chrom" + ":"
+ "chromStart" + "-" +
"chromEnd"

HotSpotAlleles String A string that describes the
variant using the following
format:
REF=reference_allele
;
OBS=observed_allele ;
ANCHOR=base_before_a
llele

AmpliconID String The Amplicon identifier. If
missing, the following string
is used "chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

HotSpotAlleles field

The HotSpotAlleles field in the hotspots file specifies the alleles that are involved
in variant calls, using this format:

REF= reference_allele; OBS= observed_allele
Examples:

• A TT insertion with 1-base prior at reference C: REF=;OBS=TT
• A TT deletion with 1-base prior at reference G: REF=TT;OBS=

Notes:
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• 6-column format
– The elements can be empty: REF=; or OBS=;. Empty means deletion.
– An additional element ANCHOR=base_before_allele can be provided for

backward compatibility, but is optional. In fact, it is recommended that the
ANCHOR key is NOT provided for Torrent Suite™ Software 4.2 or later.

– Insertion alleles should have the same start and end position, and that
position corresponds to a region between two bases. SNV, MNV, deletion,
and complex variants should correspond to the reference bases that are
spanned by the event.

– The REF and OBS should be on the forward genomic strand. There should be
one alternative allele per line.

8-column format
– The +/- strand notation in the hotspots file refers to the orientation of the Ion

AmpliSeq™ Designer design input sequence, not to the reference sequence.
REF and OBS alleles must always be reported on the forward strand of the
reference sequence.

– HotSpotAlleles are always reported based on the allele information from the
positive strand of the reference sequence. Even if the allele strand is negative,
the REF and OBS bases still report the alleles on the positive strand.

For example, if there is a hotspot either on the positive strand or on the negative
strand on a genomic coordinate, the strand information makes no difference as to
what is reported on the HotSpotAlleles column. The HotSpotAlleles column
always reports the alleles on the positive strand. In the following example, the
strands are different, but the reported alleles are always from the positive strand:
chr 143815007 43815009 ID1 0 - REF=TG;OBS=AA AMPL1
chr 143815007 43815009 ID2 0 + REF=TG;OBS=AA AMPL2

Partial example of a hotspots BED file

track name="HSMv12.1" description="AmpliSeq Pool HSMv12.1" 
type=bedDetail

chr1 43815007 43815009 COSM19193 REF=TG;OBS=AA AMPL495041 
chr1 43815008 43815009 COSM18918 REF=G;OBS=T AMPL495041 
chr1 115256527 115256528 COSM585 REF=T;OBS=A AMPL30014 
chr1 115256527 115256528 COSM586 REF=T;OBS=G AMPL30014 
chr1 115256527 115256529 COSM33693 REF=TT;OBS=CC AMPL30014 
chr1 115256527 115256529 COSM30646 REF=TT;OBS=CA AMPL30014 
chr1 115256527 115256530 COSM53223 REF=TTG;OBS=CTT AMPL30014 
chr1 115256528 115256529 COSM583 REF=T;OBS=A AMPL30014 
chr1 115256528 115256529 COSM584 REF=T;OBS=C AMPL30014 
chr1 115256528 115256529 COSM582 REF=T;OBS=G AMPL30014 
chr1 115256528 115256530 COSM12725 REF=TG;OBS=AA AMPL30014 
chr1 115256528 115256530 COSM579 REF=TG;OBS=CT AMPL30014

Note: The REF=;OBS= field is required, as is the track line.
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Extended BED Detail format

Ion AmpliSeq™ Designer 3.0 and later uses Extended BED Detail format for the
following fixed panels:

• CCP
• CFTR
• CHP v2
• Ion AmpliSeq™ Exome

New fixed panels that are introduced for Ion AmpliSeq™ Designer 3.0 and later also
follow this format. Other panels, and all panels from previous releases, do not use this
format.

The Extended BED Detail format contains two additional fields (at the end of each
line).

Name Values Description

Id Any string supplied by the
user or '.'

A user-supplied name or
identification for the region.

Description The key-value pairs
separated by semicolon, or
'.' if empty

Contains a '.' or one or more
of the following:

• GENE_ID=
• Pool=
• SUBMITTED_REGION

=
These key-value pairs are
described in the next table.

The following table lists the keys and describes the key-value pairs that are
supported.

Key Description

GENE_ID A gene symbol or comma-separated list of gene symbols. If no
gene symbol is available, this key is absent.

Example: GENE_ID=brca1
Example: GENE_ID=brca1, ret

Pool The Ion AmpliSeq™ Designer pool or pools containing this
amplicon.

Example: Pool=2
If an amplicon is present in multiple pools, the pools are
delimited with "," (comma), with the primary pool listed first. For
example, if an amplicon is present in pools 1 and 3, and 1 is the
primary pool, the entry is Pool=1,3.

Single-pool designs do not include the Pool= key-value pair.
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Key Description

SUBMITTED_REGION The region name provided during the Ion AmpliSeq™ Designer
design process. If a region name is not provided, this key is
absent.

Example: SUBMITTED_REGION=Q1
CNV_ID A gene symbol used to specify a copy number region for the cnv

pca algorithm. This takes precedence over the GENE_ID and
once CNV_ID can span multiple GENE_IDs.

CNV_HS A CNV region hotspot. This can be a value of either 0 or 1.

• 1 reports as a hotspot (HS) in the output VCF file from the
CNV PCA algorithm.

• 0 is not reported as HS.

The Extended BED Detail format requires a track line with both type=bedDetail
and ionVersion=4.0. The Torrent Suite™ Software BED validator treats the Id and
Descriptor fields as optional.

Examples from BED files in the Extended BED Detail format

This example shows the GENE_ID= and Pool= keys:

track name="4477685_CCP" description="Amplicon_Insert_4477685_CCP" type=bedDetail 
ionVersion=4.0 
chr1 2488068 2488201 242431688 . GENE_ID=TNFRSF14;Pool=2 
chr1 2489144 2489273 262048751 . GENE_ID=TNFRSF14;Pool=4 
chr1 2489772 2489907 241330530 . GENE_ID=TNFRSF14;Pool=1 
chr1 2491241 2491331 242158034 . GENE_ID=TNFRSF14;Pool=3

This example is from the CFTR designed.bed file:

track type=bedDetail ionVersion=4.0 name="CFTRexon0313_Designed" 
description="Amplicon_Insert_CFTRexon0313" 
chr7 117119916 117120070 CFTR_1.91108 . GENE_ID=CFTR;Pool=1;SUBMITTED_REGION=1,31 
chr7 117120062 117120193 CFTR_1.38466 . GENE_ID=CFTR;Pool=2;SUBMITTED_REGION=1 
chr7 117120186 117120304 AMPL244371551 . GENE_ID=CFTR;Pool=1;SUBMITTED_REGION=1,32

Merged Extended BED Detail format files

In the case of two overlapping records, those records are merged during upload into
Torrent Suite™ Software. An ampersand (&) is the delimiter between multiple values
in merged files.

Example 1

When these two GENE_ID fields appear in overlapping records:

GENE_ID=raf

GENE_ID=brca1

The merged GENE_ID field is:

GENE_ID=raf&brca1
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Example 2

When these two GENE_ID fields appear in overlapping records:

GENE_ID=raf

GENE_ID=brca1,ret

The merged GENE_ID field is:

GENE_ID=raf&brca1,ret

Score and strand fields in uploaded hotspot BED files

Uploaded BED files are converted to add score and strand columns, with the default
values 0 and +. You see these values in BED files that you download from Torrent
Suite™ Software:

track type=bedDetail name="BRCA1.BRCA2_HotSpots" 
description="BRCA_HOTSPOT_ALLELES" allowBlockSubstitutions=true 
chr13 32890649 32890650 COSM35423 0 + REF=G;OBS=A AMPL223487194 
chr13 32893206 32893207 COSM23930 0 + REF=T;OBS= AMPL223519297 
chr13 32893221 32893221 COSM23939 0 + REF=;OBS=CCAATGA AMPL223519297 
chr13 32893290 32893291 COSM172578 0 + REF=G;OBS=T AMPL223521074
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RNA fusions BED file formats and examples

The following information describes the target regions Browser Extensible Display
(BED) format used with Ion AmpliSeq™ RNA fusion designs. BED files are text files
with tab-separated fields.

Track line

The track line is required in the Target Regions BED file. The following is an example
track line:

track name="Fusions 2.6" description="AmpliSeq RNA" 
type=bedDetail ionversion="4.0"

The track line includes these tab-separated fields:

Field Type Description

name
(Optional)

String A unique design identifier.

description
(Optional)

String The description of the design.

type
(Required)

String Must be "bedDetail" (without quotes).

ionversion String Introduced in the Torrent Suite™ Software
4.0 (Ion AmpliSeq™ Designer 3.0 and higher
fixed panels).

When set to "4.0", indicates that the BED
file supports the Extended BED Detail
format..

Optional. This field relates to only the BED
file format version, not the version of panel
designs.

Columns

This format includes eight required columns that are separated by a tab (\t)
character.
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Field Type Description

chrom String (chars ≥ 0x20, other
than \tab)

The name of the
chromosome. This name
must be an exact match with
a chromosome in the
reference.

chromStart Unsigned int64 The starting position of the
feature (Insert Start not the
Amplicon Start). Must be
zero-based.

chromEnd Unsigned int64 The ending position of the
feature (not inclusive) (Insert
End not the Amplicon End).
Must be greater than
chromStart.

AmpliconID String The Amplicon ID. If missing,
the following string is used
"chrom" + ":" +
"chromStart" + "-" +
"chromEnd"

Score Unsigned int64 Score. If missing, set to '.'.
This field is not used.

Strand String (+ or -) Strand. If unknown, set to
'+'.

ID String A customer-specified ID. If
missing, set to '.'. This field
is not used.

Key-value pairs String Multiple attributes specified
as semicolon separated key-
value pairs. See below for
specific key-value pairs. All
of these KVPs are required
for fusions designs files, but
most of these are optional
for other White Glove
designs.

The genomic (hg19) coordinates provided in the key-value pairs must represent the
entire amplicon sequence. If you want to generate the fusions mapping reference
FASTA file from the BED file, all the information that is needed should be available in
the BED file.

The following key-value pairs are supported.
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Key Value Example

TYPE The type of the event.
Allowed values:

• Fusion
• CONTROL or

ExpressionContro
l

• Driver_Gene or
5p3pAssay

• GeneExpression
• RNA_Hotspot

TYPE=Fusion

FP_TRANSCRIPT_ID The transcript ID for the 5′
gene partner.

This key value pair is only
for fusion type targets.

FP_TRANSCRIPT_ID=ENS
G00000156735

TP_TRANSCRIPT_ID The transcript ID for the 3′
gene partner. This field is
absent for CONTROL type
amplicons.

This key value pair is only
for fusion type targets.

TP_TRANSCRIPT_ID=ENS
G00000077782

BREAKPOINT The position in the sequence
for the breakpoint.
Applicable to only fusion
type amplicons. This
position is number of bases
from the Insert start, not the
Amplicon Start.

BREAKPOINT=56

FP_GENE_ID The name of the 5′ gene
partner in the fusion.

This key value pair is only
for fusion type targets.

FP_GENE_ID=BAG4

FP_GENE_STRAND The strand for the 5′ gene
partner. Allowed values are
'+' and '-'.

This key value pair is only
for fusion type targets.

FP_GENE_STRAND=+

FP_EXON_NUMBER The exon number in the 5′
gene. Use comma-
separated values if the
amplicon spans multiple
exons.

This key value pair is only
for fusion type targets.

FP_EXON_NUMBER=2
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Key Value Example

TP_GENE_ID The name of the 3′ gene
partner in the fusion. This
field is absent for CONTROL
type amplicons.

This key value pair is only
for fusion type targets.

TP_GENE_ID=FGFR1

TP_GENE_STRAND The strand for the 3′ gene
partner. Allowed values are
'+' and '-'. This field is
absent for CONTROL type
amplicons.

This key value pair is only
for fusion type targets.

TP_GENE_STRAND=-

TP_EXON_NUMBER The Exon number in the 3′
gene. Use comma-
separated values if the
amplicon spans multiple
exons.

This key value pair is only
for fusion type targets.

TP_EXON_NUMBER=6

FP_CHROM The chromosome of the 5′
gene.

This key value pair is only
for fusion type targets.

FP_CHROM=chr8

FP_START The start position for the 5′
segments. Use comma-
separated values if there are
multiple segment Starts.

This key value pair is only
for fusion type targets.

FP_START=38050257

FP_END The end position for the 5′
segments. Use comma-
separated values if there are
multiple segment Ends.

This key value pair is only
for fusion type targets.

FP_END=38050313

TP_CHROM The chromosome of the 3′
gene. This field is absent for
CONTROL type amplicons.

This key value pair is only
for fusion type targets.

TP_CHROM=chr8
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Key Value Example

TP_START The start position for the 3′
segments. Use comma-
separated values if there are
multiple segment Starts.

This key value pair is only
for fusion type targets.

TP_START=38283673

TP_END The end position for the 3′
segments. Use comma-
separated values if there are
multiple segment Ends.

jTP_END=38283763

HOTSPOT_POSITION The genomic coordinate of
the hotspot snp covered by
the amplicon. Use comma-
separated values if multiple
hotspots are covered by the
amplicon.

HOTSPOT_POSITION=382
83769

CHROM The chromosome name of
the target region. This key is
for all non-fusion type
targets. For fusion targets,
we have FP_CHROM and
TP_CHROM.

CHROM=chr8

GENE_ID The name of the gene for
nonfusion type targets. For
fusion targets, we have
FP_GENE_ID and
TP_GENE_ID.

GENE_ID=LMNA

TRANSCRIPT_ID The transcript Id for
nonfusion type targets. For
fusion targets, we have
FP_TRANSCRIPT_ID and
TP_TRANSCRIPT_ID.

TRANSCRIPT_ID=ENST00
000389048

GENE_STRAND The strand of the gene. This
key is for all nonfusion type
targets. For fusion targets,
we have FP_GENE_STRAND
and TP_GENE_STRAND.

GENE_STRAND=+

EXON_NUM The exon number(s) in the
gene. Use comma-
separated values if the
amplicon spans multiple
exons. For fusion targets, we
have FP_EXON_NUM and
TP_EXON_NUM.

EXON_NUM=3,4
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Key Value Example

START The start position of the
target segment. Use
comma-separated values if
there are multiple segment
starts in genomic space.
This key is for all nonfusion
type targets. For fusion
targets, we have FP_START
and TP_START.

START=53586113,53585
786

END The end position of the
target segment. Use
comma-separated values if
there are multiple segments
in genomic space. This key
is for all nonfusion type
targets. For fusion targets,
we have FP_END and
TP_END.

END=53586228,5358580
3

MIN_READ_COUNT The minimum number of
reads needed to call the
particular target as
present/absent. This value is
optional and if present,
overrides the universal
minimum read count
threshold (for example, 20).

Example usage—For EGFR
deletion assay, we would use
a higher read count
threshold (greater than 20).

MIN_READ_COUNT=100

Example BED file entries

BAG4-FGFR1.B2F6 1 156 AMP1 . + . TYPE=Fusion;BREAKPOINT=36;
FP_GENE_ID=BAG4;
FP_ GENE_STRAND=+;
FP_EXON_NUM=2;
TP_GENE_ID=FGFR1;
TP_GENE_STRAND=-;
TP_EXON_NUM=6;
FP_CHROM=chr8;
FP_START=3805025 7;
FP_END=38050313;
TP_CHROM=chr8;
TP_START=38283673;
TP_END=38283763;
FP_TRANSCRIPT_ID=ENSG00000156735;
TP_TRANSCRIPT_ID=ENSG00000077782 ITGB7.ENCTRL.E14E15 1 132  
AMP99 . + . TYPE=CONTROL;
FP_GENE_ ID=ITGB7;
FP_CHROM=chr12;
FP_EXON_NUM=14,15;
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FP_START=53586113,53585786;
FP_END=53586228,53585803;
FP_GENE_STRA ND=-;
FP_TRANSCRIPT_ID=ENSG00000139626

Test fragments

Test fragments are known genetic sequences that are used to measure the quality of
your chip loading and sequencing run. You can include test fragments in your
sequencing run and, after the run completes, review the Details section of the run
report to evaluate the quality of your loading and sequencing run. For example, TF_1
is a single known sequence fragment that is added along with the customer library at
the beginning of templating and is processed through sequencing. TF_C is already
templated on ISPs and added after enrichment so goes through the loading and
sequencing portions of the workflow.

Test fragments are displayed when there are at least 500 high-quality reads, with an
85% match against the appropriate template in the Test Fragment list.

You can view existing test fragment nucleotide sequences used for quality metrics.

Torrent Suite™ Software provides six test fragments by default: TF_A, TF_B, TF_C,
TF_D, TF_G, and TF_1.

1. Click  (Settings)4 References, then click Test Fragments in the left navigation
menu.
The Test Fragments table appears.

2. In the Test Fragments table, in the Name column, click a test fragment name to
view the test fragment details such as the complete test fragment sequence.

3. (Optional) In the Edit Test Fragment dialog box, add comments about the test
fragment.

You can add custom test fragments to Torrent Suite™ Software.

1. Click  (Settings)4References, then click Test Fragments in the left navigation
menu.

2. In the Test Fragments screen, click Add Test Fragment.

View test
fragment details

Add a custom test
fragment
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3. In the Add New Test Fragment dialog box, complete the following information.

Option Description

Name Enter a unique name for your test fragment.

Key Enter the test fragment key using only the uppercase letters A, T, C, and
G.

Sequence Enter the sequence using only the uppercase letters A, T, C, and G.

Enabled Select to enable.

Comments (Optional) Enter any comments about the test fragment.

If you enter an invalid character or duplicate test fragment, you can not save
your changes.

4. Click Save.

Your new test fragment and its details are displayed in the test fragment table.

You can edit or delete custom test fragments in Torrent Suite™ Software.

WARNING! Do not modify the test fragment sequences for the test fragments
that are supplied by Torrent Suite™ Software: TF_A, TF_B, TF_C, TF_D, TF_G,
and TF_1. For example, TF_1 is used to assess the quality of bead loading. TF_C
is used to assess the quality of a templating and library matching.

On your own test fragment (not test fragments supplied by Torrent Suite™ Software),
you can make the following edits:

• Change the test fragment name, key, or comments.
• Change the test fragment nucleotide sequence.
• Change whether or not the test fragment is enabled.

1. Click  (Settings)4References, then click Test Fragments in the left navigation
menu.

2. In the Test Fragments table, click a link in the Name column.

3. To manage the test fragments, in the Edit Test Fragment dialog box, do one of
the following:

• Edit Name, Key, Sequence, or Comments, or select/deselect the Enabled
checkbox, then click Save. Changes appear in the Test Fragments table.

• Click Delete to permanently remove the test fragment from Torrent Suite™

Software. Deleted test fragments are removed from the Test Fragments table.

Barcodes and barcode sets

Torrent Suite™ Software supports sequencing runs in which multiple samples can be
processed, or multiplexed. A DNA barcode adapter molecule is used to tag a sample
library when it is prepared. The sample is then identified and tracked based on the
barcode.

Edit or delete a
custom test
fragment
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Barcode adapter sets are used to associate multiple adapter barcodes with each
individual sample when Planned Runs are set up, or when manual runs of Torrent
Suite™ Software plugins are configured. For more information, see “Plan step in the
workflow bar“ on page 54 and “Run a plugin manually from the sequencing run
report“ on page 141.

During a sequencing run that uses barcodes, Torrent Suite™ Software generates output
files with reads that are associated with the barcodes. The barcoded reads are aligned
against the reference genome, and results are stored in BAM and BAM index (BAI)
files for each barcode. Reads that cannot be classified as into one of the barcodes in the
designated set are grouped into a no-match group; alignment against the reference is
also performed on the no-match group.

Alignment metrics for each barcoded read are available in the run reports for
completed sequencing runs. For more information, see “Output files“ on page 118.

A sequencing run on the Ion PGM™, Ion Proton™, Ion S5™, and Ion GeneStudio™ S5
Systems that uses barcodes requires a sample preparation kit that includes a barcode
set or kit, such as the Ion Xpress™ barcode set or Ion Torrent™ Dual Barcode Kit 1–96.
Torrent Suite™ Software includes barcode sets for the latest available barcode kits.

You can create custom sets of barcode adapters with comma-separated value (CSV)
files, then upload these files onto the Ion Torrent™ Server as barcode sets for use
during sequencing runs. To create the custom barcode set, you can download a
sample DNA barcode set CSV file or an existing DNA barcode set CSV file, customize
the DNA barcode set in the file, and import the custom DNA barcode set to the Ion
Torrent™ Server.

You can also transfer DNA barcode sets between two different Ion Torrent™ Servers.

IMPORTANT! The creation of custom barcode sets is for advanced users only. For
help with creating custom barcode sets, contact your local Field Service Engineer.

You can view barcode ID, barcode and adapter sequences, notes, and barcode type for
individual barcodes in a barcode set.

1. Click  (Settings)4References, then click Barcode Sets in the left navigation
menu.

2. In the Barcode Sets table in the Name column, click the barcode name.
A table appears listing all the individual barcode IDs within the barcode set and
their associated information.

3. Click any column header to sort the display of that column.

To edit the existing barcode set, download the barcode set CSV file, edit the file, then
import the revised CSV file into Torrent Suite™ Software. For more information, see 
“Download a DNA barcode set CSV file“ on page 295.

View a DNA
barcode sequence
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You can download a DNA barcode set CSV file and save it on your local storage. Use
this feature to transfer DNA barcode sets between two different Ion Torrent™ Servers.
Alternatively, you can download an existing DNA barcode set CSV file, customize the
DNA barcode set, then import the new custom DNA barcode set onto your Ion
Torrent™ Server.

1. Click  (Settings)4References, then click Barcode Sets in the left navigation
menu.

2. In the Barcode Sets table, in the Action column, click  (Actions)4Download.
A CSV file containing DNA barcode information is downloaded.

Save the CSV file to your local storage. You can now transfer this file to another Ion
Torrent™ Server or edit the file and import the new custom DNA barcode set into
Torrent Suite™ Software. For more information, see “Add a custom DNA barcode
set“ on page 295.

You can create custom DNA barcode sets and add them to Torrent Suite™ Software for
use in Planned Runs. To add a custom barcode set, you must generate a Comma-
Separated Value (CSV), save the file to your local storage, then import the file into
Torrent Suite™ Software.

All custom DNA barcode set files must have a .csv extension.

1. Click  (Settings)4References, then click Barcode Sets in the left navigation
menu.
The Barcode Sets table lists all the available custom and system DNA barcode
sets.

2. (Optional) Create a custom DNA barcode set CSV file using an existing DNA
barcode set.

a. In the row of the existing DNA barcode set, In the Action column, click 
(Actions)4Download.
A CSV file is automatically downloaded to your computer.

b. Edit the CSV file as described in “DNA barcode set CSV file setup“ on
page 296, then save it to your local storage.

3. In the Barcode Sets screen, click Add new DNA Barcodes.

4. In the Add New DNA Barcodes dialog box, in Barcode Set Name, enter a
descriptive name for the custom DNA barcode set.

5. (Optional) Create a custom DNA barcode set CSV file using the example CSV file.
a. Click Download the example file.

A CSV file is automatically downloaded to your computer.

b. For each individual barcode in the barcode set, enter the information in each
column as described in “DNA barcode set CSV file setup“ on page 296.

c. Save the CSV file to your local storage.

Download a DNA
barcode set CSV
file

Add a custom DNA
barcode set
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6. Click Choose File, select a DNA barcode set CSV file from your local storage,
then click Open.

7. Click Upload File.
The custom DNA barcode set is added to the DNA Barcodes table in the Barcode
Sets screen, and is now available to be used in a Planned Run.

DNA barcode set CSV file setup

Each row in the CSV file contains information for an individual barcode in the
barcode set.

Column name Type Description

index Integer A unique index for an individual barcode (for
example, 1, 2, 3,...)

Only numerical characters are accepted.

id_str String A unique name for an individual barcode entry.
Typically the name of the barcode kit followed by a
3′– to 4′– digit unique identifier, such as
IonXpress_001 or IonCode_0101.

sequence
(Required)

String The 5′– barcode sequence.

Upper‑case G, C, A, and T are allowed.

adapter String The portion of the 5′– barcode adapter not used to
identify this barcode. Often referred to as the "stuffer
sequence".

Upper‑case G, C, A, and T are allowed.

annotation -- Use for any barcode-specific notes.

end_sequence String The 3′– barcode sequence.

IMPORTANT! This sequence is required for
libraries that were prepared using dual barcode
technology.

Upper‑case G, C, A, and T are allowed.

end_adapter String The portion of the 3′– barcode adapter not used to
identify this barcode. Often referred to as the "stuffer
sequence".

This sequence is available only for libraries that were
prepared using dual barcode technology.

Upper‑case G, C, A, and T are allowed.
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After you import a custom DNA barcode set into Torrent Suite™ Software, if you no
longer want to use the set in your Planned Runs, you can delete it from your Ion
Torrent™ Server.

IMPORTANT! Do not delete the any system barcode set.

1. Click  (Settings)4References, then click Barcode Sets in the left navigation
menu.

2. In the Barcodes table, in the row of the barcode set to be deleted, click 
(Actions)4Delete.

3. In the Confirm Delete Barcode Set dialog box, click Delete Barcode Set.

4. Click Yes, Delete! to confirm.
The DNA barcode set is permanently deleted from your Ion Torrent™ Server.

Upload history

Upload History is a list of the recent uploads of compressed file directories from 
AmpliSeq.com, target regions files, and hotspots files.

The following information is displayed.

Delete a custom
DNA barcode set
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Column Description

Uploaded File The file name of the uploaded file.

Type Indicates whether the file is a target
regions, hotspots, or ZIP file.

Date The date that the file was uploaded.

Status A report of whether the file was
successfully uploaded.

Any errors that occur during upload are
shown in this column.
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Data management

■ View disk usage parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299

■ View category statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300

■ View active data management jobs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300

■ Search for run reports with disk usage status . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302

■ Keep run report data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302

■ Import data for data transfers or restoration . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303

■ View the data management actions log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303

Use the Data tab to view information about completed runs. You can also import data
for data transfers or restoration.

Data management actions to archive, export, or delete files require administrator
rights, except for import; a regular user can import or restore data back to a local
drive.

View disk usage parameters

In the Data tab, click Data Management, then scroll to the Disk Usage section.

Parameters in the Disk Usage section.

Parameter Definition

Keep File space devoted to files that are to be kept.

Used File space being currently used by data files.

Free Space available for storing data files.

Threshold I Threshold above which intermediate files are deleted or archived,
based on the automatic configuration settings.

Threshold S Threshold above which signal processing input files are deleted or
archived, based on the automatic configuration settings.

Threshold B Threshold above which basecaller input files are deleted or
archived, based on the automatic configuration settings.

Threshold O Threshold above which output files are deleted or archived, based
on the automatic configuration settings.

For details regarding automatic deletion and archive creation, see “Archive or delete
data automatically“ on page 346.
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View category statistics

In the Data tab, click Data Management, then scroll to the Category Statistics section.

Category statistics in the Category Statistics section.

Parameter Definition

File Category Group File type. For details, see “Ion instrument data types“ on page 345.

Total The total number of data sets in each file category.

Keep The number of data sets in each file category that are exempt from
data management actions.

Archived The number of data sets in each file category that have been
removed from your Ion Torrent™ Server by data management
archival.

Deleted The number of data sets in each file category that have been
removed from your Ion Torrent™ Server by data management
deletion.

In Process The data sets that are currently archiving/deleting/importing.

Error Error column displays the count of file categories that are
currently in an error state.
If a data management action is rerun on one of these file
categories and completes successfully, then that file category no
longer appears in the error count.

Disk Usage GB used by each file category.

View active data management jobs

You can view runs that are in progress on the Torrent Server.

1. Click the Data tab, click Data Management, then scroll to the Active Data
Management Jobs section.
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2. (Optional) click a report to see the status of that report.

Details about active data management jobs.

Parameter Definition

Started On The start date and time of the job.

State The status of the job or file.

Report Mame The identifier of job.

Category Identifies the file as one of the following file types.

• Signal processing input—required input files for signal
processing.

• Basecalling input—required input files for base calling.

• Output files—files for data processing.

• Intermediate files—files used for debugging.

Size The file size, in MB, of the report.

Destination The folder location for archive or export action on the report.

User The user who started the data management action. For auto-
actions, "dm-agent" is the user.

Comment Text box for notes.

Monitor the Disk Space Management section for messages that require administrator
action.

Error message Action

Backup drive is full or missing Replace the backup drive.

Error Check the file /var/log/ion/
data_management.log for information
regarding the specific error condition. If
appropriate, report the error to Ion
technical support.

Torrent Suite™ Software performance is affected when a disk partition is more than
95% full. When a Ion Torrent™ Server or a mounted storage device reaches 95% full
(and again at 99%), a warning is displayed at the top of the Torrent Suite™ Software
screen.

*** CRITICAL! /results/: Partition is getting very full - 95% 
***

Error messages

Disk full message
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Search for run reports with disk usage status

You can find run reports with searches that are based on disk usage status, such as
whether the data type is archived, or is stored in a local directory. You can also use
other search criteria, including name and report date.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Enter a search term or select for the following criteria:

• Search names
• Report date
• File type settings that are configured as Keep, are stored in the Local

directory, Archived, Deleted, In-process, or contain an Error for each file
type:

– SigProc (Signal processing)
– Basecalling (Basecalling input)
– Output
– Intermediate

3. After you select the filters, click Go.

Run reports that match the criteria that you use in the search are listed in the Disk
Space Management table.

Keep run report data

You can prevent data from being deleted for individual run reports by applying the
Keep attribute to the types of files that are associated with the run report that were
created during the run. These file types are:

• Signal processing input files
• Basecalling input files
• Output files
• Intermediate files

If the Keep is applied to a data file, the data file can not be deleted by any user.
Instead, an error occurs if any user tries to confirm deletion of run report data.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Find the report, then select the checkbox under the Keep column that appears on
the left of each file category in that row.
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Import data for data transfers or restoration

You can import data to a Ion Torrent™ Server from a mounted storage drive such as an
external server or a USB drive. The import function can be used to transfer data
between servers or restore data that has been archived.

Data can be imported only from storage drives that have been mounted on your Ion
Torrent™ Server. For information about mounting a storage drive, see “Increase file
storage and available disk space“ on page 351.

The Import function can retrieve only the data files that were previously exported or
archived. For example, if you try to import files from an archive that does not include
signal processing input or basecalling input files, these files are not retrieved.

Note:
· Exported and archived files on a mounted drive can be viewed and analyzed

directly in Torrent Suite™ Software under Completed Runs & Reports. If you
unmount the storage device, the data is no longer available. Import files before
unmounting a drive to continue using them.

· If you import data that has been previously archived, the original archive remains.
After an import, data exists in two locations. The data is copied to Ion Torrent™

Server and remains in the original archive location. If you later delete the file
manually, the imported files remain in the archive.

1. Under the Data tab, click Data Management.

2. In the Data Import section, click Import.

3. Select a mounted Archive Directory, or click Browse to navigate to a particular
subdirectory, then click Select.

4. Use the checkboxes to select the file categories that you want to import, then click
Import.

Imported files appear as standard data files under Completed Runs & Reports. The
State of the data files on the server is Local.

View the data management actions log

You can view a log for each run report that describes each change that is made to data
management settings.

1. In the Data tab, click Data Management.

2. Scroll to the Disk Space Management section.

3. Find the report for which you want to view the data management actions log.
For details about how to search for a run in the Disk Space Management section,
see “Search for run reports with disk usage status“ on page 302.
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4. Click  (Actions)4View Log.
A new screen containing chronological list of actions that are taken for this run
report opens. The date of the action, name of the user, and any comments are
displayed.

5. Click Close to return to the Data Management screen.
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Supported software modules

■ Analysis pipeline overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305

■ BaseCaller module and barcode classification overview . . . . . . . . . . . . . . . . . . 306

■ TMAP modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 320

Torrent Suite™ Software supports additional software modules in the analysis
pipeline. These are the Signal Processing module, the BaseCaller module, and the
TMAP modules.

Analysis pipeline overview

The following depicts and describes the beginning steps of the Torrent Suite™

Software analysis pipeline.

13
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Steps:

1. The sequencing instrument generates DAT files of raw traces of electrical signals.
2. The signal processing step converts the raw traces into a single number per flow

per well, in the 1.WELLS file.
3. The BaseCaller module converts the 1.WELLS file information into a sequence of

bases, and writes the sequence into an unaligned BAM file.
4. The BAM file is passed to the TMAP module for alignment.

The signal processing step also marks several types of low-quality reads:
• Polyclonal reads (reads with two template beads instead of one).
• Reads with high signal processing residual (indicating an ambiguous signal

value).
• Reads that do not contain a valid library key.

The signal processing step marks these problematic reads but does not remove them.

BaseCaller module and barcode classification overview

The BaseCaller module controls barcode classification and filtering and trimming.

In addition to creating a sequence of bases from the 1.WELLS file information, the
BaseCaller module also performs read filtering and read trimming.

Notes on read filtering
• Filters out low-quality reads that were marked during signal processing.
• Filters out reads that fail basecalling filters.
• The removed reads do not appear in the BAM file. The BaseCaller module keeps

counts of these reads but there is no record of specific reads that are filtered out.

Notes on read trimming
• Removes specific bases from the read for quality reasons.
• The read appears in the BAM file.
• The removed bases do not appear in the BAM file.

The BaseCaller module performs these functions:

1. Removes low-quality reads that were marked during the signal processing step.
2. Performs base calling:

a. From the signal values, creates the sequence of bases.
b. Estimates the base quality value for each base.

3. Performs 5′ barcode classification:

a. Assigns each read to a barcode.
b. Trims the barcode sequence away if the parameter --trim-barcodes=on

is specified. The default is 'on'.
4. Trims 5′ PCR handle.
5. Trims 5' unique molecular tag.

Overview of the
BaseCaller
module
functionality
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6. Trims extra bases at the 5' end. Trimming is controlled by the parameter --
extra-trim-left. The default is 0, meaning no extra trimming.

7. Filters out reads that are too short. Filtering is controlled by the parameters--
min-read-length and -- trim-min-read-len.

8. Filters out reads that do not have the correct library key. Filtering is turned off by
the parameter --keypass-filter.

9. Trims the P1 adapter at the 3' end.
10. Classifies and trims the 3′ barcode.
11. Trims the 3′ PCR handle.
12. Trims the 3’ unique molecular tag.
13. Trims extra bases on the 3’ end. Trimming is controlled by the parameter --

extra-trim-right . The default is 0, meaning no extra trimming.
14. Performs quality trimming. Trimming is affected by the parameters --trim-

qual-window-size and -- trim-qual-cutoff.

The BaseCaller module classifies and trims read elements from the outside inwards to
obtain the query sequence. If an outer element cannot be identified, the BaseCaller
module does not attempt to identify and trim an inner one. If trimming the barcode is
disabled using the -trim-barcodes parameter, PCR handles, UMTs, or extra-bases
will not be trimmed. Read elements on the 5' end will only be trimmed if the P1
adapter was found.

Notes about quality trimming
• The purpose of quality trimming is to identify where quality problems start at the

end of a read. We try to identify when bases fall below a quality threshold and
trim both of those bases and a bit before those bases.

• The parameter --trim-qual-window-size sets the window size for quality
trimming. The algorithm slides through the sequence of bases and, each time the
window shifts, computes the mean Base QV value for all bases in the window.

• If the mean Base QV value for all bases in the window falls below a threshold (set
by the parameter --trim-qual-cutoff where the default 16), then trims all
bases from the center of the window at that time to the 5' end.

Notes about barcode classification and barcode filtering

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole
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Ion Torrent™ BAM files follow the conventions of the SAM/BAM Format Specification
Working Group. SAM stands for Sequence Alignment/Map.

The following highlights specific Ion Torrent™ conventions and the meaning of
custom tags.

• Run ID: Every TS analysis assigns a run ID, a 5-character string consisting of
upper case letters and numbers. A reanalysis of a specific run assigns a different
run ID. Example: 0JU8V.

• Read Group ID: For non-barcoded runs the read group ID is equal to the run ID.
For barcoded runs it is a combination of the run ID and the barcode name, which
is separated by a dot. Example: 0JU8V.IonXpress_001.

• Key Sequence (KS): For non-barcoded runs, the Key Sequence tag is the Ion
Torrent™ library key (TCAG). For barcoded runs the KS tag entry includes the
barcode sequence and the barcode adapter sequence if barcode trimming is
enabled.

• Reverse Key Sequence (sk): For dual-barcoded runs, the Reverse Key Sequence
tag includes the end barcode adapter sequence and the end barcode sequence.

• SAM record (read) names: Read names are a combination of the run ID and the
chip coordinates of the well that produced the read. The coordinate values are 5-
digit numbers and are given in the order row and the column, which is separated
by a colon. Example: 0JU8V:01308:00107.

• BAM header comment lines (CO): Comment lines in the BAM header are used to
store base calibration information, or information about the 3' adapter sequences.

Ion Torrent™ technology uses a collection of custom tags to store sequencing and
alignment information useful for downstream processing. In general, custom BAM
tags starting with Z or Y are written by the BaseCaller module, and BAM tags starting
with X stem from TMAP. As a consequence, tags starting with Z or Y are present both
in aligned and unaligned BAM files, whereas tags starting with X appear only in
aligned BAM files.

BAM tag Type Description

XA Z The algorithm that produced this mapping and from what
stage. The format is the algorithm name and the zero-
based stage (separated by a dash).

XM i The target length, that is, the number of reference bases
spanned by the alignment.

XS i The alignment score of the next-best suboptimal mapping.

ZA i The number of library insert bases, where the library
insert is defined as the sequence after the 5' trimmed
region (sequence in tags KS, ZK, ZT, ZE), and before the 3'
trimmed region (sequence belonging to the 3' adapter, and
the content of the tags SK, YK, YT, YE). Present only if a 3'
adapter was found.

ZB i The number of overlapping adapter bases. Present only if a
3' adapter was found.)

Ion Torrent™ BAM
format

Custom BAM
recorder tags
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BAM tag Type Description

ZC B:i A vector of the following four values (present only if a 3'
adapter was found):

• Field 1: The zero-based flow during which the first
base of the adapter was incorporated (same as ZG).

• Field 2: The zero-based flow corresponding to the last
insert base.

• Field 3: Length of the last insert homopolymer.

• Field 4: Zero-based index of adapter type found.

ZF i The zero-indexed flow position corresponding to the first
template base after 5' trimmed region.

ZG i The zero-based flow during which the first base of the
adapter was incorporated. (Present only if a 3' adapter was
found.)

ZM B:s Normalized signals, which include phasing effects. Stored
as floor(256*value).

ZP B:f The estimated phase parameters for the read. The values
are stored in the order CF (carry forward), IE (incomplete
extension), and DR (droop).

ZT Z The trimmed 5’ unique molecular tag sequence. Written
only if a tag was trimmed.

YT Z The trimmed 3’ unique molecular tag sequence. Written
only if a tag was trimmed.

ZE Z The 5’ trimmed sequence removed by the extra-trim-
left command. Written only if a sequence was trimmed.

YE Z The 3’ trimmed sequence removed by the extra-trim-
right command. Written only if a sequence was trimmed.

ZK Z The trimmed 3' portion of read group specific identifiers
that can vary within a read group. Written only if a tag was
trimmed.

YK Z The trimmed 3' portion of read group specific identifiers
that can vary within a read group. Written only if a
sequence was trimmed.

The following select arguments are used with the BaseCaller module.

About BaseCaller module parameters

BaseCaller module parameters are provided to reanalyze a completed run. The
default BaseCaller module parameters are tuned for Ion Torrent™ sequencing data. In
most cases, you do not need to modify these settings.

Modifying these parameters is recommended for advanced users only. If you need to
use a custom barcode set, contact your Field Service Engineer for assistance. Correct
parameter settings require knowledge of the barcodes distances in signal space. The

BaseCaller
module
arguments
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BaseCaller module parameter defaults are optimized for the Ion Xpress™ barcode set,
and likely are not correct for a custom barcode set.

When you reanalyze a run, other parameters are also listed in the BaseCaller
arguments field. These parameters are for internal use; do not change or remove these
fields.

Note: Barcode classification is the process by which reads are assigned to one of the
barcodes present in one analysis run. Correct barcode classification is important
because a classification error results in a read being assigned to the wrong barcode,
which in turn leads to the read being analyzed as belonging to a wrong sample.

Barcode classification determines which barcode group a read is assigned to. Barcode
classification is done for each read immediately after base calling.

Barcode filtering determines if a specific barcode is included in the run report or is
filtered out. Barcode filtering works on the barcode groups as a whole.

Barcode classification parameters

The more common BaseCaller module parameters relating to barcode classification
are listed and described in the following table. All parameters listed in this table are
barcode classification parameters.

Parameter Default Description

--barcode-
cutoff

1.0

(float)

The maximum distance allowed in barcode matches.
A threshold that sets the stringency for barcode
matches. Lower values require more exact matches
when assigning reads to barcodes. Higher values
allow less exact matches.

Reads that have a distance greater than this value
are counted as barcode no-matches.

--barcode-
mode

2

(integer)

The barcode mode.

• 0—Classification based on exact barcode base
match.

• 1—A barcode is scored by comparing each read
sequence to each barcode sequence in a flow
space alignment. Errors in each flow are
summed over the length of the barcode flows.
Then any barcode with a number of errors equal
to or less than the --barcode-cutoff value
can be considered, and the barcode with the
fewest errors with respect to the input sequence
is the matching barcode. (The default in 4.0,
known as hard decision classification.)

• 2—The barcode classification is based on signal
information, specifically on the squared
distance between the measured signal and the
predicted barcode signal. (The default in 4.4,
known as soft decision classification.)
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Parameter Default Description

--barcode-
separation

2.5

(float)

This setting controls how much ambiguity in barcode
assignment you want to tolerate, by investigating the
distances to both the closest barcode and to the next
closest barcode. A read is rejected if the difference in
these two distances is less than the --barcode-
separation setting.

--barcode-separation has no effect when --
barcode-mode is set to 1.

--barcode-
filter-
postpone

1

(integer)

• 0—Keeps the 4.0 behavior: barcode filtering is
done independently on each block. This is the
default for all Ion PGM™ analyses and for Ion
Proton™ thumbnail (which consist of only a
single block) processing and base calibration
training stage processing.

• 1—The BaseCaller module does barcode pre-
filtering at a 10x lower frequency threshold (10
times more lenient). Barcode filtering is done on
the full information of the whole chip, after the
96 blocks are merged into one. This is the
default for Ion Proton™ full-chip (not thumbnail)
analyses.

• 2—The BaseCaller module does not do any
barcode prefiltering. All barcode classification
happens after the 96 blocks are merged into
one. The "2" setting is slower, creates more
files, and involves more processing than the "1"
setting.

Do not change this parameter. Instead accept the
pipeline defaults, which are different for Ion PGM™

and Ion Proton™ analyses.

--barcode-
filter

0.01

(float)

Barcode frequency threshold to be reported in the
user interface. The relative frequency of a barcode is
the number of assigned reads divided by the number
of reads assigned to the most frequent barcode.

0.0—Off. The setting 0.0 causes all barcodes in the
barcode set to be reported in the user interface,
including barcodes with no or very few reads,
provided that the barcode group has at least --
barcode-filter-minreads number of reads.
Barcodes with no or very few reads typically are not
relevant to your analysis and should be filtered out.

--barcode-
filter-
minreads

20

(integer)

The threshold for the minimum number of reads in a
barcode group for that group to be reported in the
user interface.
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Parameter Default Description

--end-
barcodes

on

(boolean)

For dual barcoding runs, specifying "off" disables
end barcode classification and uses the start
barcodes for read classification instead of both
barcodes.

For example, for DNA germline or somatic variant
calling, dual barcodes are generally not needed. You
may also do hybrid analyses with varying limits of
detection, that account for fluctuations in read
coverage.

Using this option turned "on":

• End barcodes are still searched for and
trimmed off the read if found.

• No sk tag is written in the BAM read group
header.

• End barcodes, end barcode adapters, or PCR
handles are trimmed if they are found and all
stored in the YK tag.

• Reads not having a YK tag are those that are
normally filtered by a dual barcode analysis,
such as read where no bead adapter was found.

• Using Ion AmpliSeq™ HD chemistry, the tag
trimmer options have to be adjusted to keep
reads where no end barcode was identified. Use
--tag-filter-method=need-prefix.

• Using Ion AmpliSeq™ HD chemistry, variant
caller options have to be adjusted to emulate a
normal Ion AmpliSeq™ analysis. Specifically,
variant caller needs to be configured to ignore
molecular tag information.

• End barcode classification will not be
completely off. Reads where an end barcode
was identified that does not match read group
expectations, that is, reads that are “certified
contamination” are still being filtered and
pushed to no-match.

--trim-
barcodes

on

(boolean)

Trim the barcode and barcode adapter. If off, disables
all other 5’ trimming.

--barcode-
adapter-
check

0.15 Validate the barcode adapter sequence. The
parameter given is the maximum allowed squared
residual per flow. This feature reduces cross-
contamination, for example, between the Ion
Xpress™ Barcode Adapters and IonCode™ Barcode
Adapters barcode sets.

0—Off.
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Cutoff setting

Notes about the --barcode-cutoff parameter with --barcode-mode set to 1:
• The setting 0 is the most restrictive setting. --barcode-cutoff set to 0 allows

only reads that perfectly match a barcode in base space.
• The setting 0 works with any barcode set (for both Ion Torrent™ sets and custom

barcode sets).
• Do not set --barcode-cutoff greater than 2 with the Ion Xpress™ Barcode

Adapters barcode set. Values greater than 2 relax the classification rules and
allow incorrect barcode assignments.

A rule of thumb for the maximum --barcode-cutoff setting is based on the
minimum distance of the barcode set in flow space:

The minimum distance for the Ion Xpress™ Barcode Adapters barcode set is 5. The
maximum recommended value for --barcode-cutoff is 2 for analyses that use the
Ion Xpress™ Barcode Adapters barcode set.

Separation setting

Notes about the --barcode-separation parameter:
• Larger values (close to the minimum distance of the code) require more strict

matching of the predicted signal for a read to be assigned to a barcode.
• Smaller values (for example, 0.2 and below) allow barcode assignment with an

expanded tolerance for errors. For example in the extreme case of separation=0,
the measured signal may be in between two predicted barcode signals.

• If --barcode-separation is set at or above the minimum distance of the
barcodes in flow space, no reads at all are assigned to a barcode.

• If --barcode-separation is set close to the minimum distance of the barcodes
in flow space, very few reads are assigned to a barcode.

• If --barcode-separation is too small, the risk of cross-contamination
increases. More ambiguous reads are forced into a barcode assignment (with a
higher rate of error in these assignments).

A rule of thumb for a good --barcode-separation setting is one half of the
minimum distance of the barcode set in flow space:

Other public parameters

The BaseCaller module and its parameter settings control these types of filtering:
• Keypass
• Quality trimming
• Adapter trimming
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The public BaseCaller module parameters are listed and described in the following
table. The defaults for these parameters are optimized for most scenarios and in most
cases the default settings are recommended.

Parameter Default Description

-d, or

--disable-all-filters
off When on, disables all filtering and

trimming and overrides other
filtering and trimming settings.

-k, or

--keypass-filter
on When on, filters out reads that do

not both produce a signal and
match the library key (or the test
fragment key).

--min-read-length 25

(integer)

Filters out reads less than this
minimum read length.

This filter screens out poor reads
early on to avoid wasting
processing time on them.

See also --trim-min-read-
len, which sets the minimum
length threshold that is applied
after trimming.

--prefix-mol-tag Empty Base structure of 5’ unique
molecular tag (ACGTN bases) to
be trimmed after the barcode
adapter.

In Torrent Suite™ Software 5.10
and 5.12, specify the read
structure via a read structure
input file. While this option still
exists in the code base and could
potentially be used, none of our
run plans do so.

--suffix-mol-tag Empty Base structure of 5’ unique
molecular tag (ACGTN bases) to
be trimmed before P1 adapter.

In Torrent Suite™ Software 5.10
and 5.12, specify the read
structure via a read structure
input file. While this option still
exists in the code base and could
potentially be used, none of our
run plans do so.

--extra-trim-left 0

(integer)

Trims this number of bases
beyond the barcode adapter and
the 5' unique molecular tag (if
applicable).
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Parameter Default Description

--extra-trim-right 0 Trims this number of bases at the
3' end of the template before the 3'
unique molecular tag (if
applicable) and the P1 adapter.
Only done if the P1 adapter was
found.

--trim-adapter-cutoff 16

(float)

A score cutoff value.

Smaller values correspond to
more stringent adapter search and
larger values to less stringent
adapter search.

Set to 0 to turn off.

--trim-adapter-min-match 6

(integer)

The minimum number of P1
adapter bases required in order to
trim the P1 adapter.

--trim-qual-window-size 30

(integer)

Window size for quality trimming.

--trim-qual-cutoff 16

(float)

Cutoff for quality trimming.

Set to 100 to turn off. When set to
100, no reads are filtered out due
to this parameter.

--trim-min-read-len 25

(integer)

Filters out any reads that fall
below this minimum read length
after any trimming step. By default
it is initialized with the value of
min-read-length.

Barcodes are short base sequences that during library preparation are placed between
the library key and the read. The barcode sequences provide a mechanism to
distinguish and identify reads from different samples during data analysis.

The use of barcodes allows multiple samples to be sequenced together on one chip
during a sequencing run, and still have the read data for the run be analyzed
separately afterward as distinct samples.

This diagram shows the placement of the barcode sequence, and the library key and
adapters, with the read sequence (labeled "Template Bases"). The key is on the 5' end.

This example shows the location of the barcode sequence in both base space and flow
space, using barcode IonPress_001 as an example:

About barcodes
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Use the BaseCaller JSON output file to troubleshoot barcode classification issues.
Barcode classification metrics are available in the basecaller_results/
datasets_basecaller.json file in the Torrent Suite™ Software analysis directory.
This file contains information about all barcodes, whether they appear in the run
report or are filtered out.

A sample of this file is shown here, and is used in later examples.

{
    "0NCWC.IonHDdual_0101": {
        "Q20_bases": 25,
        "barcode": {
           "barcode_adapter": "",
            "barcode_adapter_filtered": 0,
            "barcode_bias": [
                0.209209978580475,
                -0.0654730796813965,
                -0.0002632737159729,
                0.0154760638251901,
                0.177288889884949,
                0.2724369764328,
                0.00381212681531906,
                0.105516441166401,
                -0.292163729667664,
                0.0684881433844566,
                -0.000637046992778778,
                -0.0821478366851807,
                -0.0467215031385422,
                0.0904117226600647
            ],
            "barcode_distance_hist": [
                0,
                1,
                0,
                0,
                0
            ],
            "barcode_errors_hist": [
                1,
                0,
                0
            ],
            "barcode_match_filtered": 0,
            "barcode_name": "IonHDdual_0101",
            "barcode_sequence": "CTAAGGTAAC"
        },
        "barcode_name": "IonHDdual_0101",
        "description": 
"KHAresPanV5bidirhUnewdesignMETCNVladder3",
        "end_barcode": {
            "adapter_filtered": 0,
            "barcode_adapter": "",
            "barcode_errors_hist": [

Troubleshooting
barcode
classification
issues
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                1,
                0,
                0,
                0
            ],
            "barcode_filtered": 757,
            "barcode_name": "IonHDdual_0101",
            "barcode_sequence": "TGACTCTATTCG",
            "no_bead_adapter": 17
        },
        "filtered": true,
        "handle": {
            "bc_handle_distribution": [
                0,
                1,
                0
            ],
            "bc_handle_errors_hist": [
                1,
                0,
                0,
                0
            ],
            "bc_handle_filtered": 82,
            "end_handle_distribution": [
                0,
                0,
                1
            ],
            "end_handle_errors_hist": [
                1,
                0,
                0,
                0
            ],
            "end_handle_filtered": 0
        },
        "index": 1,
        "mol_tag_prefix": "TNNNACTNNNTGAT",
        "mol_tag_suffix": "ATCANNNAGTNNNA",
        "num_blocks_filtered": 96,
        "platform_unit": "s5/540/QPT035/18/DADL00693/
IonHDdual_0101",
        "read_count": 1,
        "reference": "hg19",
        "sample": "none",
        "total_bases": 25
    }
}
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Explanation of fields in the BaseCaller JSON file

The information that follows describes the numbers of barcodes that would be
included or discarded if you reanalyze a run with certain changed BaseCaller module
settings.

Barcode bias

The barcode_bias values show the mean signal deviation by flow: how much the
observed signal is off from the expected signal. Low bias values, for example with the
value shown here, are indications of good signal.

Bias values around 0.33 indicate a signal that is about a third of a base off. Values near
0.5 indicate a signal that is half a base off. Values in this range indicate a problem with
the sequencing run or with the barcode classification.

"barcode_bias": [ 0.026, -0.028, -0.034, 0.011, -0.019, 
-0.001, 0.072,? -0.061, 0.103, -0.008, -0.062, 0.110, -0.021, 
0.001],

Barcode distance histogram

The barcode distance histogram shows, in signal space, the number of reads at various
squared residual distances between the predicted signal and the observed signal.

The distance fields are given in 0.2 increments:
• The first field gives the number of reads with a squared residual distance of

between 0 and 0.2.
• The second field gives the number of reads with a squared residual distance of

between 0.2 and 0.4.
• The third field gives the number of reads with a squared residual distance of

between 0.4 and 0.6, and so on.

Smaller distances reflect better matches of the read to barcode. Larger distances reflect
poorer matches.

This example reflects the pattern that is typical of a real barcode:
• The most reads have shorted distance residuals.
• Fewer reads have larger distance residuals.
• The entry 5342 in the fifth field tells us that reducing --barcode-cutoff to 0.8

would cause those 5342 reads not to be assigned to a barcode.

"barcode_distance_hist": [ 907546, 50122, 10793, 4498, 5342 ],
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Barcode errors histogram

The barcode errors histogram shows the number of reads with difference levels of
basecalling errors in this barcode:

• The first field gives the number of reads that have 0 basecalling errors (949782 in
this example). This is the number of reads that perfectly match this barcode (in
base space).

• The second field gives the number of reads that have one basecalling error (24584
in this example).

• The third field gives the number of reads that have two basecalling errors (3935 in
this example).

From the 3935 value with 2 basecalling errors, we know that if we reanalyze with the
number of allowed errors set to 1 instead of 2, then 3935 fewer reads are assigned to
this barcode.

"barcode_errors_hist": [ 949782, 24584, 3935 ],

This histogram is typical of a real barcode. A large majority of reads are perfect
matches, a few have one error, and a smaller number have two errors.

If the pattern is reversed (with very few perfect matches, some reads with one error,
and many reads with 2 errors), we suspect that this is probably a fake barcode.

Barcode match filtered

The barcode_match_filtered field gives the number of reads that perfectly
match the barcode in base space, and also are filtered out because they do not meet the
separation criteria in signal space. The signal for these reads are in-between two
barcodes, and are not close enough to either barcode to be assigned.

"barcode_match_filtered": 162,

Filtered

The filtered field is true if this barcode is filtered out and false if the barcode
appears on the run report.

"filtered": false,

Read count

The read_count field shows how many reads were assigned to this barcode.

"read_count": 978301,
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TMAP modules

The Torrent Mapping Alignment Program (TMAP) is a sequence alignment software
program that is optimized specifically for Ion Torrent™ data.

TMAP generally operates in two phases:
• Initial mapping, when the read sequences are located within the reference

genome.
• Alignment refinement, when each particular position of the read is aligned to the

corresponding position in the reference.

TMAP can run mapping/alignment cycles iteratively, applying different algorithms
and parameters to the reads that were not aligned at earlier iterations. In a typical
workflow, just one mapping/alignment iteration is used.

TMAP provides several mapping algorithms by using the map1, map2, map3, map4,
and mapvsw modules, each with its own best application. The default algorithm is
the map4 module.

The alignment refinement phase includes initial alignment using Smith-Waterman or
Needleman-Wunch algorithms, and some optional alignment refinement stages that
are designed to compensate for specific systematic biases of the sequencing process.
Thus:

• The reads can be realigned for better homopolymer alignment (the --context
option).

• The portions with likely phasing errors can be realigned with low indel scores
(the --do realign option).

• The long indels at the edges of amplicons can be salvaged (the --end-repair
option).

• The tandem repeats can be clipped from the read 3' tail (the --do-repeat-clip
option).

• The alignment can be performed in flowspace instead of basespace (the --final-
flowspace option). In this case the flow signal obtained from the sequencer is
aligned with the estimated flow signal from corresponding zone in the reference
genome.

When you reanalyze a run, you can change both the TMAP module and the module
parameters. Usually, you do not need to modify the default parameter settings. The
default TMAP parameters are tuned for Ion Torrent™ data. Modifying these
parameters is for advanced users.
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The mapping alternatives supported by TMAP are listed and described in the
following table. The map4 module is the default. Other modules are not run unless
specifically called, for instance on the Reanalyze screen.

Click the module name link to see the options supported for that module.

Module Description

“TMAP map1
options“ on
page 323

BWA-short reads mapping.

• Very fast at finding perfect matches.

• Very slow at finding a set of matches with up to two
mismatches.

“TMAP map2
options“ on
page 324

BWA-long / BWASW reads mapping.

“TMAP map3
options“ on
page 325

Simplified SSAHA, based on a k-mer lookup table.

“TMAP map4
options“ on
page 326

Based on the BWA fastmap routine.

Searches for the maximum exact matches between the reads and
reference.

“TMAP mapvsw
options“ on
page 327

A vectorized implementation of Smith-Waterman.

• A single mapping strategy that is twice as fast as the other
modules.

• Modified to improve specificity.

mapall A command to quickly map short sequences to a reference genome.

For steps to open the run report log and search for the TMAP command, see “TMAP
examples“ on page 321. The analysis must be completed before you can find the
command.

This example uses TMAP map4 mapping algorithm with default settings.

tmap mapall -f /results/referenceLibrary/tmap-f3/hg19/
hg19.fasta 
-r /<server_path>/results/analysis/output/Home/
Auto_user_G35-685--R65832-110mM_K2SO4-
OT_salts-0630_24057_58335/IonXpress_057_rawlib.bam 
-v 
-Y 

Mapping modules

Find the TMAP
command for a
specific analysis

TMAP examples
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-u --prefix-exclude 5 
-o 2 stage1 map4

The next example is the previous TMAP default setting. This example uses the map1,
map2, and map3 modules in that order. Progressively more reads are mapped by each
module.

tmap mapall -f <FASTA_file> 
-v 
-Y 
-u --prefix-exclude 5 stage1 map1 map2 map3

Global options used by all TMAP modules

Option Alternate option Type Default Description

-f --fn-fasta File [ no default ] FASTA reference file.

-r --fn-reads File Standardinput (stdin) The reads file name.

-i --reads-format String Unknown The reads file format
(fastq | fq | fasta | fa |
sam | bam).

-s ---fn-sam File Standardoutput (stdout) The SAM file name.

--bam-
start-
vfo

none Integer 0 Sets the starting
virtual file offsets that
limit the range of BAM
reads to process.

-A --score-match Integer 1 Score for a match.

-M --pen-mismatch Integer 3 Mismatch penalty.

-O --pen-gap-open Integer 5 INDEL start penalty.

-E --pen-gap-extension Integer 2 INDEL extension
penalty.

-G --pen-gap-long Integer -1 Long INDEL penalty.

Global pairing options

Option Alternate option Type Default Description

-Q --pairing Integer 0 The insert pairing.

• 0 = Do not perform pairing.

• 1 = Mate pairs (-S 0 -P 1).

• 2= Paired end (-S 1 -P 0).
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The TMAP map1 module implements BWA-short reads mapping and has these
characteristics:

• map1 is very fast at finding perfect matches.
• map1 is very slow at finding a set of matches with up to two mismatches.

The map1 module is not the default for TMAP, map4 is the default.

The following options are supported with the TMAP map1 module (all are optional).

Option Type Default Description

--seed-length Integer 32 The k-mer length to seed CALs.

-1 to disable.

--seed-max-diff Integer 2 The maximum number of edits in
the seed.

--seed2-length Integer 48 The secondary seed length.

-1 to disable

--max-diff Float 0.04 The maximum number of edits or
false-negative probability
assuming the maximum error
rate.

--max-error-
rate

Float 0.02 The assumed per-base maximum
error rate.

--max-
mismatches

Integer 3 The maximum number of or (read
length) fraction of mismatches.

--max-gap-opens Integer 1 The maximum number of or (read
length) fraction of INDEL starts.

--max-gap-
extensions

Integer 6 The maximum number of or (read
length) fraction of INDEL
extensions.

--max-cals-
deletion

Integer 10 The maximum number of CALs to
extend a deletion.

--indel-ends-
bound

Integer 5 The number of bps from the end of
the read.

--max-best-cals Integer 32 Optimal CALs have been found.

--max-nodes Integer 2000000 The maximum number of
alignment nodes.

--min-seq-
length

Integer -1 The minimum sequence length to
examine.

-1 to disable

--max-seq-
length

Integer -1 The maximum sequence length to
examine.

-1 to disable

TMAP map1
options

Chapter 13 Supported software modules
TMAP modules 13

Torrent Suite™ Software 5.12 User Guide 323



The TMAP map2 module implements BWA-long / BWASW reads mapping.

The map2 module is not the default for TMAP, map4 is the default.

The following options are supported with the TMAP map2 module (all are optional).

Option Type Default Description

--max-seed-
hits

Integer 1,024 The maximum
number of hits
returned by a seed.

--length-coef Float 5.5 The coefficient of
length-threshold
adjustment.

--max-seed-
intv

Integer 6 The maximum
seeding interval size.

--z-best Integer 1 The maximum
number of top-
scoring nodes to
keep on each
iteration.

--seeds-rev Integer 5 The number of seeds
to trigger reverse
alignment.

--narrow-rmdup Integer false Remove duplicates
for narrow SA hits.

--max-chain-
gap

Integer 10,000 The maximum gap
size during chaining.

--min-seq-
length

Integer -1 The minimum
sequence length to
examine.

-1 to disable.

--max-seq-
length

Integer -1 The maximum
sequence length to
examine.

-1 to disable

TMAP map2
options
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The TMAP map3 module implements a simplified SSAHA, based on a k-mer lookup
table.

The map3 module is not the default for TMAP, map4 is the default.

The following options are supported with the TMAP map3 module (all are optional).

Option Type Default Description

--seed-length Integer -1 The k-mer length to
seed CALs.

-1 to disable

--max-seed-
hits

Integer 20 The maximum
number of hits
returned by a seed.

--hit-frac Float 0.2 The fraction of seed
positions that are
under the maximum.

--seed-step Integer 8 The number of bases
to increase the seed
for each seed
increase iteration.

-1 to disable

--hp-diff Integer 0 The single
homopolymer error
difference for
enumeration.

--fwd-search Boolean False Use forward search
instead of a reverse
search.

--skip-seed-
frac

Float 0.2 The fraction of a
seed to skip when a
lookup succeeds.

--min-seq-
length

Integer -1 The minimum
sequence length to
examine.

-1 to disable

--max-seq-
length

Integer -1 The maximum
sequence length to
examine.

-1 to disable

TMAP map3
options
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The TMAP map 4 module is based on the BWA fastmap routine, and searches for the
maximum exact matches between the reads and reference.

The map4 module is the default for TMAP.

The following options are supported with the TMAP map4 module (all are optional).

Option Type Default Description

--seed-step Integer 8 The number of bases
to increase the seed
for each seed
increase iteration.

-1 to disable.

--hit-frac Float 0.2 The fraction of seed
positions that are
under the maximum.

--min-seed-
length

Integer -1 The minimum seed
length to accept hits.

-1 to disable

--max-seed-
length

Integer 48 The maximum seed
length to accept hits.

--max-seed-
length-adj-
coef

Float 2.0 maximum seed
length adjustment
coefficient.

-1 to disable

--max-iwidth Integer 20 The maximum
interval size to
accept a hit.

--max-repr Integer 3 The maximum
representative hits
for repetitive hits.

--rand-repr Integer false Choose the
representative hits
randomly. Otherwise
uniformly.

--use-min Boolean false When seed stepping,
try seeding when at
least the minimum
seed length is
present. Otherwise,
use the maximum
seed length.

TMAP map4
options
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Option Type Default Description

--min-seq-length Integer -1 The minimum
sequence length to
examine.

-1 to disable.

--max-seq-length Integer -1 The maximum
sequence length to
examine.

-1 to disable

The TMAP mapvsw module implements a vectorized implementation of Smith-
Waterman.

The mapvsw module is not the default for TMAP, map4 is the default.

The following options are supported with the TMAP mapvsw module (all are
optional)

Option Type Default Description

--min-seq-
length

Integer -1 The minimum
sequence length to
examine.

-1 to disable

--max-seq-
length

Integer -1 The maximum
sequence length to
examine.

-1 to disable

The TMAP alignment refinement phase is organized as a pipeline of optional
processing stages, each controlled by a specific set of options. The following stages are
available (given in the order of their optional invocation).

Stage Description

Flow space realignment Performs alignment of the sequence of read flow signals
to simulated reference flow signal. Turned on with the --
final flowspace flag.

Context-based realignment Realigns read with reduced cost of INDELs within
homopolymers. Turned on with the --context flag.

Local realignment with
reduced gap cost

Realigns specific zones that are likely to contain errors
associated with signal phasing using reduced gap cost.
This helps to reduce false positive variants in low
complexity zones. Turned on with the --do-realign
flag.

TMAP mapvsw
options

TMAP alignment
refinement
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Stage Description

Long INDEL salvage Realigns zones adjacent to the read ends while allowing
for longer indels. Helps to find long indels continued
beyond the ends of the amplicons. Turned on by specifying
long INDEL gap penalty using the (-G option.

End repair Extends the alignment beyond the amplicon edges, where
suitable. Also trims alignment tails below given mismatch
ratio. This is a simplified and often better performing
version of the long indel salvage option. It is turned
on by specifying the --end-repair <MM> option on the
TMAP command line, where <MM> is the maximum
allowed mismatch percentage at the alignment edge. End
repair is typically used together with the --J option (max
adapter bases for soft clipping), where recommended
usage is --end-repair 25-J 15).

Bed file The BED file specification, given with the --bed-file
file_name option, provides TMAP with the amplicon
boundary coordinates. This is used by end-repair to extend
gaps over amplicon edges. It also alters the way mapping
scores are calculated: the reads mapped within amplicon
boundaries are given a 12-point boot in MAPQ, and thus
are preferred over the alternative mapping locations
outside of the amplicon set.

5' softclip removal Removes soft clips from the 5' end of the alignment if
introduced by end-repair. This option is on by default.
Turned off with the --er-5clip flag.

3' tandem repeat clipping Clips tandem repeats from 3' end of the reads. Helps
reduce variant detection errors in tandem repeat zones.
Turned on with the --do-repeat-clip flag.
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Administer Torrent Suite™ Software

■ Open the Site Administration screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
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Administrative privileges allow you to configure Torrent Suite™ Software, administer
Ion Torrent™ Server databases, manage user accounts, back up and restore data, and
enable remote monitoring.

An ionadmin account is required to perform the procedures in this section. A user
account, such as ionuser, does not include sufficient privileges to perform these
procedures.

Open the Site Administration screen

An administrator can use tools in the Site Administration screen in the Ion Web
portal to modify default settings for sequencing runs.

IMPORTANT! Use extreme caution when you modify any of the settings in this
screen. Settings with incorrect values can corrupt the database or produce
unpredictable results. Check with your Field Service Engineer if you want to change
any of the settings or complete any of the procedures that are available through this
administrative tool.

1. Click  (Settings)4Configure.

2. In the Configure screen, scroll down to the Database Administration section.

3. Click the Admin Interface link to access the database administration functions.

14
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4. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen opens.

5. After you have made changes, click Back to Main Site at the top of the screen to
return to the Torrent Suite™ Software.

Install Torrent Suite™ Software

An administrator can use these steps to install Torrent Suite™ Software.

IMPORTANT! During an upgrade, you must use the same user account for both Ion
Torrent™ Server and Ion systems (Ion PGM™ Instrument, Ion Chef™ System, Ion S5™

System, Ion S5™ XL System, and Ion GeneStudio™ S5 Systems.

1. Click  (Settings). Ensure that there are no active jobs running.

2. Click  (Settings)4Configure4Admin Interface.

3. Click Update Server.

4. Click Check for updates.

5. When the Available message displays, click Update Server to start the update
process.

6. On the User Agreement (EULA) screen, scroll down to read and then accept
terms to begin the update.

7. When finished, ensure that the "Upgrade completed Successfully!" message
displays.

An administrator can manage Torrent Suite™ Software user accounts from the Site
Administration screen.

1. Click  (Settings)4Configure.

2. Scroll to the Database Administration section, then click the Admin Interface
link.

If you are prompted to sign in, use your administrator account.

Manage Torrent
Suite™ Software
user accounts
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3. In the Site administration screen, in the Users row, do one of the following:

Option Description

Add Click Add to add a new user.

Change Check Change to modify a user account.

Approve or reject a new user account

New users can request a user account in the Torrent Suite™ Software sign-in screen.
An administrator must approve each request before the new account is active. An
administrator account is required to approve or reject each request for a new user
account.

When an administrator signs in to Torrent Suite™ Software, a message alerts the
administrator that requests are pending for new user accounts.

IMPORTANT! Use extreme caution when you modify any of the settings in this
screen. Settings with incorrect values can corrupt the database or produce
unpredictable results. Check with your Field Service Engineer if you want to change
any of the settings or complete any of the procedures that are available through this
administrative tool.

1. In the message for the new pending account registration, click Account
Management.

The User Registration section shows the pending requests for new user
accounts:

Alternatively you can check for new user registrations if you click 
(Settings)4Accounts, then go to the User Registrations section in the User
Profile/Account Information screen.

2. Review the new user registration request, then choose one of the following.

• Click Approve to approve the account for the new user, then click Yes,
Approve.

• Click Reject to reject the account for the new user, then click Yes, Reject.

3. After you have made changes, click Back to Main Site at the top of the screen to
return to the Torrent Suite™ Software.

The user account is added to the list of user accounts in the Torrent Suite™ Software
Site administration screen. For details, see “Manage Torrent Suite™ Software user
accounts“ on page 330.
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Modify a user account

An administrator can modify the access level for an existing user using tools in the
Site administration screen.

IMPORTANT! Use extreme caution when you modify any of the settings in this
screen. Settings with incorrect values can corrupt the database or produce
unpredictable results. Check with your Field Service Engineer if you want to change
any of the settings or complete any of the procedures that are available through this
administrative tool.

1. Click  (Settings)4Configure.

2. In the Configure screen, scroll down to the Database Administration section.
Click the Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The screen in the Ion Web portal opens.

4. In the Site administration screen, in the Users row of the main screen, click
Change.

5. On the Select user to change screen, click the Username of the user that you
want to change. User names can be filtered, selected to the right, according to: By
staff status, By superuser status or By active status.

6. Use the Change user dialog box to modify user information, such as user name,
password, first and last name, email address, or active/inactive status. Confirm
that permissions are selected as follows for Staff and Superusers.

Option Description

Staff (User) Active

Superuser (Administrator) Active, Staff and Superuser
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WARNING! Do not modify Groups or User permissions categories. Do
not click Staff or Superuser individually. Staff and Superuser must both
be unchecked for Staff user, but both must be checked for Superuser.

7. Select one of the Save options at the bottom of the screen to save your changes.
The user account is modified.

8. After you have made changes, click Back to Main Site at the top of the screen to
return to the Torrent Suite™ Software.

Delete a single user account

An administrator can delete a user account, using tools in the Site administration
screen.

IMPORTANT! Use extreme caution when you modify any of the settings in this
screen. Settings with incorrect values can corrupt the database or produce
unpredictable results. Check with your Field Service Engineer if you want to change
any of the settings or complete any of the procedures that are available through this
administrative tool.

1. Click  (Settings)4Configure.

2. In the Configure screen, scroll to the Database Administration section. Click the
Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

4. In the Users line of the main Site administration menu, click Change.

5. On the Select user to change screen, click the Username of the user to be deleted.

6. At the bottom-left of the Change user screen, click Delete.

7. Ensure that you want to delete the user by clicking Yes, I'm sure.

The user is deleted.

8. After you have made changes, click Back to Main Site at the top of the screen to
return to the Torrent Suite™ Software.
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Delete multiple user accounts

An administrator can delete multiple users using tools in the Site administration
screen.

IMPORTANT! Use extreme caution when you modify any of the settings in this
screen. Settings with incorrect values can corrupt the database or produce
unpredictable results. Check with your Field Service Engineer if you want to change
any of the settings or complete any of the procedures that are available through this
administrative tool.

1. Click  (Settings)4Configure.

2. In the Configure screen, scroll to the Database Administration section. Click the
Admin Interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

4. In the Users line of the main Site administration menu, click Change.

5. On the Select user to change screen, check the checkbox for each user that you
want to delete.

6. In Action, select Delete selected users, then click Go.

7. Ensure that the list of users that you want to delete is correct by clicking Yes, I'm
sure.
If you do not want to delete the users, click the back arrow on your browser.
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8. Review the Select user to change screen to confirm that the selected users no
longer appear on the list.

The accounts are deleted.

9. After you have made changes, click Back to Main Site at the top of the screen to
return to the Torrent Suite™ Software.

Create a new administrator account to change a password

An administrator can change their password by creating an new administrator
(superuser) account, then change the user password for that account.

IMPORTANT! Use extreme caution when you modify any of the settings in this
screen. Settings with incorrect values can corrupt the database or produce
unpredictable results. Check with your Field Service Engineer if you want to change
any of the settings or complete any of the procedures that are available through this
administrative tool.

1. At the command line on the Ion Torrent™ Server, run the following command in
the command prompt: cd /opt/ion/iondb ./manage.py
createsuperuser.

2. After the new superuser account has been created, in Torrent Suite™ Software
click  (Settings)4Configure.

3. In the Configure screen, scroll to the Database Administration section, then click
the Admin Interface link to access the database administration functions.

4. If you are prompted to sign in, enter your newly created user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

5. Select the Users section under Auth:
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6. Select the account that you just created and that you want to change the
password for.

7. Click Change password form:

8. Enter the new password, then click Change Password:

9. After you have made changes, click Back to Main Site at the top of the screen to
return to the Torrent Suite™ Software.

You can now use your new password with your user account.

Chapter 14 Administer Torrent Suite™ Software
Install Torrent Suite™ Software14

336 Torrent Suite™ Software 5.12 User Guide



When an administrator is setting up the Torrent Suite™ Software, the administrator
can complete the Customer Support Contact dialog box with helpful information
about how a user can get technical support within the organization.

1. Click  (Settings)4Configure.

2. Add the information for a customer support contact and an IT contact in your
organization, then click Save Contacts.

1. Click  (Settings)4Configure.

2. Scroll to Change Timezone, select a region and a time zone, then click Save Time
Zone.

3. () Click Auto Detect Timezone, then click Save Time Zone.

The new time zone takes effect immediately on the Ion Torrent™ Server.

Add customer
support contacts

Change the time
zone for the Ion
Torrent™ Server
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You can change the server name that appears in the Torrent Suite™ Software. By
default, this name is Torrent Server. This change affects only the server name that is
shown in the Torrent Suite™ Software, and the default bookmark name that appears in
the browser when a bookmark is created.

1. Click  (Settings)4Configure, then scroll to the Customize Site Name section.

2. Enter the name of your choice, then click Save Name.
The server name that is displayed in the browser is changed.

An administrator can prevent other users from installing updates to Torrent Suite™

Software. Use this procedure to lock the current version of software and to prevent
accidental software updates.

You must be an administrator to perform this procedure.

1. Click  (Settings)4Configure.

2. Scroll to the Database Administration section, then click Admin Interface.

3. Scroll to the Management Actions section, then click Update Server.

In the Software Versions list, the software versions that are currently available
are listed. You can click Check to see whether updates are available before you
lock the current version. For example, No updates indicates that updates are not
available.

Change the
displayed server
name

Lock current
Torrent Suite™

Software version
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4. Under Disable software updates, select the Lock current TS software version
checkbox.

The software is locked at the current version.

Update Torrent Suite™ Software

The instructions in this section describe how to update Torrent Suite™ Software to a
new version.

IMPORTANT! Additional steps and procedures might be required, depending on the
type of Torrent Suite™ Software upgrade. For complete instructions, see the latest
Release Notes on the software product.

IMPORTANT! To ensure compatibility between the software and your instruments,
you must also upgrade your instruments after the upgrade is complete.

An administrator can use this procedure to update the Torrent Suite™ Software on the
Ion Torrent™ Server. Updates cause the software web services to restart.

IMPORTANT! To ensure compatibility between the software and your instruments,
you must also upgrade sequencing instruments after the Torrent Suite™ Software
upgrade is complete.

1. Click  (Settings)4Configure.

2. Scroll to the Database Administration section, then click Admin Interface.

If you are prompted to sign in, use your ionadmin account.

3. On the Site administration screen in the Management Actions section, click
Update Server.

The Update Torrent Suite screen opens with information on available software
versions, including whether updates are available.

4. Click Activate to power on website maintenance.

Update Torrent
Suite™ Software
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5. Click Check to check for updates.

6. If software updates are available, click Update Server to update software on the
server.

7. When the software update is complete, click Back to Main Site, then click 
(Settings)4About.

8. Review the software version number in the releases list to ensure that it reflects
the update that you completed.

9. To ensure that the software upgrade
is complete, and that the software is
ready to run analysis programs, click

 (Settings)4Services.

10. In Services in the Status column,
review all services to ensure that
each is running.

11. To ensure compatibility between the software and your instruments, upgrade
your sequencing instruments after the software upgrade is complete.
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To check if there are any newer updates for your products, plugins, or instrument, use
the Updates screen.

To update Torrent Suite™ Software, see “Update Torrent Suite™ Software“ on
page 339.

1. Click  (Settings)4Updates.

2. On the Updates screen, compare your installed versions with the available
versions to determine if any updates listed are relevant to your work.

3. Perform the desired updates.

• To update products, see “Enable off-cycle product updates“ on page 341.
• To update plugins, see “Update off-cycle release plugins“ on page 344.
• To manually install update files, see “Install off-cycle bundles without

Internet access“ on page 341.

An administrator can add new kits, chips, templates, plugins and Ion Chef™ scripts
that are released outside of the regular software release cycle.

When you learn of a new product that you would like to use, check to see if a software
update is available.

1. Click  (Settings)4Updates.

2. Scroll down to the Update Products section at the bottom of the screen.

3. Select the desired new product and click Update.
Your installed version of Torrent Suite™ Software is updated to include the new
products that you selected.

If the site Ion Torrent™ Server is not connected to the Internet, an administrator can
manually install updates.

1. Request a USB device that contains the updates from your local Field Service
Engineer or Technical Support.

2. Insert the USB device into your Ion Torrent™ Server.

3. In Torrent Suite™ Software, click  (Settings)4Updates.

4. On the Updates screen, under Manual Upload, click Click to Upload and
Install.

5. Follow the prompts to upload the compressed folder.

Check for off-
cycle updates

Enable off-cycle
product updates

Install off-cycle
bundles without
Internet access
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Install or upgrade plugins

On Connect, an administrator can install or upgrade the following:
• Upgrades for plugins that are preinstalled in Torrent Suite™ Software. For details

about plugins that are preinstalled with the software, see “Preinstalled
plugins“ on page 145.

• The RNASeqAnalysis plugin and smallRNA plugin. These plugins are supported
by Thermo Fisher Scientific, but are not preinstalled in the Torrent Suite™

Software.

1. Sign in to the Thermo Fisher Connect.

2. Click the Apps icon ( ).

3. In AppConnect, under Resource Libraries, click Plugins.

4. (Optional) Click a category at the top of screen.
The list of plugins is narrowed to only the plugins included that are in the
selected category.

5. Click  to download the plugin. Select the checkbox to indicate that you agree
to the terms and conditions, then click Download Plugin.
Either a compressed directory or a debian file that contains the plugin is
downloaded to your local machine.

6. In Torrent Suite™ Software, click  (Settings)4Plugins4Install or Upgrade
Plugin.

7. Click Select File, browse to the location where you downloaded the plugin file,
select the file, then click Open.

8. In the Install or Upgrade Plugin dialog box, click Upload and Install.

The plugin is now visible in Torrent Suite™ Software.
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After installing a plugin, you must enable the plugin to make the plugin available in
Torrent Suite™ Software.

1. Click  (Settings)4Plugins.

2. In the Plugins list, select the Enabled checkbox next to any installed plugin, to
make it available.
The plugin is immediately available.

An administrator can change the global configuration of a plugin. The following
preinstalled plugins can be configured globally.

• DataExport plugin
• ERCC_Analysis plugin
• FileExporter plugin
• IonReporterUploader plugin
• RunTransfer plugin

Some plugins that cannot be configured globally can be configured when you set up a
Planned Run or a Planned Run template, or if you run the plugin after a sequencing
run.

1. Click  (Settings)4Plugins.

2. In the Manage column for the plugin of interest, click  (Actions)4Configure.

Enable an
installed plugin

Configure plugins
globally
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The settings in the configuration dialog box vary depending on the plugin. See
the plugin-specific configuration topic for more information.

3. To save your changes, click Submit or Save Configuration.

An administrator can add new plugins that are released outside of the regular
software release cycle.

When you learn of a new plugin that you would like to use, check to see if an update
is available.

1. Click  (Settings)4Updates.

2. Scroll to the Update Plugins section at the bottom of the screen.

3. Select the new Torrent Suite™ Software plugin that you want to install, then click
Update.
Your installed version of Torrent Suite™ Software is updated to include the new
plugin that you selected.

You can uninstall a plugin from your Torrent Suite™ Software.

1. Click  (Settings)4Plugins.

2. In the row of the plugin that you want to remove, click  (Actions)4Uninstall.

3. Click Yes, Uninstall! to confirm that you want to uninstall the selected plugin.

Manage disk usage

It is critical that sufficient disk space is available on the server to store data files and
avoid data loss. If needed, it is important to have a strategy that periodically monitors
disk space and archives or deletes data to allow for storage of new data files.

To avoid data loss and ensure that sufficient disk space is available on the server, an
administrator can configure Torrent Suite™ Software to automatically archive and
delete sequencing data that are no longer needed. An administrator can also manually
archive or delete data from individual run reports or groups of reports, or export
selected data to a mounted external drive. To understand how disk space is allocated
and how files are managed, you can view disk usage, active data management jobs,
statistics, and detailed logs on each of these activities.

Update off-cycle
release plugins

Uninstall a plugin
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In the Data tab, click Data Management, then scroll to the Disk Usage section.

Parameters in the Disk Usage section.

Parameter Definition

Keep File space devoted to files that are to be kept.

Used File space being currently used by data files.

Free Space available for storing data files.

Threshold I Threshold above which intermediate files are deleted or archived,
based on the automatic configuration settings.

Threshold S Threshold above which signal processing input files are deleted or
archived, based on the automatic configuration settings.

Threshold B Threshold above which basecaller input files are deleted or
archived, based on the automatic configuration settings.

Threshold O Threshold above which output files are deleted or archived, based
on the automatic configuration settings.

For details regarding automatic deletion and archive creation, see “Archive or delete
data automatically“ on page 346.

Data that are generated from Ion Torrent™ sequencers consists of the following types
of files:

• Signal processing input files (DAT)
• Basecalling input files (1.WELLS)
• Output files (BAM, plugin output, and so forth)
• Intermediate files

For more details about these file types, see “Analysis pipeline overview“ on page 305.

Recommendations on when to archive each file type are listed in the following table.

Data type Details

Signal processing
input files

Signal processing input files (4 files per cycle) consist of the raw
voltage measurement data collected during the sequencing run.
On the Ion PGM™ System, you can reanalyze a run with the signal
processing input file, which is available on the instrument.

Keep the signal processing input data if you want to reanalyze the
run starting from raw signal processing data.

However, on the Ion Proton™ or Ion S5™ Systems, signal
processing input data are used on the instrument, then deleted.
These files are available on Torrent Suite™ Software only as
thumbnails for the Ion Proton™, Ion S5™ Systems, or Ion
GeneStudio™ S5 Systems.

View disk usage
parameters

Ion instrument
data types
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Data type Details

Basecalling input
files

Signal processing input files are converted to a single condensed
basecalling input file representing the processed signal.

Keep or archive basecalling input data if you want to reanalyze the
run. This can save time and resources because reanalyses use the
basecalling input data, rather than the raw signal processing input
data.

On the Ion Proton™, Ion S5™ Systems and Ion GeneStudio™ S5
Systems, basecalling input data are transferred to the Ion
Torrent™ Server and are available for reanalyses.

Output files Output files consist of all BAM files, run reports, and plugin
results.

It is important to keep and archive these files. Delete output files
only if you are sure that you no longer need the files.

Intermediate files Intermediate files contain information used for debugging runs.

You can delete these files immediately after instrument runs,
without affecting data.

To avoid data loss, it is critical that sufficient disk space is available on the Ion
Torrent™ Server. Therefore, it is important to have a strategy to monitor disk space
and archive or delete data if needed.

An administrator can configure the Ion Torrent™ Server to archive data to a mounted
drive automatically after a data age threshold is met. Data that is assigned to be
automatically archived are copied to the designated location, then deleted from the
Ion Torrent™ Server. Automatic archiving helps to maintain available disk space, and
simplifies management of data that you want to save to another volume.

An administrator can also configure the Ion Torrent™ Server to delete data
automatically when thresholds are met for filled disk space and data age. Automatic
deletion of files is important to maintain available disk space, and simplifies removal
of data that are no longer necessary to keep.

Archive or delete
data automatically
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An administrator can also assign automated archive or delete actions to each data file
category independently of the others.

IMPORTANT! When you configure the Ion Torrent™ Server to delete data
automatically, the data are permanently deleted. You cannot restore data after
deletion.

1. In the Data tab, click Data Management, go the Configuration section, then click
Configure.

2. On the Data Management Configuration screen, select an auto-action, or select
Disabled for each file category, then configure:

If you select
this auto action Select these options:

Disabled No selections are necessary—data in the file category must be
archived or deleted manually.

Archive • Data Age Threshold (days): Set the number of days that you
want data to be stored on the server before data are archived.

• Archive Directory: Select the mounted volume where you want
to store the archive, or click Browse, then navigate to the
mounted volume where you want the archive to be stored.

Delete • Data Age Threshold (days): Set the number of days that data
are stored on the server before data are deleted.

• Disk Full Threshold (Percent): Set the percentage of disk
space that is filled on the server before data are deleted.
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3. Select the Enabled checkbox to enable the automatic data management you have
configured. Deselect the checkbox to suspend automatic action.

4. In Email, enter an email address of where to receive notifications for automatic
data management actions.
If you use a Linux™ mail server, you might have access to Postfix, an open-source
Linux™ mail server. Postfix has many configuration options that IT
administrators can use to adjust mail routing parameters. You can find Postfix
documentation at http://www.postfix.org/documentation.html.

5. (Optional) To enable auto-acknowledgement of deletion of signal processing
input data, select the Auto Acknowledge Delete? checkbox. Action is not
required for data deletion to occur.
If you deselect Auto Acknowledge Delete, notifications are sent for each signal
processing input deletion. A reviewer must manually acknowledge each deletion
action before the signal processing input data are deleted.

6. After you have completed the configuration, click Save.

7. (Optional) On the Data Management screen, click Configuration Log in the
Configuration section to view a record of configuration changes.

8. (Optional) To view a record of data management actions (archiving and deleting),
click History.
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An administrator can manually export run data to a storage device that is mounted on
the Ion Torrent™ Server. When you export the data, it is copied from the Ion Torrent™

Server to the archive location. The data remains on the Ion Torrent™ Server, and the
run results listed in the Completed Runs & Results screen continue to link to the data
on the Ion Torrent™ Server. For more information, see “Increase file storage and
available disk space“ on page 351.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Select the checkboxes to the left of the report names that contain the run data that
you want to export, then click Process Selected.
To export data from only one run report, click Settings ( )4Actions to the right
of the report name.

3. In the dialog box, click the checkbox to the left of each File Category for the type
of data that you want to export, then click Export Selected.

4. Click Browse to select an export directory from the list of mounted storage
devices.

5. (Optional) Enter a comment.

6. Click Confirm.
The data for the file categories of the selected run reports are copied to the
external hard drive. The data are also available in the local hard drive run results
directory.

An administrator can manually archive run data from the local drive on the Ion
Torrent™ Server to a connected storage device. When you archive the data, it is moved
from the Ion Torrent™ Server to the archive location. The run results listed in the
Completed Runs & Results screen link to the data on the archive storage device as
long as that device remains mounted on the Ion Torrent™ Server. For details, see 
“Increase file storage and available disk space“ on page 351.

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Select the checkboxes to the left of the report names that contain data that you
want to archive, then click Process Selected.
To archive data from only one run report, you can alternatively click Settings
( )4Actions to the right of the report name.

3. In the dialog box, click the checkbox to the left of each File Category for the type
of data that you want to archive, then click Archive Selected.

Manually export
run data

Manually archive
run data
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4. Click Browse to select an archive directory from the list of mounted storage
devices.

5. (Optional) Enter a comment.

6. Click Confirm.
The data in the file categories of the selected run reports are moved to the archive
location.

An administrator can manually delete select data from a run report to free up storage
space on the Ion Torrent™ Server. This procedures deletes the files that are associated
with the run report that were created during the run. These file types are:

• Signal processing input files
• Basecalling input files
• Output files
• Intermediate files

For details about automatic deletion of select run data, see “Archive or delete data
automatically“ on page 346.

IMPORTANT! Use this procedure only if you are sure that you no longer require
access to the selected run data. If a run is archived, deleting the data will remove the
archived copy when the archived drive is mounted. If a run was previously imported
or restored, deleting will remove only the Local copy."

1. In the Data tab, click Data Management, then scroll to the Disk Space
Management section.

2. Do one of the following:

• To delete select data from more than one run report, select the checkboxes to
the left of the report names that contain the run data that you want to delete,
then click Process Selected.

• To delete data from only one run report, click Settings ( )4Actions to the
right of the report name.

If Keep is enabled, the data cannot be deleted and are kept on the local hard
drive. If you try to delete this data, an error occurs.

3. In the pop-up window, select the checkbox to the left of each File Category for
the type of data that you want to delete, then click Delete Selected.

Manually delete
selected data from
a run report
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4. (Optional) Enter a comment.

5. Click Confirm.
The data for the file categories of the selected run reports is permanently deleted
from the Ion Torrent™ Server.

You can increase file storage space for data and results files with a Torrent Storage™

NAS (Network Attached Server) device, your own network access storage (NAS)
device, or a USB drive.

After one or more of these storage drives has been installed and configured, you can
use the drive to save data locally in the lab, transfer data between servers, store data
with disk failure tolerance, and expand storage space.

Storage method Description

Torrent Storage™ NAS
(Network Attached Server)
device

A Field Service Engineer typically installs this device. It
attaches directly to a Ion Torrent™ Server, Ion S5™

Instrument, or Ion GeneStudio™ S5 System, or can connect
over a local network. After installation, it must be mounted
on the local server as described in “Connect to a Torrent
Storage™ NAS (Network Attached Server) device“ on
page 351.

Your own NAS device Similar to the Torrent Storage™ NAS (Network Attached
Server) device, but typically installed by your own system
administrator.

USB Drive Attaches directly to a Ion Torrent™ Server or Ion S5™

Instrument. After installation, it must be mounted on the
local server as described in “Mount a USB drive“ on
page 354.

Connect to a Torrent Storage™ NAS (Network Attached Server) device

Initial setup of the Torrent Storage™ NAS (Network Attached Server) device is
provided by your local Field Service Engineer. If the device is moved or disconnected
for any reason (for example, a power outage), an administrator can reconnect the
device to a Ion Torrent™ Server.

• If the Torrent Storage™ NAS (Network Attached Server) device connects directly
to the Ion Torrent™ Server, see “Connect directly to a Torrent Storage™ NAS
(Network Attached Server) device“ on page 352.

• If the Torrent Storage™ NAS (Network Attached Server) device connects over a
network to the server, see “Connect over a network to a Torrent Storage™ NAS
(Network Attached Server) device“ on page 353.

Increase file
storage and
available disk
space
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Connect directly to a Torrent Storage™ NAS (Network Attached Server) device

An administrator can connect directly to a Torrent Storage™ NAS (Network Attached
Server) device. If your Ion Torrent™ Server, Ion S5™ Instrument, or Ion GeneStudio™

S5 System is connected directly to your Torrent Storage™ NAS (Network Attached
Server) device, use the following steps to mount the device.

1. Click Settings ( )4About, then confirm that the Torrent Suite™ Software
version is 5.2 or later.
To update your software, see “Update Torrent Suite™ Software“ on page 339.

2. Click Settings ( )4Configure, then scroll to Torrent Storage.

3. Find the IP address of the Torrent Storage™ NAS (Network Attached Server)
device in the Select a TorrentNAS Device list. It can take several seconds for the
list to populate.
If the Torrent Storage™ NAS (Network Attached Server) device is not
automatically detected in less than 1 minute, confirm that the correct network
ports are connected, then click Refresh List.

4. In the Select a TorrentNAS Device list, select the IP address of the device .

5. Under Select a Share Volume, select a volume on the device , then click Add
Volume.

The storage volume is connected to the server and is listed in the Currently Mounted
Volumes list.
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Connect over a network to a Torrent Storage™ NAS (Network Attached
Server) device

If the Ion Torrent™ Server, Ion S5™ Instrument, or Ion GeneStudio™ S5 System is
installed on the same network as the Torrent Storage™ NAS (Network Attached
Server) device, an administration can use the following steps to mount the device.

1. Click Settings ( )4About, then confirm that the Torrent Suite™ Software
version is 5.2 or later.
To update your software, see “Update Torrent Suite™ Software“ on page 339.

2. Click Settings ( )4Configure, then scroll to Torrent Storage.

3. In or enter an IP or hostname here, enter the IP address of the Torrent Storage™

NAS (Network Attached Server) device, then press the Enter key.

4. In Select a Share Volume, select a volume on the device, then click Add Volume.

The storage volume is connected to the server and is listed in Currently Mounted
Volumes.
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Monitor the Torrent Storage™ NAS (Network Attached Server) device

You can check the status of a Torrent Storage™ NAS (Network Attached Server) device
in Torrent Suite™ Software.

1. Click Settings ( )4Services.

2. Scroll to the Torrent NAS Info section to view information on Torrent Storage™

NAS (Network Attached Server) devices that are attached to your server through
a network, including available storage capacity, usage, and health of the device.

USB drives

Mount a USB drive

To mount a USB drive (either an external hard drive or large flash drive), a working
knowledge of Linux™ command line interface and a basic understanding of disk
drives and partitions are necessary.

Ion Torrent™ Server is an Ubuntu™ server, which does not mount external hard drives
automatically. To address this need, the ion-usbmount utility is included with
Torrent Suite™ Software. This utility automatically mounts attached USB drives in
the /media directory. If ion-usbmount does not mount a particular USB drive
automatically, follow these steps to mount the drive manually.

These instructions provide only an overview of the required steps, and can be a
helpful reminder if you are new to the Linux™ operating system. For more detailed
instructions and background information, see the Ubuntu™ documentation at https://
help.ubuntu.com/community/Mount/USB.

We recommend that a system administrator perform the Linux™ mount and unmount
procedures.

1. Before connecting a USB drive, enter the following command to see a list of the
drives in the system: sudo fdisk -l
The local hard drive usually has a name such as /dev/sda, as in the following
example:

ionadmin@itw-test01: ~$ sudo fdisk -l

Disk /dev/sda: 500.1 GB,
500107862016 bytes
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255 heads, 63 sectors/track, 60801
cylinders
Units = cylinders of 16065 * 512 = 
8225280 bytes
Sector size (logical/physical) : 512
bytes / 512 bytes
Disk identifier: 0x0004366b

Device Boot Start End
Blocks Id System
/dev/sdal * 1 37
291840 83 Linux
Partition 1 does not end on 
cylinder boundary.
/dev/sda2 37 60802
488092673 5 Extended
/dev/sda5 37 60802
488092672 8e Linux LVM

2. Connect the USB drive.

3. Wait approximately 10 seconds, then reenter: sudo fdisk -l.
The new USB drive appears in the list. The name of the USB drive is
usually /dev/sdb or /dev/sdc, depending on the number of drives installed.
The partition is a number that is added to the name of the physical drive. For
example, the first partition on drive /dev/sdc would be called /dev/sdc1. In
the following example, there is a 2-GB partition (1953512001 blocks) attached to
the system that is named /dev/sdb1. It is configured with a Linux™ partition. (If
the drive was formatted on Windows™, it is either a FAT or an NTFS partition).

ionadmin@itw-test01:/$ sudo fdisk -l

Disk /dev/sda: 500.1 GB, 
500107862016 bytes
255 heads, 63 sectors/track,
60801 cylinders
Units = cylinders of 16065 *
512 = 8225280 bytes
Sector size
(logical/physical): 512 bytes 
/ 512 bytes
I/O size (minimum/optimal) :
512 bytes / 512 bytes
Disk identifier: 0x0004366b

Device Boot Start End
Blocks Id System
/dev/sdal * 1 37
291840 83 Linux
Partition 1 does not end on 
cylinder boundary.
/dev/sda2 37 60802
488092673 5 Extended
/dev/sda5 37 60802
488092672 8e Linux LVM

Disk /dev/sdb: 2000.4 GB,
2000398934016 bytes
255 heads, 63 sectors/track,
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243201 cylinders
Units = cylinders of 16065 * 
512 = 8225280 bytes
Sector size
(logical/physical): 512 bytes
/ 512 bytes
I/O size (minimum/ optimal) :
512 bytes / 512 bytes
Disk identifier: 0x5786fcfb

Device Boot Start End
Blocks Id System
/dev/sdb1 1 243201
1953512001 83 Linux

4. If the drive has a Windows™ FAT or NTFS partition, reformat the drive as an ext3
partition to preserve the Linux™ file information.

IMPORTANT! Be careful to format the correct hard drive.

a. Enter sudo mkfs.ext3 <your_device>. For example:

sudo mkfs.ext3 /dev/sde5

b. Label the partition on the external USB drive. To label the partition, enter the
following:

sudo e2label <your_device_place> <partition_label>.?

For example, the external drive that is connected in /dev/sdbl is labeled as
TS_Backup1:

sudo e2label /dev/sdb1 TS_Backup1

It is important to provide a different label name to each partition to avoid
error when multiple external USB drives are connected to the Ion Torrent™

Server at the same time.

5. Ensure that the external USB drive mounts automatically. Disconnect the external
USB drive, then reconnect it. Wait approximately 10 seconds.
The external USB drive appears under the Services tab in Torrent Suite™

Software

Unmount a USB drive

IMPORTANT! Before disconnecting a USB drive, unmount it first to ensure that all
data have been written to disk. If you pull out the USB connection without
unmounting the USB drive first, there is a high risk of data loss.

To unmount a USB drive, enter the following command in the command line of your
Ion Torrent™ Server: sudo umount /dev/sdb1 /media/external.
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The Ion Torrent™ dataflow involves the transfer of raw sequencing data from the Ion
GeneStudio™ S5 Prime, Ion S5™ XL, Ion PGM™, or Ion Proton™ sequencer to the Ion
Torrent™ Server for analysis and reporting.

The following tables show high-level views of the dataflow from different devices.

Dataflow using the 200-bp kit on the Ion GeneStudio™ S5 Plus System, Ion
GeneStudio™ S5 Prime System, and Ion S5™ XL System

The following table shows a high-level view of the dataflow using the 200-bp kit on
the Ion GeneStudio™ S5 Plus System, Ion GeneStudio™ S5 Prime System, and Ion
S5™ XL System. File sizes for Ion Torrent™ data depend on the Torrent Suite™ Software
version, chip type, and kit type.

Step Resulting
file type

Ion 510™

Chip
Ion 520™

Chip
Ion 530™

Chip
Ion 540™

Chip
Ion 550™

Chip

Read
capacity

— 2.5 M 5 M 15–20 M 60–80 M 100–130 M

Signal
processing
input[1]

DAT 65 GB 125 GB 310 GB 2 TB 1 TB*

Signal
processing
output

WELLS 9 GB 18 GB 45 GB 180 GB 330 GB

Base
calling
output

Unaligned
BAM

3 GB 8 GB 23 GB 85 GB 100 GB

Aligned
output

Aligned
BAM

3 GB 7 GB 20 GB 55 GB 90 GB

[1] Signal Processing input files for S5 systems are not transferred from the instrument and are not part of Ion 
Torrent™ Server data management.

* Data compression enabled.

Dataflow file sizes
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Dataflow using the 400-bp kit on the Ion GeneStudio™ S5 Plus System, Ion
GeneStudio™ S5 Prime System, and Ion S5™ XL System

The following table shows a high-level view of the dataflow using the 400-bp kit on
the Ion GeneStudio™ S5 Plus System, Ion GeneStudio™ S5 Prime System, and Ion
S5™ XL System. File sizes for Ion Torrent™ data depend on the Torrent Suite™ Software
version, chip type, and kit type.

Step Resulting file
type Ion 510™ Chip Ion 520™ Chip Ion 530™ Chip

Read capacity -- 2.5 M 5 M 15–20 M

Signal
processing
input[1]

DAT 110 GB 210 GB 530 GB

Signal
processing
output

WELLS 15 GB 30 GB 75 GB

Base calling
output

Unaligned BAM 6 GB 12 GB 30 GB

Aligned output Aligned BAM 5 GB 10 GB 25 GB

[1] Signal Processing input files for S5 systems are not transferred from the instrument and are not part of Ion 
Torrent™ Server data management.

Dataflow using the 400-bp kit on the Ion PGM™ Sequencer

The following table shows a high-level view of the dataflow using the 400-bp kit on
the Ion PGM™ Sequencer. File sizes for Ion Torrent™ data depend on the Torrent
Suite™ Software version, chip type, and kit type.

Step Resulting file
type Ion 318™ Chip Ion 316™ Chip Ion 314™ Chip

Flows — 900 900 900

Raw image
acquisition

DAT 396 GB 246 GB 52 GB

Image
processing

WELLS 31.4 GB 18.4 GB 3.5 GB

Signal
processing and
base calling

BAM 6.8 GB 4.5 GB 0.65 GB

CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signals, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in the analysis
pipeline steps before alignment.

Chapter 14 Administer Torrent Suite™ Software
Manage disk usage14

358 Torrent Suite™ Software 5.12 User Guide



Dataflow using the 200-bp kit on the Ion PGM™ Sequencer and Ion Proton™

Sequencer

The following table shows a high-level view of the dataflow from the 200-bp kit on
the Ion PGM™ Sequencer and Ion Proton™ Sequencer. File sizes for Ion Torrent™ data
depend on the Torrent Suite™ Software version, chip type, and kit type.

Step Resulting
file type Ion Proton™ Chip Ion 318™

Chip
Ion 316™

Chip
Ion 314™

Chip

Flows -- 500 500 520 520

Raw image
acquisition

DAT 2.7 TB 225 GB 135 GB 30 GB

Image
processing

WELLS 219 GB 16.4 GB 9.0 GB 2.0 GB

Signal
processing
and base
calling

BAM 44 GB 4.2 GB 3.1 GB 0.5 GB

CAUTION! File sizes vary depending on the number of flows, the number of
wells generating signals, and the number of library reads available. Your file
sizes may be different. An unmapped BAM file format is used in the analysis
pipeline steps before alignment.

Set up flexible workflows

An administrator can set up flexible workflows by forming a connection between two
or more Ion Torrent™ Servers that are running the same software version.

With flexible workflows, you can:
• View all runs of interest across multiple Ion Torrent™ Servers on the Completed

Runs and Reports screen.
• Transfer Planned Runs between sequencers that are connected to different Ion

Torrent™ Servers.
• Track reagent and cartridge usage across Ion Chef™ Instrument flexible
workflows from different Ion Chef™ Instruments connected to different Ion
Torrent™ Servers.
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1. In any tab, click  (Settings), then click Ion Mesh.

2. Select one of the following options.

Option Description

Link a selected Torrent Server. Select a Ion Torrent™ Server, then click Link
Selected TS.

Manually link a Torrent Server. Click Link TS Manually.

3. Enter the following information in the Setup Mesh Computer dialog box.

Option Definition

Hostname/Address Host name or address of the server.
If linking a selected Ion Torrent™ Server, this option is
automatically populated and cannot be edited.

Nickname A common name that is assigned to the Ion Torrent™ Server.

Username Your username.

Password Your password.

4. Click Setup.
The linked and enabled Ion Torrent™ Servers are available to be used in the
Planned Runs, and the data from the linked and enabled Ion Torrent™ Servers
can be viewed on the same Data screen.

Before viewing runs on multiple servers, you must first connect the servers using Ion
Mesh. For more information, see “Set up flexible workflows“ on page 359.

1. In the Data tab, click Completed Runs and Reports.

2. In Server , select one or more Ion Torrent™ Servers for which you want to view
data.
Notice that the server name is now reflected in the Run Name column. Your
results across multiple sequencers are ready for your review.

View sequencing
runs on multiple
sequencers with
Ion Mesh
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You can transfer Planned Runs that are created on one Ion Torrent™ Server and
transfer them to another Ion Torrent™ Server by using Ion Mesh. This is useful if the
sequencer connected directly to the origin Ion Torrent™ Server is offline or busy.

Before Planned Run transfer, first connect the Ion Torrent™ Server with Ion Mesh. For
more information, see “Set up flexible workflows“ on page 359.

IMPORTANT! The Ion Torrent™ Server must have the same version of Torrent Suite™

Software installed in order for a Planned Run transfer to be successful.

1. Sign in to Torrent Suite™ Software on the original Ion Torrent™ Server.

2. In the Plan tab, click Planned Runs.

3. Find the row of the Planned Run that you want to transfer, then click 
(Actions)4Transfer.

4. Select the Ion Torrent™ Server that you want to receive the Planned Run.

5. In the confirmation dialog box, confirm the information, then click Transfer.
You can no longer access this Planned Run on the origin server after it has
transferred.

A status appears in a message box with the results of the transfer.
• A green box lists the Planned Runs that are successfully transferred.

• A red box lists any failed Planned Run transfers.

Transfer a
Planned Run to a
Ion Torrent™

Server with Ion
Mesh
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To use the flexible workflow feature and enable cartridge use tracking between
Torrent Servers across multiple Ion Chef™ instruments, Torrent Servers must be linked
in an Ion Mesh configuration. For further information on how to link Torrent Servers
in an Ion Mesh setup, see “Set up flexible workflows“ on page 359. For more
information on configuring a flexible workflow on the Ion Chef™ Instrument, see the
Ion 550™ Kit − Chef User Guide (Pub No. MAN0017275).

IMPORTANT! If you have Torrent Servers that are connected in an Ion Mesh
configuration, and the connection to one Ion Torrent™ Server is disrupted or lost,
cartridge tracking between servers is disabled. In this situation, an error message
appears if you attempt to start a run. The run is not allowed to start because the
cartridge use status is not trackable. Ion Mesh communication must be restored to
verify that cartridge use status before the run can start.

1. In the Data tab, click Completed Runs & Reports.

2. Click a completed report.

3. In the run report, scroll down to the Details section, then select the Chef
Summary and S5 Consumable Summary tabs to track the cartridge use.

Data backup and restore locations

The Ion Torrent™ Server maintains the following types of data in separate locations:

Data type Storage location

Ion PGM™ and Ion S5™ Sequencer, and Ion
GeneStudio™ S5 Systems data

/results/< instrument_ name>
directory, by default.

Ion Proton™ Sequencer data /rawdata/<Proton_Name> directory,
by default.

Report data /results/analysis/output/Home
directory, by default.

Database records PostgreSQL database

The nightly backup of the database is created automatically, then stored for 30 days.

To restore the database, you need a complete working Ion Torrent™ Server installation.

The two scenarios for restoring a database are:
• Installing a new Ion Torrent™ Server from the Ion Torrent™ Server installation

disk due to migrating the database to a new server or needing to reinstall the
server.

• Replacing the database on an existing Ion Torrent™ Server, possibly because the
database is corrupted and you want to restore a previous version.

Track Ion Chef™

Instrument
flexible workflows
for Ion 550™ chips
with Ion Mesh

Restore the
PostgreSQL
Database
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• To restore the database from the backup file, execute these commands on the Ion
Torrent™ Server:

{{# copy the backup file to the server and decompress it 
gzip -d iondb.20100711_142442.backup.gz 

# stop the Torrent Server background processes 
sudo /etc/init.d/ionCrawler stop 
sudo /etc/init.d/ionJobServer stop 
sudo /etc/init.d/ionPlugin stop 
sudo /etc/init.d/celeryd stop 

# login as user postgres
sudo su postgres 

# restart the service to clear database connections
 /etc/init.d/postgresql restart 

# drop the existing iondb database
dropdb iondb 

# create a new empty database 
psql <<-EOFdb CREATE DATABASE iondb; 
GRANT ALL PRIVILEGES ON DATABASE iondb to ion; 
\q EOFdb
 
# import data
psql -e iondb < iondb.20100711_142442.backup 

# logout of user postgres
exit 

# start the Torrent Server background processes 
sudo /etc/init.d/ionCrawler start 
sudo /etc/init.d/ionJobServer start 
sudo /etc/init.d/ionPlugin start 
sudo /etc/init.d/celeryd start}}

Occasionally, a Django error occurs after completing the import data step. If this
error occurs, repeat the following steps:

1. Drop database.

2. Create database.

3. Import data.

Manage telemetry services

Torrent Suite™ Software uses telemetry services to provide connectivity to the
software that allows Thermo Fisher Scientific Technical Support personnel to perform
remote troubleshooting on request. Telemetry services also report anonymous usage
statistics to Thermo Fisher Scientific.

The telemetry services used with the software are:
• Axeda™ Remote System Monitoring agent (Axeda™ RSM agent)
• Deep Laser
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To enable or disable these telemetry services, click  (Settings)4Services, then scroll
down to the Telemetry Services section.

Disabling telemetry services stops all Connect integration and makes remote support
more difficult.

Remote access for troubleshooting

When there is a problem with a sequencer or the Ion Torrent™ Server, the Axeda™

RSM agent allows Thermo Fisher Scientific Technical Support personnel to remotely:
• Collect log files from the system for review.
• Restart the device.
• Upgrade software.
• Provide a remote sign in connection to the device for further diagnostic work.

When a problem with an Ion S5™, Ion PGM™, Ion Proton™, or Ion GeneStudio™ S5
System, or Torrent Suite™ Software is reported, Thermo Fisher Scientific service and
support tries to solve the problem by telephone or email. If remote access is required
for additional troubleshooting, a member of Thermo Fisher Scientific Technical
Support requires authorization from the technical contact to initialize a remote
connection. Only after getting authorization does Thermo Fisher Scientific Technical
Support personnel proceed with remote troubleshooting. After the problem is
resolved, you are notified. Additional authorization is required before starting any
further remote help.

Axeda™ RSM agent overview

The Axeda™ Remote System Monitoring agent (Axeda™ RSM agent) is a software
component that is installed automatically on the Ion Torrent™ Server and Ion S5™, Ion
PGM™, and Ion Proton™, and Ion GeneStudio™ S5 Systems through the software
update process.

Approximately every 60 seconds, the Axeda™ RSM agent sends a heartbeat message
to Thermo Fisher Scientific. This information is used to track the deployment and
software configuration of machines in the field.

Data is collected in the Axeda™ monitoring database, where Thermo Fisher Scientific
Technical Support personnel can review the information that agents collect. Because
the heartbeat message is sent many times an hour, Technical Support can quickly see
the following:

• If a machine is online
• The software versions in use
• Some technical details about the instrument such as temperature and hard drive

status.

The agent also allows Thermo Fisher Scientific personnel to remotely access the Ion
S5™, Ion PGM™, Ion Proton™, and Ion GeneStudio™ S5 Systems and the Torrent Suite™

Software, which is required for system support. Without remote access, Thermo
Fisher Scientific Field Application Scientists cannot access, view, and troubleshoot
problems regarding machine performance.

Axeda™ Remote
System
Monitoring (RSM)
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Port assignments

To support fully the Ion Torrent™ Server and multiple Ion Torrent™ sequencers,
remote monitoring must be provided using Axeda™ Remote System Monitoring
software enabled, and must be able to reverse SSH into the boxes. This requirement
means that the multiple sequencers and the Ion Torrent™ Server must be connected to
the Internet with outbound connections that are permitted on the following ports.

Port Required Use

22 Yes Start reverse SSH tunnel for remote troubleshooting.

80 Yes Download updates from http://updates.iontorrent.com and 
http://us.archive.ubuntu.com.

123 Yes (UDP) NTP access to the Internet, incoming and outgoing.

443 Yes Enable sending of basic status information to the remote
monitoring server.

The IonReporterUploader plugin also requires port 443 to
transfer data to Ion Reporter™ Software.

5432 No Remote access to the PostgreSQL database.

When there is a problem with a sequencer or the Ion Torrent™ Server or Torrent Suite™

Software, Deep Laser telemetry service allows Thermo Fisher Scientific Technical
Support personnel to remotely troubleshoot the problem.

Telemetry services are enabled by default. When enabled, connectivity to Connect is
allowed in order to transfer support archived files to Thermo Fisher Scientific
technical support staff to perform remote troubleshooting. Anonymous usage
statistics are also reported to Thermo Fisher Scientific.

Disabling telemetry services stops all Connect integration and may make remote
support more difficult. You can disable telemetry services on the System Services
screen in the Telemetry Services section. Disabling telemetry services disables both
Deep Laser and Axeda™ RSM agent.

For assistance, contact your local Field Service Engineer.

Deep Laser
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Event names, data types, and sample values of the data being collected by Axeda™

RSM agent and the Deep Laser telemetry service are described in the following tables.
This information is sent automatically from the Ion Torrent™ Server and Ion S5™, Ion
PGM™, Ion Proton™, and Ion GeneStudio™ S5 Systems back to Thermo Fisher
Scientific.

Ion Torrent™ Server data

The following table lists and describes the Ion Torrent™ Server events that are
collected by Axeda™ RSM agent and the Deep Laser telemetry service, then
automatically sent to Thermo Fisher Scientific.

Event name Data type Sample value

TS.Config.biosversion String 6.00

TS.Config.configuration String standalone

TS.Config.hostname String Ion-torrent-server

TS.Config.ipaddress String 10.45.3.246

TS.Config.mode String Master

TS.Config.serialnumber String 1SMJFP1 ( DO NOT USE Dell™ service tag)

TS.Contact.IT Contact String email, phone

TS.Contact.Lab Contact String email, phone

TS.Experiment String chip type, flow count, run type, bedfile,
barcode count, seq s/n

TS.GPU String No problems

TS.host String Ion-torrent-server

TS.HW.HD./results String 58.99

TS.Location.City String Rockville

TS.Location.Org-Name String Unknown

TS.Location.Postal-Code String Unknown

TS.Location.State String Unknown

TS.Location.Street-Address String Unknown

TS.Nexenta<n>_lic_days_left String 180

TS.Nexenta<n>_lic_status String license status

TS.Nexenta<n>_machine_sig String 5EDI8L9NA

TS.Nexenta<n>_UUID String 44454c4c-5900-1046-8048-b2c04f533532

TS.Nexenta<n>_vol<v> String pool1 size=32.5T allocated=860G
free=31.7T capacity=2%
health=ONLINE

Data automatically
collected by the
telemetry services
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Event name Data type Sample value

TS.Nexenta<n>_vol<v>_d<d> String c0t5d1 health=ONLINE
vendor=SEAGATE
product=ST6000NM0034
serial=Z4D1XT26 size=6TB

TS.Server.celerybeat String ok/offline/error

TS.Server.celery_diskutil String ok/offline/error

TS.Server.celery_periodic String ok/offline/error

TS.Server.celery_plugins String ok/offline/error

TS.Server.celery_slowlane String ok/offline/error

TS.Server.celery_transfer String ok/offline/error

TS.Server.celery_w1 String ok/offline/error

TS.Server.dhcp String ok/offline/error

TS.Server.ionCrawler String ok/offline/error

TS.Server.ionJobServer String ok/offline/error

TS.Server.ionPlugin String ok/offline/error

TS.Server.ntp String ok/offline/error

TS.Server.RabbitMQ String ok/offline/error

TS.Server.RSM_Launch String ok/offline/error

TS.Server.tomcat String ok/offline/error

TS.TYPE String TS1

TS.Version.alignment String 1.42-0

TS.Version.analysis String 1.40-0

TS.Version.dbreports String 1.95-3

TS.Version.docs String 1.15-1

TS.Version.referenceLibrary String 1.6-1

TS.Version.tmap String 0.0.19-1

TS.Version.tsconfig String 1.3-9
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Ion PGM™ data

The following table lists and describes the Ion PGM™ events that are collected by
Axeda™ RSM agent and the Deep Laser telemetry service, then automatically sent to
Thermo Fisher Scientific.

Event name Data type Sample value

Instrument.Event.LastExperiment String R_2011_04_22_15_34_58_usr_S-1

Instrument.Event.Pressure Analog 0 (chart)

Instrument.Event.ValveBoard String Valve Board not accessible

Valve Board Down Stream Errors

Valve Board Up Stream Errors

Instrument.Event.RunAborted String Run aborted

Instrument.Event.LostChipCon String Lost chip connection, run aborted

Instrument.Event.UBoot String U-boots don’t match

Instrument.Event.Kernel String Kernels don’t match

Instrument.Event.ResultsDrive String Results drive not accessible

Instrument.Event.BootDrive String Bad boot drive detected

Instrument.Event.DataDrive String Bad data drive detected

Instrument.HW.HD1 Analog 34.001 (chart)

Instrument.InstrumentName String Stork

Instrument.Pressure Analog 10.2 (chart)

Instrument.Temperature Analog 27.06 (chart)

Instrument.TYPE String PGM1

Instrument.Version.Board String 4 A.1

Instrument.Version.Datacollect String 180

Instrument.Version.driver String 31

Instrument.Version.fpga String 70

Instrument.Version.Graphics String 15

Instrument.Version.LiveView String 268

Instrument.Version.OS String 12

Instrument.Version.Scripts String 16.3.58
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Ion S5™, Ion Proton™, and Ion GeneStudio™ S5 System data

Ion S5™, Ion Proton™, and Ion GeneStudio™ S5 System data are divided into these
categories:

• DataCollect—These items come from the instrument configuration file.
• RunData—These items reflect parameters from the last Auto pH or sequencing

run.
• Status—These items reflect the current instrument parameters.
• System—These items provide parameters related to the operating system

supporting the instrument.
• Version—These items provide the version numbers for the various software

packages installed on the instrument.

In addition, two items (InstrumentState, Type) are not placed in any category.

The following table lists and describes the Ion S5™, Ion Proton™, and Ion GeneStudio™

S5 System events that are collected by Axeda™ RSM agent and the Deep Laser
telemetry service are automatically sent to Thermo Fisher Scientific. The number and
names of these entries are subject to change across software releases.

Data item name Data type Sample value

Alarm.* String Various hardware alarm messages

BIOS.BIOS Analog 5350

DataCollect.FlowsSinceClean Analog 400

DataCollect.RunsSinceClean Analog 1

Event.CleanCompleted String Clean completed

Event.DatacollectStarted String Datacollect Started

Event.InstrumentMustBeInitialized String Instrument must be initialized

Event.PostRunCleanHasNotBeenRun String Post Run Clean has not been run

InstrumentState String Idle

RunData.a1a2 String R_2016_02_17_13_01_08_user_F4--145
W1.dat dffffe cntArry 9 0 0 9

RunData.AutoPhFinal Analog 7.660635

RunData.AutoPhInitial Analog 6.321023

RunData.AutoPhIterations Analog 4

RunData.AutoPhResult String Pass

RunData.AutoPhTotalW1Volume Analog 1.0

RunData.ChipGain Analog 1.066389

RunData.ChipPixelAverage Analog 8241
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Data item name Data type Sample value

RunData.ChipPixelsInRange Analog 164698460

RunData.ChipPixelsPinnedHigh Analog 0

RunData.ChipPixelsPinnedLow Analog 676

RunData.ChipTemp Analog 81.826172

RunData.CpuTemp0 Analog 53

RunData.CpuTemp1 Analog 74

RunData.efuse String **********L:Q6C841,W:4,J:WC2012C00086-
C00272,P:16,C:PT4,F:F6,Y:4,X:0,B:3,SB:31,B:1
P,N:343***********************************
**

RunData.FpgaMasterTemp Analog 113

RunData.FpgaSlaveTemp Analog 118.4

RunData.GpuTempC Analog 82

RunData.LastAutoPhRealPh Analog 766

RunData.LastAutoPhRef Analog 745

RunData.LastAutoPhTarget Analog 770

RunData.R1pH Analog 7.00

RunData.R2pH Analog 7.00

RunData.R3pH Analog 7.00

RunData.R4pH Analog 7.00

RunData.W1pH Analog 8762

RunData.W2pH Analog 7619

RunData.W3RefpH Analog 7.45

Status.HDPctFull Analog 0.823612

Status.SsdPctFull Analog 6.220454

System.CpuUsagePct Analog 7

System.Date String 2013-01-0

System.FreeMemoryKB Analog 129951948

System.Hostname String d1.ite

System.IpAddress String 10.25.3.150

System.PhysMemTotalGB Analog 128

System.Time String 03:42:58 PM GMT

Chapter 14 Administer Torrent Suite™ Software
Manage telemetry services14

370 Torrent Suite™ Software 5.12 User Guide



Data item name Data type Sample value

TYPE String Proton1

Version.Datacollect String 3371

Version.DiskImage String 2015_06_04

Version.Graphics String 80

Version.KernelRelease String 3.13.9-ionrt1

Version.LiveView String 2166

Version.OIA String 5203

Version.OS String 17

Version.Reader FPGA String 3d400109

Version.Reader FPGA1 Analog 33400109

Version.Reader Woddr FPGA String 3400043

Version.Reader Woddr FPGA1 String 340004b

Version.RSM String 24

Version.Scripts String 2.0.63

Version.S5 Release Analog 5.2

Version.S5 Script String 0.1.13

Version.TSLink String 1.0.2r5

Version.Valve FPGA String c010
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Administration with command-line utilities

You can monitor disk space if the Torrent Suite™ Software is not available, or if you
want to use a command-line utility.

IMPORTANT! If there is insufficient space on the Ion Torrent™ Server, data files are
retained on the Ion PGM™ Sequencer and the Ion Proton™ Sequencer until space
becomes available.

1. Sign in to the Ion Torrent™ Server using an ssh client:

$ ssh ionadmin@ion-torrent-server 
$ password: ionadmin

2. Enter the df command to display partitions and disk utilization:

Most growth is seen in the /results directories, which is where Ion Reporter™

Software data are stored.
The Use% column indicates how much space is being used.

You can also monitor disk space through the Ion Reporter™ Software. For details, see 
“View disk usage parameters“ on page 299.

Monitor disk
space
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Use the following command to change the hostname:

sudo TSconfig --change-hostname

You must restart the server after the hostname is changed. This command
automatically restarts the server.

Use the following command to change the time zone:

sudo TSconfig --configure-timezone

Use the following command to add an HTTP proxy:

sudo TSsetproxy

Set the proxy address and authentication according to the following prompts:

1. Enter http proxy address: Enter the proxy address. (If no address is
entered, you are prompted to exit the program.)

2. Enter http proxy port number [3128]: Enter a port number or carriage
return to accept the default, 3128, port number.

3. Enter the username for proxy authentication: Enter a username. If
you do not enter a username, no authentication is set.

4. Enter the password for proxy authentication: Enter a password. If
you do not enter a password, no authentication is set.

A proxy address confirmation message is displayed:

http_proxy is set to http://username:password@proxyAddress

The recommended usage is to enter the command sudo TSsetproxy, as shown above,
and be prompted for each value. You can however use the TSsetproxy arguments
instead:

Usage: TSsetproxy [option]... --address Proxy address (example:
                'http://proxy.net') --port Proxy port number 
(default: 3128) --username
                Username for authentication --password 
Password for authentication --remove Removes
                proxy setting --debug,-d Prints script 
commands when executing (set -x) --demo
                Prints what changes would be executed only. No 
changes are made --help,-h Prints
                command line args --version,-v Prints version

1. Connect to your Ion Torrent™ Server host, using ssh, and verify that the Crawler
and Job Server services are running:

ps -aux | grep py

Change the
hostname

Change the time
zone

Add an HTTP
proxy

Alternate checks
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This should show active crawler.py and serve.py processes.

2. Run a test analysis of the provided cropped data set and review the resulting
report.
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Troubleshooting

This appendix includes information on troubleshooting tips, resources, and where to
get additional information or Technical Support assistance for Ion GeneStudio™ S5
and Ion S5™ Systems sequencing runs. It also includes known recommended actions
to observed problems, such as low loading density, low percentage of live ISPs, and
missing test fragments.

Troubleshooting resources

For more troubleshooting information, see the instrument user guides on the Ion S5™

System, Ion S5™ XL System, and Ion GeneStudio™ S5 System product pages. You can
also search for manuals on the Services & Support tab at www.thermofisher.com.

• Customer Support Archive (CSA)—For problems that require technical help,
obtain the CSA. The sequencing CSA is used by Technical Support to diagnose
problems. Due to the large size of the full analysis CSA, it is necessary to use the
thumbnail version for troubleshooting purposes. To download this CSA:

a. In the Data tab, click Completed Runs & Reports, then click the Report
Name link with "_tn" appended.

b. In the left navigation menu, click Details, or scroll to the Details section of
the run report, then click the Support tab.

c. Click Download to download a compressed directory that contains a PDF
and HTML version of the run report, and logs that can be used for
troubleshooting.

d. Email the report to Technical Support. If you would like to be able to upload
these support files directly, ask your local Field Service Engineer how to
enable the Customer Support Archive function.

• Instrument log files—Instrument log files from the Ion OneTouch™ 2 or Ion Chef™

instruments can also be sent to Technical Support for troubleshooting help.
Contact Technical Support for instructions to download instrument log files. The
CSA includes instrument log files.

• Turn off 3' quality trimming—In cases of shorter-than-expected library reads, the
3’ quality trimming can be turned off to help distinguish short reads that
originate from the library preparation and short reads resulting from the 3’
quality trimming by the software. To turn off the 3’ quality trimming:

a. In the Data tab, click Completed Runs & Reports.
b. Search, filter, or sort the list to find your run report of interest.
c. In Table View mode, in the row of the run of interest, click 

(Actions)4Reanalzye.
d. Under the Advanced options, on the Start reanalysis from line, select Base

Calling.

A
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e. In the Basecaller args field, change the --trim-qual-cutoff 15 value to
100. The field should now read, BaseCaller --trim-qual-cutoff 100
--trim-qual-window-size 30 --trim-adapter-cutoff 16.

f. Give the reanalysis report a new name and select Start Analysis.
• ISP QC (Qubit™ data)
• Library QC data (Agilent™ Bioanalyzer™ Instrument trace or quantification data)
• Ion Library, Template Kit, and Sequencing Kit names and lot numbers

Troubleshoot Torrent Suite™ Software

You can view the report log when troubleshooting a completed run. If you need
further assistance after viewing the report log, you can generate a customer support
archive that you can share with technical support for assistance.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name
link to open the report of interest.

2. In the left navigation menu, click Details, or scroll to the Details section of the
run report, then click the Support tab.

3. Click View the report log to see a list of errors.

4. If you are unable to resolve an issue using the report log, click Download to
download a customer support archive. This is a compressed directory that
contains a PDF and HTML version of the run report, and logs that can be used
for troubleshooting.

5. (Optional) Email the customer support archive to your local Field Service
Engineer or Technical Support representative. If you would like to be able to
upload the customer support archive directly, ask your Field Service Engineer
how to enable the Customer Support Archive function.

Low loading density, low live ISPs, missing test fragments, primer-dimers, and other
issues can affect sequencing runs.

Observation Possible cause Recommended action

Failed status for a run It is not clear whether the
sequencing run data transfer
completed and you can access
the sequencer.

Go to the sequencer Data Management screen
to confirm complete data transfer. If you are
not sure the data set was transmitted, you can
re-transfer it.

The run report was successful
but you are not sure whether
the data was transferred.

In Torrent Suite™ Software, under the Data tab,
click Completed Runs & Reports to view the
run report and ensure that the file transfer was
complete. Also, check if there are any error
messages, such as User Aborted on the report
itself. Look for a status of Error or Pending.

Get technical
support files for a
completed run

Troubleshoot a
sequencing run
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Observation Possible cause Recommended action

Failed status for a run
(continued)

You cannot determine the
cause of the failed run status.

Reanalyze the run. For more information, see 
“Reanalyze a run“ on page 88.

Send the customer support archive to your
local Field Service Engineer or Technical
Support for review. For more information, see 
“Get technical support files for a completed
run“ on page 376.

Low loading density from
Ion Chef™ Instrument runs

Too little library input into
template preparation. Low
enriched ISP recovery is caused
by unenriched ISPs with <5%
templated ISPs.

Review Qubit™ QC assay results to determine if
% templated ISPs was low.

• If % templated ISPs was <10%, increase
library input to target 15–25% templated
ISPs.

• Requantify the library. If the library yield
was below recommended, rebuild the
library.

Too much library input into
template preparation.

Review Qubit™ QC assay results to determine if
% templated ISPs was too high after template
preparation.

• If library is >25% but <70% templated
ISPs, rebuild the library. Decrease library
input to target 10-25% templated ISPs, or
continue with sequencing and expect
lower throughput.

• If library is >70% templated ISPs, check
Agilent™ 2100 Bioanalyzer™ traces for
adapter dimer peak (amplicon library or
Ion AmpliSeq™ library peak near 70 bp;
miRNA library peak near 60 bp). Repurify
(reduce) library using Agencourt™

AMPure™ XP Kit clean-up steps as
outlined in appropriate user guides.

Chip adapter placement or
removal was improper.

Inspect chip adapters for any obvious defects
before installation.

The best practice for removing chip adapters
for Ion S5™ chips is to squeeze the adapter
ends at the same time and remove the adapter
by keeping it parallel to the chip.

Bubbles were present during
chip loading or during the chip
run.

Air bubbles in the reagent tubes can affect
various steps through the sequencing run,
including loading density. Let reagents settle
before using.

Low loading density from
Ion OneTouch™ 2 System runs

Too little library input into
template preparation. Low
enriched ISP recovery is caused
by unenriched ISPs with <5%
templated ISPs.

Review Qubit™ QC assay results to determine if
% templated ISPs was low.

• If % templated ISPs was <10%, increase
library input to target 15–25% templated
ISPs.

• Requantify the library. If the library yield
was below recommended, rebuild the
library.
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Observation Possible cause Recommended action

Low loading density from
Ion OneTouch™ 2 System runs
(continued)

Too much library input into
template preparation.

Review Qubit™ QC assay results to determine if
% templated ISPs was too high.

• If library is >25% but <70% templated
ISPs, rebuild the library. Decrease library
input to target 10-25% templated ISPs, or
continue with sequencing and expect
lower throughput.

• If library is >70% templated ISPs, check
Agilent™ 2100 Bioanalyzer™ traces for
adapter dimer peak (amplicon library or
Ion AmpliSeq™ library peak near 70 bp;
miRNA library peak near 60 bp). Repurify
(reduce) library using Agencourt™

AMPure™ XP Kit clean-up steps as
outlined in appropriate user guides.

Low pre-enriched ISP recovery. Review Qubit™ QC assay results to determine if
ISP recovery was low after template
preparation.

Ensure that ISPs are properly vortexed
(1 minute at maximum speed as suggested in
the user guide) before the addition of
amplication mix.

Ensure proper OT2 instrument setup and
performance.

Low enriched ISP recovery. Ensure proper reagent setup for ES
enrichment.

Ensure that enrichment beads (Dynabeads™

MyOne™ beads) are washed and resuspended
in the correct washing solution.

Properly prepare the fresh melt-off solution.

Improper addition of
sequencing primer and
polymerase.

Ensure that sequencing primer and
polymerase were added.

During the primer annealing step, it is
important to thoroughly resuspend the
enriched ISP pellet before and after adding the
sequencing primer. This helps to break up ISP
clumps and ensure even sequencing primer
distribution to the templates on the ISPs.

Properly mix ISPs during the primer annealing
step. Improper mixing can cause lower than
expected key signal and possible
misidentification of template ISPs.

Wrong loading protocol was
used.

Use the recommended protocol for the chip
type and sequencing kit.
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Observation Possible cause Recommended action

Low percentage of live ISPs.
The Live (% enrichment) metric
includes both live TF and
library ISPs. When evaluating
the percent enrichment metric,
also consider the ratio of test
fragment ISPs to library ISPs. If
the ratio of TF ISPs is higher
than expected, the reported
percent of enriched library ISPs
is not accurate. Instead,
calculate the library
enrichment from the values in
the run report table: [Library
ISPs/(Live ISPs - TF ISPs)] x
100 = Library ISP %
Enrichment.

Improper addition of
sequencing primer and
polymerase.

Review Test Fragment (TF) metrics. If TFs are
missing or the signal is low: primer or
polymerase can have been added incorrectly.

Ensure proper addition of sequencing primer
and polymerase.

Poor library amplification onto
the ISPs (template
preparation).

Review Test Fragment (TF) metrics. If TFs are
present and have the expected key signal and
quality, check the Qubit™ QC assay. If results
indicate <10% templated unenriched ISPs, then
too little library was added.

Check Ion OneTouch™ 2 System performance
by downloading the log files.

Too little library input into
template preparation.

Review Test Fragment (TF) metrics. If TFs are
present and have the expected key signal and
quality, check the Qubit™ QC assay. If results
indicate <10% templated unenriched ISPs, then
too little library was added.

Check Ion OneTouch™ 2 System performance
by downloading the log files.

Enrichment failure. Check the ES enrichment process to ensure
that fresh melt-off and the correct enrichment
beads (Dynabeads™ MyOne™ beads) and
solutions are used.

If >5-µL residual volume is left in wells 1
through 8, perform a residual volume test.

Test Fragment-1 is not present
or conversion is low
There are two test fragment
controls: TF-C is a sequencing
control and TF-1 is an
amplification control. Starting
in Torrent Suite™ Software 5.4,
only TF-1 is present.

Poor amplification onto the
ISPs (template preparation).

Review Qubit™ QC assay results to determine if
% templated ISPs was low after template
preparation.

Ensure that reagents were set up correctly.

Sequencing or consumables
problem occurred.

Ensure that sequencing primer was annealed
and sample was incubated with polymerase.

Ensure that all reagents were from the same
sequencing kit type. Do not swap reagents
between kit types.

Ensure that reagents set up were correctly.

Send Customer Support Archive (CSA) to
Technical Support.

Lower than expected
number of live library ISPs with
a key sequencing matching the
library key (TCAG).

Low loading density reported. See recommendations for low loading density.

Bad library key used. Ensure that the library was properly prepared.
This is less likely to be the problem if an Ion
library kit was used for library construction.

Ensure that the template preparation was
successful. Check Qubit QC assay results. Send
Customer Support Archive (CSA) to Technical
Support.
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Observation Possible cause Recommended action

Lower than expected
number of live library ISPs with
a key sequencing matching the
library key (TCAG).
(continued)

Poor library quality or
templating efficiency.

Ensure that the library was properly prepared.
This is less likely to be the problem if an Ion
library kit was used for library construction.

Ensure that the template preparation was
successful. Check Qubit QC assay results. Send
Customer Support Archive (CSA) to Technical
Support.

High polyclonal count Too much library input into
template preparation.

Verify library quantification and template
preparation with QC (Qubit assay).

If the library key signal is lower than expected,
% polyclonal estimate might be inaccurate.

High number of low quality
reads.
Reads are too short after
quality trimming.

Poor library quality or
templating efficiency: bad or
low key signal.

Check Agilent™ Bioanalyzer™ Instrument trace
to ensure that library is within the
recommended size range (amplified, non-
equalizer libraries only).

Ensure that library was properly prepared
(correct adapter sequences, adapter ligation).

Review the library ISP QC data Qubit™ data.

High relative primer dimer
count

Library preparation resulted in
high number of primer dimers.

Check Agilent™ Bioanalyzer™ Instrument trace.
Non-barcoded adapter dimers ~70 bp.
Barcoded adapter dimers ~80 bp.

Repurify library to remove adapter dimers.

Low Final Library ISPs count Low ISP loading density
reported.

Review well classification and read filtering
results to narrow troubleshooting focus.

Poor library read filtering
reported.

Send a Customer Support Archive (CSA) to
Technical Support.

You can download an archive that a Technical Support representative can use to
diagnose Torrent Suite™ Software issues. The Customer Support Archive (CSA)
contains log files and other technical data about your Torrent Suite™ Software and
analysis runs.

Under some circumstances, you can use the FieldSupport plugin to generate an
archive for use by Technical Support. For details, see “FieldSupport plugin“ on
page 172.

Generate a customer support archive

1. Under the Data tab, in the Completed Runs & Reports screen, click the link for
your completed analysis run.

2. In the Run Summary, click the Plugin Summary link, or scroll down to the
Plugin Summary section.

3. Click the Support tab, then click Download.

A compressed archive is downloaded to the directory location that you specified to
download files from the browser. This location depends on your browser settings. You
can attach this archive to an email to send to Customer Support.

Customer Support
Archive (CSA)
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Ion Torrent™ Server cannot access the customer support server automatically. If you
would like to upload files directly, contact your local Field Service Engineer and ask
how to enable the customer support archive upload for your Ion Torrent™ Server.

Customer support archive contents

The tables in this section describe the files and locations of the files that are included
in a customer support archive. Files for optional modules (such as recalibration)
appear only if the optional module is run.

In the top level directory:

File Description

alignment.log The log of the final TMAP alignment
process.

<RunName>_<AnalysisReportName>
.alignment.summary

A text format summary of sample
alignment final results .

alignment.summary A text format summary of sample
alignment final results (same as the file 
<RunName>_<AnalysisReportName>
.alignment.summary, but with a
predictable file name).

backupPDF.pdf A PDF file of the analysis report and plugin
results (similar to the output of the
Download as PDF button on a run report).

Controller The Live View log of user activity on the
sequencing instrument.

debug The log from data collect, the background
data acquisition module.

DefaultTFs.conf Contains a list of known test fragment
sequences and their bases.

drmaa_stderr_block.txt The analysis pipeline error log for the block
being executed by Oracle™ Grid Engine.

drmaa_stdout.txt The log of events after primary analysis.

drmaa_stdout_block.txt The analysis pipeline output log for the
block being executed by Oracle™ Grid
Engine.

explog.txt The initial run settings needed for Torrent
Suite™ Software analysis when being
exported from an instrument.

explog_final.txt The final run settings needed for Torrent
Suite™ Software analysis when being
exported from an instrument.

InitLog.txt The instrument auto pH log.

InitValsW2.txt The pH log of the W2 solution.
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File Description

InitValsW3.txt The pH log of the W3 solution.

RawInit.txt Contains initialization data output.

sysinfo.txt Contains Torrent Suite™ Software system
settings.

TF.alignment.summary A summary of test fragment alignment
results in a text file.

uploadStatus The log of metrics being uploaded to the
Torrent Suite™ Software.

version.txt Lists the Torrent Suite™ Software versions
used for the analysis report.

In the basecaller_results directory:

File Description

basecaller.log A log file for the BaseCaller analysis
module.

datasets_basecaller.json A JSON-format file of the settings needed
for the BaseCaller module to analyze the
sample data.

datasets_pipeline.json A JSON-format file of the settings needed
by the pipeline to run the BaseCaller
module.

datasets_tf.json A JSON-format file of the settings needed
for the BaseCaller module to analyze the
Test Fragments.

<RunName>_<AnalysisReportName>
.quality.summary

A quality summary of the BaseCaller
module unaligned reads/bases after
filtering and trimming.

quality.summary Same as above, but with a predictable file
name.

TFStats.json A JSON-format file of test fragments
results statistics.

In the basecaller_results/recalibration directory:

File Description

alignment.log A log of the TMAP alignment process during
base recalibration.

alignmentQr_out.txt A log file from the TMAP analysis module.

In the basecaller_results/unfiltered.trimmed directory:

Appendix A Troubleshooting
Troubleshoot Torrent Suite™ SoftwareA

382 Torrent Suite™ Software 5.12 User Guide



File Description

alignment.log A log of the TMAP alignment process based
on unfiltered and trimmed reads.

<RunName>_<AnalysisReportName>
. alignment.summary

A text format summary of sample
alignment results for unfiltered and
trimmed reads.

alignment.summary A text format summary of sample
alignment results for unfiltered and
trimmed reads(same as above, but with a
predictable file name).

datasets_basecaller.json A JSON-format file of the settings needed
for the BaseCaller module to analyze the
sample data, when generating the raw BAM
file.

<RunName>_<AnalysisReportName>
.quality.summary

The BaseCaller module unfiltered and
trimmed reads/bases quality summary.

quality.summary The BaseCaller module unfiltered and
trimmed reads/bases quality summary
(same as above, but with a predictable file
name).

In the basecaller_results/unfiltered.untrimmed directory:

File Description

alignment.log A log of the TMAP alignment process based
on unfiltered and trimmed reads.

<RunName>_<AnalysisReportName>
. alignment.summary

A text format summary of sample
alignment results for unfiltered and
untrimmed reads.

alignment.summary A text format summary of sample
alignment results for unfiltered and
untrimmed reads (same as above, but with
a predictable file name).

datasets_basecaller.json A JSON-format file of the settings needed
for the BaseCaller module to analyze the
sample data, when generating the raw BAM
file.

<RunName>_<AnalysisReportName>
.quality.summary

The BaseCaller module unfiltered and
untrimmed reads/bases quality summary.

quality.summary The BaseCaller module unfiltered and
untrimmed reads/bases quality summary
(same as above, but with a predictable file
name).

In the sigpror_results directory:
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File Description

analysis.bfmask.stats Contains analysis statistics of wells in the
bead find stage (the bfmask is a set of bit
flags for each well, indicating the contents
of each well).

avgNukeTrace_ATCG.txt Contains ATCG key signal measurements.

avgNukeTrace_TCAG.txt Contains TCAG key signal measurements.

bfmask.stats Contains summary statistics of wells in the
bead find stage.

processParameters.txt Contains parameter settings for analysis
signal processing.

separator.bftraces.txt Contains matrix data to separate between
live wells and empty wells during bead find
phase.

separator.trace.txt Contains matrix data to separate between
live wells and empty wells.

sigproc.log A log file for the analysis module.

In the sigpror_results/dcOffset directory:

File Description

dcOffset.txt The background model parameter values of
dcOffset.

In the sigpror_results/NucStep directory:

The files in this folder contain background model parameter values based on the
location of the well in the chip.

File

NucStep_frametime.txt
NucStep_inlet_head.txt
NucStep_inlet_empty.txt
NucStep_inlet_empty_sd.txt
NucStep_inlet_step.txt
NucStep_middle_head.txt
NucStep_ middle_empty.txt
NucStep_ middle_empty_sd.txt
NucStep_ middle_step.txt
NucStep_outlet_head.txt
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File

NucStep_ outlet_empty.txt
NucStep_outlet_empty_sd.txt
NucStep_outlet_step.txt

Troubleshoot IonReporterUploader plugin account setup

Observation Possible cause Recommended action

IonReporterUploader plugin account is not
configured.
Red status appears on the Ion Reporter™ Software
account configuration screen.

If you change your account
password, you see a red dot in
the status column of the
IonReporterUploader plugin
account.

When you change your
password, click Edit and enter
your new password.

If you upgrade the account,
you see a red dot in the status
column of the
IonReporterUploader plugin
account.

When you upgrade your
account to a new version,
click Edit, then delete your
old account and create a new
account for the new version.

Some types of errors do not appear in the Processing Log section (see the log entry
under Upload History in Reference Sequence). Major problems with files can
prevent file uploading.

Observation Possible cause Recommended action

File upload errors.
File validation cannot be
attempted.

• Incorrect file format

• Incorrect file extension

• The ZIP file contains no
files or multiple files

• A corrupted ZIP or GZ file

Check for possible errors in the source BED or
VCF file.

Fix the errors, or replace the file, then re-
attempt the upload.

Reference genome file cannot
be opened

• An invalid FASTA file was
uploaded.

• No FASTA header found at
line 1.

• Genome information text
file may have been deleted.

1. Delete the existing reference sequence
entry.

2. Identify and correct formatting errors in
the FASTA file.

3. Upload the corrected file.

Troubleshoot Ion Torrent™ Server

These troubleshooting recommendations apply to system level issues such as
networking, disk space, and system load.

Troubleshooting
file import/upload
errors
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Use the Crawler and Jobs Server screen to view information about the background
processes that are running on Torrent Suite™ Software.

If these processes are not running, run information is not updated and analysis
reports are not generated. If this occurs, there is no risk of data loss but the Crawler
and Jobs Server processes should always be running. The Archive process runs only if
archiving has been configured.

If a process is not running, a Down or Offline reason displays in the Services screen.
An example message is The crawler is offline.

1. Click  (Settings)4Services.

2. In the Crawler and Jobs Server screen, review the information about the
background processes described in the following table.

Process Program Startup script Description

Crawler crawler.py ionCrawler Searches for new
runs from the
sequencers and
puts run
information into the
database so that it
appears in the Data
> Completed Runs
& Reports screen.

Job Server serve.py ionJobServer Sends analysis jobs
to the Oracle™ Grid
Engine.

Plugin Server ionPlugin.py ionPlugin Sends plugin jobs
to the Oracle™ Grid
Engine.

Celeryd manage.py celeryd A background job
processor for
Django (the web
application
framework).

Check crawler and
job server status
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Queue status

Click the Queue Status link in the Active Jobs section to open a table of SGE queue
activity:

There can be many reasons for network connectivity or name resolution to fail. Use
this procedure to try to resolve connectivity and name resolution problems.

If you cannot reach the Ion Torrent™ Server by using an IP address, you are likely to
need help from the site IT administrator who understands how the local network is
configured.

1. Click  (Settings) Configure.

2. In the Configure screen, scroll down to the Database Administration section,
then click Admin interface link to access the database administration functions.

3. If you are prompted to sign in, enter your administrator user name and
password, then click Sign in.
The Site administration screen in the Ion Web portal opens.

4. Scroll down to Management Actions, then select the Network Settings line.
The software performs several network checks:

Verify network
connectivity and
name resolution
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5. Verify that the Ion Torrent™ Server is configured correctly by reviewing the Ion
Torrent™ Server deployment instructions.

6. Find the IP address of the Ion Torrent™ Server as described in “Verify the Ion
Torrent™ Server IP address“ on page 388.

After you are finished, click Back to Main Site at the top of the screen to return to the
software.

The Ion Torrent™ Server is configured out-of-the-box to automatically get an IP
address from the DHCP server on the network. Unless the local IT administrator has
specifically assigned an IP address in advance, you may not know the current IP
address.

The Ion Torrent™ Server has several Ethernet ports on the back. Make sure that your
site network is connected to the port labeled LAN, called eth0 in Linux™ terminology.
The Ethernet ports are identified as eth0, eth1, ..., for as many ports as are available.
On Ion Torrent™ Server, eth0 is the only port connected to your network and is
configured by DHCP.

To determine the IP address assigned to eth0, sign in and type: ifconfig eth0. This
displays the following output:

ionadmin@ion-torrent-server:~$ ifconfig eth0
eth0 Link encap:Ethernet HWaddr 00:1b:21:5b:bb:44
inet addr:192.168.1.123 Bcast:192.169.4.255 Mask:255.255.255.0
inet6 addr: fe80::21b:21ff:fe5b:bb44/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:209970726 errors:0 dropped:0 overruns:0 frame:0
TX packets:419252947 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:14131928595 (14.1 GB) TX bytes:607398487997 (607.3 GB)
Memory:fbea0000-fbec0000

Your IP address is the inet addr.

inet addr:192.168.1.1 Bcast:192.169.4.255 Mask:255.255.255.0

Another useful check is the line beginning with UP, which indicates the interface is
active and working.

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

If the eth0 port is not available, it is possible that the Ethernet cable is connected to a
network, so you may not see the word UP.

BROADCAST MULTICAST MTU:1500 Metric:1

If an IP address is assigned, the interface is likely to work. If no IP address is assigned
and the interface is not UP, you may need to get help from your site IT administrator.

If you are still concerned about network connectivity, you can test whether different
desktops are able to successfully ping the server IP address. If you are not able to
ping the server from the desktops that need to access the Torrent Suite™ Software
running on the server, contact your site IT administrator.

Verify the Ion
Torrent™ Server IP
address
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The Ion Torrent™ Server uses the Linux™ Network Time Protocol (NTP) program to
synchronize its time with another time server. By default, the Ion Torrent™ Server is
configured to synchronize its time service to a trusted time service on the Internet.
This configuration requires that the network configuration allows the NTP network
protocol to connect to that time service on the Internet.

The Ion Torrent™ Server can also act as a time server for Ion PGM™ and Ion Proton™

Systems. However, if the server is not able to synchronize with the trusted time
service, it does not act as a time server for the systems (Ion Torrent™ Server does not
forward potentially incorrect information to other machines).

If the network configuration is blocking the NTP protocol from reaching the Internet,
the Ion Torrent™ Server and the Ion PGM™ and Ion Proton™ Systems cannot
synchronize time.

Your site network administrator is probably aware of this connectivity restriction, and
it is likely that IT has a time server in the network.

Do not delete the data from the Ion PGM™ or Ion Proton™ Sequencer until you are
confident that the data are present on the Ion Torrent™ Server, the analysis is
successful, and the Analysis Report has been generated successfully.

1. Verify that all files successfully transferred from the Ion PGM™ and Ion Proton™

Sequencers to the Ion Torrent™ Server.

2. (Optional) Manually transfer files by going to Data Management4 Re-transfer,
then select an option for any of the runs in question. You can then safely transfer
data again.

System diagnostics information can help in troubleshooting network, disk space, and
system status problems.

1. To access system diagnostics
information, click 
(Settings)4About

2. Scroll down to the More
Information and Assistance section,
then click System Support
Diagnostics.
The diagnostics screen provides Network, System, and Data sections. A small
section of each is shown:

Troubleshoot and
configure the time
service

Verify file transfer

View system
support
diagnostics
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Use Instrument Diagnostics to investigate chip and sequencing instrument problems,
such as pH levels.

1. To access the Instrument Diagnostics information, click  (Settings)4About:

2. Scroll down to the More
Information and Assistance section,
then click the Instrument
Diagnostics link:

The Instrument Diagnostics screen lists the sequencing instruments that are
associated with each of your results partitions. Passed and failed analysis runs
are shown for each instrument.
The InitLog.txt file includes diagnostic measurements and if possible presents a
probable cause and suggests next steps.

View instrument
diagnostics
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3. To investigate a failed run, click the View log link for that run:

The InitLog.txt file opens for that run on the instrument:
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If you need to restart a service, you can not restart the service using the Torrent Suite™

Software. The easiest approach is to shut down and restart the Ion Torrent™ Server.

After shutting down and restarting the server, all services that were running before
shutting down continue from the point where they were interrupted, and no more
user interaction is needed.

IMPORTANT! Before restarting the Ion Torrent™ Server, make sure that no Ion PGM™

Sequencer or Ion Proton™ Sequencer is uploading data to the server, otherwise the file
transfer is interrupted.

1. Shut down and restart the Ion Torrent™ Server.

2. (Optional) Restart the services using the scripts located in the /etc/init.d
directory. For example, use the following command to restart the Crawler:

user@svr:/etc/init.d$ sudo /etc/init.d/ionCrawler restart 
Stopping crawler Starting crawler pid = 26025

3. Verify that the services are running using the ps ax | grep py command or
the Torrent Suite™ Software user interface.
If the services do not continue to run after being restarted, contact your local
Field Service Engineer for assistance.

After the root cause of a major problem is identified, the following more intrusive
action may be needed:

• Replace a failed hard disk drive
• Downgrade software packages
• Reinstall software
• Modify configuration files
• Add, modify, or delete database information

Contact your local Field Service Engineer for assistance before you attempt any of
these actions.

Restart services

Further
investigation and
problem
resolution
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Documentation and support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
• Worldwide contact telephone numbers
• Product support information

– Product FAQs
– Software, patches, and updates
– Training for many applications and instruments

• Order and web support
• Product documentation

– User guides, manuals, and protocols
– Certificates of Analysis
– Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,
contact the manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale at 
www.thermofisher.com/us/en/home/global/terms-and-conditions.html. If you have
any questions, please contact Life Technologies at www.thermofisher.com/support.
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Glossary

Number of Ion Sphere™ Particles at 50+ bp at Q10.

Number of Ion Sphere™ Particles at 50+ base pairs at Q17.

ISPs that carry DNA insert length of less than 8 bp.

The aligned length of a read at a given accuracy threshold is defined as the greatest
position in the read at which the accuracy in the bases up to and including the
position meets the accuracy threshold. For example, the AQ17 length of a read is the
greatest length at which the read error rate is 2% or less. The "perfect" length is the
longest perfectly aligned segment. For all of these calculations, the alignment is
constrained to start from position 1 in the read—that is, no 5′ clipping is allowed.

The number of bases covered by reads aligned to the reference sequence.

An alignment quality (AQ) score defines read accuracy when compared to the
reference sequence. The discrepancy can be biological (real variant) or technical
(sequencing error). For example, an AQ score of 17 represents 2% aligned read error
rate, while an AQ score of 20 represents 1% aligned read error rate when compared to
the reference sequence.

The average number of reads of all targeted reference bases.

The average number of reads of all targeted reference bases that were read at least
once.

A BAM (binary alignment map) file (. bam ) is the binary version of a SAM (sequence
alignment map) file. A SAM file (.sam) is a tab-delimited text file that contains
sequence alignment data. A BAM file contains aligned reads sorted by reference
location.

A barcode is a machine-readable code in the form of numbers and a pattern of parallel
lines of varying widths, printed on and identifying a product.

There are several applications for barcodes. Libraries can be molecularly barcoded
with unique nucleic acid sequence identifiers. Library barcodes are used during data
analysis to sort the sequencing results from sequencing reactions that contain
combined libraries. Chips and sample tubes also contain unique numeric barcodes
that aid in the setup of the experimental analysis workflow.

50Q10 Reads

50Q17 Reads

adapter dimer
(ISPs)

aligned read
length

aligned reads

AQ score

average base
coverage depth

average base read
depth

BAM file

barcode
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Base calling is the process by which raw data from the sequencing instrument is con-
verted to nucleotide sequences. This is performed by base calling software that is usu-
ally run from the instrument itself.

Signal processing input files are converted to a single condensed basecalling input file
that represents the processed signal. Basecalling input files are required files for
basecalling.

The percentage of chip wells that contain live ISPs. The percentage value considers
only potentially addressable wells. Bead loading is calculated as number of loaded
ISPs divided by the number of potentially addressable wells.

Abbreviation for "base pair(s)".

The percentage of tumor cells in a given sample.

Browser Extensible Data file—BED file—defines chromosome positions or regions.

An ISP is clonal if all of its DNA fragments are cloned from a single original template.
All fragments on such a bead are identical and respond in unison during a nucleotide
flow across the chip.

Copy number variation (CNV) is the variation in copy number of any given gene
between two samples. CNV is a phenomenon in which sections of the genome are
repeated and the number of repeats in the genome varies between individuals in the
human population.

A contig (from contiguous) is a set of overlapping DNA segments that together
represent a consensus region of DNA.

Control nucleic acid sequences can be added to DNA or RNA samples to facilitate
post-sequencing data analysis. Two types of control sequences can be used during
sample preparation. ERCC RNA Spike-In Mix is used with RNA samples to achieve a
standard measure for data comparison across gene expression experiments. Ion
AmpliSeq™ Sample ID Panel, comprised of nine specially designed primers, can be
added prior to template amplification to generate a unique ID for each sample during
post-sequencing analysis.

A comma-separated values (CSV) file is a delimited text file in which each line
represents a data record with information fields separated by a comma. A CSV file
stores tabular data (numbers and text) in plain text. Each line of the file is a data
record.

CSV files are easily opened using spreadsheet software, such as Microsoft™ Excel™ or
Apache® OpenOffice ™ Calc, where each comma-separated field is listed in a separate
column.

A user-created Planned Run template. Custom templates can be created based on a
preinstalled Planned Run template and modified to fit specific needs.

base calling

basecalling input
file

bead loading

bp

cellularity (%)

BED file

clonal ISP

CNV

contig

control sequence

CSV file

custom template
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A DAT file is a generic data file. It contains data that may be opened or referenced by
a specific application. While some DAT files can be opened directly, most contain
program data that is referenced the program when it is running. Therefore, most DAT
files are not meant to be opened manually.

Nucleic acid sequence data that is assembled from sequencing reads without the aid
of a reference genome library sequence.

Wells on a chip that do not contain an ISP.

Predicted number of live ISPs that have a key signal identical to the library key signal.
The percent enrichment value reported is the number of loaded ISPs that are library
ISPs, after taking out the test fragment ISPs.

A FASTA file is a text-based format for representing either nucleotide sequences or
peptide sequences, in which base pairs or amino acids are represented using single-
letter codes. A sequence in FASTA format begins with a single-line description,
followed by lines of sequence data.

A FASTQ file is a text-based format for storing both a biological sequence (usually
nucleotide sequence) and its corresponding quality scores. Both the sequence letter
and quality score are each encoded with a single ASCII character for brevity.

A data filtering parameter that is used instead of INDEL, SNP, and MNP.

Number (and percentage) of reads, passing all filters that are recorded in the
unmapped BAM file. This value may be different from the total number of reads
located in the Library Summary Section due to specifications associated with read
trimming beyond a minimal requirement resulting in total number of reads being
slightly less than Final Library Reads.

A flow is the event of exposing a chip to one particular dNTP ( deoxyribonucleotide
triphosphate), followed by a washing step.

The order in which a chip is exposed to each particular dNTP. The default Samba flow
order consists of a 32-base sequence, repeated. This flow order resists phase errors by
providing opportunities for out-of phase molecules to catch up and is designed to
sample all dimer (nucleotide pair) sequences efficiently. Samba is the default flow
order because it improves sequencing accuracy for longer reads by resisting phase
errors.

Progress of the sequencing run expressed as number of total flows completed. For
example, a sequencing run set to 500 flows shows 250/500 flows in the status column
of the Runs in Progress table when the sequencing run is half completed.

A target technique used for detection and annotation of gene fusions (or translocation
of genetic material) in samples.

DAT file

de novo assembly

empty wells

enrichment (%)

FASTA file

FASTQ file

FD (flow
disruptiveness)

final library reads

flow

flow order

flow transfer

fusions
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A BED or a VCF file that defines regions in the gene that typically contain variants.
Specifying a hotspots file to use in a run enables Torrent Variant Caller to identify if a
specific variant is present or absent. A hotspot file instructs the Torrent Variant Caller
to include these positions in its output files, including evidence for a variant and the
filtering thresholds that disqualified a variant candidate. A hotspot file affects only the
variantCaller plugin, not other parts of the analysis pipeline. If you don't specify a
hotspots file, the software tells only the difference between your sequence and the
reference genome.

Isothermal application (IA) is a template preparation technique that uses nonemulsion
isothermal reaction to clonally amplify DNA onto an ISP surface.

INDEL is an abbreviation used to designate an insertion or deletion of bases in the
genome of an organism.

Intermediate files contain information used for debugging runs.

A network of Ion Torrent™ Servers that allows users to perform the following actions:
• View all runs of interest across multiple servers on the same data page.
• Transfer Planned Runs between different connected servers.
• Perform flexible workflows for Ion 550™ Chips across different Ion Chef™

instruments connected to different servers. Torrent Suite™ Software can track
reagent/cartridge usage across multiple servers that are a part of the same Ion
Mesh.

Ion Sphere™ Particles (ISPs) are particles that contain bound copies of a single
(ideally) DNA fragment amplified during template preparation.

Average 1-mer signal in the library key.

Live ISPs that have a key signal identical to the library key signal.

Laboratory Information Management System (LIMS) software is used for recording
sequencing metadata. Entered text is associated with the Planned Run and can be
extracted using APIs for LIMS consumption.

An ISP with a signal of sufficient strength and composition to be associated with the
library or test fragment key.

An ISP with a low or unrecognizable signal.

A short known sequence of bases used to distinguish a library fragment from
a test fragment (for example, "TCAG").

Sequencing reads that have been mapped to the reference sequence.

Average raw accuracy of 1-mers at a specific position in the read.

hotspots file

IA

INDEL

intermediate files

Ion Mesh

ISPs

key signal

library ISPs

LIMS metadata

live ISP

low quality ISP

library key

mapped reads

mean raw
accuracy
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Multiple nucleotide polymorphism (MNP) is a genetic mutation in an allele that
differs from the reference allele of the same length by >1 nucleotide.

Sequencing reads mapped to any target region of the reference. A read is considered
to be on target if at least one aligned base overlaps a target region. A read that
overlaps a targeted region but where only flanking sequence is aligned, for example,
due to poor matching of 5′ bases of the read, is not counted.

A Planned Run template that comes preinstalled with Torrent Suite™ Software on the
Ion Torrent™ Server. Preinstalled Planned Run templates are designed to help users
create a Planned Run or a customized Planned Run template for a specific research
application. Preinstalled Planned Run templates cannot be deleted from the server.

A Planned Run is a file that contains executable instructions for individual runs. The
file contains all the specifications, settings, and parameters for template preparation
and chip loading on the Ion Chef™ Instrument, and sequencing on an Ion S5™/Ion
S5™ XL or Ion GeneStudio™ S5 Series system.

A reusable experimental design (digital protocol) for the sequencing instrument that
holds specifications for sample preparation, sequencing, data export, and post-
sequencing data analysis.

An ISP that carries clones from two or more library sequences.

A primer dimer (PD) is a potential by-product in PCR, a common biotechnological
method. As its name implies, a PD consists of primer molecules that have attached
(hybridized) to each other because of strings of complementary bases in the primers

An ISP that carries an insert length of less than 8 base pairs.

A person or a sample that is serving as a starting point for the genetic study. Denoting
the proband aids in establishing relationships within a group. In medical genetics, the
proband is the first affected family member who seeks medical attention for a genetic
disorder.

Predicted error rate of 10%.

Predicted error rate of 2%.

The number of bases that have a Q Score of ≥17 in a given sequencing output.

Predicted error rate of 1%.

The number of bases that have a Q Score of ≥20 in a given sequencing output.

The length of called reads measured in base pairs.

The sequence of a section of a unique fragment obtained after the end of the
sequencing process.

MNP

on target reads

preinstalled
Planned Run
template

Planned Run

Planned Run
template

polyclonal ISP

primer dimer

primer dimer ISP

proband

Q10

Q17

Q17 bases

Q20

Q20 bases

read length

read
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A consensus nucleotide sequence that represents the genome of a particular species.
The results from a sequencing run are compared to the reference library to identify
sequence variants.

Defines related samples within a Sample Set. Related samples are designated by the
same relationship group number.

A SAM (Sequence Alignment Map) file is a tab-delimited text file that contains
sequence alignment data. It stores biological sequences aligned to a reference
sequence.

Genetic material from one source (for example, DNA from one individual).

Signal processing input files consist of the raw voltage measurement data collected
during the sequencing run. These files are required to reanalyze the run from signal
processing.

Single nucleotide polymorphism (SNP) is a genetic mutation in an allele that differs
from the reference allele of the same length by one nucleotide.

Genetic mutations that cause a change in the organism's chromosome structure, such
as insertions, deletions, copy number variations, duplications, inversions, and
translocations.

System signal-to-noise ratio.

Summary statistics for targeted base reads of the reference. A base covered by
multiple target regions is counted only once per sequencing read.

A BED file that specifies all of the regions that a panel represents such as the amplified
regions that are used with target sequencing. The complete software analysis pipeline,
including plugins, is restricted to only these specified regions instead of analyzing the
entire reference library.

A test fragment (TF) is a known nucleotide sequence that is used to monitor system
characteristics.

Live ISPs with a key signal that is identical to the test fragment key signal.

A test fragment key (TF key) is the nucleotide sequence that is used to identify test
fragment reads.

Signal strength of the first three bases of the TF key.

Ion Torrent™ Server API (Application Programming Interface) can be used to access
database records on a Ion Torrent™ Server. Ion Torrent™ Server APIs are compliant
with REST (Representational State Transfer) architectural constraints and can be used
to retrieve all available information about sequencing run results and plugin data, and
create Planned Runs using third-party software solutions.

reference library

relationship group

SAM file

sample

signal processing
input files

SNP

structural variants

system SNR

target base
coverage

target regions file

test fragment

test fragment ISPs

test fragment key

TF key peak
counts

Ion Torrent™

Server API
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Total number of filtered and trimmed reads independent of length reported in the
output BAM file.

A tab-separated values (TSV) file is a tab-delimited file that is used with spreadsheet
software. TSV files are essentially text files, and the raw data can be viewed by text
editors, though they are often used when moving raw data between spreadsheets. See
also VCF file

A uBAM file is a variant form of the BAM file format in which the read data does not
contain mapping information. This is basically an "off-label" use of the BAM format
(which was specifically designed to contain mapping information) that is used for
data management reasons. It allows you to attach metadata to the reads from as early
on in the analysis process as possible.

Nucleotide bases covered by reads that are not aligned to the reference.

The percentage of bases in all targeted regions (or whole genome) covered by at least
0.2X the average base coverage depth.

Usable reads consist of library ISPs that pass the polyclonal, low quality, and primer
dimer filter.

A variant call format (VCF) file specifies a variant of interest and its location. This file
stores only the differences between the BAM file and the reference file.

Number of wells that were determined to be positive for the presence of an ISP within
the well. Wells containing ISPs have a delayed pH change due to the presence of an
ISP slowing the detection of the pH change from the solution.

Microsoft™ Excel™ format of a VCF file.

total reads

TSV file

uBAM file

unaligned reads

uniformity of base
coverage

usable sequence /
usable reads

VCF file

wells with ISPs

XLS file
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